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KATA PENGANTAR 
 
 

Puji syukur kepada Tuhan yang maha esa, bahwa buku yang berjudul “Desain model 

Arsitektur dan Furnitur” dibagi jadi 2 (dua) bagian, yaitu buku jilid 1 (satu) dan buku jilid 2 

(dua) yang telah dapat diselesaikan. Kedua buku itu memakai program aplikasi SketchUp yaitu 

aplikasi model 3D intuitif yang memungkinkan kita membuat dan mengedit model 2D dan 3D 

dengan menggunakan teknik cara “push and Pull” yang telah dipatenkan. Pemakaian push & 

Pull ini menyebabkan para desainer dapat mengubah permukaan datar menjadi bentuk 3D.  

Buku ini membahas desain model 3D seperti arsitektur, desain interior, arsitektur 

lanskap dengan memakai aplikasi SketchUp. Setelah SketchUp terinstal pada komputer kita, 

maka kita dapat memulai dengan menelusuri tempat penyimpanan (gudang) gambar 3D.  

Gudang Gambar 3D adalah berisi basis data model gambar 3D buatan para pengguna yang 

telah disediakan bagi siapa saja untuk diakses, mulai dari bangunan sederhana hingga seluruh 

gambar arsitektur bangunan kota dan furnitur pada abad pertengahan. 

Pada buku ini juga diajarkan fungsi dan tata letak dalam menggambar, perenderan 

permukaan dan didukung oleh Gudang gambar 3D yang tersedia secara ekstensi. Aplikasi 

SketchUp ini memiliki berbagai kemudahan yang mendukung desain arsitektur, desain 

interior, dan desain lanskap. Salah satu alasan dalam buku desain model arsitektur dan 

furnitur memakai aplikasi sketchup karena aplikasinya ringan, sehingga hampir semua 

komputer dapat mengoperasikan aplikasi sketchup dengan baik, demikian juga system 

antarmukanya juga menarik dan sedernana, bahkan bagi para pemula. Demikian juga 

tersedianya fungsi untuk mengimpor file ekstensi seperti 3ds, dwg, pdf, jpg dan lain lain. 

 Semoga buku ini dapat memberi pengetahuan, pengalaman dan bermanfaat bagi para 

mahasiswa yang ingin belajar mengembangkan desain model arsitektur dan furnitur dengan 

cara yang mudah dan sederhana.  

 
 
                     Semarang, 20 Mei 2021 
 
      Dr. Mars Caroline Wibowo, ST, M.Mm.Tech. 
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BAGIAN 1 
PERMODELAN MODEL 

 
BAB 1 

PENGANTAR TOOL TERRAIN 
 

Alat medan adalah alat serbaguna yang kuat untuk membuat dan mengedit geometri organik. 
Geometri organik mengacu pada tepi dan permukaan yang disusun untuk mensimulasikan 
tampilan bentuk dan objek yang tidak beraturan. Beberapa contoh geometri organik adalah 
kemiringan dan kemiringan tanah yang landai, lengkungan pada sebuah bangunan, dan 
lengkungan kanopi yang bergelombang. 

Berbagai alat medan memungkinkan Anda menghasilkan nilai yang ada dan yang diusulkan. 
Dengan alat ini, Anda dapat dengan cepat dan mudah mengubah model denah lokasi datar untuk 
menyertakan tanjakan tanpa perlu mengimpor tepi, titik, atau ketinggian kontur. Demikian pula, 
dimungkinkan untuk membuat model denah lokasi secara langsung ke model kontur digital yang 
ada atau yang diusulkan. 

Sandbox 

Bermain di Sandbox 

Berasal dari SketchUp, alat ini berfungsi sebagai rangkaian ekstensi luar biasa yang 
memungkinkan pemodelan nilai yang cepat dan akurat. Untuk mengaktifkan bilah alat Sandbox, 
buka View Toolbars dan centang kotak Sandbox Tools. 

Kami memperkenalkan Sandbox di sini karena membantu orang membuat model medan - benda 
yang diduduki bangunan Anda (atau di dalamnya, jika yang Anda buat adalah di bawah tanah). 

Sandbox bukanlah hal baru, tetapi karena lokasinya yang kurang jelas, sebagian besar pengguna 
SketchUp belum pernah menggunakannya. Berikut fakta-faktanya: 

 Sandbox adalah kumpulan tool. Setiap tool memiliki tujuan yang cukup spesifik dan 
dimaksudkan untuk digunakan pada tahap tertentu dari proses pemodelan medan. 
Karena itu, seperti semua tool SketchUp, tool ini sangat fleksibel. Anda dapat 
menggunakannya untuk memodelkan apa pun yang Anda inginkan. 

 Sandbox ada di Make dan Pro. Terlepas dari apa yang dipikirkan banyak orang, tool 
Sandbox tidak hanya untuk pengguna Pro; orang yang menggunakan versi gratis dari 
SketchUp juga dapat menggunakannya. Mereka hanya disembunyikan, yang membawa 
Anda ke poin kami berikutnya. 

 Sandbox disembunyikan. Alasannya rumit, tetapi tool di Sandbox sedikit istimewa; itu 
ekstensi - Anda harus menemukannya dan mengaktifkannya sebelum Anda dapat 
menggunakannya. Jika Anda menggunakan SketchUp Pro, Anda dapat melewati dua 
langkah pertama dalam daftar berikut - keduanya sudah diaktifkan. Ikuti langkah-langkah 
berikut untuk mengaktifkan tool Sandbox. 
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a. Pilih Window => Preferensi dari Menu bar untuk membuka kotak dialog 
Preferensi. Pilih SketchUp => Preferensi jika Anda menggunakan Mac. 

b. Di panel Ekstensi, pastikan kotak centang tool Sandbox dipilih dan kemudian 
tutup kotak dialog Preferensi. 

c. Pilih View => Toolbars => Sandbox dari menu bar untuk menampilkan toolbar 
Sandbox. 

Membuat model medan baru 

Baik Anda membuat model sepetak tanah untuk sebuah bangunan atau mendesain ulang Central 
Park, Anda memerlukan salah satu dari dua metode pemodelan medan: 

 Mulai dari data yang ada: Data yang ada ini biasanya datang dalam bentuk garis kontur 
atau topo; lihat bagian selanjutnya untuk membaca lebih lanjut tentang mereka. 

 Memulai dari awal: Jika Anda tidak memiliki data untuk memulai atau jika Anda memulai 
dengan situs yang sangat datar, Anda dapat menggunakan tool Dari Awal dari SketchUp 
untuk menggambar kisi yang mudah dibentuk menjadi perbukitan, tanggul, dan lembah. 
Lewati ke”Membuat model medan dari awal" untuk informasi lebih lanjut. 

Alat From Contour 

From Contours adalah alat utama dalam palet Sandbox, dan memiliki banyak kegunaan. Ini 
menghasilkan”kulit" yang menyatukan face di antara tepi yang dipilih. Face yang dijahit secara 
otomatis membentuk kelompok. 

Meskipun biasanya digunakan untuk membuat medan simulasi menggunakan data kontur yang 
diimpor dari AutoCAD, namun dapat digunakan untuk membuat hampir semua geometri, 
termasuk trotoar landai, dinding window kaca arsitektur, dan struktur tarik. 

Banyak contoh dan tutorial di Bagian 4 berfokus pada cara memanfaatkan alat Dari Kontur.  

Catatan: Jika Anda tidak dapat melihat tool Sandbox di menu Anda, Anda belum 
mengaktifkannya. Lihat awal bagian ini,”Membuat dan Memodifikasi Medan,” untuk 
memperbaiki situasinya. 

 Garis kontur Anda perlu dinaikkan. tool Dari Kontur membuat permukaan dari garis 
kontur yang sudah diposisikan pada ketinggian yang tepat dalam ruang 3D. Sebagian 
besar waktu Anda bekerja dengan kontur yang merupakan bagian dari gambar 2D, dan 
itu berarti Anda mungkin harus mengangkatnya sendiri menggunakan Move toolkan - 
satu per satu. Itu membosankan tapi perlu. Cukup oleskan tool Pilih, nyalakan musik, dan 
mulai bekerja.  

 Unduh dan pasang Weld. Ekstensi Weld SketchUp mengubah pilihan segmen garis 
individu menjadi polyline - ini membuatnya jauh lebih mudah untuk dikerjakan. Jika Anda 
bekerja dengan garis kontur yang diimpor dari file gambar berbantuan komputer (CAD), 
menggunakan Weld membuat hidup Anda sedikit lebih mudah.  
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 Anda Akhiri dengan grup. Saat Anda menggunakan From Contours, SketchUp secara 
otomatis membuat permukaan baru Anda (yang Anda buat dari garis kontur) ke dalam 
grup. Ini meninggalkan garis asli itu sendiri sepenuhnya; Anda dapat memindahkannya, 
menyembunyikannya, atau menghapusnya jika Anda mau. Kami merekomendasikan 
membuat grup lain dari mereka, meletakkannya di layer terpisah dan menyembunyikan 
layer itu sampai Anda membutuhkannya lagi. 

 Untuk mengedit permukaan baru Anda, aktifkan Hidden geometry. Permukaan organik 
mengalir yang baru saja Anda buat sebenarnya hanyalah sekumpulan segitiga kecil. tool 
Dari Kontur memperhalus tepian yang mendefinisikannya, tetapi semuanya ada di sana. 
Untuk melihatnya, pilih View => Hidden Geometry dari menu bar. 

 Cobalah untuk menjaga geometri Anda tetap masuk akal. tool Dari Kontur sangat 
berguna, tetapi ada batasnya. Masalahnya adalah terlalu mudah menggunakannya untuk 
membuat geometri (muka dan tepi) dalam jumlah besar yang benar-benar dapat merusak 
sistem Anda. Jika kontur Anda membutuhkan waktu lama untuk berubah menjadi 
permukaan, atau jika permukaan itu sangat besar sehingga komputer Anda berubah 
menjadi biru dan menggulung menjadi posisi janin (boleh dikatakan begitu), Anda perlu 
mundur beberapa langkah dan melakukannya ( atau mungkin semua) dari berikut ini: 

o Bekerja di area yang lebih kecil. Betapa menyenangkannya untuk memiliki seluruh 
lingkungan dalam model SketchUp Anda, Anda mungkin harus mempersempit 
cakupan Anda. Hanya membuat yang Anda butuhkan adalah kebijakan pemodelan 
yang baik. 

o Gunakan hanya setiap garis kontur lainnya. Melakukan ini secara efektif membagi 
dua jumlah geometri di permukaan yang Anda hasilkan. 

o Dumb Down garis kontur. Ini agak sulit untuk dijelaskan, tetapi begini: tool Dari 
Kontur bekerja dengan menghubungkan garis kontur yang berdekatan bersama 
dengan edge yang membentuk segitiga. Berapa banyak segitiga yang dibuatnya 
bergantung pada berapa banyak segmen edge individu di setiap garis kontur; 
Gambar 6-18 memberikan ilustrasi. Kecuali Anda membuat garis kontur untuk 
memulai - kemungkinan besar Anda mengimpornya sebagai bagian dari file CAD - 
Anda tidak memiliki kendali atas seberapa detailnya. Menggambar ulang setiap 
garis kontur memang mengecewakan, tetapi untungnya, Anda dapat mengunduh 
ekstensi Simplify Contours yang hebat yang membuat prosesnya jauh lebih 
sederhana. 

 Anda tidak harus memulai dengan garis kontur yang sudah ada. Faktanya, menggambar 
edge Anda sendiri dan menggunakan From Contours untuk menghasilkan permukaan 
darinya adalah salah satu cara paling ampuh untuk membuat bentuk organik dan non-
kotak di SketchUp. Bagian berikutnya,”Memodelkan medan dari awal", memiliki detail 
lebih lanjut. 

 Bersiaplah untuk melakukan pembersihan. Permukaan yang dibuat From Contours 
biasanya perlu dibersihkan sampai batas tertentu. Gunakan Penghapus untuk menghapus 
geometri ekstra (Anda akan menemukan banyak di sepanjang edge atas dan bawah 
permukaan Anda). Gunakan tool Flip Edge untuk memperbaiki orientasi face segitiga 
Anda. Lihat sidebar terdekat”Jangan membalik - Balik Tepi" untuk melihat ke bawah. 
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Gambar 1-1 Berapa banyak segitiga yang dibuat tergantung pada jumlah segmen edge pada garis 
kontur yang Anda buat. 

 

JANGAN FLIP OUT - FLIP EDGE 

Alat Flip Edge Sandbox adalah bidang sederhana, tetapi sangat diperlukan jika Anda bekerja 

dengan tool Dari Kontur. Pada dasarnya, Anda menggunakan Flip Edge untuk membersihkan 

permukaan yang dibuat From Contours. Saat Anda mengubah garis kontur menjadi 

permukaan, banyak sekali permukaan segitiga muncul. Terkadang, tool Dari Kontur 

memutuskan untuk menggambar edge di antara dua segmen garis yang salah, membuat dua 

permukaan segitiga yang membentuk ”titik datar" di permukaan Anda. Lihat gambar berikut. 

Anda menghilangkan titik-titik datar ini secara manual dengan membalik edge yang 

membuatnya. Melakukannya akan mengubah permukaan segitiga yang dihasilkan, biasanya 

membuatnya berakhir berdampingan (bukan satu di atas yang lain). 

Untuk menggunakan tool Flip Edge (pilih Tools => Sandbox => Flip Edge), cukup klik edge yang 

ingin Anda balik. Jika Anda tidak yakin tentang sebuah tepi, lanjutkan dan balikkan; lalu lihat 

apakah semuanya terlihat lebih baik. Jika tidak, Anda selalu dapat mengUndo atau 

membalikkannya kembali. 
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Gambar 1-2 Buat draf model seperti yang diuraikan dalam gambar. 
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Gambar1-3 Pilih tepi seperti yang ditunjukkan dan jalankan alat Dari Kontur. 

 

Gambar 1-4 Face akan dijahit di antara tepi yang dipilih. 
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Gambar 1-5 Face yang dijahit mensimulasikan kemiringan dan medan. 

Memodelkan medan dari awal 

Tanpa garis kontur yang menentukan bentuk medan yang ingin Anda modelkan, Anda harus 
mulai dengan permukaan yang rata. Gunakan tool From Scratch untuk membuat persegi panjang 
datar besar yang mewakili sebongkah tanah. Karena persegi panjang sudah dibagi menjadi 
permukaan segitiga, maka mudah menggunakan tool Smoove (dibahas selanjutnya dalam bab 
ini) untuk membentuk persegi panjang menjadi bukit, lembah, jebakan pasir, dan apa pun yang 
Anda pikirkan. 

Inilah masalahnya: Ini adalah kesempatan yang sangat jarang Anda memiliki carte blanche 
dengan sebidang tanah. Kecuali jika Anda mendesain sesuatu seperti lapangan golf di tengah 
dasar danau yang kering atau terraform sebagai planet baru untuk kolonisasi, Anda mungkin 
harus menghadapi kondisi medan yang sudah ada sebelumnya. Dan jika itu masalahnya, Anda 
mungkin lebih baik memulai dengan serangkaian garis kontur yang menggambarkan kondisi 
tersebut, seperti yang dibahas sebelumnya di bab ini. 

Jadi, meskipun tool Dari Awal berfungsi dengan baik, Anda mungkin tidak perlu terlalu sering 
menggunakannya. Semua sama, berikut cara melakukannya, untuk berjaga-jaga. 

Ikuti langkah-langkah berikut untuk membuat permukaan medan baru dengan tool Dari Awal dan 
lihat Gambar 6-19 saat Anda melakukannya: 

1. Pilih Draw => Sandbox => From Scratch dari menu bar untuk mengaktifkan tool From 
Scratch. 

2. Ketik jumlah spasi kisi dan tekan Enter.  
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Jumlah jarak grid default adalah 10 kaki, yang berarti tool tersebut menggambar persegi 
panjang yang terdiri dari persegi sepanjang 10 kaki. Jarak petak yang Anda pilih 
bergantung pada seberapa besar area yang Anda rencanakan untuk dimodelkan dan 
seberapa detail Anda berencana membuat medan untuk model tersebut. 

3. Klik untuk memosisikan salah satu sudut permukaan medan baru Anda di tempat yang 
Anda inginkan. 

4. Klik untuk menentukan lebar permukaan yang Anda gambar. 
5. Klik untuk menetapkan panjang permukaan medan baru Anda.  

Setelah selesai, kotak besar besar yang Anda buat akan otomatis menjadi grup. Klik dua 
kali dengan tool Pilih untuk mengeditnya dan memulai. Anda mungkin akan memutuskan 
untuk menggunakan tool Smoove selanjutnya; lanjutkan ke”Membuat bukit dan lembah 
dengan bentuk yang unik dengan Smoove" (nanti di bab ini) untuk mencari tahu caranya. 

 

Gambar 1-6 Gunakan tool Dari Awal untuk membuat contoh besar medan datar. 

Membuat kasar sebuah situs Mungkin Anda ingin membuat model bagian kecil dari medan non-
datar yang mengelilingi sebuah bangunan. Mungkin Anda mencoba mereproduksi kondisi situs 
yang ada, atau mungkin Anda sedang dalam proses mendesain lanskap untuk sebuah proyek. 
Ada teknik rapi untuk kasus seperti ini: Anda dapat menggunakan From Contours untuk membuat 
permukaan dengan cepat hanya dari beberapa garis sederhana. 
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From Scratch membuat serangkaian face persegi panjang yang membentuk kisi. Ukuran persegi 
panjang yang menyusun kisi dapat disesuaikan dengan memasukkan nilai di measurement 
window. Misalnya, memasukkan 4’akan membuat kotak yang terdiri dari kotak 4'×4’. Setelah nilai 
untuk ukuran kisi dipilih, alat Dari Awal memerlukan tiga titik pemilihan: titik awal, titik untuk 
menentukan lebar, dan titik yang menyediakan panjang. SketchUp akan menghasilkan kisi Dari 
Awal sebagai grup. 

Mengedit model medan yang ada 

Tidak peduli bagaimana Anda membuat model medan, ada kemungkinan 99 persen terdiri dari 
banyak sekali segitiga. Aktifkan Hidden Geometry (pilih View => Hidden Geometry) untuk 
melihatnya. Selama Anda memiliki segitiga, Anda dapat menggunakan tool pengeditan medan 
Sandbox. Bagian ini menunjukkan kepada Anda bagaimana melakukan hal berikut: 

 Bentuk (atau bentuk kembali) medan Anda dengan tool Smoove. 

 Buat tempat datar untuk bangunan dengan tool Stempel. 

 Gambar path dan jalan dengan tool Drape. 

Bersamaan dengan alat Smoove, kisi Dari Awal dapat dibuat untuk mensimulasikan bentuk lahan 
dan ketinggian. 

 

Gambar 1-7 Dengan menggunakan alat dari awal, gambar kotak yang terdiri dari kotak 4’× 4'. 
Buat kisi 80 ′×80 ′. 
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Alat Smoove 

Alat ini dimaksudkan untuk digunakan dengan From Scratch. Saat aktif, ini menggunakan line tool 
melingkar untuk memilih tepi dan face pada kisi Dari Awal. Geometri yang dipilih kemudian dapat 
ditarik ke atas atau ke bawah untuk membentuk gundukan atau cekungan. Ukuran garis luar 
lingkaran dapat disesuaikan menjadi lebih besar atau lebih kecil. Alat Smoove memang 
membutuhkan beberapa latihan untuk menguasainya. 

Membuat bukit dan lembah berbentuk bebas dengan Smoove 

Smoove adalah tool untuk bergerak dengan lancar - paham? Smooth + Move = Smoove. Kami 
akan menunggu sementara Anda menenangkan diri. 

Smoove sebenarnya adalah salah satu tool paling keren di SketchUp; ini memungkinkan Anda 
membentuk medan (atau permukaan horizontal apa pun yang terdiri dari permukaan segitiga 
yang lebih kecil) dengan mendorong dan menarik (semacam) tonjolan dan cekungan dalam 
berbagai ukuran. Smoove menyenangkan untuk digunakan dan memberikan hasil yang sulit Anda 
buat dengan tool lain di SketchUp. Gambar 6-21 menunjukkan apa yang dapat dilakukan Smoove. 

 

Gambar 1-8 Gunakan alat Smoove pada kisi dari awal. Sesuaikan ukuran alat Smoove menjadi 
35’. 

 

Gambar 1-9 Dengan menggunakan window Measurement, buat gundukan berukuran 6’pada titik 
tertingginya. 
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Gambar 1-10 Berlatih membuat berbagai ketinggian dengan menyesuaikan radius alat Smoove. 

Alat Drape 

Alat Drape memproyeksikan tepi yang dipilih ke permukaan tepat di bawahnya. Tepi yang 
diproyeksikan harus membagi face yang terpengaruh. Alat Drape memiliki banyak kegunaan, 
seperti menentukan luas permukaan dan memproyeksikan garis ke volume untuk membuat 
arsitektur. 

 

Gambar 1-11 Tepi yang terletak di atas permukaan diproyeksikan ke permukaan di bawah. 

 

Gambar 1-12 Face di bawah tepi yang diproyeksikan sekarang memiliki tepi yang ”disampirkan" 
ke face. Jika memungkinkan, tepi yang tersampir akan membagi face. Ini ditentukan oleh, apakah 
garis yang diproyeksikan membentuk perimeter tertutup. 
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Tool Add Detail 

Untuk menambahkan detail yang lebih halus, alat Add Detail selanjutnya dapat membagi kisi Dari 
Awal menjadi lebih kecil, bagian face yang terbagi. 

 

Gambar 1-13 Alat Tambahkan Detail diterapkan ke kisi 

Tool Stamp dan Flip Edge 

Alat Stempel dapat membantu Anda menempatkan objek ke permukaan organik. Alat Stempel 
membantu menyematkan item yang dipilih ke medan dengan menyesuaikan geometri untuk 
melipat objek. 

 

Gambar 1-14 Alat Stempel diaktifkan pada model bangunan. 

Alat Flip Edge sederhana membalikkan dan menyesuaikan orientasi tepi. Saat Anda membuat 
face menggunakan From Contours, beberapa tepi disejajarkan sedemikian rupa sehingga 
mengubah geometri. Menggunakan Flip Edge pada garis yang menyebabkan distorsi akan 
menyebabkan garis tersebut terbalik dan ”memperbaiki" arah face, menghilangkan distorsi 
tersebut. 
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Gambar 1-15 Permukaan di bawah akan menyesuaikan untuk membantu menempatkan 
bangunan tepat di atas model. 

 

Gambar 1-16 Model medan yang disesuaikan dengan bangunan 

Meskipun alat Stamp dan Flip Edge memiliki kegunaan praktis, tutorial Sandbox di Bagian 3 tidak 
menggunakannya untuk membuat kelas, arsitektur, atau formulir. Meskipun Anda tidak akan 
menggunakannya di sini, silakan jelajahi sendiri. 

Ekstensi medan 

Seperti disebutkan, tersedia beberapa ekstensi medan lain yang dapat membantu menghasilkan 
dan mengedit geometri tidak beraturan. Kebanyakan dari mereka tersedia secara gratis. Skrip-
skrip ini sangat berharga (seperti banyak skrip lainnya yang tidak tercakup dalam buku ini). 
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Alat di Permukaan 

Ini adalah seperangkat alat canggih yang mirip dengan perintah Menggambar SketchUp. Mereka 
dapat digunakan pada geometri organik dan permukaan tidak beraturan untuk menggambar 
garis, busur, dan bentuk dengan cara yang sama seperti menggambar pada permukaan datar. 
SketchUcation. 

 

Gambar 1-17 Alat di toolbar permukaan 

 

Gambar 1-18 Bentuk disusun langsung ke permukaan organik menggunakan Tools on Surface 

JointPushPull 

Ekstensi ini setara dengan Push/pull untuk geometri organik. Dengan memilih sekelompok face 
faceted dan menerapkan JointPushPull, Anda dapat menarik face ke atas atau ke bawah untuk 
menambah volume. Skrip memungkinkan Anda memilih beberapa face yang tidak terhubung dan 
menerapkan Push/Pull ke semua face yang dipilih. Seperti halnya Alat di Surface, skrip ini dibuat 
oleh Fredo6 dan tersedia melalui Toko Plugin SketchUcation. 
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Gambar 1-19 Face yang dipilih pada permukaan medan yang akan Dorong/Ditarik secara massal, 
menggunakan Ruby Joint PushPull 

 

Gambar 1-20 Face JointPushPull dimaksudkan untuk menentukan jalan dan mengekang melalui 
medan. 
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Gambar 1-21 Alat JointPushPull dapat digunakan untuk membuat fitur pada permukaan 
melengkung. Beberapa permukaan pada permukaan lengkung ini telah dipilih. 

 

Gambar 1-22 Alat JointPushPull digunakan pada permukaan yang dipilih untuk membuat 
indentasi. 

 

Gambar 1-23 Muka yang didorong diimbangi untuk membentuk tiang window untuk membuat 
window non komponen pada kelengkungan. 
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Gelembung Kulit Sabun 

Ekstensi ini mirip dengan From Contour, tetapi jauh lebih kuat. Ini menciptakan face jala grid 
antara tepi yang dipilih. Bentuk yang dibuat oleh ekstensi ini cenderung memiliki definisi yang 
lebih besar dibandingkan dengan From Contour. Muka yang dihasilkan dapat diberi nilai untuk 
menambah tonjolan dan kelengkungan dengan menambahkan”tekanan" ke permukaan, seperti 
gelembung sabu. Perluasan ini membutuhkan beberapa latihan sehingga tepi yang dipilih 
membentuk loop tertutup yang terhubung, tetapi hasilnya sepadan dengan waktu yang 
dihabiskan untuk menguasainya. 

Skrip ini ditulis oleh Josef Leibinger dan dapat ditemukan di Extension Warehouse dan di 
http://www.tensile-structures.de/sb_software.html. 

 

Gambar 1-24 Dari Kontur ini membutuhkan dua atau lebih tepi. Soap Bubble 
membutuhkan ”lingkaran” tepi yang tertutup untuk menjahit permukaan. 

 

Gambar 1-25 Gelembung Sabun memungkinkan Anda menambahkan lebih banyak definisi ke 
permukaan dengan menyesuaikan tonjolan dan kelengkungan permukaan. 

http://www.tensile-structures.de/sb_software.html
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Jatuhkan GC 

Ekstensi Drop GC menjatuhkan grup atau komponen yang dipilih ke permukaan di bawah. Anda 
dapat menggunakan skrip ini untuk membantu menempatkan objek di medan organik. Ini hanya 
dapat digunakan pada komponen atau grup dan tidak akan berfungsi jika tidak ada permukaan 
atau objek di bawah geometri yang dipilih yang akan dijatuhkan. Skrip ini dibuat oleh Smustard 
dan dapat ditemukan di Extension Warehouse. 

 

Gambar 1-26 Komponen yang mengambang di atas medan dapat dijatuhkan langsung dengan 
ekstensi Drop GC. 

 

Gambar 1-27 Komponen mendarat di medan pada sisi pertama mereka berpotongan ke bawah 
sepanjang sumbu vertikal. Hasilnya adalah komponen ”memeluk” model medan. Ini lebih mudah 
daripada mencoba menempatkan setiap komponen di lokasi permukaan tertentu di medan. 

 

Gambar 1-28 Sebuah ”hutan" pepohonan akan dijatuhkan pada model medan besar yang dibuat 
menggunakan From Scratch dan Smoove. 
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Gambar 1-29 Pohon yang tumbang memeluk kontur model medan. 

Artist 

Artist adalah toolset pemodelan multiguna yang serbaguna. Ini dapat digunakan untuk 
memodelkan objek kompleks seperti produk konsumen atau mengedit nilai. Sculpt Brush adalah 
alat utama yang digunakan untuk bekerja dengan medan. Artisan adalah alternatif yang harus 
dimiliki untuk alat Sandbox Smoove. Alat medan tambahan juga dapat membantu dalam 
memilih, mengecat, dan mengedit permukaan organik. Artisan dapat ditemukan di Extension 
Warehouse. 

Alat dan Konsep Tambahan 

Alat medan bukan satu-satunya metode untuk memanipulasi geometri organik. Alat dan konsep 
berikut ditinjau di bab selanjutnya terkait dengan alat Sandbox. 

Berpotongan dengan Model 

Perpotongan dengan Model menciptakan tepi di mana geometri dan volume 3D tumpang tindih. 
Ini dapat digunakan untuk membantu menggabungkan objek, mengurangi volume, atau 
memotong geometri. Ini sangat berguna saat Anda menentukan area permukaan, seperti jalan 
setapak dan jalan raya, pada medan yang disimulasikan. Volume luas permukaan ditarik melalui 
model medan dan kemudian dipotong dengan model medan. Volume permukaan kemudian 
dihapus, dan kontur permukaan dipertahankan pada medan. 

Ada tiga cara untuk menggunakan Intersect with Model: 

 Dapat digunakan pada seluruh model tanpa ada yang dipilih (klik kanan menu 
konteks dan pilih Intersect Intersect with Model).  
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 Ini hanya dapat digunakan pada geometri yang dipilih (klik kanan menu konteks 
dan pilih Intersect Intersect Selected).  

 Dapat digunakan untuk menambahkan tepi ke grup dan komponen yang 
berpotongan (klik kanan menu konteks dan pilih Intersect Intersect Context). 

 

Gambar 1-30 Perpotongan dengan Model dilakukan pada kubus dan bola. Bola akan dikurangkan 
dari kubus. Perhatikan bahwa tidak ada objek yang merupakan grup atau komponen. 

 

Gambar 1-31 Bola dihapus dari kubus. Face bola tetap berada di kubus tempat kedua benda 
berpotongan. 
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Gambar 1-32 Perpotongan dengan Model dilakukan pada kubus dan komponen Sphere 

 

Gambar 1-33 Karena bola adalah sebuah komponen, setelah dihapus, geometri bola tidak akan 
tetap mengisi kekosongan di kubus. 

Geometri Konstruksi 

Geometri konstruksi menyediakan metode lain yang berguna untuk menghasilkan bentuk 
organik. Geometri konstruksi terdiri dari tepi yang digambar yang digunakan untuk membuat 
bentuk kerangka atau wireframe suatu objek. Dari Kontur diterapkan ke bingkai gambar untuk 
menghasilkan tepi dan permukaan yang menentukan”kulit" dari objek atau bentuk.  
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Gambar 1-34 Tepi/bingkai di sebelah kiri menyusun geometri konstruksi untuk membuat 
bangunan dan kubus. 

Seperti alat SketchUp lainnya, alat Sandbox dapat digunakan dalam banyak konteks berbeda. Tiga 
bab berikutnya mencakup tutorial dan contoh bagaimana memanfaatkan alat Sandbox dan Ruby 
Scripts terkait untuk membuat penilaian konseptual dan arsitektur model, dan membuat kanopi 
yang kompleks. 
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BAB  2 
Penilaian Konseptual SketchUp 

 

Model SketchUp harus menggambarkan arsitektur, permukaan, dan objek secara realistis. Bagian 
penting dari lingkungan binaan dan alami adalah medan: lereng, tanjakan, dan ketinggian yang 
menentukan puncak dan lembah. Dengan menggunakan metode dalam bab ini, medan dapat 
direpresentasikan secara realistis, menambahkan definisi penting ke model. 

Penilaian Konseptual 

Sebagian besar model SketchUp mewakili volume dan detail 3D di situs datar. Mereka biasanya 

tidak menyertakan medan atau tanjakan. Relief vertikal apa pun dalam denah lokasi dicapai 
dengan volume Push/pull dari area yang ditinggikan, biasanya langkah-langkah yang mengarah 
ke permukaan datar lainnya. 

Namun, SketchUp dapat membuat medan simulasi tanpa DEM dengan menggunakan alat 
Sandbox. Dengan alat Sandbox, ketinggian dapat dibentuk untuk menciptakan bentang alam dan 
lereng yang dapat diidentifikasi untuk mencapai tampilan, nuansa, dan skala tertentu. 
Pendekatan dasarnya tidak berbeda dengan menambahkan volume ke geometri SketchUp 
tradisional menggunakan drawing tool dan Modifikasi. From Contour adalah alat utama yang 
digunakan untuk membuat grading konseptual. Fleksibilitas alat ini didemonstrasikan secara 
ekstensif sebagai bagian dari tutorial yang disertakan. 

Penilaian Konseptual cocok dengan Pemodelan Proses SketchUp. Karena nilai simulasi dan 
medan dimodelkan ke dalam Flatwork Base, mereka harus ditambahkan setelah base selesai, 
tetapi sebelum elemen situs dimasukkan. Proses pemodelan akan diperluas menjadi sebagai 
berikut: 

1. Hasilkan dasar Flatwork. 
2. Tambahkan warna.  
3. Tambahkan volume.  
4. Detail volumenya.  
5. Tambahkan kemiringan dan kemiringan (Grading Konseptual SketchUp).  
6. Mengisi dasar dengan komponen dan objek situs. 

 

Tips Pemodelan dan Penilaian 

Saat Anda mengikuti tutorial untuk membuat lereng dan ketinggian, ingatlah tip berikut ini.  

 Seperti yang telah dibahas sebelumnya, semua konsep tepi dan permukaan harus 
digambar pada Layer 0.  

 Geometri yang dihasilkan menggunakan From Contour akan dibuat sebagai grup. 
Tempatkan geometri grup ke layernya sendiri yang disebut Terrain. 
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 Saat Anda bekerja dengan grup dan komponen, pastikan Anda mengetahui instans grup 
atau komponen di mana Anda bekerja, terutama Flatwork Base.  

 Anda harus mengaktifkan Hidden geometry (Lihat Hidden geometry) saat Anda bekerja 
dengan alat yang membantu menghasilkan dan mengedit geometri organik.  

 Dalam kebanyakan kasus, Anda perlu merancang geometri konstruksi, kerangka kerja 
yang terdiri dari tepian untuk menggambarkan bentuk dan bentuk ketinggian atau 
kemiringan yang akan dihasilkan. 

 

Tutorialnya 

Tutorial Penilaian Konseptual SketchUp berfokus pada pembuatan fitur khusus yang merupakan 
ciri khas dari denah situs. Mereka dirancang untuk membantu Anda mempelajari dan memahami 
cara membuat beberapa objek khas yang dapat diduplikasi dan digunakan di model situs lain. 
Tutorial dibangun di atas satu sama lain dan menjadi lebih kompleks seiring kemajuan Anda. Anda 
perlu mengunduh model yang ditentukan untuk menyelesaikan tutorial. 

Jalur untuk Pejalan Kaki dan Kendaraan Anda dapat menggunakan alat Dari Kontur untuk 
membuat jalur pejalan kaki dan jalur masuk kendaraan, dua elemen penting dari denah lokasi 
mana pun. Jalur landai penting untuk penyeberangan dan aksesibilitas pejalan kaki. Dengan 
menambahkan permukaan ini, Anda memberikan realisme dan konteks ke rencana situs Anda. 
Tutorial berfokus pada landai trotoar jalan dan pintu masuk jalan masuk. 

Lereng Sederhana Lereng dan medan terhadap bangunan dan dinding adalah fitur umum di 
lingkungan binaan, dan keduanya memberikan detail estetika yang bagus dalam model. Dengan 
memasukkannya ke dalam model Anda, Anda dapat membuat representasi yang lebih baik dari 
kondisi dunia nyata. 

Tutorial mendemonstrasikan bagaimana menggunakan garis sederhana, busur, dan Dari Kontur 
untuk menghasilkan lereng; ini juga menunjukkan bagaimana mengisi lereng dengan vegetasi. 

Sengkedan dan Gundukan Bioswales dan elevasi yang ditinggikan melayani berbagai tujuan. 
Mereka menyampaikan air, tampilan layar, dan menambahkan detail estetika. From Scratch, 
Drape, dan Smoove ideal untuk memahat medan seperti itu. 

Tanjakan Pejalan Kaki 

Dalam tutorial ini, Anda akan belajar membuat jalan persimpangan pejalan kaki sederhana 
menggunakan beberapa tepi sederhana dan Dari Kontur. 

Unduh dari 3D Warehouse dan model terbuka: Pedestrian_Ramp_Tutorial  

1. Push/pull permukaan”sudut” ke bawah agar rata dengan permukaan jalan yang 
berdekatan. 
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2. Pilih tepi luar yang melengkung (sejajar dengan jalan) dan tepi atas yang lebih kecil yang 
berdekatan dengan bangunan dan jalan. Dengan tepi yang dipilih, aktifkan From Contour. 

 
 
Alat Dari Kontur akan menjahit dua busur yang dipilih bersama-sama dengan serangkaian 
face. Muka yang dihasilkan membuat kurva pejalan kaki tersimulasi. Dalam banyak situasi, 
From Contour akan menghasilkan artefak (permukaan ekstra) seperti yang ditunjukkan 
oleh panah dalam grafik. 
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3. Dengan mengubah Hidden Geometry menjadi terlihat (View Hidden Geometry), Anda 
dapat menampilkan semua tepi (garis putus-putus) yang membentuk tanjakan yang 
dijahit. Anda dapat dengan mudah menghapus permukaan artefak. Masukkan instance 
grup dari tanjakan yang dihasilkan. Dengan eraser tool, hapus permukaan dan tepi ekstra. 
Pastikan untuk menghapus cukup banyak face sehingga tidak ada tumpang tindih dengan 
jalan yang berdekatan. Buatlah setepat mungkin, hapus tepi dan permukaan yang 
menopang busur asli yang digunakan untuk menghasilkan kemiringan. 
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4. Matikan hidden geometry dan tambahkan warna yang sesuai ke grup Ramp. 
 

 

Jalan Tol 

Dalam tutorial ini, Anda akan membangun tanjakan jalan masuk. Anda harus merancang tepi dan 
busur untuk membantu melengkapi bentuk tanjakan. Ini adalah contoh pertama di mana Anda 
akan menggunakan geometri konstruksi yang akan menyediakan kerangka untuk ramp. 

Unduh dari 3D Warehouse dan model terbuka: Drive_Ramp  

1. Push/pull permukaan yang ditunjukkan oleh panah pada gambar ke bawah agar rata 
dengan permukaan jalan yang berdekatan. 

 

2. Dengan Hidden geometry diatur ke terlihat, gambar tepi dan busur yang menghubungkan 
permukaan vertikal yang terbuka. Gambarlah satu tepi dari sudut atas ke titik tengah tepi 
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pertama sisi pertama yang menyusun segi kurva. Tambahkan busur, dimulai dengan titik 
tengah tepi ke persimpangan bawah. Jepitkan tonjolan (titik busur ketiga) ke tepi antara 
Facet 6 dan Facet 7. 
Ulangi langkah 2 untuk sisi lain drive. 
 

 
 

3. Pilih tepi yang dirancang dari langkah 2. Sertakan tepi bawah yang berdekatan dengan 
jalan dan tepi atas yang berdekatan dengan jalan setapak. Aktifkan alat Dari Kontur. 
 

 
 
Alat Dari Kontur akan menjahit semua tepi yang dipilih dengan serangkaian kemiringan, 
permukaan terhubung yang menirukan tanjakan penggerak. 
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4. Tambahkan warna pada tanjakan agar sesuai dengan jalan yang berdekatan. Tambahkan 
warna pada permukaan tepi jalan yang menempel pada lereng. 
 

 
 

Lereng dan Tingkatan 

Tutorial ini akan mengajari Anda cara menggunakan busur dan tepi yang disusun pada 
permukaan vertikal untuk menghasilkan serangkaian kemiringan dan kemiringan yang landai. 
Pastikan busur rata dengan permukaan vertikal dinding. 

Unduh dari 3D Warehouse dan model terbuka: Slopes_Grades 
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1. Gambarkan tiga busur yang terhubung di sepanjang permukaan vertikal dinding seperti 
yang ditunjukkan pada grafik di bagian atas halaman 234. Pastikan untuk menghubungkan 
titik pertama dari busur pertama dan titik kedua dari busur ketiga ke titik ujung sudut 
bawah dari dinding dan Base Flatwork. Pilih tiga busur yang digambar dan busur yang 
membentuk tepi yang berdekatan dari jejak. Dengan semua tepi dipilih, aktifkan alat Dari 
Kontur. 
 

 
 

 
 

2. Dari Kontur akan menghasilkan permukaan antara tepi yang dipilih. Edit grup Slope yang 
dihasilkan dan bersihkan serta hapus permukaan artefak yang tumpang tindih dengan 
jalan setapak. Pastikan Hidden Geometry diubah menjadi terlihat saat Anda menghapus 
permukaan ekstra. 
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3. Tambahkan rumput hijau dan warna tanaman ke lereng yang dihasilkan. 
 

 
 

4. Ulangi langkah 1 sampai 3 pada dinding yang berlawanan: gambar tiga busur, pilih tepi 
sepanjang jalan dan busur yang digambar, dan aktifkan alat Dari Kontur untuk 
menghasilkan kemiringan. Bersihkan geometri artefak apa pun. Tambahkan warna pada 
medan simulasi. 

 
5. Tambahkan pohon dan vegetasi ke lereng yang disimulasikan. Sertakan orang, bangku, 

dan fasilitas lainnya untuk melengkapi pemandangan. Pelajari cara menjepret pohon dan 
objek lain ke permukaan miring yang dihasilkan dalam tutorial. 
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Building Entry Walk 

Tujuan dari tutorial ini adalah untuk membuat jalan setapak dan medan terkait yang mengarah 
ke entri bangunan. Tutorial ini lebih kompleks dari contoh sebelumnya yang menggunakan 
geometri konstruksi. Semua tepi yang dirancang akan digunakan untuk menentukan berbagai 
lereng dan tingkatan. Tujuan dari tutorial ini adalah untuk mendemonstrasikan bagaimana edge 
sederhana dapat digunakan untuk menghasilkan elevasi dan grade tertentu. 

Beberapa langkah untuk tutorial ini mungkin tampak rumit. Luangkan waktu Anda dan selesaikan 
semuanya. Metode ini relatif mudah setelah selesai, tetapi mengharuskan Anda untuk berpikir 
secara tiga dimensi. 

Unduh dari 3D Warehouse dan model terbuka: Building_Entry_Walk 

1. Identifikasi area dalam model yang ditinjau dalam diagram: empat busur yang 
membentuk jalan kaki (dua di setiap sisi) dan titik awal masuk dan jalan bangunan. Pintu 
masuk bangunan terletak 8'-6 di sepanjang permukaan vertikal bangunan tempat jalan 
berakhir. Anda akan menggunakan busur dan titik akhir jalan sebagai referensi untuk 
membuat kerangka kerja untuk memodelkan jalan miring dan lanskap. 

 
2. Draft three horizontal edges onto the walk, snapping to the arc endpoints and midpoints. 

These edges will be used in the next step to place vertical edges along the length of the 
walk.  

a. Draft Edge 1 between the approximate midpoints of Arc 1 and Arc 2. Make sure 
the edge is perpendicular (magenta when being drafted).  

b. Draft Edge 2 from the endpoint where Arc 1 and Arc 3 connect to the opposite 
endpoint where Arc 2 and Arc 4 connect.  

c. Draft Edge 3 at the approximate midpoint of Arc 3 to the midpoint of Arc 4. Make 
sure the edge is perpendicular. 
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3. Pilih, salin, dan tempel (menggunakan Pindahkan/Salin) tepi vertikal 8'-6 ″ di entri gedung. 
Pilih salah satu tepi vertikal yang mengapit entri bangunan. Pilih tepi di titik ujung 
bawahnya. Tempelkan tepi ke kedua titik ujung Tepi 1, 2, dan 3 dari langkah sebelumnya.  
Tepi yang disalin mewakili titik tertinggi yang harus dicapai lereng untuk mencapai jalan 
miring. 
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4. Busur dan tepi yang ditambahkan pada langkah berikutnya (4 sampai 9) disebut busur 
yang diproyeksikan dan tepi yang diproyeksikan. Itu adalah proyeksi vertikal dari garis-
garis yang membentuk jalan horizontal. Intinya, Anda sedang membangun rangka jalan 
horizontal yang miring. Garis yang diproyeksikan akan diambil ke berbagai titik di 
sepanjang tepi vertikal yang ditambahkan pada langkah 3. Mulailah dengan berjalan Arc 
3. 

a. Dengan menggunakan alat Arc, pasang titik pertama dari busur 3 yang 
diproyeksikan ke atas tepi vertikal pada entri bangunan. 

b. Selanjutnya, jepret titik kedua ke titik tengah tepi vertikal di mana Busur 1 
terhubung ke Busur 3. Jepitkan tonjolan (titik ketiga) busur kira-kira tiga perempat 
dari jalan ke atas di tepi vertikal di titik tengah busur horizontal 3 Diagram 
menunjukkan hasil yang diinginkan. Busur miring dari pintu masuk gedung ke 
bagian tengah jalan setapak. Busur yang diproyeksikan harus ditempatkan tepat 
di atas Busur horizontal 3. 

 

5. Salin dua tepi horizontal yang ditambahkan pada langkah 2 yang terhubung ke Busur 
horizontal 3 ke atas sepanjang tepi vertikal. Pindahkan/Salin setiap tepi secara terpisah. 
Tepi harus diikat ke titik persimpangan busur 3 yang diproyeksikan dan tepi vertikal. 
Gunakan diagram sebagai referensi. Tepi yang diproyeksikan disalin ini akan digunakan 
sebagai panduan untuk memasang ke busur 4 yang diproyeksikan. 
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6. Tambahkan busur proyeksi kedua di atas busur horizontal 4. Gunakan tepi yang 
diproyeksikan disalin pada langkah 5 sebagai referensi untuk titik snap busur dan lokasi 
tonjolan. Jepitkan titik pertama busur ke atas entri bangunan yang berlawanan dengan 
busur yang diproyeksikan 3. Jepitkan titik kedua ke titik akhir tepi yang diproyeksikan 
disalin ke atas pada langkah 5 yang terletak di persimpangan Busur 2 dan Busur 4. 
Pasang tonjolan ke titik akhir dari tepi yang diproyeksikan terletak di titik tengah Busur 
horizontal 4.  
Busur 4 yang diproyeksikan ditambahkan harus sejajar dengan busur 3 yang diproyeksikan 
dan tepat di atas busur horizontal 4, seperti yang ditunjukkan dalam diagram.  
Jika dilakukan dengan benar, Anda akan membuat wireframe sederhana yang terdiri dari 
edge dan arc. Sekarang seharusnya ada dua busur miring yang miring dari pintu masuk 
gedung ke tengah jalan setapak. Paruh pertama perjalanan sekarang telah selesai. 

 
7. Ulangi langkah 4 sampai 6 di bagian bawah jalur berjalan pada busur horizontal 1 dan 2, 

membuat busur proyeksi 1 dan 2.  
a. Mulailah dengan busur 1 yang diproyeksikan. Buatlah sketsa busur, dengan 

mematahkan titik pertama ke titik akhir Busur horizontal 1 di titik akhir di tanah. 
Jepitkan titik busur kedua ke titik akhir busur 3 yang diproyeksikan.  

b. Jepitkan tonjolan busur kira-kira tiga perempat ke bawah dari atas tepi vertikal 
tengah yang terletak di titik tengah busur horizontal 1. 
Dengan busur 1 yang diproyeksikan selesai dan terhubung ke busur 3 yang 
diproyeksikan, satu sisi kerangka jalan telah selesai. 
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8. Pindahkan/Salin ke atas tepi horizontal yang terletak di titik tengah busur horizontal 1 dan 
2. Jepitkan tepi yang disalin ke persimpangan busur 1 yang diproyeksikan dan tepi vertikal 
tempat tonjolan busur diikat.  
Tambahkan busur yang diproyeksikan 2. Ini mirip dengan langkah 7. Jepitkan titik pertama 
busur ke titik akhir busur horizontal 2 pada awal perjalanan. Jepret titik kedua ke titik 
akhir busur 4 yang diproyeksikan. Terakhir, pasang tonjolan ke titik akhir tepi yang 
diproyeksikan disalin dan ditempatkan pada langkah ini. 

 

9. Hapus semua tepi yang diproyeksikan dan vertikal. Jangan hapus busur apa pun. 
Geometri konstruksi yang dihasilkan terdiri dari empat busur miring yang terhubung dan 
sejajar dengan jalan di bawahnya. Busur yang diproyeksikan sekarang menyediakan jalur 
landai yang realistis dari awal jalan setapak hingga entri gedung. 
Langkah selanjutnya mirip dengan tutorial Slopes and Grades. Serangkaian tepi dan busur 
akan disusun pada permukaan vertikal bangunan. Ini akan membantu menentukan lebih 
lanjut nilai-nilai masa depan yang akan menentukan Jalan Masuk Building Walk. 

 

10. Buatlah rancangan rangkaian busur yang terhubung pada permukaan vertikal bangunan. 
Dimulai dengan permukaan di sebelah kiri jalan setapak, mulailah di lokasi di mana busur 
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3 yang diproyeksikan terhubung ke pintu masuk gedung. Akan ada total tiga busur pada 
tiga sisi. Busur terakhir harus terhubung ke titik ujung luar bagian bawah bangunan (di 
mana ia memotong tanah). Ikuti diagram untuk ketinggian relatif dan penempatan busur 
ini. 

 

11. Selanjutnya, mulai dari persimpangan busur 4 yang diproyeksikan pada pintu masuk 
gedung dan bergerak ke kanan, buat draf rangkaian busur terhubung lainnya pada 
permukaan vertikal bangunan. Seperti pada langkah 10, ada total tiga busur, dengan 
busur terakhir menghubungkan ke bagian bawah bangunan yang memotong tanah. 
Pastikan untuk mengikuti diagram untuk mencapai ketinggian dan penempatan busur. 

 

12. Saatnya membuat permukaan jalan dan tanjakan. Pilih semua tepi yang disusun dalam 
langkah 4 hingga 11, seperti yang ditunjukkan dalam diagram. Sertakan tepi bawah luar 
tanah yang sejajar dengan jalan masuk. 
Dengan semua tepi dipilih, aktifkan From Contour. 
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13. Alat Dari Kontur akan menghasilkan jalur dan medan miring yang mengarah ke entri 
bangunan. Beralih ke Hidden geometry (Lihat Hidden geometry). 
Anda dapat melihat semua face yang dihasilkan Dari Kontur untuk membuat lereng dan 
berjalan. Namun, warna dibutuhkan untuk membantu menentukan permukaan jalan dan 
lanskap. Langkah selanjutnya akan mendemonstrasikan cara menambahkan warna. 

 

14. Masukkan turunan grup dari kemiringan yang dibuat dengan menggunakan From 
Contour. Pilih semua face yang membentuk jalan kaki. Busur luar jalan setapak akan 
terlihat jelas. Gunakan select tool dan tahan Ctrl untuk membuat pilihan aditif. Coba 
gunakan selection box untuk memilih face yang benar. Hidden geometry harus diubah 
agar terlihat untuk pekerjaan ini. 
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15. Dengan permukaan jalur yang dipilih, terapkan warna Marker Beige dari palet Material 
ke face. Keluar dari instance komponen dan terapkan warna rumput (hijau) ke grup Slope. 
Ini akan mengecat permukaan yang tersisa. Alihkan Hidden geometry ke nonaktif. 

 

Jalan masuk dan medan yang landai selesai. Meskipun ada metode lanjutan lain untuk 
mencapai tujuan yang sama, menggunakan geometri konstruksi memungkinkan Anda 
mengukur naik-turun jalan, tanjakan, atau elevasi tertentu untuk menciptakan presisi yang 
lebih baik. Ini berguna saat mendesain jalur landai yang dapat diakses atau untuk 
mendapatkan pemahaman tentang lereng spesifik apa yang merupakan bagian dari model 
proyek. 
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16. Tambahkan pohon, mobil, orang, lampu pejalan kaki, rak sepeda, dan fasilitas lainnya ke 
tempat berjalan dan tanjakan untuk membuat pemandangan lebih realistis. 

 

Taman Landform 

Sekarang saatnya bekerja di taman. Dalam tutorial ini, Anda akan memberikan taman itu 
kepribadiannya sendiri. Anda akan belajar membuat medan menggunakan tiga alat Sandbox 
terpisah: Dari Awal, Drape, dan Smoove. Jika digabungkan, keduanya memungkinkan Anda 
membuat medan yang mulus ke dalam lokasi denah lokasi tertentu. Ketinggian atau kedalaman 
medan mudah dikontrol, dan Anda akan belajar memasang medan ke bagian atas dinding dan 
tepinya. 

Unduh dari 3D Warehouse dan model terbuka: Park_Landform 
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1. Tinjau model dasarnya. Untuk tutorial ini, Anda akan menerapkan From Scratch, Drape, 
dan Smoove ke Area 1 dan 2 untuk menghasilkan medan simulasi. 

 

2. Berbatasan langsung dengan taman model Flatwork Base, gambar kisi menggunakan 
From Scratch. Grid harus 400’× 600' dengan jarak grid 10’× 10'. 

 

3. Pilih permukaan Area 1 dan Area 2. Dengan kedua permukaan dipilih, klik kanan dan ubah 
menjadi satu grup. Pindahkan grup dan tempatkan di atas grid From Scratch yang dibuat 
pada langkah 2. Pastikan bahwa area permukaan Area 1 dan 2 sesuai dengan batas grid 
From Scratch. 
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4. Pindahkan grup Area 1 dan 2 yang Anda tempatkan pada kisi ke atas pada sumbu vertikal 
untuk duduk tepat di atas kisi. 

 

5. Pilih grid From Scratch, klik kanan, dan pilih Soften/Smooth Edges. Setel tab ke paling 
kanan dan centang kotak Soften Coplanar. Ini akan menyebabkan tepi kisi disembunyikan. 

 

6. Pilih grup Area 1 dan 2 dan aktifkan perintah Drape. Pilih kisi di bawah grup dengan 
mengarahkan kursor ke atasnya. Ini akan menggantungkan tepi grup ke kisi. Masukkan 
instance grid From Scratch (itu adalah grup). Tepi yang dibungkus harus membagi bagian 
depan bingkai. 
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7. Dalam beberapa kasus, perintah Drape tidak akan membagi face kisi. Celah di pojok kanan 
bawah di bagian tepi mencegah face agar tidak terbagi. Masukkan instance grup Grid 
untuk memperbaiki masalah.  

 

8. Dalam contoh kisi, tambahkan tepi yang menghubungkan titik-titik akhir tempat celah 
berada. Pastikan tepi tambahan membagi face. 

 

9. Hapus grup Area 1 dan 2 yang terletak di atas grid From Scratch. Selanjutnya, masukkan 
contoh kisi dan hapus tepi dan permukaan kisi di luar area permukaan yang menentukan 
Area 1 dan Area 2. Setelah permukaan tambahan dihapus, aktifkan Hidden geometry 
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(Lihat Hidden geometry). Dengan hidden geometry terlihat, garis kisi ditampilkan dan 
sekarang dapat dimanipulasi. Bentuk kisi Dari Awal sesuai dengan yang ada di denah 
lokasi. 

 

 

10. Pilih kisi cut ‐ out From Scratch dan tempatkan kembali ke Flatwork Base. Gunakan sudut-
sudut grid untuk beralih ke sudut atau lokasi Flatwork Base yang diketahui. Setelah kisi 
berada di tempatnya, Anda akan siap untuk memanipulasi geometri untuk 
mensimulasikan medan menggunakan alat Smoove. 
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11. Masukkan contoh grid. Aktifkan alat Smoove dan atur Radius alat Smoove ke 60’. Mulailah 
dengan Area 1 dan aktifkan kembali pahat dan tarik permukaan ke atas 10’dengan 
memasukkan nilai di measurement window. Dengan lingkaran alat Smoove aktif, arahkan 
kursor ke lokasi kisi. Pilih lokasi dengan mengklik kiri. Tarik permukaan ke atas. Sebelum 
mengklik lagi, masukkan nilai di measurement window untuk menghasilkan ketinggian 
tertentu. Menggunakan alat Smoove untuk menghasilkan ketinggian tertentu 
membutuhkan beberapa latihan untuk dikuasai. 

 

12. Pindahkan alat Smoove ke perkiraan tepi luar dari permukaan yang ditarik ke atas dan klik 
dua kali. Ini akan mengulangi perintah Smoove terakhir dan menaikkan”gundukan" 
lainnya ke ketinggian yang sama seperti yang pertama. Ini adalah salah satu metode 
menggunakan alat Smoove untuk membuat nilai konstan dan tingkat. 
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13. Lanjutkan untuk membuat gundukan yang dimulai pada langkah 10 dan 11. Ulangi 
langkah 11 untuk membuat serangkaian gundukan. Untuk menghasilkan medan yang 
mulus, saat mengulangi perintah Smoove pada set face berikutnya, cari lingkaran pahat 
Smoove sehingga tepi luar lingkaran Smoove terletak kira-kira di atas bagian tertinggi dari 
gundukan yang berdekatan. Kemudian ulangi perintah (klik dua kali). Ini akan 
meninggikan bagian atas permukaan baru agar sesuai dengan gundukan yang berdekatan 
tanpa membuat”pelana" atau celah di antara bentang alam. 
Cobalah untuk membuat bentuk lahan yang meliuk-liuk melewati Area 1 dan pertahankan 
ketinggian yang teratur, tanpa terlalu banyak celah atau pelana. 
 

 
14. Selanjutnya, Anda akan menggunakan alat Smoove untuk memasang permukaan kisi ke 

atas dinding sehingga dinding”menahan" medan. 
Cari dinding yang berdekatan dengan jalan dan bangunan di Area 1. Sesuaikan Radius alat 
Smoove ke 30’. Tempatkan alat Smoove di atas permukaan yang berbatasan langsung 
dengan dinding. Aktifkan alat Smoove dan tarik permukaan ke atas. Alat Smoove akan 
memungkinkan Anda untuk menjepret ke titik inferensi di bagian atas dinding. Ini akan 
membawa permukaan bingkai agar sesuai dengan tinggi dinding. 
Ulangi langkah ini, jepitkan kisi ke bagian atas permukaan dinding dan buat tingkat yang 
konsisten di sepanjang bagian atas tepi dinding. 
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Permukaan bingkai sekarang berkontur dengan dinding, menciptakan simulasi dinding 
penahan. Metode ini dapat diadaptasi untuk digunakan untuk memasang bingkai ke 
permukaan vertikal bangunan dan objek lainnya. 
 

 
15. Alat Smoove juga dapat digunakan untuk membuat sengkedan.  

a. Setel alat Smoove ke 55’. Di lokasi yang berdekatan dengan jalan setapak di Area 
2, lekukan permukaan kisi cukup untuk membuat depresi lembut.  

b. Pindahkan alat Smoove ke tepi depresi dan klik dua kali untuk mengulangi 
kedalaman indentasi yang tepat. Ini identik dengan membuat bentuk lahan di 
langkah 13.  
Seperti bentuk lahan, kedalaman indentasi dapat ditetapkan dengan memasukkan 
nilai di measurement window. 

 
16. Lanjutkan untuk mengulangi langkah 14, membuat swale di area yang berdekatan dengan 

jalan setapak. 
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17. Berdekatan dengan swale di Area 2, berlatihlah membuat beberapa nilai yang 

mengangkat secara lembut dengan alat Smoove. Berlatih menyesuaikan ukuran radius 
pahat Smoove. Tujuannya adalah untuk menciptakan medan simulasi bentang alam yang 
landai dan mulus. 

 
18. Setelah Anda menyelesaikan kontur yang disimulasikan, matikan Hidden geometry dan 

tambahkan warna hijau ke permukaan. 
 

  



57 
 

19. Tambahkan fasilitas situs (pohon, orang, bangku, dll.) Ke denah lokasi. 
 

 

Dengan menambahkan nilai sederhana dan cepat ini ke situs dan menggabungkannya dengan 
berbagai fasilitas situs, Anda telah mengubah model untuk menggambarkan program, bentuk, 
dan perasaan tertentu. 

 

Quad Campuss— Area 1 

Model Kampus Quad terdiri dari empat area. Dengan menggunakan metode yang diuraikan 
dalam tutorial penilaian sebelumnya, Anda akan menambahkan nilai konseptual ke masing-
masing area ini untuk membuat model situs yang holistik dan bertingkat. Beberapa instruksinya 
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singkat. Terapkan apa yang Anda pelajari di tutorial sebelumnya untuk menyelesaikan langkah-
langkahnya. 

Unduh dari 3D Warehouse dan model terbuka: Campus_Quad  

1. Tinjau model dasar dan catat setiap peruntukan area. 
 

 
2. Identifikasi Area 1. Di lokasi ini, Anda akan menambahkan kelas konseptual untuk 

memasukkan anak tangga dan bangunan ke dalam situs. 
 

 
3. Draf serangkaian tepi dan busur, seperti yang ditunjukkan pada gambar di bagian atas 

halaman 257.  
a. Perkirakan beberapa tepi pada bidang tanah sedekat mungkin.  
b. Tambahkan tepi dan busur di sepanjang permukaan dinding anak tangga dan 

permukaan bangunan.  
c. Pilih semua tepi yang dirancang seperti yang ditunjukkan.  
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d. Aktifkan alat Dari Kontur untuk menjahit face menjadi satu. 

 

1. Masukkan contoh grup dari permukaan From Contour yang dihasilkan dan sembunyikan 
tepi luar (gunakan Eraser tool + Shift) seperti yang ditunjukkan oleh panah. Setelah 
meninggalkan instance grup, hapus geometri konstruksi asli di sekitar tepi luar. Ini akan 
memungkinkan simulasi medan menjadi bagian dari lanskap. 

 

Sekarang setelah Anda menyelesaikan Area 1 dari Quad, langkah-langkah dan bangunan 
terintegrasi dengan lebih baik ke dalam lanskap dan aspek situs. 
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Quad Campus — Area 2 

Untuk tutorial ini, cari Area 2. Ikuti diagram dengan hati-hati untuk penyusunan dan penempatan 
busur dan tepi. Anda perlu membuat bingkai gambar yang mengelilingi tiga sisi Hijau untuk dapat 
menghasilkan medan yang diinginkan. 

1. Identifikasi Area 2 dalam model contoh. Tentukan area yang dijelaskan di Area 2 yang 
akan direferensikan dalam tutorial. Anda akan menambahkan kemiringan halus pada 
anak tangga dan area lansekap. Idenya adalah untuk mensimulasikan langkah-langkah 
yang terkait dengan lanskap atau Green. 

 

2. Dimulai dengan lokasi Dinding Belakang, salin tepi atas dinding (menghadap ke arah Hijau) 
ke bawah, jepret tepi yang disalin ke persimpangan Langkan 1 dan 2. Ini adalah set tepi 
pertama yang akan digunakan untuk menghasilkan simulasi medan. 
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3. Gambarlah busur dari perpotongan dinding dan tepi di titik akhir Langkan 1 ke atas Lokasi 
Langkah 1. Pasang titik tengah busur ke permukaan vertikal Langkan 1. Jangan jepret 
tonjolan busur ke atas permukaan vertikal tetapi sedikit di bawah bibir Langkan 1. Busur 
itu bisa sebagian tersembunyi di balik permukaan vertikal. Selama busur dapat dipilih, ini 
tidak akan menimbulkan masalah saat membuat kemiringan. 

 

4. Salin tepi Lokasi Langkah 1 ke titik akhir Lokasi Langkah 2. Buat garis dari titik akhir garis 
yang disalin ke titik akhir busur yang dibuat pada langkah sebelumnya. Ini adalah tepi 
diagonal kecil di sisi anak tangga yang ditunjukkan pada diagram. 

 

5. Salin tepi vertikal Lokasi Langkah 2 ke bawah dan tempelkan ke titik teratas dari langkah 
terendah. Hubungkan tepi yang disalin ke puncak anak tangga yang berdekatan dengan 
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menambahkan garis diagonal di kedua ujungnya. Satu garis harus terhubung secara 
diagonal ke bagian atas anak tangga (pada titik akhir dari tepi yang disalin pada langkah 
sebelumnya) dan tepi lainnya harus ditempatkan secara diagonal untuk menghubungkan 
di sepanjang tanah. Gunakan diagram untuk kejelasan. 

 

6. Ulangi langkah 3 sampai 5 di sisi berlawanan dari Green. Ulangi langkah 3 di sisi lain lokasi 
Hijau untuk Langkan 2, buatlah busur dari belakang dinding ke atas Lokasi Langkah 3. 

 

7. Ulangi langkah 4 dan 5 pada Lokasi Langkah 3 dan 4 di sisi lain Green. Ini akan 
menyelesaikan pembuatan wireframe. 
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8. Pilih semua tepi yang dirancang dan disalin pada langkah 2 hingga 7. Aktifkan alat Dari 
Kontur. 

 

Alat Dari Kontur akan menjahit tepi yang dipilih, menghasilkan kemiringan yang 
disimulasikan. 
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9. Tambahkan warna ke permukaan yang dihasilkan. Menggunakan Shift + Erase, 
sembunyikan garis apa pun yang mungkin mengganggu dari permukaan. 

 

Dinding belakang dan tangga diintegrasikan ke dalam model situs. Meskipun permukaan yang 
dihasilkan menciptakan tingkat yang sangat halus, mata pemirsa akan menangkap kehalusan 
di permukaan. Kelas simulasi menggambarkan representasi Quad Green yang lebih realistis 
dan akurat. 

 

Kampus Quad — Area 3 

Tutorial ini menggunakan model yang sama dari Area 1 dan 2 untuk menyelesaikan Area 3. 
Penyelesaian yang berhasil akan membutuhkan perhatian terhadap detail dan kesabaran. 
Meskipun langkah-langkahnya cepat, membuat permukaan yang diinginkan agak rumit. 
Tujuannya adalah untuk menunjukkan bagaimana mungkin membuat ketinggian yang 
bervariasi, namun terhubung di beberapa lokasi. 
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Seperti pada tutorial sebelumnya, perhatikan diagram untuk lokasi penempatan, salin, dan 
konsep busur dan tepi. 

1. Identifikasi Area 3 dalam model contoh. Mulailah dengan Jalur 1. Temukan tepi vertikal, 
seperti yang ditunjukkan pada diagram berikut (tepi adalah bagian dari pendaratan ke 
gedung). 

 

2. Salin dan tempel tepi di depan papan entri bangunan ke lokasi yang ditunjukkan. Tepi ini 
akan berfungsi sebagai panduan untuk menjepret busur yang diproyeksikan. Anda akan 
menggunakan tepi ini untuk menyusun serangkaian busur yang diproyeksikan yang 
mendefinisikan jalan kaki dalam ruang 3D. 
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3. Gambarlah busur seperti yang ditunjukkan di dalam Jalur 1. Pasang titik busur ke awal 
dan akhir jalan kaki seperti yang ditunjukkan (ujung jalan dan akhir jalan kaki). Jepitkan 
tonjolan busur ke titik tengah tepi vertikal yang dibuat pada langkah sebelumnya. 

 

4. Melanjutkan jalur:  
a. Gambarlah busur dari sudut bawah jalan setapak ke titik tengah tepi vertikal 

seperti yang ditunjukkan.  
b. Jepitkan tonjolan sepertiga ke atas di sepanjang tepi vertikal, seperti yang 

ditunjukkan dalam diagram. 

 

5. Pada dua tepi vertikal yang terletak di tempat Jalur 1 berpotongan dengan Trotoar 1, 
gambar satu tepi dari titik tengah ke titik tengah tepi vertikal. 
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Gambar busur kedua untuk menyelesaikan tepi luar Jalur 1. Pasang titik busur ke titik akhir tepi 
yang digambar pada langkah 5. Jepitkan tonjolan busur seperti yang ditunjukkan. 

 

6. Ulangi langkah 2 hingga 6 ke lokasi Jalur 2. Salin dan tempel tepi vertikal dari depan 
Building Landing ke lokasi yang ditunjukkan. Ulangi langkah yang telah diselesaikan untuk 
Jalur 1. Pasang busur ke lokasi yang sesuai untuk membuat serangkaian busur miring yang 
mengarah dari tepi jalan setapak di jalan ke landasan gedung. 
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7. Tambahkan dua tepi miring ke lokasi Trotoar 1. Mulai dari titik akhir tepi yang disusun 
pada langkah 5, gambar dua tepi ke ujung penanam dan ujung Trotoar 1, seperti yang 
ditunjukkan pada diagram. 

 

9. Gambarlah dua sisi untuk mendefinisikan Trotoar 2.  
a. Dimulai dengan perpotongan tepi dan penanam yang digambar pada langkah 8, 

tambahkan tepi yang meluas ke ujung bangunan kecil seperti yang ditunjukkan.  
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b. Gambarlah sebuah tepi vertikal dari bagian depan Trotoar 2 untuk memotong tepi 
miring dari Trotoar 1 seperti yang digambar pada langkah 8.  

c. Dari titik akhir dari tepi/persimpangan vertikal yang digambar, tambahkan tepi 
yang sejajar dengan tepi yang ditarik dari penanam ke sudut bangunan besar. 

 

10. Tambahkan dua tepi miring untuk menentukan Trotoar 3. Menambahkan tepi mirip 
dengan proses di langkah 8. 

 



70 
 

11. Pilih tepi yang menyusun Jalur 1 (busur dan tepi disusun dalam langkah 3 hingga 6). 
Dengan tepi yang dipilih, aktifkan alat Dari Kontur untuk menjahit tepi untuk membuat 
jalur miring yang mengarah ke papan entri bangunan. 

 

 

12. Select the sloping edges that define Sidewalk 1 (drafted in step 8). Activate the From 
Contour tool to stitch the selected edges to form an elevated walk for Sidewalk 1. 
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13. Pilih tepi yang menentukan Sidewalk 2 (dibuat di langkah 9). Aktifkan alat Dari Kontur 
untuk menjahit tepi dengan face. 

 

Saat Hidden geometry diubah menjadi terlihat, face yang dijahit untuk Jalur 1, Trotoar 1, dan 
Trotoar 2 menunjukkan jalan miring yang telah selesai. 
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14. Buat face untuk jalur yang tersisa. Pilih busur dan tepi untuk Jalur 2 dan jahit tepi dengan 
face menggunakan Dari Kontur. Pilih dua tepi untuk Sidewalk 3 dan buat permukaan 
menggunakan From Contour. 

 

 

15. Tambahkan warna pada jalan miring: Jalur 1, Jalur 2, Trotoar 1, Trotoar 2, dan Trotoar 3. 

 

16. Di lokasi Lawn 1, gambar dua busur yang akan digunakan untuk membantu membangun 
permukaan miring. Gambar Arc 1 seperti yang ditunjukkan. Saat Anda memasang tonjolan 
busur ke dinding, pastikan tonjolan itu sedikit mengarah ke atas. 

Hubungkan Busur 2 ke ujung Busur 1 ke persimpangan gedung besar dan Trotoar 2. 
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17. Pilih tepi seperti yang ditunjukkan oleh diagram untuk lokasi Lawn 1. Pastikan untuk 
memilih tepi miring untuk Jalur 1 dan Trotoar 1 dan 2. Aktifkan alat Dari Kontur untuk 
menjahit permukaan draf untuk membuat tanjakan yang menghubungkan ke dinding dan 
jalan-jalan yang dihasilkan. 

 

Alat Dari Kontur akan menjahit permukaan yang menghubungkan jalur dan dinding. Geometri 
yang dihasilkan akan mensimulasikan kemiringan landai. 
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18. Pilih tepi yang menguraikan Lawn 2. A 
a. Pastikan tepi yang dipilih termasuk geometri konstruksi yang dirancang (garis 

miring) yang digunakan untuk menentukan Jalur 1 dan Trotoar 1.  
b. Gambarlah tepi tegak lurus, seperti yang ditunjukkan, untuk menentukan ujung 

area Lawn 2. Sertakan tepi ini dalam seleksi. 

 

19. Dengan tepi untuk Lawn 2 dipilih, aktifkan From Contour untuk menghasilkan kemiringan. 
Bersihkan permukaan artefak di sekitar tepi jalan dan permukaan yang tumpang tindih 
yang ditemukan di halaman. Masukkan contoh grup untuk kemiringan dan gunakan 
eraser tool untuk menghapus tepi, seperti yang ditunjukkan dalam diagram. 
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Saat Lawn 2 selesai dan Hidden geometry diatur ke terlihat, tampilan mulai terlihat seperti 
scene akhir yang dibuat. Jalan setapak dan lereng yang berbeda mengarah ke gedung besar 
dan diintegrasikan ke dalam denah lokasi dengan tingkat konseptual. 

 

20. Buatlah sebuah busur di Dinding Depan. Pasang titik akhir busur ke titik ujung bagian 
dalam Jalur 1 dan Jalur 2. Pasang tonjolan busur ke tepi tengah dinding depan. Tempatkan 
tonjolan 1'-5 ″ di bawah bagian atas dinding. 
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21. Pilih tepi yang menguraikan Lawn 3 (busur dalam yang menentukan Jalur 1 dan 2, tepi 
tepi dalam di bagian bawah Lawn 3, dan tepi busur yang dirancang pada langkah 20). 
Setelah mereka dipilih, aktifkan From Contour untuk menghasilkan kemiringan untuk 
menentukan Lawn 3. 

 

Dari Contour akan menentukan tingkat lembut untuk Lawn 3. 
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22. Untuk menentukan lokasi Lawn 4, buat draf serangkaian busur dan tepi di sisi bangunan 
besar. Mulailah dengan persimpangan/titik akhir Jalur 2 dan lanjutkan di sepanjang 
dinding; gunakan dimensi yang ditunjukkan untuk menentukan tinggi busur dan tepi. 
Hubungkan busur terakhir (paling kiri) kembali ke bidang tanah. 

 

23. Pilih tepi yang menguraikan Lawn 4 dan terapkan alat Dari Kontur untuk menghasilkan 
kemiringan. Pilih tepi yang menguraikan Lawn 5 dan terapkan From Contour ke lokasi itu. 
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Grafik berikut menunjukkan jalur, jalan setapak, dan halaman rumput yang telah selesai 
untuk bangunan besar seperti yang terlihat dari seberang jalan. Lereng yang landai mengarah 
ke bantalan bangunan dan membantu membangun bangunan sebagai fitur yang menonjol. 
Medan yang landai mengarahkan mata pemirsa dan membantu menentukan konsep tertentu 
untuk nilai dan medan situs. 

 

Grafik berikut menunjukkan pemandangan dari Area 2 ke Area 1 dan Area 3. Nilai konseptual 
yang digunakan untuk menentukan ketiga area menciptakan interaksi yang halus dari 
ketinggian yang terlihat di seluruh situs. 



79 
 

 

Kampus Quad — Area 4 

Gunakan model yang sama dari Area 1, 2, dan 3 untuk menyelesaikan Area 4. Latihan ini akan 
menggunakan alat From Scratch, Drape, dan Smoove untuk membuat nilai halus di sekitar 
tiga bangunan. 

1. Identifikasi empat lokasi yang membentuk Area 4. 
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2. Pilih area permukaan Lawns 1, 2, 3, dan 4. Dengan keempat area dipilih, klik kanan dan 
pilih Make Group. 
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3. Salin grup yang Anda buat pada langkah 2 dan tempatkan itu berbatasan langsung dengan 
model dasar. Pastikan untuk menyisakan ruang yang cukup antara halaman yang disalin 
dan model asli untuk menyelesaikan langkah selanjutnya. 

 



82 
 

4. Berdekatan dengan lokasi rumput yang disalin, gunakan alat Dari Awal untuk membuat 
kisi dengan lebar 270’dan panjang 395'. Grid harus terdiri dari persegi 6’× 6'. 

 

5. Tempatkan grup Lawn tepat di atas grid yang dibuat pada langkah 4. Pastikan bahwa 
pengelompokan rumput tidak meregang atau berada di luar batas grid From Scratch. 

 

6. Pilih gird From Scratch, klik kanan, dan gunakan Soften Smooth Edges untuk 
menyembunyikan garis kisi. 
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7. Pilih grup Lawn dan, dengan menggunakan perintah Drape, gantungkan grup Lawn ke grid 
di bawah ini. 

 

8. Masukkan contoh grid From Scratch dan hapus permukaan dan tepi ekstra, meninggalkan 
bentuk yang sama dari grup Lawn. Tambahkan warna pada potongan kisi untuk mewakili 
area rumput. Setelah selesai, alihkan Hidden geometry menjadi terlihat. Face kisi 
sekarang akan terlihat dan siap untuk diterapkan Smoove padanya. Anda dapat 
menghapus grup Lawn asli yang terletak di atas yang digunakan untuk menggantungkan 
ke kisi. 
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9. Tempatkan kembali potongan kisi Dari Awal ke dalam denah lokasi: Pilih titik akhir umum 
pada grup dan pindahkan kembali ke titik akhir umum model Campus_Quad. 

 

10. Dimulai dengan Bangunan 1 (label bangunan yang ditunjukkan pada langkah 1), masukkan 
contoh rumput kisi Dari Awal dan gunakan alat Smoove untuk mengangkat permukaan 
secara perlahan untuk menyimulasikan kemiringan permukaan bangunan. Jangan 
membesar-besarkan medan, tetapi pahatlah bentuk lahan simulasi untuk membuat 
medan yang melengkapi bangunan dan denah lokasi. Anda dapat memasang alat Smoove 
ke permukaan vertikal bangunan atau menambahkan nilai ke dalam measurement 
window untuk menghasilkan ketinggian yang tepat pada bentuk lahan. 
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11. Ulangi langkah 10 pada Bangunan 2 dan 3. Gunakan alat Smoove pada Bangunan 2. Buat 
kemiringan yang sangat halus dan minimal dengan kisi-kisi. 

 

12. Gunakan alat Smoove di sekitar Gedung 3. Seperti pada Bangunan 1 dan 2, buat 
kemiringan halus dengan alat Smoove. 
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Grafik berikut menunjukkan tampilan Kampus Quad setelah nilai dipindahkan di sekitar tiga 
gedung. Hidden geometry diubah menjadi terlihat. 

 

Gambar berikut menunjukkan tampilan Quad dengan Hidden geometry yang dimatikan. 
Denah lokasi sekarang menggabungkan nilai halus di dalam area alun-alun. 
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13. Tambahkan pohon, orang, tiang penopang, bangku, dan fasilitas situs lainnya ke denah 
situs. Bangunan pada gambar akhir ini dilapisi dengan Material Stone Stone_Flagstone_ 
Ashlar. Komponen Window ditambahkan dari paket Bonus Arsitektur SketchUp yang 
terdapat di www.sketchup.com. 

 

Dalam grafik ini, Anda dapat melihat pemandangan menghadap ke seberang Quad dan di 
seberang jalan. 

http://www.sketchup.com/
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Dalam grafik ini, Anda dapat melihat pemandangan bangunan besar. Pemandangan ini 
mencakup vegetasi, fasilitas situs, dan orang-orang. Komponen situs ini membantu 
menekankan medan konseptual yang ditambahkan ke denah lokasi. 

 

Ini adalah pemandangan dari pintu masuk gedung besar, di seberang situs. 
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Bab 3 

Memodelkan dengan Foto dan Sumber Daya Lainnya 

Membuat model dari awal semuanya baik-baik saja, tetapi untuk membantu Anda, SketchUp 
dapat mengimpor banyak informasi - dalam bentuk foto digital, data medan 3D, dan bahkan CAD 
2D yang ada. 

Jika Anda memiliki model yang ingin Anda lukis dengan foto, Anda bisa melakukannya. Anda 
dapat menerapkan foto ke face dan kemudian menggunakan informasi dalam gambar untuk 
membantu pemodelan. Membangun window jauh lebih mudah jika dicat tepat di dinding. Itulah 
yang kita bicarakan di bagian pertama bab ini. 

Jika Anda ingin menggunakan foto sebagai dasar pemodelan sesuatu yang ada di dunia nyata, 
Anda juga dapat melakukannya di SketchUp. Dengan fitur Photo-matching, Anda dapat 
mengimpor gambar dan melacak apa yang Anda lihat dengan tool pemodelan SketchUp. 

Jika Anda memodelkan sebuah bangunan atau struktur lain yang Anda rencanakan untuk 
dibangun di darat, Anda dapat menemukan lokasi yang Anda inginkan di peta online dan 
mengimpor medan langsung ke model Anda - yah, representasi digital dari medan tersebut. 
(Anda juga dapat mengimpor jenis file medan tertentu jika Anda memilikinya.) 

Jika Anda bekerja dengan SketchUp Pro, Anda dapat mengimpor file CAD untuk digunakan 
sebagai titik awal untuk model 3D. Proses impor tidak sulit, tetapi akan sangat membantu untuk 
memahami beberapa petunjuk sebelum Anda mencobanya untuk pertama kali. 

Melukis Face dengan Foto 

Secara teknis, mengecat permukaan dengan gambar menggunakan perangkat lunak 3D disebut 
pemetaan, seperti dalam”Saya memetakan foto face Anda ke bagian bawah model pile-driver 
yang saya buat". Program perangkat lunak yang berbeda memiliki metode berbeda untuk 
memetakan gambar ke face. Untungnya, di SketchUp, prosesnya cukup mudah. 

Bagian berikut membahas foto pemetaan ke dua jenis face: datar dan melengkung. toolnya 
serupa, tetapi metodenya tidak. Kami menjelaskan keduanya, karena Anda tidak pernah tahu apa 
yang akan Anda hadapi. 

Tips 

SketchUp menggunakan banyak istilah untuk merujuk pada hal-hal yang dapat Anda gunakan 
untuk melukis face; secara umum, semuanya adalah materi. Bahan bisa berupa warna atau 
tekstur; tekstur berbasis gambar, dan warna adalah rona tunggal yang solid. Saat Anda 
mengimpor gambar untuk memetakannya ke face, gambar menjadi tekstur - sama seperti tekstur 
lainnya di Material Panel Anda.  

Menambahkan foto ke flat face 
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Saat memetakan foto ke permukaan datar, Anda dapat memilih cara yang sulit atau cara mudah. 
Sayangnya, cara yang sulit adalah metode yang akhirnya Anda gunakan sebagian besar waktu, 
jadi kami jelaskan terlebih dahulu. Mengimpor gambar dengan menggunakan menu File 
memungkinkan Anda mengambil gambar dan memetakannya ke semua permukaan datar dalam 
model Anda. 

Cara mudah dirancang untuk satu kasus tertentu: Ini memberi Anda akses ke koleksi besar 
gambar Street View Google, memungkinkan Anda melukis model Anda dengan fasad bangunan 
yang difoto oleh armada keliling Google. Fiturnya keren, tapi juga sangat spesifik. 

Mengimpor gambar: Gunakan foto Anda sendiri 

Sebelum Anda mengikuti langkah-langkah ini, pastikan Anda memiliki setidaknya satu face dalam 
model Anda; Anda memetakan tekstur Anda ke face. Saat Anda siap, berikut ini cara 
menempatkan gambar ke face itu: 

1. Pilih File => Impor. 

Kotak dialog Impor terbuka. 

2. Pilih file gambar yang ingin Anda gunakan sebagai tekstur. 

Anda dapat menggunakan JPEG, TIFF, dan PNG sebagai tekstur di SketchUp; semua ini adalah 
format file gambar yang umum. 

3. Di area Gambar yang digunakan Gunakan, pilih opsi Tekstur, seperti yang ditunjukkan 
pada Gambar 3-1. 

4. Klik tombol Impor. 

Kotak dialog Impor ditutup, Paint Bucket menjadi tool aktif Anda, dan kursornya dimuat dengan 
gambar yang Anda pilih untuk diimpor. 

5. Klik sekali di sudut kiri bawah face yang ingin Anda cat. (Lihat Gambar 3-2.) 

Klik Anda memberi tahu SketchUp di mana harus memosisikan sudut kiri bawah gambar yang 
Anda gunakan sebagai tekstur. Meskipun Anda dapat mengeklik di mana saja pada face yang 
Anda coba lukis, mengeklik sudut kiri bawah membuat semuanya tetap sederhana. 

6. Klik di tempat lain pada face yang Anda lukis. (Lihat Gambar 3-2.) 

Kecuali jika proporsi gambar Anda cocok dengan face yang dipetakan, gambar Anda akan 
berulang. Jangan khawatir - itu normal. SketchUp secara otomatis menyusun gambar Anda untuk 
mengisi seluruh face. Jika Anda ingin mengedit tekstur baru Anda sehingga tidak terlihat berubin 
(dan mungkin Anda melakukannya), lompat ke bagian selanjutnya,”Mengedit tekstur Anda". 
Anda dapat mengatur skala, memutar, memiringkan, atau bahkan meregangkan tekstur agar 
terlihat seperti yang Anda inginkan. Lihat sidebar terdekat,”Kapan gambar menjadi tekstur?" 
untuk detail Background lebih lanjut. 
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Gambar 3-1: Beri tahu SketchUp Anda ingin menggunakan gambar sebagai tekstur. 
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Gambar 3-2: Klik sekali untuk menemukan sudut kiri bawah gambar yang Anda gunakan sebagai 
tekstur. Klik lagi untuk mencari sudut kanan atas. 

 

KAPAN SEBUAH GAMBAR MENJADI SEBUAH TEKSTUR? 

Waktunya untuk sedikit teori: Tekstur gambar di SketchUp terdiri dari ubin. Untuk membuat 

area tekstur yang luas, seperti dinding bata, SketchUp menggunakan sekumpulan ubin yang 

bersebelahan. Dalam kasus dinding bata, face suatu model mungkin terlihat seperti ribuan 

batu bata, tetapi efeknya sama dengan ubin yang sama dari sekitar 50 batu bata yang diulang 

berkali-kali. 

Karena SketchUp memperlakukan tekstur gambar yang diimpor sama seperti tekstur lainnya, 

yang sebenarnya Anda lakukan saat mengeklik untuk menemukan sudut kanan atas gambar 

Anda adalah ini: Anda memberi tahu SketchUp seberapa besar membuat ubin untuk tekstur 

foto baru Anda . Jangan terlalu khawatir tentang mendapatkan ukuran yang benar pada kali 

pertama. Anda selalu dapat menyesuaikannya nanti. 
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Dapatkan tekstur foto: Gunakan gambar online 

Google Street View menawarkan cara yang imersif dan seram untuk menikmati dunia luar dari 
kenyamanan layar komputer Anda yang malas. 

Google Street View dan SketchUp terhubung kembali di SketchUp 8, saat Google memiliki 
SketchUp. Sejak itu, Anda dapat mengambil gambar dari yang pertama dan menggunakannya di 
yang terakhir. Jika tujuan Anda adalah membangun model bangunan dunia nyata bertekstur foto, 
Anda beruntung. 

Tips 

Untuk menggunakan fitur ini, Anda harus memenuhi dua prasyarat penting: 

 Model Anda harus memiliki lokasi geografis. Anda pasti sudah memberi tahu SketchUp 
di mana tepatnya model Anda dengan menambahkan cuplikan geo-lokasi ke file Anda. 
Jika kalimat sebelumnya tidak masuk akal bagi Anda, lihat bagian”Menempatkan 
geografis model Anda", nanti di bab ini. 

 Data Street View harus ada untuk hal yang Anda coba buat teksturnya. Google telah 
memotret banyak sekali tempat, tetapi selalu ada kemungkinan bahwa di mana pun Anda 
bekerja bukanlah salah satunya. 

Ikuti langkah-langkah berikut untuk melukis flat face dalam model Anda dengan gambar Google 
Street View: 

1. Pilih face yang ingin Anda lukis dengan gambar Street View. 

Memilih face berbentuk persegi panjang membantu. Anda melihat alasannya dalam beberapa 
langkah. 

2. Pilih Edit => Face => Add Photo Texture. 

Window Tekstur Foto akan muncul. Jika data Street View tidak tersedia untuk lokasi tempat Anda 
membuat model, inilah saatnya Anda mengetahuinya. 

3. Bingkai gambar yang ingin Anda gunakan di window: 

 Klik dan seret untuk memutar”kamera". 

 Klik tanda panah pada foto untuk bergerak ke atas dan ke bawah jalan. 

 Perbesar dan perkecil menggunakan tombol + dan -. 

 Jika perlu, ubah ukuran seluruh window untuk mendapatkan tampilan yang lebih baik. 
4. Klik tombol Select Region di pojok kanan atas window. 

Sebuah persegi panjang dengan pin biru di sudut muncul, dan bagian yang menyenangkan 
dimulai. 

5. Seret pin biru untuk menentukan area yang akan dicat pada face yang Anda pilih pada 
Langkah 1. (Lihat Gambar 3-3.) 
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6. Klik tombol Ambil untuk mengecat face yang Anda pilih pada Langkah 1 dengan gambar 
yang Anda tentukan pada Langkah 5. 

7. Tutup Photo Textures window. 

 

Gambar 3-3: Anda dapat menggunakan gambar Google Street View untuk memberi tekstur pada 
model Anda. 

Tekstur foto yang Anda terapkan menggunakan Tambahkan Tekstur Foto sama seperti tekstur 
foto lainnya dalam model Anda. Anda dapat mengedit tekstur dengan cara yang persis sama, 
seperti yang kami jelaskan di bagian selanjutnya. 

Mengedit tekstur Anda 

Setelah Anda berhasil memetakan gambar ke face, Anda mungkin ingin mengubah gambarnya: 
Buat lebih besar, balik, putar - Anda mengerti. Di sinilah tool Tekstur Posisi masuk. 

Posisi Texture tool sebenarnya lebih dari sebuah mode; kami menyebutnya Texture Edit mode. 
Dalam mode ini, Anda dapat menggunakan salah satu dari dua submode. Nama mereka kurang 
penting dari apa yang mereka lakukan, jadi begitulah cara kami mendeskripsikan mereka: 

 Mode Move/Scale/Rotate/Shear/Distort Texture: Gunakan mode ini untuk 
memindahkan, menskalakan, memutar, menggeser, atau mengubah tekstur Anda 
(terkejut?). Secara teknis, mode ini disebut mode Pin Tetap. Anda tahu mengapa dalam 
sekejap. 
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 Mode Stretch Texture: Mode Stretch Texture memungkinkan Anda mengedit tekstur 
dengan meregangkannya agar sesuai dengan face yang dilukis. Jika Anda ingin 
memetakan foto fasad bangunan ke model Anda, ini adalah mode yang ingin Anda 
gunakan. Dalam dokumentasi Bantuan SketchUp, mode Tekstur Peregangan disebut 
mode Pin Gratis, jika Anda tertarik. 

Ingat 

Anda hanya dapat mengedit tekstur pada permukaan datar; tool Tekstur Posisi tidak berfungsi 
pada permukaan melengkung. Untuk detail tentang bekerja dengan tekstur dan permukaan 
melengkung, lihat”Menambahkan tekstur foto ke permukaan melengkung" nanti di bab ini. 

Moving, scaling, rotating, shearing, dan distorting tekstur Anda 

Judul bagian ini cukup banyak menjelaskan semuanya - melakukan hal-hal yang disebutkan di 
atas pada tekstur Anda melibatkan mode Texture Edit, yang sayangnya sedikit tersembunyi. Ikuti 
langkah-langkah berikut untuk memindahkan, menskalakan, memutar, atau memiringkan 
tekstur Anda: 

1. Dengan memilih tool, klik face dengan tekstur yang diinginkan untuk diedit 
2. Pilih Edit => Face => Position 

Perintah ini mengaktifkan (napas dalam) mode Moving, scaling, rotating, shearing, dan distorting. 
Anda melihat versi transparan dari gambar Anda, bersama dengan empat pin, masing-masing 
memiliki warna berbeda, seperti yang ditunjukkan pada Gambar 3-4. Jika semua pin Anda 
berwarna kuning, Anda berada dalam mode Tekstur Peregangan. Context-clicks pada texture 
face Anda dan pilih Pin Tetap untuk beralih ke mode yang benar. 

Tips 

Cara yang lebih cepat untuk masuk ke mode Texture Edit adalah dengan mengcontext-clicks pada 
texture face, lalu pilih Texture => Position dari menu konteks. 

3. Edit tekstur Anda. 

Pada titik ini, Anda dapat mengedit tekstur Anda dengan dua cara: dengan menggunakan opsi 
pada menu konteks atau dengan menyeret pin berwarna. 

Mengcontext-clicks tekstur Anda membuka menu konteks dengan opsi berikut: 

 Done: Memberi tahu SketchUp Anda sudah selesai mengedit tekstur Anda. 

 Reset: MengUndo semua perubahan yang telah Anda buat pada tekstur Anda 

 Flip: Membalik tekstur Anda dari kiri ke kanan atau atas dan bawah, tergantung pada 
suboption yang Anda pilih. 

 Rotate: Memutar tekstur Anda 90, 180, atau 270 derajat, tergantung pada suboption 
yang Anda pilih. 
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 Fixed Pin: Saat opsi ini dipilih, Anda berada dalam mode Pindah/Skala/Putar/Geser/ 
Distort Tekstur (mode Pin Tetap). Membatalkan pilihan itu akan mengalihkan Anda ke 
mode Tekstur Peregangan, yang dibahas di bagian mendatang”Meregangkan foto di atas 
face". 

 Unde/Redo: Mundur atau maju selangkah dalam proses kerja Anda. 

Menarik setiap pin berwarna memiliki efek yang berbeda (lihat Gambar 3-4): 

 Scale/Shear (Blue) pin: Menskala dan memotong tekstur saat Anda menyeretnya. 
Pemotongan membuat edge atas dan bawah sejajar sambil membuat gambar”miring" ke 
kiri atau kanan. 

 Distort (Yellow) pin: Mendistorsi tekstur Anda saat Anda menyeretnya; dalam hal ini, 
distorsi terlihat seperti efek perspektif. 

 Scale/Rotate (Green) pin: Menskala dan memutar tekstur Anda saat Anda menyeretnya. 

 Scale/Shear (Blue) pin: Memindahkan tekstur Anda saat Anda menyeretnya. Dari 
keempat pin berwarna, yang ini paling berguna. Ini bagus untuk secara tepat 
memposisikan batu bata, sirap, dan tekstur bahan bangunan lainnya dalam sebuah 
model. 

4. Di window pemodelan Anda, klik di mana saja di luar tekstur Anda untuk keluar dari 
mode Edit Tekstur. 

Anda juga dapat menekan Enter atau context-clicks dan memilih Selesai dari menu konteks. 
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Gambar 3-4: Menarik setiap pin berwarna akan melakukan sesuatu yang berbeda 

Streching foto di atas face 

Bayangkan sebuah foto dicetak pada selembar kain yang dapat Anda regangkan sampai foto 
terlihat seperti yang Anda inginkan dan Anda pegang di tempatnya dengan pin. Pada dasarnya 
itulah cara kerja mode Tekstur Peregangan (juga dikenal sebagai mode Pin Gratis).  

Ikuti langkah-langkah ini untuk meregangkan tekstur Anda menggunakan mode Stretch Texture 
dari tool Position Texture: 

1. Dengan select tool, klik face dengan tekstur yang ingin Anda edit. 
2. Pilih Edit => Face => Texture => Position.  

Cara yang lebih cepat untuk masuk ke mode Texture Edit adalah dengan mengcontext-
clicks pada texture face dan memilih Texture => Position dari menu konteks. 

3. Context-clicks pada tekstur Anda dan hapus tanda centang di sebelah opsi Pin Tetap. 
(Pastikan tidak ada tanda centang di sebelahnya.)  
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Anda beralih ke mode Stretch Texture. Alih-alih empat pin berwarna berbeda dengan 
simbol kecil di sebelahnya, Anda melihat empat pin putih. (Pin dulu berwarna kuning.) 

4. Klik dan seret setiap pin untuk mengubah posisinya hingga foto Anda membentang di 
atas face sesuai keinginan Anda. 

Tips 

Jika Anda mengubah posisi foto sebuah bangunan, klik pin untuk mengambilnya, lalu klik untuk 
menempatkan pin di sudut bangunan, seperti yang ditunjukkan pada Gambar 3-5. Lalu, seret 
setiap pin ke sudut face untuk meregangkan foto. 

Jika perlu, jangan ragu untuk mengorbit, memperbesar, dan menggeser model Anda untuk 
mendapatkan tampilan terbaik dari apa yang Anda lakukan; cukup gunakan roda gulir pada 
mouse Anda untuk menavigasi tanpa berpindah tool. 

5. Tekan Enter untuk keluar dari mode Edit Tekstur. 

 

Gambar 3-5: Letakkan pin di sudut yang sesuai (misalnya, kiri atas ke kiri atas) bangunan di foto 
Anda. 

Jika Anda tidak menyukai apa yang Anda lihat, kembali dan edit teksturnya lagi; Anda bisa 
bermain-main sebanyak yang Anda suka. 

Scaling model Anda hingga foto terlihat benar 

Jika Anda senang dengan tekstur Anda yang diregangkan agar pas dengan face, salah satu dari 
dua hal ini akan benar: 
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 Proporsinya benar. Yang kami maksud dengan ini adalah foto tidak terlihat melebar atau 
miring. Ini terjadi hanya jika face yang Anda terapkan tekstur foto sudah berukuran tepat. 

 Proporsinya salah. Jika tekstur foto yang baru saja Anda”sesuaikan" terlihat melar atau 
terjepit, ukuran face yang ada di foto itu salah. Jangan khawatir - Anda hanya perlu 
menyesuaikan seluruh face sampai teksturnya terlihat pas. Lebih baik lagi, jika Anda tahu 
seberapa besar face yang seharusnya (dalam kehidupan nyata), Anda dapat 
meregangkannya hingga benar. 

Ikuti langkah-langkah berikut untuk meregangkan face hingga teksturnya terlihat benar: 

1. Gunakan tool Pita Pengukur untuk membuat panduan yang dapat Anda gunakan untuk 
meregangkan face secara akurat. 

Jika Anda tidak tahu berapa lebar bangunan Anda, tebaklah sebaik-baiknya dan lihat bagaimana 
hasilnya.  

2. Pilih face yang ingin Anda regangkan - atau seluruh model Anda jika Anda hanya 
membuat model yang kasar. 

Jika model Anda pada tahap yang cukup awal, paling mudah untuk memilih seluruh kit dan 
caboodle. Klik tiga kali face dengan tool Pilih untuk memilihnya dan semua yang melekat 
padanya. 

3. Pilih tool => Scale untuk mengaktifkan Scale tool. Atau pilih scale tool pada bilah tool. 

Saat tool Skala aktif, kotak skala SketchUp mengelilingi model Anda. 27 kubus hijau kecil (atau 
pegangan) dan garis kuning tebal sulit untuk dilewatkan. 

4. Ubah skala pilihan Anda ke ukuran yang tepat.  

Gunakan tool Skala dengan mengklik grid dan menggerakkan kursor Anda untuk meregangkan 
apa pun yang dipilih (termasuk tekstur Anda). Klik lagi untuk menghentikan penskalaan. 

Tips 

Untuk menskalakan sesuatu secara tepat menggunakan panduan, klik pegangan skala untuk 
mengambilnya dan kemudian arahkan kursor ke atas panduan yang relevan untuk memberi tahu 
SketchUp di mana Anda ingin mengukurnya. Klik lagi untuk menyelesaikan operasi skala. 
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Gambar 3-6: Gunakan pegangan tool Skala untuk meregangkan pilihan Anda (tekstur dan 
semuanya). 

Wajar jika ingin mempertahankan pemodelan dengan texture face foto Anda; menelusuri 
window dan mendorongnya sedikit dengan push/pull tooladalah salah satu hal paling 
memuaskan yang dapat Anda lakukan di SketchUp. Balik beberapa halaman dan lihat 
bagian”Membuat Model di Atas Tekstur Foto" untuk menemukan semua yang perlu Anda 
ketahui. 

Mengedit piksel dalam gambar tekstur 

Mungkin ada sesuatu dalam foto yang Anda gunakan, dan Anda tidak ingin foto itu ada di sana. 
Anda dapat menggunakan Edit Gambar Tekstur untuk membuka tekstur yang telah Anda pilih 
dalam program pengeditan gambar, tempat Anda dapat mengedit tekstur secara langsung. 

Ikuti langkah-langkah berikut untuk menggunakan Edit Gambar Tekstur: 

1. Konteks-klik tekstur dalam model yang ingin Anda edit dan pilih Texture => Edit Texture 
Image. 

2. Di program yang terbuka, buat perubahan apa pun yang perlu Anda lakukan. 

Pastikan untuk tidak mengubah proporsi gambar - itu dapat benar-benar mengacaukan 
segalanya. 

3. Simpan (jangan Simpan Sebagai dan ubah nama file) gambar yang Anda edit dan tutup 
jika Anda mau. 

4. Kembali ke SketchUp, periksa untuk memastikan hasil edit Anda telah diterapkan. 



102 
 

Program pengeditan gambar mana yang benar-benar terbuka bergantung pada apa yang telah 
Anda instal di komputer Anda; Anda menentukan mana yang akan digunakan pada panel Aplikasi 
dari kotak dialog Preferensi. Untuk apa nilainya, sebagian besar desainer menggunakan Adobe 
Photoshop, tetapi Anda dapat menggunakan apa pun yang Anda miliki. 

Tips 

Perlu mengurangi ukuran file model SketchUp Anda secara drastis? Context-clicks pada texture 
face apa pun dalam model Anda dan pilih Make Unique Texture untuk membuat salinan tekstur 
yang telah Anda pilih dan pangkas (pangkas semua yang tidak terlihat) yang disalin sesuai dengan 
face yang ada. Mengapa ini penting? Hanya karena Anda tidak dapat melihat sebagian gambar, 
bukan berarti tidak ada; SketchUp menyimpan seluruh foto dengan model, meskipun Anda hanya 
menggunakan sedikit. Dalam model yang kompleks dengan lusinan tekstur foto, semua data foto 
tambahan yang tidak terlihat bertambah. Membuat tekstur Anda unik dapat membuat model 
Anda jauh lebih kecil. 

Menambahkan tekstur foto ke permukaan melengkung 

Perhatikan bagaimana judul bagian ini diakhiri dengan permukaan dan bukan dengan face? Itu 
karena (seperti yang Anda ketahui sekarang) setiap face di SketchUp selalu datar - tidak ada 
pengecualian. Saat Anda melihat permukaan yang tidak rata, sebenarnya itu terdiri dari beberapa 
face. Anda tidak dapat melihat tepian di antara keduanya karena telah dihaluskan. Memilih 
Tampilan => Hidden geometry memperlihatkan semua permukaan lengkung apa adanya. 

Cara Anda memetakan gambar ke permukaan lengkung di SketchUp bergantung pada jenis 
permukaan lengkung yang Anda miliki. Dengan pemikiran tersebut, permukaan lengkung dibagi 
menjadi dua kategori umum (lihat Gambar 3-7): 

 Single-direction curves: Silinder adalah contoh klasik permukaan yang hanya melengkung 
ke satu arah. Di SketchUp, silinder pada dasarnya adalah serangkaian persegi panjang 
yang disusun berdampingan. Kebanyakan dinding melengkung yang Anda lihat pada 
bangunan memiliki cara yang sama; mereka tidak meruncing ke dalam atau ke luar saat 
naik. 

Tips 

Cara lain untuk memikirkan Single-direction curves adalah dengan mempertimbangkan 
bagaimana kurva itu bisa dibuat. Jika permukaan melengkung yang Anda lihat mungkin hasil dari 
operasi push/pull tunggal (seperti mengubah lingkaran menjadi silinder), ada kemungkinan besar 
itu adalah arah tunggal. 

Untuk memetakan gambar ke permukaan kurva tunggal, Anda dapat menggunakan metode Face 
Berdekatan; ini bekerja dengan baik dan tidak meregangkan gambar Anda.  

 Multi-direction curves: Objek medan, sadel, dan tirai adalah contoh utama permukaan 
yang melengkung ke lebih dari satu arah pada satu waktu. Mereka selalu terdiri dari 
segitiga - bukan persegi panjang dasar. 



103 
 

Untuk memetakan gambar ke jenis permukaan lengkung ini, Anda harus menggunakan metode 
Tekstur Proyeksi. Lewati beberapa halaman untuk membaca semuanya. 

Tips 

Harap diingat bahwa kami benar-benar membuat nama untuk metode Face Berdekatan dan 
Tekstur yang Diproyeksikan untuk memetakan gambar ke permukaan yang tidak rata. Kami harus 
menyebut mereka sesuatu, dan ini terdengar deskriptif tanpa terlihat terlalu teknis. 

 

Gambar 3-7: Semua permukaan lengkung bisa satu arah (kiri) atau multi-arah (kanan). 

Metode Face Berdekatan 

Jika Anda perlu melukis gambar ke permukaan yang melengkung hanya dalam satu arah (seperti 
silinder), Anda dapat menggunakan teknik ini. Ikuti langkah-langkah ini untuk mencari tahu 
caranya dan perhatikan Gambar 3-8 untuk melihat prosesnya.  

1. Pilih Tampilan => Hidden geometry untuk mengaktifkan Hidden geometry sehingga Anda 
dapat melihat setiap face dalam model Anda. 

2. “load” kursor Anda dengan gambar yang diimpor.  

Ikuti Langkah 1–4 dalam”Mengimpor gambar: Gunakan foto Anda sendiri” (di awal bab ini) untuk 
mengimpor gambar sebagai tekstur. 

3. Warnai sub-face paling kiri seluruhnya dengan gambar.  

Permukaan lengkung Anda terdiri dari sub-permukaan. Berikut cara melukis yang benar:  

a. Arahkan kursor ke sudut kiri bawah sub-face terjauh ke kiri. Jangan klik dulu.  
b. Saat gambar diorientasikan ke arah yang benar, klik sekali 
c. Klik lagi di pojok kanan atas sub-face yang sama. Ini menempatkan gambar; itu harus 

dipotong di sebelah kanan. 
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4. Pilih offset toolnt Bucket, tahan tombol Alt (Command di Mac), dan klik sub-face pertama 
untuk mengambil sampel tekstur (gambar) yang baru saja Anda tempatkan.  

Ini”memuat" offset toolnt Bucket Anda dengan tekstur. 

5. Dengan offset toolnt Bucket, klik satu kali pada face tepat di sebelah kanan face yang 
Anda lukis di Langkah 3.  

Jika semuanya bekerja dengan benar, gambar yang Anda tempatkan muncul di face yang baru 
saja Anda klik. 

6. Terus lukis sub-face sampai Anda selesai.  

Ingatlah untuk bekerja dari kiri ke kanan; melewatkan sub-face mengacaukan banyak hal. Untuk 
memperbaiki masalah, cukup gunakan Urung dan lanjutkan. 

 

Gambar 3-8: Metode Face Berdekatan memungkinkan Anda memetakan gambar ke permukaan 
lengkung sederhana. 

Metode Proyeksi Tekstur  

Untuk mengecat gambar ke permukaan lengkung yang kompleks, tidak ada pengganti untuk 
metode ini. Bongkahan medan adalah contoh bagus dari permukaan lengkung yang kompleks - 
bergelombang, bengkok, bergelombang, dan multidirectional. Jika kurva yang Anda hadapi lebih 
rumit daripada ekstrusi sederhana, Anda perlu menggunakan teknik pemetaan gambar ini. 

Kuncinya adalah menyejajarkan permukaan datar dengan permukaan lengkung yang ingin Anda 
terapkan tekstur foto. Anda kemudian”mengecat" permukaan datar dengan tekstur, 



105 
 

membuatnya diproyeksikan, mengambil sampelnya, dan terakhir, mengecat permukaan 
lengkung dengan tekstur sampel yang diproyeksikan. Wah. 

Ikuti langkah-langkah berikut untuk mendapatkan ide dasarnya (lihat Gambar 3-9): 

1. Buat permukaan datar yang sejajar dengan permukaan lengkung Anda.  

Anda dapat menggunakan Line Tool dan sistem inferences SketchUp untuk menggambar 
permukaan datar yang sejajar dengan (dan berukuran sama dengan) permukaan lengkung 
Anda. 

2. Terapkan tekstur foto ke permukaan datar Anda dan pastikan posisinya benar.  

Untuk bantuan, lihat”Menambahkan foto ke flat face" di awal bab ini. 

3. Context-clicks pada texture face dan pilih Texture => Projrcted.  

Ini memastikan bahwa tekstur diproyeksikan, yang merupakan kunci dari keseluruhan operasi 
ini. 

4. Pilih offset toolnt Bucket, tahan tombol Alt (Command di Mac), dan klik tekstur yang 
diproyeksikan untuk mengambil sampelnya.  

Ini”load" Paint Bucket tool Anda dengan tekstur yang diproyeksikan. 

5. Tanpa menekan apapun pada keyboard Anda, klik permukaan lengkung untuk 
mengecatnya dengan tekstur yang diproyeksikan.  

Piksel pada gambar kemungkinan terlihat melebar di beberapa tempat. 

6. Hapus permukaan datar tempat Anda awalnya memetakan gambar; Anda tidak 
membutuhkannya lagi. 



106 
 

 

Gambar 3-9: Memetakan tekstur yang diproyeksikan ke permukaan melengkung dapat 
dilakukan, tetapi itu tidaklah mudah. 

Tips 

Jika Anda mencoba melakukan tugas ini pada permukaan lengkung Anda sendiri dan ada hal-hal 
yang tampaknya tidak berfungsi, permukaan lengkung Anda mungkin adalah bagian dari grup 
atau komponen. Baik explode atau klik dua kali untuk mengedit grup atau komponen sebelum 
Anda melakukan Langkah 5 dan lihat apakah itu membantu.  

Membuat Model Langsung dari Foto: Memperkenalkan Photo-Matching 

Pertama kali kami melihat fitur Photo-Matching SketchUp beraksi, kami terkikik dan bertepuk 
tangan seperti balita di kebun binatang. Kami juga tidak malu. Terkadang teknologi yang sangat 
berguna, yang sangat memuaskan, muncul, dan Anda tidak bisa menahan diri. 

Jadi, apa yang dilakukan Photo-Matching? Jika Anda memiliki foto yang bagus (atau beberapa 
foto) dari hal yang ingin Anda modelkan, fitur Photo-Matching SketchUp dapat membantu Anda 
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membuat model. Aplikasi ini adalah cara 99 persen pemodel menggunakan fitur ini, dan teknik 
yang kami fokuskan di bagian ini. (Anda juga dapat mencocokkan model yang ada dengan foto.) 

Ingat 

Anda dapat mengedit tekstur apa pun dalam model Anda - termasuk yang dihasilkan oleh Photo-
Matching - dengan membukanya di perangkat lunak pengedit gambar (seperti Photoshop) 
langsung dari SketchUp. Trik ini berguna untuk mengambil hal-hal yang mungkin tidak Anda 
inginkan dalam foto Anda, seperti pohon, mobil, dan mantan suami. Lihatlah bagian”Mengedit 
piksel dalam gambar tekstur," di awal bab ini, untuk semua detail menarik. 

Memilih gambar yang Cocok dengan Foto 

Photo-Matching hanya berfungsi pada foto objek dengan setidaknya satu pasang permukaan 
yang tegak lurus satu sama lain. Untungnya, ini mencakup jutaan hal yang mungkin ingin Anda 
bangun. Tapi tetap saja, jika benda yang ingin Anda foto-cocok seluruhnya bulat, atau 
bergelombang, atau bahkan segitiga, metode ini tidak akan berhasil. 

Berikut tips memilih foto untuk proses ini: 

 Waspadai distorsi lensa. Saat Anda mengambil gambar dengan lensa sudut lebar, 
beberapa garis lurus pada gambar sedikit melengkung, tergantung di mana posisinya 
dalam bingkai. Coba gunakan foto yang diambil dengan lensa normal atau telefoto: 50mm 
hingga 100mm adalah pilihan yang bagus. 

 Pastikan edge dua permukaan tegak lurus terlihat dalam bidikan. Anda perlu melihat 
bidang yang tegak lurus satu sama lain untuk menggunakan Photo-Matching dengan 
benar. 

 Bidik pada sudut 45 derajat jika Anda bisa. Karena cara kerja perspektif, hasil Anda lebih 
akurat jika Anda menggunakan foto di mana Anda dapat melihat kedua permukaan tegak 
lurus dengan jelas; jika salah satunya terdistorsi tajam, Anda akan mengalami kesulitan. 

Jenis foto berikut, yang diilustrasikan pada Gambar 3-10, bekerja sangat baik dengan fitur Match 
Photo SketchUp: 

 Tampilan interior ruangan tempat sudut bertemu di sudut kanan 

 Tembakan udara 
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Gambar 3-10: Pilih style yang paling menggambarkan posisi kamera foto Anda. 

Pemodelan Melalui Photo-Matching 

Fitur Match Photo membantu Anda membuat model berdasarkan foto. Berikut dua konsep dasar: 

1.  Prosesnya berulang, bukan linier. Membangun model menggunakan foto yang cocok 
mencakup antara menggambar tepi, mengorbit, menggambar lebih banyak tepi, kembali 
ke Scene foto yang cocok, dan menggambar lebih banyak tepi. Setiap foto berbeda, jadi 
foto yang Anda kerjakan akan menghadirkan tantangan unik yang (mudah-mudahan) 
akan Anda temukan dengan senang hati. 

2. Jangan lupa tekstur fotonya. Sejauh ini, salah satu fitur paling keren dari Photo-Matching 
adalah kemampuan untuk secara otomatis memberi tekstur pada face model Anda 
dengan menggunakan foto Anda sebagai”melukis". Ini adalah operasi satu tombol, dan 
dijamin akan membuat Anda tersenyum. 

Ikuti langkah-langkah berikut untuk mulai membuat model dari foto: 

1. Pilih Camera => Match New Photo.  

Kotak dialog terbuka. 

2. Pilih gambar di komputer Anda yang ingin Anda gunakan dan klik tombol Buka.  

Kotak dialog ditutup, dan Anda melihat gambar yang Anda pilih di window pemodelan Anda. 
Anda juga melihat campuran techno-spaghetti warna-warni, seperti yang ditunjukkan pada 
Gambar 3-11. Jangan khawatir - itu semua adalah bagian dari antarmuka Photo-Matching. 

3. Di panel Match-photo, pilih style yang sesuai dengan foto Anda: Di Dalam, Di Atas 
(untuk tampilan udara), atau Di Luar (untuk tampilan luar ruangan yang diambil dari 
permukaan tanah).  
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Untuk gudang yang ditunjukkan dalam contoh ini, kami memilih Di luar. 

4. Klik dan seret titik akhir bilah perspektif hijau sehingga setiap bilah sejajar dengan edge 
di foto yang harus sejajar dengan sumbu hijau model.  

Bagian atas dan bawah window adalah kandidat yang baik, begitu pula garis atap, permukaan 
meja, dan ubin langit-langit. Dalam contoh kami, kami menyelaraskan bilah perspektif hijau 
dengan garis atap gudang. 

Tips 

Kiat berikut dapat membantu Anda memosisikan bilah dengan benar: 

 Memperbesar dan memperkecil (menggunakan roda gulir pada mouse Anda) untuk 
melihat foto Anda dengan lebih baik saat Anda menempatkan bilah perspektif. 
Semakin akurat Anda menempatkan palang, hasilnya akan semakin baik. 

 Cocokkan bilah perspektif Anda dengan edge yang bagus dan panjang pada foto Anda; 
Anda mendapatkan hasil yang lebih baik dengan cara itu. 

5. Klik dan seret titik akhir bilah perspektif merah sehingga sejajar dengan edge di foto 
yang harus sejajar dengan sumbu merah model 

Ingat 

Tepi harus tegak lurus dengan rangkaian edge pertama, atau Photo-Matching tidak akan 
berhasil. Dalam contoh kami, kami menyelaraskan bilah perspektif merah ke edge pada sisi 
gudang yang juga tegak lurus dengan bilah perspektif hijau. Anda dapat melihat hasilnya pada 
Gambar 3-12. 

6. Seret asal sumbu (persegi kecil tempat sumbu bertemu) ke tempat di mana bangunan 
Anda menyentuh tanah dan tepat di persimpangan dua sisi tegak lurus, seperti yang 
ditunjukkan pada Gambar 3-13.  

Menyetel asal sumbu adalah cara Anda memberi tahu SketchUp di mana bidang tanah 
berada. Setelah Anda menetapkan asal sumbu di tempat yang tepat, perhatikan bahwa garis 
cakrawala, yang merupakan bilah kuning horizontal, sejajar dengan cakrawala di foto Anda. 
Selama Anda menempatkan bilah perspektif dengan benar, bilah garis cakrawala biasanya 
akan berfungsi dengan sendirinya. Namun, sekarang Anda tahu apa yang dilakukan bilah garis 
cakrawala kuning jika Anda membutuhkannya. 

7. (Opsional) Di panel Photo-matching, setel jarak kisi sehingga Anda dapat secara kasar 
mengubah skala model ke foto Anda. 

Dalam contoh kami, kami membiarkan opsi Spacing disetel ke default 5 kaki. Kami tahu tinggi 
gudang itu sekitar 20 kaki. Hanya 4 garis kisi yang kita butuhkan untuk menskalakan model 
ke foto (karena 4×5 = 20). Jika Anda menphoto-matching sebuah arena atau gedung pencakar 
langit, Anda mungkin perlu menyesuaikan jarak kisi sehingga kisi dapat menyesuaikan dengan 
lebar atau tinggi yang begitu besar. 
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8. Klik tombol Selesai di panel Photo-matching. 

Saat Anda mengklik tombol Selesai, Anda berhenti mengedit foto yang cocok. Semua garis 
warna-warni dan grid menghilang, dan Anda tersisa dengan foto yang Anda bawa, sumbu 
model, dan pemikiran Anda. Ini mungkin tampak seperti banyak keajaiban, tetapi yang Anda 
lakukan cukup sederhana: Anda menggunakan Photo-Matching untuk membuat 
pemandangan dengan posisi kamera dan pengaturan lensa yang sesuai dengan yang 
digunakan untuk mengambil gambar. di layar Anda. Akibatnya, Anda sekarang”berdiri" persis 
di tempat fotografer berdiri saat foto diambil. 

9. Pilih Line Tool dan, mulai dari asal sumbu, lacak salah satu edge di foto Anda. 

Pastikan Anda menggambar di salah satu dari tiga arah utama: merah, hijau, atau biru. Jika 
Anda mengorbit secara tidak sengaja sehingga foto Anda menghilang, klik tab pemandangan 
untuk melihat foto itu lagi. (Kami berbicara sedikit lebih banyak tentang mengorbit saat Anda 
menggambar di tip yang mengikuti Langkah 11.) 

10. Terus telusuri dengan Line Tool sampai Anda memiliki face persegi panjang, perhatikan 
warna tepinya saat Anda menggambar. 

Ingat 

Anda selalu ingin garis Anda berubah menjadi merah, hijau, atau biru saat Anda memulai. 

11. Gunakan drawing tool SketchUp untuk terus menjiplak foto dalam tiga dimensi. 

Pada Gambar 3-14, Anda melihat dua face persegi panjang, satu digambar pada sumbu hijau 
dan yang lainnya digambar sepanjang sumbu merah. 

Tips 

Berikut adalah petunjuk agar foto Anda berhasil dijiplak dengan drawing tool SketchUp: 

 Selalu mulai edge di ujung edge yang sudah Anda gambar. Melakukan hal itu 
membantu memastikan bahwa hasil Anda sesuai dengan yang Anda harapkan. 

 Jangan pernah menggambar edge di udara. Oke - ini sama dengan yang terakhir, 
tetapi berulang: Saat Anda menggambar edge berdasarkan edge lain, Anda 
mendapatkan hasil terbaik. 

 Untuk memulai, berhati-hatilah agar tidak mengorbit saat Anda menggambar. Anda 
dapat memperbesar dan menggeser semua yang Anda inginkan. Jika Anda mengorbit 
menjauh dari titik pandang yang Anda tetapkan, foto Anda akan hilang, dan Anda 
hanya melihat geometri yang telah Anda gambar, seperti yang ditunjukkan pada 
Gambar 3-15. Anda dapat dengan mudah kembali dengan mengklik tab Scene untuk 
foto Anda yang cocok. Tab ini diberi label dengan nama foto Anda di bagian atas 
window pemodelan Anda. 

 Setelah model Anda mulai terbentuk, orbit sering untuk melihat apa yang sedang 
terjadi. Anda akan terkejut dengan apa yang terkadang Anda alami - melacak gambar 
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2D dalam 3D adalah bisnis yang rumit. Biasakan mengorbit untuk memeriksa hasil dan 
menggambar edge tertentu. Klik tab pemandangan foto yang cocok untuk kembali ke 
tampilan yang benar. 

 Gunakan tool lain (seperti Push/Pull dan Offset) jika perlu. Tidak ada yang 
menghalangi Anda untuk menggunakan tool pemodelan SketchUp yang lengkap. 
Namun, menelusuri kerangka dasar model dengan Line Tool dan Penghapus membuat 
prosesnya tetap sederhana. 

 Perhatikan warnanya. Dengan foto berwarna sebagai hamparan, melihat apa yang 
Anda lakukan bisa jadi rumit. Perhatikan untuk memastikan bahwa Anda 
menggambar edge yang ingin Anda gambar. 

 Gambarlah sudut dengan menghubungkan titik-titiknya. Jika Anda perlu menjiplak 
edge di foto Anda yang tidak sejajar dengan sumbu berwarna apa pun (garis atap 
bersudut, misalnya), cari tahu di mana titik ujungnya dengan menggambar edge tegak 
lurus dan menghubungkannya dengan garis miring, seperti ditunjukkan pada Gambar 
3-16. Anda dapat menghapus garis atau garis yang tidak Anda perlukan nanti. 

 Tampilkan atau sembunyikan foto Anda. Melakukannya terkadang membantu Anda 
melihat pekerjaan Anda. Bagian selanjutnya menjelaskan di mana menemukan 
kontrol pada panel Styles. 

 

Gambar 3-11: Antarmuka Photo-Matching menyertakan gambar Anda, ditambah banyak hal 
lainnya. 
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Gambar 3-12: Palang perspektif sejajar dengan garis atap dan dinding. 
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Gambar 3-13: Asal sumbu berada di sudut yang menyentuh tanah 
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Gambar 3-14: Saat Anda mulai menjiplak model Anda, sejajarkan edge Anda dengan sumbu 
gambar untuk membuat bentuk dasar. 
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Gambar 3-15: Saat Anda mengorbit, foto Anda menghilang. Klik tab Scene untuk melihat gambar 
lagi. 
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Gambar 3-16: Gambar garis sementara untuk membuat edge untuk garis atap atau edge lain yang 
tidak sejajar dengan sumbu berwarna. 

Setelah Anda selesai menggambar model Anda, Anda dapat menskalakannya secara tepat 
dengan menggunakan tool Pita Pengukur.  

Membuat foto Anda yang cocok muncul kembali (atau menghilang) 

Setelah Anda menphoto-matching dengan model Anda, tips berikut berguna untuk diketahui: 

 Klik matched photo scene tab: Saat Anda membuat foto baru yang cocok, Anda membuat 
pemandangan baru. Mengklik tab pemandangan foto yang cocok mengembalikan 
tampilan Anda ke tampilan yang Anda atur saat Anda membuat (atau mengedit) foto yang 
cocok. Ini juga membuat foto terkait muncul kembali - berguna jika Anda telah mengorbit 
ke tampilan lain. 

 Kelola pengaturan visibilitas foto di panel Styles: Jauh, jauh di dalam panel Styles, pada 
tab Edit, di bagian Modeling Settings, Anda dapat mengontrol visibilitas foto yang cocok.  

Pemodelan di Atas Tekstur Foto 

Setelah Anda menempatkan tekstur foto di sisi kanan dan di tempat yang tepat di face itu (ya, 
kami telah banyak membaca Dr. Seuss), Anda dapat menggunakan informasi di foto Anda untuk 
membantu menambahkan geometri ke model Anda . Ini adalah cara yang bagus untuk menjadi 



117 
 

akurat secara kasar tanpa harus mengukur banyak, dan kombinasi tekstur foto dan beberapa 
operasi tarik/tarik sederhana bisa sangat meyakinkan. 

Membuat tekstur yang diproyeksikan 

Membuat model dengan texture face foto tidaklah sulit, tetapi Anda harus mengambil satu 
langkah penting sebelum dapat melakukannya: Anda harus memastikan tekstur Anda 
diproyeksikan. 

Gambar 3-17 menunjukkan apa yang terjadi saat Anda mencoba mendorong/menarik bukaan 
pada texture face foto: Di sebelah kiri, jika tekstur tidak diproyeksikan, bagian dalam akan dicat 
dengan bagian tekstur yang acak, membuat model Anda terlihat seperti teka-teki mata yang 
penuh stiker. Di sebelah kanan, saat diproyeksikan, perhatikan bagaimana permukaan”dalam" 
yang dibuat oleh operasi push/pull berwarna abu-abu polos dan mudah dilihat. Hasilnya biasanya 
lebih sesuai untuk apa yang Anda lakukan. 

 

Gambar 3-17: Mendorong/menarik bukaan pada permukaan bertekstur saat tekstur tidak 
diproyeksikan (kiri) dan saat diproyeksikan. 

Ingat 

Pastikan tekstur face Anda diproyeksikan sebelum Anda mulai menggambar di atasnya. 
Untungnya, memberi tahu SketchUp untuk membuat tekstur foto yang diproyeksikan hanyalah 
masalah menekan tombol. Context-clicks pada face dengan tekstur foto dan pilih Tekstur ⇒ 
Diproyeksikan dari menu konteks. Jika Anda melihat tanda centang di samping Diproyeksikan, 
tekstur Anda sudah diproyeksikan; jangan memilih apapun. 

 

MEMBUAT MULTIPLE MATCHES 

Jika Anda memiliki lebih dari satu foto subjek pemodelan Anda, Anda dapat memiliki beberapa 

foto yang cocok dalam file SketchUp yang sama. Lakukan sejauh mungkin dengan foto 

pertama dan kemudian mulai lagi dengan foto berikutnya menggunakan geometri yang Anda 

buat sebagai”bangunan yang ada". Lihat bagian”Menphoto-matching dengan model yang 
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sudah ada," di awal bab ini, dan ikuti langkah-langkah untuk menyejajarkan model yang sudah 

ada dengan foto baru. 

Berikut ini adalah model yang Aidan mulai buat dari Habitat 67, di Montreal. Dia menggunakan 

dua gambar untuk membuat dua pertandingan dalam file SketchUp yang sama. Membuat 

lebih dari satu foto yang cocok adalah cara yang bagus untuk membangun lebih banyak model 

daripada yang bisa Anda lihat dalam satu gambar. 

 

 

Pemodelan dengan tekstur yang diproyeksikan: Alur kerja dasar 

Ikuti langkah-langkah berikut untuk memahami bekerja dengan tekstur yang diproyeksikan (dan 
lihat langkah-langkah dalam tindakan pada Gambar 3-18): 

 Buat kotak persegi panjang dasar dan kemudian terapkan tekstur foto ke salah satu sisi 
face. Lihat bagian,”Menambahkan foto ke flat face," di awal bab ini. 

 Context-clicks pada texture face dan pilih Texture ⇒ Projected dari menu konteks. 
Pastikan Proyeksi memiliki tanda centang di sebelahnya. 

 Gambar persegi panjang pada permukaan bertekstur dan push/pull ke dalam. Perhatikan 
efek piksel yang direntangkan? 

 (Opsional) Tambahkan sudut atau fitur lain ke model Anda. Perhatikan face bersudut yang 
kita buat pada Gambar 3-19. 

 Beralih ke offset toolnt Bucket, tahan tombol Alt (Command di Mac), dan klik di suatu 
tempat pada permukaan bertekstur untuk mencicipi teksturnya. (Kursor Anda terlihat 
seperti pipet saat Anda melakukan ini.) Langkah ini memuat Paint Bucket Anda dengan 
tekstur yang diproyeksikan. 
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 Lepaskan tombol Alt (Command) untuk beralih kembali ke kursor Paint Bucket dan 
kemudian klik face bersudut sekali untuk mengecatnya dengan tekstur yang 
diproyeksikan. Anda juga melihat efek piksel yang direntangkan di sini. 

 

Gambar 3-18: Bekerja dengan tekstur yang diproyeksikan. 
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Gambar 3-19: Area yang Anda bingkai dengan pin diimpor ke model Anda sebagai snapshot geo-
lokasi. 

Menambahkan Data Geografis 

Saat Anda menambahkan data geografis ke model Anda (juga disebut geo-locating model Anda), 
Anda memberinya garis lintang, bujur, dan orientasi mata angin tertentu berdasarkan alamat, 
persimpangan jalan, atau informasi lainnya. Kedengarannya tidak banyak pada awalnya, tetapi 
berikut adalah tiga hal yang memungkinkan geo-location untuk Anda lakukan: 

 Lakukan studi bayangan yang akurat. Untuk sebagian besar tipe desainer, ini mungkin 
manfaat terbesar dari geo-locating model. Dengan garis lintang, bujur, dan orientasi mata 
angin, mesin bayangan SketchUp dapat menampilkan bayangan yang sangat akurat untuk 
setiap saat, hari apa pun sepanjang tahun. 

 Buat model konteks bertekstur foto. Jika Anda mendesain sebuah bangunan, mungkin 
bangunan itu dikelilingi oleh bangunan lain, dan bangunan lain itu mungkin berpengaruh 
besar pada desain bangunan Anda, bukan? Bukankah menyenangkan untuk memilikinya 
dalam model Anda? Anda dapat menggabungkan gambar resolusi tinggi, warna, udara 
(diambil dengan pesawat atau satelit) dengan fotografi tingkat jalan untuk membuat 
model konteks tercepat dan paling berguna yang pernah Anda miliki. Heck - Anda bahkan 
mungkin tidak perlu mengunjungi situs tersebut secara langsung. Cobalah penelusuran 
web untuk”Video Pemodelan Situs di SketchUp" (atau arahkan browser Anda ke alamat 
web ini: https://youtu.be/nVhM3IYMF8o) untuk menemukan tutorial YouTube 
mendalam yang Aidan susun hanya tentang subjek ini. 
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 Tampilkan model Anda di Google Earth. Setelah model Anda memahami di mana 
tempatnya di planet ini, Anda dapat dengan mudah mengekspor file model dan 
mengirimkannya ke salinan Google Earth Anda. Terbang dari Menara Eiffel ke Taj Mahal 
dan kemudian ke gudang tool baru yang Anda usulkan memberikan desain Anda tingkat 
keseriusan yang menyatakan,”Lihat apa yang telah saya kerjakan selama 37 jam terakhir 
ini!" untuk pasangan Anda tidak bisa cocok. Ini juga mengesankan bagi klien. 

Bagian berikut menguraikan langkah-langkah seluk beluk untuk memberi tahu SketchUp di mana 
letak model Anda di Bumi (secara harfiah), melihatnya di Google Earth, dan menyimpannya 
sebagai file Google Earth yang dapat Anda bagikan dengan orang lain. 

Menempatkan model Anda secara geografis 

Ikuti langkah-langkah berikut untuk menambahkan snapshot geo-lokasi ke file SketchUp Anda: 

1. Pastikan Anda online.  

Semua geo-data disimpan di server yang sangat jauh; jika Anda tidak memiliki koneksi 
internet, Anda tidak dapat menggunakan geo-data. 

2. Buka file SketchUp yang ingin Anda geolokasi.  

Anda dapat menambahkan snapshot geo-lokasi ke model Anda kapan saja saat Anda 
mengerjakannya. Jika Anda belum memulai pemodelan, tidak masalah untuk menambahkan 
lokasi geografis ke file kosong. 

3. Pilih File => Geo-Location => Add Location dari menu bar.  
4. Window baru yang mungkin Anda kenali terbuka: Ini adalah versi Google Maps yang 

disederhanakan. 

Temukan area di mana Anda ingin model Anda ditempatkan. 

Anda dapat mengetik alamat ke dalam bilah pencarian di pojok kiri atas jika Anda mau. Anda 
juga dapat menggunakan mouse atau kontrol di sisi kiri window untuk bernavigasi. Gulir roda 
mouse Anda untuk memperbesar; klik dan seret untuk menggeser.  

Saat Anda memperbesar cukup dekat, Anda akan melihat foto putih berukuran 1 kmx1 km 
persegi: Ini adalah jepretan terbesar yang dapat Anda impor sekaligus. Itu masih merupakan 
area yang sangat besar, jadi Anda mungkin ingin terus memperbesar/memperkecil. 

5. Klik tombol Select Region untuk menampilkan persegi panjang cropping. 
6. Seret pin untuk menentukan sudut yang tepat dari snapshot geo-lokasi Anda, seperti 

yang ditunjukkan pada Gambar 3-19.  

Cobalah untuk membingkai area yang cukup besar untuk menjadi dasar model Anda. 
Mengimpor terlalu banyak data medan dapat memperlambat komputer Anda. Anda selalu 
dapat membawa lebih banyak data medan nanti. 
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7. Klik tombol Grab untuk menambahkan lokasi geografis ke file SketchUp Anda.  

Window terpisah menutup, dan persegi panjang besar berwarna-warni muncul di tengah 
model Anda. Itu adalah cuplikan lokasi geografis Anda yang baru. 

8. Jika Anda menentukan lokasi geografis model yang telah Anda buat, pindahkan ke 
posisinya pada snapshot.  

Gunakan Move tool (dan mungkin Rotate tool) untuk mengambil model Anda dan 
meletakkannya di tempatnya. Namun, Anda belum selesai - Anda masih harus memastikan 
model Anda berada di medan secara vertikal. Ikuti langkah-langkah berikut untuk 
melakukannya:  

a. Pilih File => Geo-location => Show Terrain untuk beralih ke versi 3D dari snapshot geo-
location Anda.  

b. Pilih semua yang ingin Anda pindahkan dan gunakan Move tool untuk mulai bergerak; 
ketuk tombol panah atas atau bawah untuk membatasi perpindahan Anda ke sumbu biru.  

c. Tenggelamkan model Anda ke medan hingga terpasang dengan benar - hindari sindrom 
model mengambang yang ditakuti dengan segala cara. 

Ingat 

 Jika Anda ingin mengimpor snapshot lain ke SketchUp, Anda bisa. SketchUp secara otomatis 
menyusun semua foto yang Anda ambil untuk membentuk tambal sulam dalam model Anda. 
Fitur ini sangat berguna jika Anda merasa tidak mendapatkan semua yang Anda butuhkan pada 
kali pertama. 

SEGALA HAL TENTANG SNAPSHOTS GEO-LOCATION 

Saat Anda mengimpor cuplikan lokasi geografis, Anda mengakses penyimpanan data geografis 

Google yang sangat besar. Foto-foto itu lebih dari sekadar gambar-gambar cantik. Selain geo-

lokasi posisi model, snapshot memiliki beberapa fitur berikut: 

 Semuanya sudah dalam ukuran yang tepat. Mungkin Anda mengambil foto lapangan 
sepak bola; bila Anda mengukur lapangan sepak bola itu di SketchUp, panjangnya tepat 
100 yard. Itu karena SketchUp menskalakan snapshot Anda ke ukuran yang benar 
sebagai bagian dari proses impor. 

 Jepretan terlihat datar tetapi berisi data medan juga. Jepretan yang diimpor SketchUp 
lebih dari sekadar foto udara berwarna. Foto tersebut juga mencakup sebagian 
topografi - medan. Medannya datar saat Anda pertama kali mengimpornya karena 
lebih mudah untuk membangun dengan cara itu, tetapi Anda dapat beralih antara 
tampilan datar dan 3D (bukan datar) dengan memilih File ⇒ Lokasi Geografis ⇒ 
Tampilkan Medan. Jangan khawatir jika Anda tidak melihat perbedaan apa pun saat 
beralih di antara tampilan - Anda mungkin hanya memilih situs datar. 
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Melihat model Anda di Google Earth 

Setelah Anda membuat (atau hanya memposisikan) model di atas snapshot geo-lokasi, 
mengekspor model sehingga Anda dapat melihatnya di salinan Google Earth Anda adalah operasi 
sederhana. Anda juga dapat mengirim file KMZ melalui email ke semua teman Anda. Jika Anda 
mencontoh klien alih-alih teman, Anda juga dapat mengirim file kepada mereka. 

Saat seseorang membuka file KMZ, Google Earth terbuka di komputernya (jika dia memiliki 
Google Earth), dan dia”terbang" untuk melihat model yang Anda buat. Coba kirimkan petunjuk 
arah ke pesta Anda berikutnya dengan cara ini; teman Anda akan menganggap Anda jenius. 

Ikuti langkah-langkah berikut untuk mengekspor model SketchUp ke file KMZ: 

1. Di SketchUp, pilih File ⇒ Ekspor ⇒ Model 3D.  
2. Dalam kotak dialog Model Ekspor yang muncul, pilih di mana pada hard drive Anda Anda 

ingin menyimpan file KMZ. 
3. Beri nama file dan pilih jenis file KMZ.  
4. Klik tombol Ekspor untuk menyimpan model Anda sebagai file KMZ. 

Mengerjakan dengan file CAD yang Diimpor 

Di SketchUp Spectrum of Fun, mengimpor dan menyiapkan file CAD terletak tepat di antara 
penggalian jamban dan memerah susu kucing - ini bukanlah sesuatu yang dinanti-nantikan oleh 
banyak orang. Bagian ini adalah kumpulan tip dan trik yang telah dipelajari Aidan selama 
bertahun-tahun menangani file CAD orang lain. 

Mengimpor file CAD ke SketchUp Pro 

Ini mungkin saat yang tepat untuk memberi tahu Anda (seandainya Anda melewatkan judul tepat 
di atas paragraf ini) bahwa hanya SketchUp Pro yang dapat mengimpor file CAD 2D dalam format 
DWG dan DXF; SketchUp Make tidak menyertakan fungsi ini. 

File CAD Anda mungkin dibuat sendiri, tetapi kemungkinan besar Anda telah menerimanya dari 
orang lain. Dalam hal ini, hal terbaik mutlak yang harus dilakukan adalah membukanya di 
perangkat lunak yang sama yang membuatnya. Jika Anda memiliki file AutoCAD, buka di AutoCAD 
dan lihat struktur layernya. Buat salinan file, hapus semua yang tidak Anda perlukan untuk 
dibawa ke SketchUp Pro, dan lanjutkan dari sana. 

Sederhana bukan? Tetapi bagaimana jika (seperti Aidan) Anda tidak memiliki AutoCAD? Tidak 
apa-apa - kebanyakan orang tidak. Anda akan memiliki cukup banyak pekerjaan pembersihan 
yang harus dilakukan di SketchUp setelah Anda mengimpor data CAD, tetapi dapat dikelola. 
Bagian setelah ini menjelaskan serangkaian hal yang dapat Anda lakukan untuk menyusun 
gambar menjadi bentuk sebelum Anda dapat memulai pemodelan. 

Sebenarnya mengimpor data CAD ke SketchUp Pro tidaklah terlalu rumit. Ikuti langkah-langkah 
berikut, dan Anda akan baik-baik saja: 
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1. Buka file SketchUp baru dan segar.  

Anda tidak bisa begitu saja membuka file DWG atau DXF di SketchUp Pro; Anda harus 
mengimpor data ke model yang ada. Kami sangat menyarankan memulai dengan file 
SketchUp baru karena sebagian besar file CAD sangat rumit. Membawa semua kerumitan 
itu - ribuan tepian dan banyak layer - ke dalam model SketchUp yang sudah rumit hanya 
akan menimbulkan masalah. Pisahkan hal-hal dan tetap waras. 

2. Pilih File ⇒ Import.  

Kotak dialog Impor File terbuka. 

3. Pilih file AutoCAD (* .dwg, * .dxf) dari daftar drop-down Format.  

Untuk beberapa alasan, Anda harus memberi tahu SketchUp jenis file apa yang ingin Anda 
impor sebelum mengizinkan Anda memilihnya di sistem file Anda. 

4. Temukan file CAD (DWG atau DXF) yang ingin Anda impor dan pilih.  

Jangan klik Impor dulu. 

5. Klik Option.  

Kotak dialog Opsi Impor DWG terbuka. 

6. Setel Unit agar cocok dengan unit pengukuran default dari file CAD yang akan Anda 
impor. 

 Jika file CAD berasal dari seseorang di AS, kemungkinan besar unitnya adalah Inci atau 
Kaki. Negara lain (dengan bijak) menggunakan sistem metrik. Jika Anda tidak tahu unit 
apa yang harus dipilih di sini, mulailah dengan Inci dan lihat apakah itu berhasil. 

7. Putuskan apa yang harus dilakukan tentang tiga opsi lainnya di kotak dialog:  
a. Merge Coplanar Faces memberi tahu SketchUp untuk secara otomatis 

menggabungkan face yang berdekatan yang merupakan coplanar menjadi satu 
face. Ini dapat menghemat waktu pembersihan jika file CAD yang Anda impor 
benar-benar memiliki face di dalamnya, tetapi file CAD jarang melakukannya. Jika 
Anda memilih kotak centang ini dan impor Anda gagal (itu terjadi), coba hapus 
pilihannya di lain waktu.  

b. Orient Faces Consistently menginstruksikan SketchUp untuk melakukan yang 
terbaik untuk memastikan bahwa face dalam data yang Anda impor (jika ada) 
menghadap ke arah yang sama. Sekali lagi, ini mungkin menghemat waktu 
pembersihan, tetapi juga dapat mengganggu proses impor Anda.  

c. Preserve Drawing Origin berguna jika Anda akan mengimpor lebih dari satu file 
CAD ke model SketchUp yang sama. Anda dapat melakukan ini jika Anda 
mengimpor beberapa denah lantai dari gedung yang sama dan Anda ingin mereka 
berbaris. 

8. Klik OK untuk menutup kotak dialog Opsi Impor DWG. 
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9. Klik Impor…. …  

Dan silangkan jari Anda. Dengan beberapa kali mencoba, Anda biasanya dapat 
mengimpor data CAD. Jika Anda mendapatkan pesan kegagalan, coba lagi dengan 
pengaturan Unit yang berbeda di kotak dialog Opsi Impor (Langkah 6). Jika tidak berhasil, 
file mungkin telah disimpan dalam format CAD yang lebih baru dari yang dapat diimpor 
oleh salinan SketchUp Pro Anda. Hubungi orang yang mengirimi Anda file tersebut dan 
minta dia untuk menyimpan salinan lain untuk Anda dalam format CAD yang lebih lama. 

10. Lihatlah kotak dialog Hasil Impor untuk melihat di mana Anda berdiri.  

Jika, setelah bilah kemajuan impor berjalan sepenuhnya ke kanan dan impor itu sendiri 
berhasil, SketchUp Pro akan memberi Anda kotak dialog dengan statistik tentang apa 
yang diimpor dan apa yang diabaikan. Versi sederhananya adalah bahwa layer CAD, blok 
(yang diterjemahkan ke komponen di SketchUp), dan semua jenis edge dapat diimpor. 
Objek teks, dimensi, dan garis arsir (dari jenis yang menunjukkan bahan yang berbeda) 
tidak. Jika Anda sudah puas, klik OK dan tarik napas lega 

Tips 

Setelah Anda melalui proses impor CAD dan SketchUp telah memasukkan geometri yang 
dihasilkan ke dalam model Anda, pastikan semuanya berjalan sesuai rencana: Ukur beberapa hal 
dengan tool Pengukur Pita untuk melihat apakah ukurannya sesuai dengan yang Anda harapkan 
menjadi. Pintu masuk adalah tempat yang baik untuk memulai; jika Anda mengukur satu dan 
berkali-kali lebih kecil atau lebih besar dari yang seharusnya, Unit Anda (pada Langkah 6 dari 
langkah sebelumnya) salah. Tutup file, buka yang baru, dan coba lagi. 

Membersihkan data CAD yang diimpor 

Sebagian besar waktu, file CAD yang Anda impor tampak seperti kekacauan yang ditunjukkan 
pada gambar atas Gambar 3-20. Dinding, anotasi, garis kisi, dan hal-hal lain semuanya campur 
aduk, dan sepertinya Anda harus menghabiskan sisa minggu ini untuk menghapus tepian. 
Sebenarnya mungkin tidak - bagian berikut menjelaskan peningkatan yang dapat Anda lakukan. 

Beralih ke style yang lebih mudah dibaca 

Jika Anda menggunakan style tampilan yang menyertakan banyak hiasan edge (seperti Profil, 
Ekstensi, dan Titik Akhir), jenis geometri padat di sebagian besar gambar CAD sepertinya model 
Anda menerima kunjungan yang tidak diinginkan dari Peri Mascara. Yuck. Gunakan panel Styles 
untuk menerapkan style yang polos dan sederhana. Kami merekomendasikan Shaded atau 
Shaded with Textures, yang keduanya dapat Anda temukan di koleksi Style Default. Gambar 3-20 
menunjukkan perbedaan yang dapat dibuat oleh style. 
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Gambar 3-20: Menerapkan style tampilan sederhana ke model dengan data CAD yang diimpor 
membuatnya lebih mudah untuk dikerjakan. 

Matikan Layer yang tidak Anda butuhkan 

Sebagian besar simbol gambar dan anotasi lain yang Anda bawa ke SketchUp bukanlah hal yang 
Anda butuhkan, setidaknya untuk saat itu juga. Cara termudah dan teraman untuk 
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menyingkirkannya adalah dengan mematikan layernya. Ingat bahwa SketchUp Pro juga 
mengimpor semua informasi layer yang terkait dengan data CAD yang Anda bawa; sekaranglah 
waktunya untuk menggunakan semua kerumitan itu untuk keuntungan Anda. 

Ikuti langkah-langkah berikut untuk mengidentifikasi dan menyembunyikan hal-hal yang tidak 
Anda butuhkan: 

1. Buka panel Layers.  

File CAD biasanya hadir dengan lusinan layer. Buat panel Layers bagus dan besar sehingga 
Anda dapat melihat lebih banyak lagi.  

2. Buka panel Entity Info.  

Panel Entity Info memberi tahu Anda di layer mana entitas yang dipilih berada.  

3. Context-clicks bagian mana pun dari gambar CAD yang diimpor dan pilih Edit 
component.  

Selama model Anda berisi setidaknya satu entitas saat Anda melakukan impor data CAD, 
SketchUp Pro secara otomatis menempatkan semua geometri yang diimpor ke dalam satu 
komponen. Apa pun yang Anda lakukan, cobalah untuk tidak explodekan komponen ini - 
Anda akan mengetahui alasannya nanti di bab ini.  

4. Pilih entitas yang tidak ingin Anda lihat sekarang.  

Pada Gambar 3-21, garis kisi yang menurut kami tidak akan dibutuhkan untuk sementara 
(atau sama sekali) dipilih.  

5. Lihat Entity Info untuk melihat layer apa yang berisi entitas yang Anda pilih.  

Dalam hal ini, garis kisi yang dipilih ada di layer A-GRID. Oke, mungkin kami tidak 
memerlukan Entity Info untuk memberi tahu kami tentang itu.  

6. Temukan layer yang mengganggu di panel Layer dan matikan.  

Di bagian kedua Gambar 3-21, mematikan layer A-GRID sementara menyembunyikan 
semua entitas pada layer itu. Sudah lebih baik! Jika Anda yakin Anda tidak memerlukan 
konten layer tertentu, Anda dapat menghapusnya semuanya. Rebecca suka membuang 
barang yang tidak dibutuhkan, digital atau lainnya, tapi Aidan adalah tipe orang yang 
memegang barang (dan memiliki ruang bawah tanah untuk membuktikannya).  

7. Ulangi Langkah 4–6 untuk semua tipe entitas yang ingin Anda sembunyikan.  

Bagian dari proses pembersihan ini adalah katarsis SketchUp murni. Memang butuh 
waktu, tapi hasilnya langsung terlihat. Bagian terakhir dari Gambar 3-21 menunjukkan 
hasil dari menyembunyikan sekelompok layer. 
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Gambar 3-21: Pilih hal-hal yang tidak Anda perlukan dan sembunyikan layer tempat mereka 
berada.  

Tips 

Tentu saja, Anda juga dapat langsung masuk ke panel Layer dan mulai mematikan setiap layer, 
terutama jika Anda tahu entitas apa yang dikandungnya. Langkah-langkah sebelumnya berguna 
untuk situasi di mana layer tidak dinamai secara deskriptif atau saat Anda kewalahan dan tidak 
tahu harus mulai dari mana. 

Pemodelan di atas data CAD yang diimpor 

Jadi, Anda telah berhasil mengimpor gambar CAD dan menghapus style serta layernya yang 
terlihat agar lebih mudah dikelola. Kudos - sekarang waktunya untuk bersenang-senang. 
Membangun model 3D berdasarkan garis CAD yang mendasari (secara harfiah) bisa menjadi 
pengalaman Zen yang mengejutkan jika Anda mengikuti satu aturan sederhana: 

Ingat 

Simpan data CAD yang diimpor diisolasi di dalam komponennya sendiri dan buat model Anda di 
atasnya. Jangan tergoda untuk menggunakan edge yang diimpor untuk membuat face secara 
langsung. 

Inilah tiga alasan mengapa: 

 Data CAD hampir selalu penuh dengan celah. Garis yang harus sampai ke tetangga 
terkadang pendek demi sedikit, jumlah yang tidak terlihat, yang berarti Anda akan 
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menghabiskan waktu berjam-jam menggambar tepian dan mencoba mencari tahu 
mengapa face tidak akan muncul di tempat yang Anda inginkan. 

 Garis CAD yang seharusnya sejajar dengan salah satu sumbu berwarna seringkali tidak. 
Pikirkan edge itu sejajar dengan sumbu merah hanya karena terlihat seperti itu? Belum 
tentu. Mengubah pinggiran yang diimpor menjadi face dan kemudian 
mendorong/menariknya menjadi geometri 3D seperti membangun rumah di atas pasir 
apung; hal-hal menjadi miring dengan cepat. 

 Gambar CAD yang diimpor tidak selalu datar. Kadang-kadang bagian berbeda dari 
linework impor Anda terletak pada ketinggian yang sedikit berbeda. Kita berbicara 
tentang seperseribu inci - tidak cukup untuk diperhatikan pada awalnya, tetapi cukup 
pasti untuk mengacaukan pekerjaan Anda. 

Alih-alih mencoba menggunakan edge yang diimpor sebagai bagian dari model 3D Anda, gunakan 
itu sebagai referensi untuk geometri baru yang Anda gambar di atasnya. Melacak geometri yang 
diimpor tidak memakan waktu sebanyak yang Anda kira, dan hasilnya adalah model yang 
geometrinya jauh lebih akurat dan dapat diprediksi. Dua bagian berikut membahas tentang 
strategi untuk”menelusuri" konten CAD yang diimpor.  

Memodelkan dinding vertikal lurus berdasarkan edge CAD yang diimpor 

Ada teknik untuk memodelkan dinding sederhana dan elemen lurus lainnya di atas garis CAD 
impor yang sangat sederhana dan menyenangkan, sehingga penonton secara teratur bertepuk 
tangan saat Aidan mendemonstrasikannya. Penghargaan untuk metode ini diberikan kepada 
teman kita (dan kolega) Mike Tadros. 

Ingat 

Sebelum Anda memulai, pastikan Anda tidak mengedit component yang berisi linework CAD yang 
Anda impor. Ingatlah bahwa Anda menggunakan gambar CAD sebagai dasar referensi untuk 
aktivitas pemodelan 3D Anda sendiri. Anda akan bekerja”di atas" (di luar) komponen. 

Push/pull tooladalah pahlawan dari metode ini. Ikuti langkah-langkah ini (dan lihat Gambar 3-22) 
untuk memodelkan dinding lurus berdasarkan tepian dalam gambar CAD yang diimpor:  

1. Gunakan tool Sumbu untuk menyejajarkan sumbu pemodelan berwarna dengan 
dinding yang akan Anda buat modelnya. 

Jika sumbu sudah sejajar dengan dinding, Anda dapat melewati langkah ini. Jika tidak, 
cukup pilih tool ⇒ Sumbu dan sejajarkan sumbu pemodelan dengan edge dalam gambar 
CAD yang mewakili dinding yang sedang Anda kerjakan. Jika Anda tidak terbiasa dengan 
tool Sumbu,”Menphoto-matching dengan model yang ada” di awal bab ini memandu 
Anda melalui contoh penyelarasan sumbu dengan model. 

2. Gambar persegi panjang di samping dinding.  

Tidak peduli seberapa besar itu; Anda akan melihat alasannya sebentar lagi. 
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3. Gunakan push/pull tooluntuk mengekstrusi persegi panjang ke ketinggian dinding yang 
Anda modelkan.  

Jika Anda belum mengetahuinya, tebak saja. Mudah untuk mengubahnya nanti. 

4. Gunakan push/pull tooluntuk mengeluarkan kotak yang baru saja Anda buat sehingga 
rata dengan satu sisi dinding.  

Jika Anda menggambar persegi panjang pada Langkah 3 ke bagian luar dinding, push/pull 
permukaan sehingga sejajar dengan bagian dalam dinding. (Lihat Gambar 3-22.) Kunci 
langkah ini murni SketchUp Inferencing 101: Klik untuk mulai mendorong/menarik, 
arahkan penunjuk ke edge (atau titik akhir) yang Anda bidik, lalu klik lagi untuk berhenti 
mendorong/menarik. Anda menggunakan edge CAD yang diimpor sebagai referensi 
inferences untuk tool Anda. Ini kue setelah Anda melakukannya sekali atau dua kali. 

5. Gunakan push/pull tooluntuk membuat sisi berlawanan dari kotak rata dengan sisi 
dinding yang lain. 

Lihat apa yang terjadi? Anda menggunakan push/pull tooldan inferences yang dipilih 
dengan cermat untuk mengubah kotak menjadi dinding. 

6. Push/pull ujung dinding 3D agar sesuai dengan gambar di bawahnya.  
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Gambar 3-22: Pemodelan dinding sederhana berdasarkan beberapa edge pada gambar CAD yang 
diimpor. 

Apa yang terjadi jika tembok bertemu di sudut? Nah, itu bisa terjadi pada sudut siku-siku (yang 
umum) atau pada sudut lain (yang tidak jarang). 

PEMODELAN DINDING RIGHT-ANGLE 

Untuk sudut 90 derajat, yang harus Anda lakukan adalah menggambar persegi panjang di bagian 
dalam dinding Anda dan menggunakan push/pull tooluntuk mengeluarkannya. Setelah itu, 
gunakan tool yang sama untuk membuatnya rata dengan edge pada gambar CAD. Gambar 3-23 
memberikan visual. 
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Gambar 3-23: Gunakan tool Persegi Panjang dan Push/pull untuk memodelkan dinding yang 
bertemu pada sudut siku-siku. 

PEMODELAN DINDING YANG BERTEMU PADA NON-RIGHT-ANGLE 

Jika Anda berurusan dengan sudut yang bukan 90 derajat, Anda dapat melanjutkan dengan 
beberapa cara berbeda; menggunakan tool Intersect Faces adalah tempat yang bagus untuk 
memulai. Langkah-langkah berikut (dan Gambar 3-24) menjelaskan tekniknya:  

1. Buat model setiap segmen dinding lurus secara terpisah tetapi jangan dulu tumpang 
tindih ujungnya.  

Ikuti langkah-langkah di bagian”Membuat model dinding vertikal lurus berdasarkan edge 
CAD yang diimpor," beberapa halaman sebelumnya, untuk membangun setiap dinding 
sehingga sejajar dengan edge CAD yang sesuai. Jangan khawatir tentang dua ujung 
dinding yang pada akhirnya akan bertemu; pisahkan mereka untuk saat ini. 

2. Gunakan push/pull tooluntuk memperpanjang setiap dinding dengan baik melewati 
titik di mana dinding harus bertemu dengan yang lain.  

Anda membuat model sesuatu yang terlihat sepertixdari atas. 

3. Pilih bagian dalam dan luar setiap dinding.  

Anda harus memilih total empat face. 

4. Pilih Edit => Intersect Faces => With Selection. 

Tindakan ini memberi tahu SketchUp untuk menggambar edge di mana pun dua intersect 
face. Jika Anda memilih empat permukaan, Anda sekarang memiliki dua edge baru. 

5. Gunakan Push/pull untuk mendorong segmen dinding yang tidak Anda butuhkan.  

Mendorong face atas mereka sampai ke face bawah membuat mereka menghilang. 

6. Gunakan Eraser Tool untuk menghilangkan edge ekstra. 
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Gambar 3-24: Gunakan Intersect Faces untuk memodelkan dinding yang membentuk sudut non-
90 derajat.  

Memodelkan bentuk lengkung dan tidak beraturan dari data CAD  

Untuk dinding bujursangkar, tangga, dan bentuk lainnya, tool SketchUp Rectangle dan Push/pull 
adalah bintang rock. Bentuk bulat (seperti teras beton dan menara kastil) dan garis tidak 
beraturan (seperti dasar sungai dan bangunan Frank Gehry) membutuhkan tindakan lain yang 
lebih drastis. 

Langkah-langkah berikut memberikan contoh umum terkait fitur dalam file CAD Anda yang tidak 
perlu dilacak dengan susah payah dengan tool Line tetapi harus muncul di model SketchUp Anda. 
Dalam situasi ini, Anda dapat mengandalkan perintah Tempel di Tempat yang praktis:  

1. Selami komponen yang berisi linework CAD yang diimpor.  

Yang kami maksud dengan”menyelami" adalah mengeditnya, yang dapat Anda lakukan 
dengan mengklik dua kali menggunakan tool Pilih. 
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2. Pilih edge yang ingin Anda gunakan kembali. 
3. Buat grup dari tepi. 

Pilih Edit ⇒ Make Group untuk melakukan ini. Mengelompokkan pilihan Anda 
menyelesaikan dua hal: Pengelompokan mempermudah pemilihan ulang (jika ada yang 
salah), dan membuat semuanya tetap bagus dan terpisah untuk beberapa langkah 
berikutnya. 

4. Pilih Edit => Copy. 
5. Berhenti mengedit component linework CAD.  

Anda dapat keluar dari komponen (atau grup) dengan mengklik dua kali dengan tool Pilih 
di suatu tempat di luar kotak pembatasnya. 

6. Pilih Edit => Paste di Tempat.  

Tepi yang dipermasalahkan sekarang menjadi bagian dari model Anda, dan (berkat 
Langkah 3) dikarantina dari sisa geometri Anda melalui grup.  

Untuk bentuk yang terdiri dari busur sederhana (segmen lingkaran), taruhan terbaik Anda adalah 
mencoba membuatnya kembali dengan menggunakan tool Arc SketchUp sendiri. Mengapa tidak 
menggunakan metode Tempel di Tempat (dijelaskan di langkah sebelumnya) untuk 
menyalinnya? Untuk busur, sebaiknya Anda mengontrol jumlah sisinya, dan menggambarnya 
dari awal adalah satu-satunya cara untuk melakukannya. 

Ikuti langkah-langkah ini untuk secara akurat melacak busur dari garis CAD yang mendasari (lihat 
Gambar 3-25):  

1. Gambarlah edge yang tegak lurus dengan salah satu segmen garis busur, mengarah ke 
arah titik pusat busur.  

Anda dapat menggunakan inferensi linier Perpendicular SketchUp untuk membantu Anda 
menggambar edge tegak lurus. Ini adalah langkah pertama dalam menentukan lokasi 
tepat dari titik pusat busur. 

2. Ulangi Langkah 1 untuk segmen garis busur lainnya, melintasi edge baru Anda di atas 
yang baru saja Anda gambar. Titik perpotongan kedua sisi ini adalah titik tengah. 

3. Hapus dua edge yang baru saja Anda gambar, sisakan V kecil yang mengarah ke titik 
pusat busur. 

Lihat gambar ketiga pada Gambar 3-25 untuk melihat dua sisi mana yang saya maksud. 

4. Pilih Draw => Arcs => Arc untuk mengaktifkan tool Arc.  

Apa yang sekarang disebut Arc 2 Titik dulunya adalah satu-satunya tool Arc SketchUp; ini 
bekerja dengan mengatur titik akhir terlebih dahulu dan kemudian mengatur tonjolan. 
tool Arc (ish) baru, yang disebut hanya Arc, memungkinkan Anda memulai dengan 
menentukan titik pusat; ini jauh lebih berguna untuk situasi seperti yang Anda alami 
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sekarang. Jika Anda memiliki SketchUp 2014 atau lebih baru, Anda memiliki tool Arc baru 
ini. 

5. Klik sekali untuk mengatur titik tengah busur baru Anda. Ini, tentu saja, di ujung V yang 
Anda gambar di Langkah 3. 

6. Selesaikan busur dengan mengklik untuk mengatur setiap titik akhirnya. 
7. (Opsional) Ubah jumlah segmen edge di busur baru Anda.  

Sebelum Anda berpindah ke hal lain, ketikkan jumlah segmen yang Anda inginkan, diikuti 
dengan huruf s, lalu tekan Enter. Kemungkinan besar, Anda menginginkan lebih dari 12 
segmen default pada busur yang mewakili fitur utama dalam desain Anda. 

 

Gambar 3-25: tool Arc memungkinkan Anda menggambar busur dengan radius tertentu. 
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Bab 4 

Menampilkan Model Anda di dalam SketchUp 

Menjelajahi Kreasi Anda dengan Tools Foot (Ikon Kaki) 

Beberapa pengalaman dalam hidup sama memuaskannya dengan berlarian di dalam model 
Anda. Setelah Anda membuat ruang, Anda bisa berjalan mengelilinginya, naik turun tangga, 
menabrak tembok, dan bahkan jatuh ke tepian. Anda dapat memeriksa untuk memastikan bahwa 
televisi terlihat dari dapur, mengatakan, atau mengalami bagaimana rasanya berjalan-jalan di 
aula. Di gedung yang berpotensi membingungkan, seperti bandara atau stasiun kereta, Anda 
dapat mencari tahu di mana harus meletakkan tanda dengan mengizinkan seseorang yang belum 
pernah melihat model Anda menjelajahi ruang”dengan berjalan kaki". Bagian berikut, eh, 
memandu Anda melalui cara menggunakan fitur-fitur ini. 

Tool ini dibuat untuk berjalan 

Beberapa tool di SketchUp didedikasikan untuk menggerakkan model Anda seolah-olah Anda 
benar-benar berada di dalamnya. Langkah pertama (tidak ada permainan kata-kata) adalah 
memposisikan diri Anda sehingga Anda tampak berdiri di dalam model Anda. Ini bisa jadi rumit 
hanya dengan tool Orbit, Pan, dan Zoom, jadi SketchUp menyediakan tool hanya untuk ini: 
Posisikan Kamera. Setelah Anda berdiri di tempat yang tepat (dan di ketinggian yang tepat), Anda 
menggunakan tool Jalan untuk bergerak. Sesederhana itu. 

Ingat 

Alat Position Camera dan Walk memungkinkan Anda berjalan-jalan di dalam model Anda. 

Berdiri di tempat yang tepat: Position Camera Tool 

Position Camera Toolsecara tepat menempatkan sudut pandang Anda di SketchUp di tempat 
tertentu. Hanya itu yang dilakukannya, tetapi berfungsi dalam dua cara. 

 

 Anda ingin berdiri di sini.  

Pilih Camera => Position Camera dari menu bar atau klik tool Position Camera. (Anda 
menemukannya di Large Tool Set di Windows dan Mac OS X.) Kemudian klik di mana saja di 
window pemodelan untuk secara otomatis memposisikan sudut pandang Anda 5 kaki, 6 inci di 
atas di mana pun Anda mengklik. Karena ini adalah tinggi mata rata-rata orang dewasa, hasilnya 
adalah Anda, untuk semua maksud dan tujuan, berdiri di tempat Anda mengklik; lihat Gambar    
4-1. Setelah Anda menggunakan Position Camera, SketchUp secara otomatis beralih ke tool 
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Melihat Sekeliling, dengan asumsi Anda mungkin ingin melihat sekeliling. Kita membicarakan 
tentang Melihat Sekeliling di bagian”Berhenti untuk melihat-lihat" pada bab ini. 

Tip 

Anda tidak akan terjebak menjadi setinggi lima setengah kaki selamanya. Setelah Anda 
menggunakan Position Camera, ketik tinggi yang Anda inginkan dan tekan Enter. Ketik 18”untuk 
melihat pemandangan golden retriever di dunia, atau ketik 7’untuk berpura-pura bermain untuk 
LA Lakers. Perlu diingat bahwa measurement box (titik di pojok kanan bawah tempat angka 
muncul) menampilkan ketinggian mata Anda sebagai jarak dari tanah, dan bukan dari permukaan 
apa pun tempat Anda”berdiri". Untuk menyetel tinggi mata Anda menjadi 5 kaki di atas platform 
yang tingginya 10 kaki, Anda mengetik 15’. 

 Anda ingin mata Anda ada di sini, dan Anda ingin melihat ke arah ini. Pilih Posisi Kamera, 
klik tombol mouse saat berada di tempat yang Anda inginkan, seret ke hal yang ingin Anda 
lihat (Anda melihat garis putus-putus yang menghubungkan dua titik), dan lepaskan 
tombol mouse; lihat Gambar 4-2. Coba teknik ini beberapa kali; dibutuhkan sedikit latihan 
untuk menguasainya. Gunakan Position Camera dengan cara ini jika Anda ingin berdiri di 
tempat tertentu dan melihat ke arah tertentu. Teknik ini bekerja sangat baik dengan 
pemandangan, yang akan dibahas nanti dalam bab ini. 

 

Gambar 4-1: Jatuhkan diri Anda ke dalam model Anda dengan tool Position Camera. 

 

Gambar 4-2: Arahkan pandangan Anda dengan menggunakan Position Camera dengan cara lain. 
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Melangkah keluar dengan Walk Tool 

 

Setelah Anda menggunakan Position Camera untuk menempatkan diri Anda dalam model Anda, 
gunakan Walk Tool untuk melewatinya. Anda dapat menemukan Walk Tool pada menu Camera 
atau Large Tool Set. 

Untuk berjalan-jalan, klik dan seret mouse ke arah yang Anda inginkan: 

 Lurus ke depan. 

 Lurus ke bawah mundur. 

 Segala sesuatu di kiri atau kanan menyebabkan Anda berbelok saat Anda berjalan. 

Semakin jauh Anda menggerakkan kursor, semakin cepat Anda berjalan. Lepaskan tombol mouse 
untuk berhenti. Jika Anda pernah bermain video game, Anda akan terbiasa dengan cepat. Jika 
Scrabble lebih cepat dari Anda, perlu beberapa menit untuk memahaminya. 

Tips 

Anda bahkan dapat menggunakan Walk Tool untuk naik dan turun tangga dan landai. Ingatlah 
bahwa anak tangga tertinggi yang bisa Anda naiki adalah 22 inci - jika lebih tinggi, Anda akan 
mendapatkan kursor”benturan", seperti Anda berjalan ke dinding. Selain itu, jika Anda berjalan 
dari permukaan yang tinggi, Anda akan jatuh ke permukaan di bawah. Saat-saat seperti inilah 
kami berharap SketchUp memiliki efek suara kartun 

Menggunakan tombol pengubah yang dikombinasikan dengan Walk Tool membuat SketchUp 
semakin seperti video game: 

 Untuk berlari alih-alih berjalan, tahan tombol Ctrl (Opsi di Mac) saat Anda 
menggunakan tool Jalan dengan mouse Anda. Ini mungkin berguna jika Anda mencoba 
mensimulasikan bagaimana jadinya jika manusia serigala mengejar Anda melalui model 
Anda. 

 Untuk membuat tool Jalan mengubah ketinggian mata Anda atau bergerak ke samping, 
gunakan tombol Shift. Untuk bergerak lurus ke atas seperti Anda sedang tumbuh, tahan 
tombol Shift saat Anda menggerakkan mouse ke atas. Untuk mempersingkat, tahan Shift 
dan gerakkan mouse Anda ke bawah. Untuk bergerak ke samping seperti kepiting, tahan 
Shift dan gerakkan mouse ke kiri atau kanan. 

 Untuk menonaktifkan deteksi tabrakan agar Anda dapat berjalan menembus dinding, 
tahan tombol Alt (Command di Mac). Pencuri menganggap ini berguna untuk memasuki 
model tanpa merusak window apa pun. 

Berhenti untuk melihat-lihat 
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Melihat Sekeliling adalah tool ketiga di SketchUp yang didedikasikan untuk menjelajahi model 
Anda dari dalam. Jika menggunakan Position Camera seperti menukik untuk berdiri di tempat 
tertentu dan Berjalan seperti bergerak sambil mempertahankan ketinggian mata yang konstan, 
Look Around seperti menoleh sambil berdiri di satu tempat. Nama yang cukup bagus, kami pikir; 
ia melakukan persis seperti yang dikatakannya.  

Penggunaan Look Around sangat sederhana sehingga hampir tidak membutuhkan langkah-
langkah berikut: 

1. Pilih Camera => Look Around. 
2. Klik dan seret di window pemodelan untuk memutar kepala virtual Anda.  

Jangan bergerak terlalu cepat, atau leher virtual Anda akan tegang. 

Tip 

Saat Anda menggunakan salah satu tool navigasi, context-clicks untuk mengakses tool navigasi 
lainnya; ini membuat peralihan di antara mereka sedikit lebih mudah. 

Saat Anda menggunakan Melihat Sekeliling dengan tool bidang tampilan yang dibahas di bagian 
berikutnya, Anda mendapatkan simulasi realistis yang sangat realistis tentang bagaimana rasanya 
berdiri dalam model Anda. 

Mengatur bidang pandang Anda 

Bidang pandang adalah seberapa banyak model Anda yang dapat Anda lihat di window 
pemodelan Anda pada satu waktu. Bayangkan penglihatan Anda seperti kerucut, dengan ujung 
runcing mengarah ke mata Anda dan kerucut semakin besar saat semakin menjauh dari Anda. 
Segala sesuatu yang jatuh di dalam kerucut terlihat oleh Anda, dan segala sesuatu di luar kerucut 
tidak. 

Jika Anda meningkatkan sudut kerucut pada ujung runcing, kerucut tersebut semakin lebar, dan 
Anda melihat lebih banyak dari apa yang ada di depan Anda. Jika Anda mengurangi sudutnya, 
kerucut menjadi lebih sempit, dan Anda melihat lebih sedikit; lihat Gambar 4-3. 



141 
 

 

 

Gambar 4-3: Semakin lebar bidang pandang Anda, semakin banyak Anda bisa melihat. 

Diukur dalam derajat, bidang pandang yang lebar berarti Anda dapat melihat lebih banyak model 
Anda tanpa harus berpindah-pindah. Semakin besar sudutnya, semakin banyak yang bisa Anda 
lihat. Bidang pandang yang luas berguna saat Anda berada di dalam model SketchUp karena 
mengerjakan model yang tidak dapat Anda lihat itu sulit. 

Ada baiknya untuk mengutak-atik bidang pandang Anda sambil berjalan-jalan di dalam model 
Anda. Ikuti langkah-langkah berikut untuk melakukannya: 

1. Pilih Camera => Field of View 

Perhatikan bahwa measurement box di sudut kanan bawah window pemodelan Anda bertuliskan 
Bidang Pandang dan nilai defaultnya adalah 35 derajat. Ini berarti Anda saat ini memiliki kerucut 
penglihatan 35 derajat, yang agak sempit. 

2. Ketik 60 dan tekan Enter. 

Bidang pandang Anda meningkat, dan Anda sekarang memiliki pandangan yang lebih luas 
tentang model Anda. Imbalannya adalah Anda melihat lebih banyak distorsi di edge window 
pemodelan Anda karena lebih banyak informasi ditampilkan dalam jumlah ruang yang sama. 

Tip 
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Pedoman yang baik untuk menetapkan bidang pandang Anda adalah dengan menjaga 
keseimbangan antara kuantitas dan kualitas; pandangan yang lebih luas selalu berarti lebih 
banyak distorsi. Untuk pemandangan luar sesuatu, cobalah bidang pandang 35 hingga 45 derajat. 
Untuk tampilan interior, Anda dapat meningkatkan bidang pandang hingga 60 atau 70 derajat. 

Masalah Teknis 

Jika Anda mengetahui sesuatu tentang fotografi, Anda dapat mengekspresikan bidang pandang 
dalam milimeter, seperti Anda menggunakan lensa kamera. Mengetik 28mm memberi Anda 
tampilan sudut lebar, seolah-olah Anda sedang melihat melalui lensa 28mm. Bagi orang yang 
berpikir tentang bidang pandang dalam istilah ini, opsi ini bisa jauh lebih intuitif daripada 
mencoba membayangkan kerucut penglihatan. 

Menggunakan Scenic Route (Rute Pemandangan) 

Bukankah lebih bagus jika Anda dapat menyimpan tampilan tertentu dari model Anda? Dan 
bukankah lebih hebat lagi jika tampilan itu juga dapat menyimpan hal-hal seperti style dan 
setelan bayangan? Bagaimana jika Anda dapat kembali ke salah satu tampilan yang disimpan ini 
dengan mengklik tombol di layar Anda? Bagaimana jika seluruh paragraf ini hanyalah serangkaian 
pertanyaan? 

Scene SketchUp adalah (Anda dapat menebaknya) tampilan tersimpan model Anda. Mungkin 
paling mudah untuk menganggap Scene sebagai tampilan model Anda yang telah disimpan 
sebelumnya, kecuali bahwa pemandangan dapat menyimpan lebih dari sekadar posisi kamera. 

Ingat 

Meskipun Scene tidak mendapatkan banyak ruang di buku ini (bahkan tidak mendapatkan 
bagiannya sendiri), Scene adalah fitur penting di SketchUp karena tiga alasan: 

 Pemandangan dapat menghemat waktu berjam-jam. Kembali ke tampilan yang benar-
benar tepat dengan Orbit, Zoom, dan Geser tidak selalu mudah. Terkadang tampilan 
melibatkan bayangan, style, bagian (Anda membaca tentang itu nanti), dan bahkan 
hidden geometry. Menyiapkan semua sesuai kebutuhan Anda, setiap kali Anda 
membutuhkannya, bisa menyebalkan. Tidak sulit SketchUp - hanya saja Anda memiliki 
banyak cara berbeda untuk melihat model Anda. Membuat pemandangan 
memungkinkan Anda menerapkan lusinan pengaturan dengan satu klik pada mouse 
Anda. 

 Pemandangan sejauh ini merupakan cara paling efektif untuk menampilkan model 
Anda. Menyimpan Scene untuk setiap poin yang ingin Anda buat dalam presentasi 
memungkinkan Anda untuk fokus pada apa yang ingin Anda katakan. Alih-alih meraba-
raba dengan tool navigasi, menyalakan bayangan, dan membuat atap terlihat, Anda dapat 
mengeklik tombol untuk beralih ke Scene berikutnya (yang telah Anda siapkan persis 
seperti yang Anda inginkan). Gambar 4-4 menunjukkan serangkaian Scene yang Aidan 
buat untuk menampilkan rumah yang ia rancang untuk anjingnya, Savannah. 
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 Pemandangan adalah kunci untuk membuat animasi. Anda membuat animasi dengan 
membuat serangkaian Scene dan memberi tahu SketchUp untuk mengetahui transisi di 
antara keduanya. Prosesnya, yang dijelaskan di bagian selanjutnya, semudah mengklik 
tombol. 

 

Gambar 4-4: Untuk memperlihatkan tampilan yang sangat spesifik, buat Scene. 

Setelah Anda terbiasa dengan Scene, Anda akan mendapati diri Anda menggunakannya 
sepanjang waktu. Berikut adalah beberapa penggunaan paling umum untuk pemandangan: 

 Menampilkan kondisi naungan untuk area yang sama pada waktu yang berbeda dalam 
sehari.  

 Menyimpan Scene untuk setiap denah lantai, bagian bangunan, dan tampilan penting 
lainnya dari model Anda 

 Membangun animasi walkthrough atau flyover dari desain Anda 

 Membuat Scene yang menampilkan beberapa tampilan hal yang sama dengan opsi 
berbeda (atap runcing atau datar, Madam?) 

 Mendemonstrasikan perubahan dari waktu ke waktu dengan menunjukkan atau 
menyembunyikan rangkaian komponen.  

Membuat Scene 

Sebelum Anda mulai membuat Scene, ketahui ini: Membuat Scene di SketchUp tidak seperti 
mengambil foto model Anda. Jika Anda membuat Scene untuk menyimpan tampilan, terus 
mengerjakan model Anda, dan kemudian kembali ke Scene itu, model Anda tidak akan kembali 
ke cara semula saat Anda membuat Scene. Posisi kamera akan sama, dan setelannya akan sama, 
tetapi geometri Anda tidak akan sama. Ini adalah konsep yang cukup penting, dan salah satu yang 
membuat penggunaan Scene menjadi sangat berguna. 

Ingat 
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Pemandangan hanyalah sekumpulan setelan tampilan, yang berarti bahwa pemandangan 
tersebut diperbarui secara otomatis setiap kali Anda mengedit model Anda. Anda dapat 
membuat beberapa Scene dan menggunakannya sepanjang proses Anda, dari saat Anda mulai 
menjadi model hingga saat Anda mempresentasikan desain Anda kepada presiden. Atau untuk 
ibumu. 

Membuat Scene adalah proses sederhana. Ide dasarnya adalah Anda menambahkan Scene ke 
file SketchUp Anda setiap kali Anda memiliki tampilan yang ingin Anda lihat nanti. Anda selalu 
dapat menghapus Scene, jadi tidak ada kerugian untuk menggunakan banyak Scene. Ikuti 
langkah-langkah ini untuk membuat Scene baru: 

1. Pilih Window => Scenes untuk membuka panel Scenes.  

Saat panel Scene pertama kali terbuka, sepertinya tidak terlalu banyak. Memperluasnya 
dengan mengeklik tombol Tampilkan Detail di sudut kanan atas akan menampilkan lebih 
banyak opsi, tetapi jangan khawatir tentang itu sekarang. 

2. Atur tampilan Anda sesuka Anda. Bernavigasi di sekitar sampai Anda puas dengan sudut 
pandang Anda.  

Jika Anda mau, gunakan panel Shadows and Styles untuk mengubah tampilan model 
Anda. 

3. Klik tombol Add Scene untuk membuat pemandangan baru dengan pengaturan 
tampilan Anda saat ini.  

Scene baru ditambahkan ke file SketchUp Anda. Jika ini adalah Scene pertama yang Anda 
buat, itu disebut Scene 1, tetapi Anda dapat memberinya nama yang lebih bermakna, 
seperti yang akan dijelaskan nanti di bab ini. Seperti yang ditunjukkan pada Gambar 4-5, 
pemandangan muncul di dua tempat: 

a. Sebagai tab di bagian atas window pemodelan Anda 
b. Sebagai item daftar di panel Scenes, tepat di bawah tombol Add Scene 
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Gambar 4-5: Pemandangan muncul di dua tempat. 

Tip 

Saat Anda membuat pemandangan yang menunjukkan tampilan sejajar mata dari sebuah 
bangunan - baik itu tampilan interior maupun eksterior - ada langkah cepat dan mudah yang 
dapat Anda lakukan untuk membuat pemandangan tersebut terlihat 500 persen lebih baik: Pilih 
Kamera ⇒ Dua- Perspektif Titik untuk membuat semua edge vertikal dalam model Anda tampak 
vertikal dalam tampilan. Melakukannya akan menghilangkan efek tidak profesional dan 
terdistorsi yang merupakan ciri khas perangkat lunak pemodelan 3D yang digunakan secara tidak 
tepat. 

Ingat 

Tidak ada yang dihasilkan di luar SketchUp saat Anda menambahkan Scene; ini tidak seperti 
mengekspor JPEG atau TIFF. Scene hanyalah potongan kecil dari kode pemrograman 
yang ”mengingat" pengaturan tampilan yang berlaku saat Anda membuat Scene. Pemandangan 
juga tidak menambah banyak ukuran file Anda, jadi Anda tidak perlu khawatir tentang 
menggunakan terlalu banyak. 
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SAAT SCENE DAN STYLE BERCUBUNG 

 

Cepat atau lambat, Anda akan melihat kotak dialog Peringatan - Pemandangan dan Style yang 

ditampilkan di sini. Ini muncul setiap kali Anda mencoba membuat Scene tanpa terlebih 

dahulu menyimpan perubahan yang Anda buat pada style yang diterapkan ke model Anda. 

Dengan kata lain, SketchUp mencoba membantu dengan mengingatkan Anda untuk 

mengingat style saat Anda mengerjakan Scene.  

 

Kotak dialog peringatan ini memberi Anda tiga opsi; berikut beberapa panduan yang harus 

dipilih: 

 

 Save as a New Style: Opsi ini menambahkan style baru ke pustaka style Dalam Model 
Anda. Saat Anda kembali ke Scene ini, pemandangannya persis seperti saat Anda 
membuatnya. Memilih opsi ini adalah cara teraman untuk melanjutkan karena tidak 
dapat memengaruhi pemandangan lain. 

 Update the Selected Style: Pilih opsi ini hanya jika Anda tahu apa efek pembaruan style 
pada pemandangan lain dalam model Anda. Jika style yang Anda perbarui diterapkan 
pada salah satu style tersebut, Anda akan memengaruhi tampilannya. Dalam model 
dengan banyak pemandangan dan style, memperbarui style dapat berdampak besar. 

 Do Nothing to Save Changes: Opsi ini membuat pemandangan dengan style Anda saat 
ini diterapkan, sepenuhnya mengabaikan semua perubahan yang mungkin Anda buat 
pada style itu. Saat Anda kembali ke Scene ini, tampilannya berbeda dengan saat Anda 
membuatnya. Pilih opsi ini hanya jika Anda benar-benar tahu apa yang Anda lakukan, 
atau jika Anda senang melakukan hal yang sama lebih dari sekali. 
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Pindah dari satu Scene ke Scene lain 

Aktifkan Scene yang telah Anda tambahkan sebelumnya dengan melakukan salah satu dari tiga 
hal: 

1. Klik dua kali nama (atau gambar kecil) pemandangan di panel Scene. 
2. Klik tab untuk Scene itu di bagian atas window pemodelan. 
3. Konteks klik tab Scene mana pun dan pilih Putar Animasi untuk membuat SketchUp secara 

otomatis membalik Scene Anda. Pilih Mainkan Animasi lagi untuk membuat animasi 
berhenti. 

Tip 

Perhatikan bagaimana transisi dari satu Scene ke Scene berikutnya dianimasikan? Anda tidak 
perlu melakukan sesuatu yang khusus untuk mewujudkannya; itu adalah sesuatu yang secara 
otomatis dilakukan SketchUp untuk membuat segalanya terlihat lebih baik (dan pada akhirnya, 
membuat Anda terlihat lebih baik). 

Anda dapat menyesuaikan cara transisi SketchUp antar Scene, yang berguna untuk 
menyesuaikan presentasi Anda. Ikuti langkah-langkah berikut untuk mengakses pengaturan ini: 

1. Pilih Window => Model Info. 
2. Di sisi kiri kotak dialog Info Model, pilih Animasi.  



148 
 

Panel setelan Animasi di kotak dialog Info Model tidak terlalu rumit, tetapi dapat 
membuat perbedaan besar dalam tampilan presentasi terkait Scene Anda. 

3. Di area Scene Transitions, atur bagaimana SketchUp bertransisi dari satu Scene ke Scene 
lain.  

Pengaturan ini berlaku untuk transisi Scene manual (mengklik tab halaman) dan otomatis 
(memutar animasi):  

a. Enable Scene Transition: Kosongkan kotak centang ini untuk membuat SketchUp 
mengubah Scene tanpa menganimasikan transisi di antara keduanya. Anda 
mungkin ingin melakukan ini jika model Anda sangat rumit (atau komputer Anda 
sangat lambat) sehingga transisi animasi tidak terlihat bagus.  

b. Kedua: Jika Anda telah memilih kotak centang Aktifkan Transisi Pemandangan, 
jumlah detik yang Anda masukkan di sini menunjukkan waktu yang diperlukan 
SketchUp untuk bertransisi dari satu Scene ke Scene berikutnya. Jika 
Anda”menggerakkan kamera" sangat jauh di antara Scene-Scene, tingkatkan 
waktu transisi agar pemirsa Anda tidak sakit. Tiga detik adalah kompromi yang 
baik antara mual dan kebosanan. 

Tips 

Jika Anda menampilkan model yang tidak lengkap (mungkin Anda pernah memikirkan 
garasi dan ruang tamu, tetapi tidak ada di antaranya), sebaiknya matikan transisi Scene. 
Dengan begitu, penonton Anda tidak akan melihat hal-hal yang belum Anda kerjakan saat 
Anda mengklik tab untuk mengubah Scene. Itu licik, tapi efektif. 

4. Di area Scene Delay, atur lamanya waktu SketchUp berhenti pada setiap slide sebelum 
berpindah ke slide berikutnya.  

Jika Anda ingin presentasi tampak seperti Anda sedang berjalan atau melayang, setel ke 
0. Jika Anda ingin waktu untuk membicarakan setiap Scene dalam presentasi Anda, 
tingkatkan beberapa detik. 

 

MEMBUAT WALKTHROUGHS 

 

Cara yang sangat bagus untuk menggunakan Scene adalah dengan berpura-pura Anda sedang 

berjalan atau terbang melalui model Anda. Dengan mengatur Scene Anda secara berurutan, 

Anda dapat memberikan tur yang mulus tanpa mengotak-atik tool navigasi. Pengaturan ini 

sangat berguna saat Anda perlu berjalan dan berbicara pada saat yang bersamaan. 
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Berikut beberapa tip yang dapat membantu Anda mensimulasikan seseorang berjalan atau 

terbang melalui model Anda dengan pemandangan: 

 

 Sesuaikan bidang pandang Anda. Untuk animasi interior, buat kamera Anda”melihat" 
area yang lebih luas dengan menyetel bidang pandang ke 60 derajat. Untuk tampilan 
eksterior, cobalah bidang pandang yang berada di antara 30 dan 45 derajat. Lihat 
bagian”Mengatur bidang pandang Anda," di awal bab ini. 

 Pastikan Scene Anda tidak terlalu berjauhan. Daripada berlomba melewati ruangan 
seperti terbakar, jangan takut untuk menambahkan lebih banyak Scene. Penonton 
Anda akan berterima kasih dengan tidak muntah di meja konferensi Anda. 

 Tambahkan Scene pada interval jarak yang sama. Karena SketchUp hanya 
memungkinkan Anda mengontrol waktu transisi Scene untuk semua Scene Anda 
sekaligus, sebaiknya pastikan Scene Anda diatur pada jarak yang sama. Jika tidak, 
animasi walk-through Anda akan terlihat aneh dan aneh, seperti tarian Aidan. 

 Jangan lupa pengaturan animasi di kotak dialog Model Info. Setel penundaan Scene 
ke 0 detik sehingga animasi Anda tidak berhenti di setiap Scene. Untuk kecepatan 
berjalan normal, atur transisi pemandangan Anda sehingga Anda bergerak sekitar 5 
kaki per detik. Jika Scene Anda berjarak sekitar 20 kaki, atur waktu transisi Scene Anda 
menjadi 4 detik. Ini memberi waktu kepada audiens Anda untuk melihat-lihat dan 
memperhatikan berbagai hal. Untuk animasi terbang, pilih waktu transisi Scene yang 
terlihat bagus. 

 Geser di sekitar sudut. Saat Anda mengatur animasi berjalan, Anda memiliki cara 
yang mudah dan andal untuk berbelok tanpa terlihat terlalu robotik. Caranya 
diilustrasikan pada gambar berikut. Pada dasarnya, triknya adalah menambahkan 
Scene yang tidak terlalu lama di mana Anda ingin berbelok - dalam hal ini, beberapa 
meter di depan pintu masuk. Kuncinya adalah sedikit memiringkan pandangan Anda 
ke belokan. Siapkan pemandangan Anda berikutnya setelah belokan, dekat dengan 
bagian dalam dan menghadap tampilan baru. Teknik ini membuat Anda terlihat seperti 
berbelok secara alami. 
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Memodifikasi Scene setelah Anda membuatnya 

Setelah Anda membuat sejumlah besar Scene, Anda pasti perlu mengotak-atiknya dengan cara 
tertentu. Lagi pula, memodifikasi sesuatu hampir selalu lebih mudah daripada membuatnya lagi, 
dan hal yang sama berlaku untuk Scene. Karena model SketchUp Anda akan berubah jutaan kali, 
memahami cara membuat perubahan pada pemandangan yang ada dapat menghemat banyak 
waktu dalam jangka panjang. 

Peringatan 

Aspek-aspek tertentu dari proses modifikasi Scene bisa menjadi sedikit rumit. Ini agak 
mengejutkan, mengingat betapa sederhananya sisa bekerja dengan Scene bisa. Anda 
menghadapi banyak kerumitan saat bekerja di SketchUp, dan ini hanyalah salah satu tempat di 
mana kerumitan itu memunculkan kepalanya yang buruk. Hasilnya: Beri perhatian khusus pada 
bagian memperbarui Scene dan jangan khawatir jika Anda meluangkan sedikit waktu untuk 
memikirkannya. Itu terjadi pada yang terbaik dari kita. 

Reordering, renaming, dan removing scenes  

Membuat modifikasi sederhana pada Scene, seperti menyusun ulang, mengganti nama, dan 
menghapusnya, itu mudah. Anda dapat menyelesaikan masing-masing dengan dua cara: Anda 
dapat mengcontext-clicks tab Scene di bagian atas window pemodelan Anda atau menggunakan 
menu panel Pemandangan (klik panah menu di kanan atas). Lihat Gambar 4-6. 
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Gambar 4-6: Anda dapat memodifikasi Scene dengan mengklik tab Scene atau dengan 
menggunakan panel Pemandangan. 

 Menyusun ulang Scene: Anda dapat mengubah urutan pemutaran Scene dalam tayangan 
slide. Jika Anda menggunakan Scene, Anda harus sering melakukannya - percayalah pada 
kami. Gunakan salah satu metode berikut: 

o Konteks-klik tab Scene yang ingin Anda pindahkan (di window pemodelan) dan 
pilih Pindah ke Kanan atau Pindah ke Kiri. 

o Di panel Scene yang diperluas, klik nama (atau gambar kecil) dari Scene yang ingin 
Anda pindahkan untuk memilihnya. Kemudian klik panah Pindahkan 
Pemandangan ke Atas atau Pindahkan Pemandangan ke Bawah di bagian atas 
panel untuk mengubah posisi Scene dalam urutan Scene. 

 Ingat. Mengganti nama Scene: Berikan nama yang bermakna pada Scene Anda: Ruang 
Tamu, Tampilan Atas, dan Bayangan pada pukul 17.00 cukup deskriptif untuk menjadi 
berguna. Scene 14 tidak memiliki jenis tertentu. Gunakan salah satu metode berikut: 

o Konteks-klik tab Scene dan pilih Ganti Nama (ini hanya berfungsi di Mac, untuk 
beberapa alasan) 
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o Di panel Scene, pilih Scene yang ingin Anda ubah namanya dan ketik sesuatu ke 
dalam bidang Nama di bawah daftar. Jika Anda tidak melihat bidang Nama, klik 
tombol Tampilkan Detail di kanan atas. Jika Anda merasa benar-benar teratur, 
lanjutkan dan berikan deskripsi Scene juga - lebih banyak informasi tidak ada 
salahnya. 

 Menghapus Scene: Jika Anda tidak membutuhkan Scene lagi, silakan hapus. Namun, jika 
Anda memiliki Scene yang tidak ingin Anda munculkan di gambaran slide, Anda tidak perlu 
membuangnya. Gunakan salah satu metode berikut untuk menghapus Scene: 

o Konteks-klik tab Scene dan pilih Hapus untuk menyingkirkannya secara permanen. 
o Di panel Scene, pilih Scene yang ingin Anda hilangkan dan klik tombol Hapus. 

Untuk mengecualikan Scene dari gambaran slide tanpa menghilangkannya, pilih namanya (atau 
gambar mini) dan kosongkan kotak centang Sertakan dalam Animasi. 

Bekerja dengan properti pemandangan 

Matikan televisi. Kirim anak-anak ke luar untuk bermain. Lakukan apa pun yang perlu Anda 
lakukan untuk berkonsentrasi karena memahami konsep properti Scene tidaklah sepenuhnya 
mudah. Kami melakukan yang terbaik untuk menjelaskannya. 

Pada dasarnya, pemandangan hanyalah kumpulan properti tampilan yang disimpan. Masing-
masing properti ini berkaitan dengan tampilan model Anda: 

 Kamera location: Properti Kamera location mencakup posisi kamera, atau titik pandang, 
dan bidang pandang (dibahas sebelumnya dalam bab ini). 

 Hidden geometry: Properti Hidden geometry sebenarnya hanyalah satu hal: elemen apa 
yang tersembunyi dan elemen apa yang tidak. Properti ini melacak visibilitas garis, face, 
grup, dan komponen dalam model Anda. 

 Visible camera: Properti Visible camera melacak keterlihatan layer dalam model Anda. 

 Active section planes: Properti Active section planes mencakup visibilitas bidang bagian 
dan apakah bidang tersebut aktif. Kami berbicara tentang bagian di bagian terakhir bab 
ini. 

 Style and Fog: Properti Style and Fog adalah semua pengaturan di panel Style and Fog, 
dan ada banyak di antaranya.  

 Shadow setting: Properti Shadow setting mencakup apakah bayangan diaktifkan dan 
waktu serta tanggal untuk mengatur bayangan. Mereka juga menyertakan semua 
pengaturan lain di panel Shadows. 

 Axis location: Properti Axis location sangat spesifik. Mereka melacak visibilitas, lokasi, dan 
orientasi sumbu merah, hijau, dan biru utama di window pemodelan Anda. Terkadang 
berguna untuk memindahkan sumbu saat Anda bekerja, seperti saat Anda bekerja dengan 
petak jalan yang diputar dalam model skala perkotaan. 
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Ingat 

Inilah bagian rumitnya: Pemandangan dapat menyimpan (mengingat) kombinasi apa pun dari 
properti sebelumnya - ini bukan proposisi semua atau tidak sama sekali. Setelah pengaruh penuh 
dari informasi ini meresap, Anda akan menyadari bahwa ini berarti Scene jauh lebih kuat daripada 
yang pertama kali muncul. 

Tips 

Dengan membuat pemandangan yang hanya menyimpan satu atau dua properti (bukan ketujuh), 
Anda dapat menggunakan pemandangan untuk melakukan beberapa hal yang cukup bagus. 
Inilah tiga favorit kami: 

 Buat pemandangan yang hanya memengaruhi kamera location Anda, memungkinkan 
Anda untuk kembali ke sudut pandang mana pun tanpa memengaruhi apa pun tentang 
penampilan model Anda (seperti style dan hidden geometry). 

 Buat pemandangan yang hanya memengaruhi style dan bayangan, sehingga Anda dapat 
dengan cepat mengubah antara pengaturan tampilan yang sederhana dan kompleks 
(tersedia di komputer Anda) tanpa memengaruhi kamera location Anda. 

 Buat pemandangan yang memiliki kombinasi berbeda dari Hidden geometry untuk 
melihat alternatif desain tanpa mengubah style model dan kamera location Anda. 

Kunci untuk bekerja dengan properti scene adalah panel Scenes yang diperluas, terlihat pada 
Gambar 4-7. Meskipun panel ini cukup sederhana, orang yang memahaminya hanya sedikit dan 
jarang. Bersiaplah untuk bergabung dengan minoritas informasi. 
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Gambar 4-7: Pilih properti pemandangan mana yang akan disimpan di panel Pemandangan yang 
diperluas. 

Ikuti langkah-langkah berikut untuk menyetel properti mana yang disimpan oleh sebuah Scene: 

1. Di panel Scene, pilih Scene yang propertinya ingin Anda ubah.  

Anda tidak perlu melihat pemandangan ini saat mengeditnya; Anda dapat mengedit 
properti untuk setiap Scene kapan saja. 

 

2. Jika belum diperluas, klik tombol Show Details di pojok kanan atas panel Scenes. 
3. Pilih kotak centang di samping properti yang ingin Anda simpan.  

Itu dia. Anda tidak perlu mengklik Simpan di mana saja untuk membuat perubahan Anda 
melekat. Sedikit antiklimaks, bukan? 

Tips 

Salah satu kegunaan hebat properti Scene adalah membuat pemandangan yang membantu Anda 
memamerkan iterasi (versi) berbeda dari desain Anda. Anda melakukan ini dengan membuat 
layer berbeda terlihat dengan setiap Scene dalam model Anda.  

Memperbarui Scene 
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Jika Anda ingin memperbarui (membuat perubahan pada) pemandangan yang ada, Anda 
memiliki beberapa pilihan: 

 Perbarui semua properti Scene sekaligus, yang sangat mudah. 

 Perbarui properti Scene secara selektif, yang tidak sesederhana itu. Baca terus untuk 
kedua set instruksi. 

Peringatan 

Setelah memperbarui Scene, Anda tidak dapat menggunakan Urung untuk mengembalikan Scene 
ke keadaan semula. Sebagai gantinya, simpan file SketchUp Anda tepat sebelum Anda 
memperbarui Scene dan pilih File => Kembalikan jika Anda tidak menyukai hasilnya. 

MEMPERBARUI SEMUA PROPERTI SCENE SEKALI 

Cara termudah untuk memodifikasi pemandangan adalah dengan tidak mengkhawatirkan 
properti individu. Jika yang ingin Anda lakukan hanyalah memperbarui Scene setelah Anda 
membuat penyesuaian pada penampilan model Anda, Anda beruntung. Ikuti langkah ini: 

1. Klik tab Scene yang ingin Anda perbarui.  

Tab tersebut berada di bagian atas window pemodelan. 

2. Buat style, bayangan, kamera, atau perubahan tampilan apa pun yang Anda inginkan 
pada model Anda. 

3. Konteks-klik tab Scene saat ini dan pilih Perbarui. 

Peringatan 

Berhati-hatilah untuk tidak mengklik dua kali tab secara tidak sengaja, atau Anda akan 
mengaktifkan kembali pemandangan dan kehilangan semua perubahan yang Anda buat. Namun, 
setelah Anda memperbarui Scene, properti Scene baru menggantikan yang lama, dan Anda bebas 
dari rumah. 

MEMPERBARUI PROPERTI SCENE SECARA SELEKTIF 

Di sinilah segalanya menjadi rumit. Terkadang dalam kehidupan SketchUp Anda, Anda ingin 
memperbarui pemandangan tanpa memperbarui semua propertinya. 

Saat Anda memperbarui Scene secara selektif, Anda membuat perubahan yang tidak dapat 
langsung Anda lihat, yang berarti bencana mungkin akan melanda. Salin file SketchUp Anda 
sebelum memperbarui lebih dari satu Scene dalam satu waktu, untuk berjaga-jaga jika terjadi 
sesuatu yang buruk. 

Peringatan 

Mungkin Anda telah menggunakan pemandangan untuk membuat tur ruang berjemur yang Anda 
rancang untuk klien, dan Anda ingin mengubah setelan bayangan untuk membuat model Anda 
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terlihat lebih cerah. Anda memiliki 30 Scene dalam presentasi Anda, dan rapat Anda dalam 5 
menit. Anda tidak punya waktu untuk mengubah dan memperbarui semua 30 Scene satu per 
satu. Apa yang harus dilakukan? Ikuti langkah ini: 

1. Sesuaikan properti Shadow ke tempat yang Anda inginkan untuk semua Scene yang 
ingin Anda perbarui.  

Meskipun contoh ini berkaitan dengan bayangan, metode yang sama ini berlaku untuk 
setiap perubahan properti pemandangan yang ingin Anda buat. 

2. Di panel Scene, pilih semua Scene yang ingin Anda perbarui.  

Tahan tombol Shift untuk memilih sekelompok pemandangan yang berurutan. Tahan Ctrl 
(Command di Mac) untuk memilih Scene yang tidak bersebelahan. 

 

3. Klik tombol Update Scene di panel Scene.  

Kotak dialog Scene Update muncul, seperti yang ditunjukkan pada Gambar 4-8. 

4. Pilih kotak centang Shadow setting dan klik tombol Update.  

Jika semua yang ingin Anda perbarui adalah Shadow setting, pastikan hanya kotak 
centang itu yang dipilih. Secara lebih umum, Anda akan mencentang kotak di samping 
setiap properti yang ingin Anda perbarui. Semua Scene yang dipilih diperbarui dengan 
properti baru tersebut, dan semua properti yang kotak centangnya kosong tetap tidak 
berubah. 
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Gambar 4-8: Memperbarui hanya properti Scene tertentu sedikit lebih terlibat 
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Menguasai Pendekatan Sectional 

Software seperti SketchUp memiliki cara yang lucu untuk memberikan momen dengan 
kesederhanaan yang sempurna, momen ketika Anda duduk santai, menggaruk kepala, dan 
berpikir,”Selesai? Hanya itu saja?” 

Bagian di SketchUp menawarkan salah satu momen tersebut. Sederhananya, bagian adalah objek 
yang memotong bagian dari model Anda sehingga Anda dapat melihat ke dalam. Namun, bagian 
tersebut tidak benar-benar memisahkan atau mengubah geometri model. Sebuah bagian bersifat 
sementara dan mudah disembunyikan atau dihapus, sehingga Anda dapat melihat kembali 
seluruh model semudah Anda membuat cutaway. Anda menempatkan bagian di mana pun Anda 
membutuhkannya, menggunakannya untuk membuat tampilan yang tidak bisa Anda dapatkan, 
lalu hapus setelah selesai. Saat Anda memindahkan bidang bagian, Anda mendapatkan umpan 
balik instan; tampilan potongan model Anda juga bergerak. Jika Anda ingin menjadi mewah, Anda 
dapat menyematkan bagian dalam Scene dan bahkan menggunakan bagian dalam animasi. 
Bagian-bagiannya adalah layer gula pada kue SketchUp: mudah digunakan, sangat penting, dan 
mengesankan karena semuanya dapat dinikmati. 

Orang menggunakan bagian untuk semua jenis hal: 

 Membuat tampilan ortografi standar (seperti denah dan bagian) bangunan dan objek 
lainnya 

 Membuat tampilan potongan model yang kompleks agar lebih mudah dipahami 

 Mengerjakan interior bangunan tanpa memindahkan atau menyembunyikan geometri 

 Menghasilkan animasi bagian dengan Scene 

Cutting plans and sections  

Penggunaan paling umum untuk bagian adalah untuk membuat tampilan langsung model Anda. 
Pandangan ini sering kali menyertakan dimensi dan khas dari gambar yang dibuat arsitek untuk 
merancang dan menjelaskan ruang. 

Tampilan yang lurus dan langsung berguna karena 

 Mudah dibaca. 

 Anda dapat melakukan pengukuran dari mereka (jika dicetak sesuai skala). 

 Memberikan informasi yang tidak dapat diberikan oleh tipe gambar lain. 

Ingat 

Istilah berikut (diilustrasikan pada Gambar 4-9) dapat membantu Anda membuat tampilan yang 
berbeda dari model Anda dengan lebih mudah: 

 Plan: Tampilan planimetrik, atau rencana, adalah tampilan atas-bawah, dua dimensi, 
nonperspektif dari suatu objek atau ruang. Sederhananya, tampilan planimetrik adalah 
setiap gambar denah rumah yang pernah Anda lihat. Anda menghasilkan rencana dengan 
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memotong potongan horizontal imajiner melalui model Anda. Semua yang ada di bawah 
potongan terlihat, dan semua yang di atasnya tidak. 

 Section: Jangan tertukar dengan bagian (fitur SketchUp), tampilan bagian, atau bagian, 
adalah tampilan dari samping, dua dimensi, nonperspektif dari suatu objek atau ruang. 
Anda membuat tampilan bagian dengan memotong potongan vertikal imajiner melalui 
model Anda. Sama seperti dalam tampilan rencana, semua yang ada di satu sisi potongan 
terlihat, dan semua yang ada di sisi lain disembunyikan. 

 

Gambar 4-9: Denah adalah potongan horizontal, sedangkan bagian adalah potongan vertikal. 

 

CUTTING SEPERTI ARSITEK 

Dalam arsitektur, ketentuannya adalah memotong denah pada ketinggian 48 inci, yang berarti 

potongan horizontal imajiner dibuat 4 kaki di atas permukaan lantai. Ini memastikan bahwa 

pintu dan sebagian besar window ditampilkan terpotong oleh potongan, sedangkan counter, 

meja, dan furnitur lain berada di bawahnya, dan dengan demikian terlihat sepenuhnya. Anda 

dapat melihat apa yang kami maksud pada Gambar 4-9. Detail ini penting saat Anda mencoba 

menjelaskan spasi kepada seseorang. Bagaimanapun, gambar arsitektur adalah abstraksi dua 

dimensi dari ruang tiga dimensi, dan setiap kejelasan membantu. 

Jika menyangkut bagian arsitektur (kebalikan dari bagian, fitur SketchUp), tidak ada ketentuan 

tentang tempat untuk memotongnya, tetapi Anda harus mengikuti beberapa aturan: 

 Jangan pernah memotong kolom. Jika Anda menunjukkan kolom di suatu bagian, itu 
terlihat seperti dinding. Ini buruk karena bagian seharusnya menunjukkan sejauh mana 
ruang terbuka atau tertutup. Anda dapat berjalan mengelilingi kolom, tetapi Anda 
tidak dapat berjalan melalui dinding (setidaknya kami tidak dapat). 

 Cobalah yang terbaik untuk memotong tangga, lift, dan sirkulasi vertikal lainnya. 
Menunjukkan bagaimana orang-orang bergerak ke atas dan ke bawah melalui 
bangunan Anda membuat gambar Anda lebih mudah dibaca, belum lagi menarik. Lihat 
Gambar 4-9 sebagai contoh. 
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Anda memotong rencana dan bagian dengan menambahkan bidang bagian ke model Anda. Ini 
sedikit abstrak karena tidak ada yang seperti itu dalam kehidupan nyata. Di SketchUp, bidang 
bagian adalah objek yang memengaruhi visibilitas bagian tertentu model Anda. Ketika active 
section planes, semua yang ada di depannya terlihat dan semua yang ada di belakangnya 
tersembunyi. Di mana pun bidang bagian memotong model Anda, garis potongan bagian yang 
sedikit lebih tebal akan muncul 

Tips 

Jika Anda menggunakan Windows, buka toolbar Bagian dengan memilih View => Toolbars => 
Section. Jika Anda menggunakan Mac, tool Section Plane ada di Large Tool Set, yang dapat Anda 
aktifkan dengan memilih View => Tool Palettes => Large Tool Set. Pada kedua platform, Section 
Plane tampak seperti lingkaran putih dengan huruf dan angka di dalamnya.Untuk menambahkan 
bidang bagian, ikuti langkah-langkah berikut: 

 

1. Pilih Tools => Section Plane untuk mengaktifkan tool Section Plane.  

Anda juga dapat mengaktifkan Section Plane dengan memilih ikonnya dari Large Tool Set 
(atau jika Anda lebih suka, toolbar Bagian di SketchUp untuk Windows). 

2. Pindahkan tool Bagian Pesawat di sekitar model Anda.  

Perhatikan bagaimana orientasi kursor Section Plane (yang cukup besar) berubah menjadi 
coplanar ke permukaan apa pun yang Anda arahkan. 

3. Setelah Anda mengetahui di mana Anda ingin memotong, klik sekali untuk 
menambahkan bidang bagian.  

Untuk membuat tampilan rencana, tambahkan bidang bagian horizontal dengan mengklik 
bidang horizontal seperti lantai. Untuk tampilan penampang, tambahkan bidang 
penampang vertikal dengan mengklik dinding atau permukaan vertikal lainnya. Anda 
dapat, tentu saja, menambahkan bidang bagian di mana pun Anda inginkan; mereka tidak 
harus sejajar dengan bidang horizontal atau vertikal. Gambar 4-10 menunjukkan bidang 
penampang yang ditambahkan ke model rumah. 

 

4. Pilih Move Tool. 
5. Pindahkan bidang bagian yang baru saja Anda tambahkan dengan mengkliknya sekali 

untuk mengambilnya dan sekali lagi untuk menjatuhkannya.  
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Anda dapat menggeser bidang penampang Anda maju mundur hanya dalam dua arah 
sehingga bidang penampang tetap tegak lurus dengan bidang pemotongannya. Saat Anda 
memutuskan di mana harus menemukan potongan Anda, bilah sisi terdekat,”Memotong 
seperti seorang arsitek," menawarkan petunjuk yang berguna. Setelah Anda 
menambahkan bidang bagian dan memindahkannya ke lokasi yang diinginkan, Anda 
dapat memutar dan bahkan menyalinnya, sama seperti objek lain dalam model Anda. 
Bidang bagian tidak pernah memengaruhi geometri Anda - persis seperti yang Anda lihat. 

 

6. Jika Anda perlu memutar bidang bagian Anda, pilih dan gunakan Rotate tool.  

Mengapa memutar bidang bagian? Dalam keadaan tertentu, memutar bidang bagian 
(alih-alih membuat yang baru) dapat membantu menjelaskan ruang interior yang 
kompleks. Menampilkan tampilan rencana menjadi tampilan bagian adalah cara ampuh 
untuk menjelaskan gambar arsitektur kepada audiens yang tidak memahaminya.  

7. Untuk membuat bidang bagian baru dengan menyalin yang sudah ada, gunakan Move 
toolkan atau Putar untuk melakukannya dengan cara yang sama seperti Anda membuat 
salinan objek SketchUp lainnya.  

Menyalin bidang bagian adalah cara yang bagus untuk memberi jarak yang diketahui. 
Memberi jarak pada bagian bidang secara konsisten dapat menjadi lebih rumit jika Anda 
menggunakan tool Bagian Bidang untuk terus menambahkan yang baru.  
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Gambar 4-10 menunjukkan gerakan, rotasi, dan penyalinan bidang penampang. 
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Gambar 4-11: Memindahkan, memutar, dan menyalin bidang penampang. 

Saat bidang bagian yang Anda tambahkan berada di posisinya, Anda siap untuk mengontrol 
pengaruhnya terhadap visibilitas dengan berbagai cara lain. Lihat bagian berikut untuk detailnya. 

Mengontrol bidang bagian individu 

Anda dapat mengontrol cara pesawat bagian berperilaku dengan mengcontext-clicksnya untuk 
menampilkan menu konteks, seperti yang ditunjukkan pada Gambar 4-12. Anda melihat contoh 
dari apa yang dilakukan opsi berikut dalam ilustrasi yang sama: 

 Reverse: Opsi ini membalik arah bidang penampang, menyembunyikan semua yang 
sebelumnya terlihat, dan mengungkapkan semua yang dulunya ada di balik potongan. 
Gunakan ini saat Anda perlu melihat bagian dalam model Anda yang lain. 

 Active Cut : Meskipun Anda dapat memiliki beberapa bidang bagian dalam model Anda, 
hanya satu bidang yang dapat aktif dalam satu waktu. Potongan aktif adalah bidang 
bagian yang benar-benar memotong model Anda; lainnya dianggap tidak aktif. Jika Anda 
memiliki lebih dari satu bidang bagian, gunakan Active Cut untuk memberi tahu SketchUp 
mana yang harus aktif. Jika Anda hanya memiliki satu bidang bagian tetapi tidak dapat 
melihat potongannya, periksa apakah potongan tersebut aktif. 

Anda dapat memiliki lebih dari satu active section planes dalam model Anda sekaligus, 
tetapi hal itu mengharuskan Anda menumpuk, atau menyematkan, setiap bidang bagian 
dalam grup atau komponen terpisah. Anda dapat memperoleh efek keren dengan teknik 
ini, tetapi menjelaskan cara kerjanya secara mendetail berada di luar cakupan buku ini.  

 Align View: Saat Anda memilih Align View, tampilan Anda berubah sehingga Anda melihat 
langsung pada bidang bagian. Anda dapat menggunakan opsi ini untuk menghasilkan 
tampilan seperti yang dijelaskan dalam”Mendapatkan tampilan bagian yang berbeda" 
nanti di bab ini. 

 Create Group Slice: Opsi ini tidak banyak berkaitan dengan pilihan lain dalam menu 
konteks ini; ini benar-benar tool pemodelan. Anda dapat menggunakan perintah Buat 
Grup dari Irisan untuk melakukan persis seperti yang dikatakan: Membuat grup dari irisan 
aktif, atau bidang bagian. Perintah ini berguna untuk membuat potongan bagian yang 
terisi untuk presentasi akhir. 
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Gambar 4-12: Mengecontext-clicks bidang bagian memberi Anda beberapa opsi. 

Setting section-plane visibility 

Jika Anda ingin mengontrol visibilitas semua bidang bagian Anda sekaligus, beberapa opsi menu 
dapat membantu. Gunakan kedua matikan ini dalam kombinasi untuk mengontrol bagaimana 
potongan bagian muncul di model Anda. Kedua opsi ini, yang ditampilkan pada menu View, 
diilustrasikan pada Gambar 4-13: 

 Section Plane: Pilihan ini mengubah visibilitas objek bidang bagian tanpa mempengaruhi 
potongan bagian yang dihasilkannya. Lebih sederhananya, membatalkan pilihan Bidang 
Bagian menyembunyikan semua bidang bagian dalam model Anda, tetapi tidak 
menonaktifkan efek potongan bagian, seperti yang ditunjukkan pada gambar tengah pada 
Gambar 4-13. Tampilan ini adalah bagaimana Anda mungkin ingin menampilkan sebagian 
besar tampilan penampang Anda , jadi pengalih ini cukup penting. 

 Section Cuts: Opsi ini mengaktifkan dan menonaktifkan efek potongan bagian tanpa 
memengaruhi visibilitas objek bidang bagian dalam model Anda. Pilihan ini adalah 
kebalikan dari Section Planes, di poin sebelumnya, tapi sama pentingnya. 
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Gambar 4-13: Kontrol jarak pandang bidang bagian dengan Bidang Bagian dan Potongan Bagian. 

Mendapatkan tampilan bagian yang berbeda 

Dengan menggunakan bidang bagian, Anda dapat membuat beberapa tampilan model Anda yang 
berguna dan mengesankan tanpa banyak kesulitan. Yang kedua dibangun di atas yang pertama, 
dan keduanya ditunjukkan pada Gambar 4-14. Perspektif bagian (kiri) adalah tampilan khusus 
dari ruang tiga dimensi. Jenis kedua, pandangan ortografis (kanan), lurus dan tidak menggunakan 
perspektif. 

 

Gambar 4-14: Nyalakan Perspektif untuk perspektif bagian; pilih Proyeksi Paralel untuk 
menghasilkan tampilan ortografik. 
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MEMBUAT PERSPEKTIF BAGIAN 

Jika Anda membayangkan memotong sebuah bangunan menjadi dua dan kemudian melihat 
permukaan potongan lurus sambil melihat ke dalam, Anda memiliki perspektif bagian. Bagian 
bagian dari istilah tersebut berarti bahwa bangunan tersebut telah dipotong. Bagian perspektif 
menunjukkan bahwa objek di dalam ruang tampak lebih kecil saat semakin menjauh. 

Perspektif bagian menunjukkan ruang interior dengan cara yang dapat dipahami kebanyakan 
orang - dan perspektif bagian juga terlihat sangat keren. Untuk membuat perspektif bagian 
menggunakan tool Bagian Pesawat di SketchUp, ikuti langkah-langkah berikut: 

1. Pilih bidang bagian yang ingin Anda gunakan untuk membuat perspektif bagian dengan 
mengkliknya menggunakan tool Pilih.  

Saat bidang bagian dipilih, akan berubah menjadi biru, (dengan asumsi Anda belum 
mengubah warna default di panel Style). 

2. Jika bidang bagian yang dipilih tidak aktif, context-clicksnya dan pilih Potong Aktif.  

Bidang penampang aktif memotong geometri sekitarnya. Jika bidang bagian Anda terlihat 
tetapi tidak memotong apa pun, itu tidak aktif. 

3. Konteks-klik bidang bagian yang dipilih dan pilih Align View.  

Ini menyelaraskan pandangan Anda sehingga lurus (tegak lurus) ke bidang bagian Anda. 

4. Jika Anda tidak dapat melihat model Anda dengan benar, pilih Kamera => Zoom Extents.  

Ini memperbesar tampilan Anda sehingga Anda dapat melihat seluruh model Anda di 
window pemodelan. 

MEMBUAT BAGIAN ORTHOGRAPHIC 

Pernah melihat gambar teknik yang mencakup tampilan atas, depan, belakang, dan samping dari 
objek yang sama? Kemungkinannya adalah proyeksi ortografik, yang merupakan cara umum 
untuk menggambar objek 3D agar dapat dibuat. 

Memproduksi bagian ortografi model Anda cukup mudah; ini hanya satu langkah ekstra selain 
membuat perspektif bagian. Berikut cara melakukannya: 

1. Ikuti Langkah 1 sampai 3 di bagian sebelumnya, seolah-olah Anda membuat perspektif 
bagian. 

2. Pilih Camera => Parralel Projection. Ini mematikan Perspektif, mengubah pandangan 
Anda menjadi representasi ortografis model Anda yang sebenarnya. Jika Anda mencetak 
tampilan ortografik pada skala tertentu, Anda dapat melakukan pengukuran dari hasil 
cetakan. 

Bagian animasi dengan Scene 
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Menggabungkan tampilan bagian dengan Scene untuk membuat animasi adalah cara yang 
berguna dan mengesankan untuk memamerkan model Anda. Ide dasarnya adalah Anda dapat 
menggunakan Scene untuk membuat animasi di mana bidang bagian Anda bergerak di dalam 
model Anda. Berikut beberapa alasan Anda mungkin ingin menggunakan teknik ini: 

 Jika Anda memiliki bangunan dengan beberapa tingkat, Anda dapat membuat presentasi 
animasi yang memperlihatkan tampilan rencana potongan dari setiap tingkat. 

 Menggunakan bidang bagian beranimasi untuk”masuk" ke model Anda merupakan 
transisi yang jauh lebih berkelas daripada sekadar menyembunyikan bagian tertentu 
darinya. 

 Saat Anda perlu menunjukkan hubungan antara tampilan rencana dan bagian untuk 
sebuah proyek, menggunakan bidang bagian beranimasi membantu menjelaskan konsep 
tampilan arsitektur yang berbeda kepada pemula 3D. 

Ikuti langkah-langkah ini untuk membuat animasi bagian dasar; contoh sederhana diilustrasikan 
pada Gambar 4-15: 

1. Tambahkan bidang bagian ke model Anda. 

Untuk bantuan dengan langkah ini, lihat”Memotong rencana dan bagian," di awal bab ini. 

2. Tambahkan Scene ke model Anda.  

Bagian sebelumnya”Membuat Scene", menjelaskan cara menambahkan Scene. 

3. Tambahkan bidang bagian lain ke model Anda.  

Anda dapat menambahkan bidang bagian lain dengan salah satu dari dua cara berikut: 

a. Gunakan tool Section Plane untuk membuat yang baru. Ini mungkin opsi 
termudah, yang membuatnya ideal untuk pemula. 

b. Gunakan Move tool untuk menyalin bidang bagian yang ada. Bagian 
sebelumnya”Rencana dan bagian pemotongan" memperkenalkan teknik ini.  

Pastikan bidang bagian baru Anda aktif; jika ya, itu memotong model Anda. Jika tidak aktif, 
context-clicks pada bidang bagian dan pilih Potongan Aktif dari menu konteks. 

4. Tambahkan Scene lain ke model Anda.  

Scene baru ini mengingat yang merupakan active section planes. 

5. Klik melalui Scene yang Anda tambahkan untuk melihat animasi Anda.  

Anda melihat bagian animasi dipotong sebagai transisi SketchUp dari satu Scene ke Scene 
berikutnya. Jika tidak, pastikan Anda telah mengaktifkan transisi Scene: Pilih Window => 
Model Info dan kemudian pilih panel Animation di kotak dialog Model Info. Pastikan kotak 
centang Transisi Pemandangan dipilih. 
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Gambar 4-15: Membuat animasi bagian adalah proses yang cukup mudah 

Tip 

 Jika Anda tidak suka melihat objek bidang bagian (benda berbentuk kotak dengan panah di 
sudutnya) dalam animasi Anda, nonaktifkan objek tersebut dengan membatalkan pilihan Bidang 
Bagian pada menu Tampilan. Kemudian Anda melihat bagian itu dipotong tanpa ada persegi 
panjang jelek beterbangan. 

Ingat 

Hal tersulit untuk diingat tentang penggunaan Scene dan bidang bagian untuk membuat animasi 
bagian adalah ini: Anda memerlukan bidang bagian terpisah untuk setiap Scene yang Anda buat. 
Artinya, SketchUp menganimasikan transisi dari satu active section planes ke active section 
planes lainnya. Jika yang Anda lakukan hanyalah memindahkan bidang bagian yang sama ke 
tempat lain dan menambahkan Scene, teknik animasi ini tidak akan berfungsi. 
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Bab 5 

Pencetakan 3D dengan Model SketchUp 

Membangun Tampilan Pencetakan 3D 

Ini mungkin terdengar ajaib, tetapi pencetakan 3D adalah proses yang menggunakan informasi 
3D dari model SketchUp Anda untuk membuat versi fisik model tersebut di dunia nyata. Ini fiksi 
ilmiah yang menjadi kenyataan. 

Pencetakan 3D dimulai sebagai teknologi baru yang panas di pertengahan 1970-an - dan 
menghabiskan 35 tahun terjebak sebagai mainan berharga tinggi dari para insinyur pembuat 
prototipe dan orang-orang beruntung yang membuat jet tempur. Dan di situlah tempatnya 
sampai printer 3D desktop DIY pertama muncul pada tahun 2009. Dalam semalam, harga printer 
3D turun 100 kali lipat. Apa yang dulunya merupakan teknologi yang didambakan dari beberapa 
orang terpilih sekarang dapat ditemukan di meja desainer, insinyur, atau pembuat model yang 
memiliki peralatan lengkap. 

Membangun Model dalam Layer 

Ada banyak teknologi dan produsen pencetakan 3D yang berbeda, tetapi semuanya 
menggunakan proses yang disebut manufaktur aditif: Sebuah objek dibuat dari irisan tipis 
material horizontal, dengan setiap layer baru diekstrusi sedikit di atas layer sebelumnya dan 
kemudian menyatu dengannya. Layer demi layer, printer membangun objek hingga selesai. 

Layer pendukung dari bawah 

Dunia SketchUp adalah tempat yang menakjubkan di mana Anda dapat dengan cepat membuat 
model 3D sambil mengabaikan hal-hal kecil seperti hukum fisika. Sebuah objek yang dicetak 3D, 
bagaimanapun, tunduk pada semua kekuatan dunia fisik, termasuk yang ada di mana-mana, 
gravitasi. Layer baru tidak dapat dicetak mengambang di ruang terbuka; mereka perlu memiliki 
sesuatu di bawah mereka. 

Ingat 

Kebutuhan untuk mendukung setiap layer adalah pedoman terpenting yang harus diingat saat 
Anda mendesain objek untuk pencetakan 3D. Anda dapat menggunakan salah satu dari dua 
strategi untuk mendukung layer baru saat Anda mencetak objek: 

 Gunakan fungsi bahan pendukung printer 3D, yang membuat kisi struktural sekunder 
di sekitar bagian tersebut. Kisi tersebut menahan semua layer yang seharusnya 
mengambang bebas di ruang angkasa. Bahan pendukung dapat larut setelah pencetakan 
atau harus dilepas secara manual dengan jari dan penjepit, tergantung pada jenis printer 
3D Anda. Apa pun cara yang digunakan, penghapusan materi pendukung dapat menjadi 
bagian paling padat karya dari pencetakan 3D; itu juga meningkatkan jumlah bahan yang 
digunakan dan waktu yang dibutuhkan untuk mencetak objek. 
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 Rancang dan cetak bagian Anda dengan cara yang membatasi kondisi yang 
memungkinkan adanya layer yang tidak didukung. Transisi halus dan kurva menyapu 
tidak hanya terlihat mengagumkan; mereka juga dapat dengan mudah dicetak tanpa 
menggunakan bahan pendukung. 

Mendesain untuk menghindari material pendukung 

Dengan sedikit pemikiran sebelumnya, Anda dapat menghindari penggunaan materi pendukung 
sepenuhnya dengan mengikuti beberapa pedoman dasar: 

 Pikirkan tentang orientasi bagian Anda. Arahkan bagian tersebut sehingga tercetak 
dengan jumlah overhang terkecil. Ini mungkin berarti mencetak objek Anda secara 
terbalik atau miring. Huruf besar T pada Gambar 9-1 dapat dicetak dengan posisi berdiri 
tegak, tetapi dengan meletakkannya di punggungnya memungkinkan untuk mencetak 
lebih cepat - tanpa bahan pendukung. 

 Coba pikirkan kembali sudut pandang Anda. Kebanyakan printer dapat mencetak 
kemiringan antara 45 dan 60 derajat dari vertikal tanpa menggunakan bahan pendukung. 
Ingatlah batasan ini saat Anda mendesain. Chamfers dan fillet sangat bagus untuk 
mendukung fitur dan memperhalus transisi yang kasar. Pada Gambar 9-2, talang 
mengubah bagian dengan overhang yang tidak didukung menjadi bagian yang mudah 
dicetak. Sebagai bonus tambahan, fillet dan chamfers memperkuat bagian Anda dengan 
menghilangkan titik stres.  

 Pertimbangkan memecah objek Anda menjadi beberapa cetakan. Bola pada Gambar 9-
3 dapat dicetak menggunakan bahan pendukung, tetapi akan mencetak lebih cepat dan 
dengan lebih sedikit pembersihan jika Anda membelahnya menjadi dua dan 
memasangnya kembali setelah itu. Nanti di bab ini, Anda akan mempelajari tentang 
sistem untuk membuat bagian-bagian terkunci dengan cepat. 

 

Gambar 9-1: Mengorientasikan kembali suatu bagian dapat membuatnya dicetak lebih cepat dan 
hanya menyisakan sedikit bahan pendukung untuk dibersihkan. 
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Gambar 9-2: Talang dapat mengubah sudut 90 derajat yang tidak dapat dicetak menjadi sudut 
45 derajat yang dapat dicetak. 

 

Gambar 9-3: Seringkali bagian yang terbagi lebih cepat dan lebih bersih untuk dicetak daripada 
bagian yang dicetak sekaligus. 

Bridging 

Bridging adalah fitur pada printer 3D yang memungkinkan Anda mencetak struktur melintasi 
celah tanpa menggunakan bahan pendukung. Untuk menjembatani celah, struktur yang akan 
dicetak harus sejajar dengan platform bangunan dan memiliki titik pemasangan yang aman di 
kedua sisinya, seperti pada bagian atas kusen pintu yang ditunjukkan pada Gambar 9-4. Printer 
akan menempelkan plastik ke satu sisi celah dan meregangkan garis ke sisi lainnya. Proses ini 
diulangi sampai celah terisi. Layer masa depan dicetak di atas seperti biasa. 
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Gambar 9-4: Kapan kusen pintu menjadi jembatan? Saat dicetak 3D. 

Mempersiapkan Model SketchUp untuk Pencetakan 3D 

Semakin lama Anda mengerjakan model SketchUp, semakin cenderung dipenuhi dengan 
persimpangan tidak logis, kantilever mengambang bebas, dan pintasan cepat lainnya. Saat Anda 
membuat gambar atau panduan, ini adalah kompromi kecil yang membantu mendapatkan 
pekerjaan besar dengan cepat. Menggambar sesuatu yang terlihat tepat di luar di SketchUp tidak 
selalu berarti dapat dicetak 3D dengan satu klik tombol. Printer 3D tidak dapat menafsirkan 
campuran geometri itu untuk menebak apa yang sebenarnya Anda pikirkan. 
 

Di bagian ini, Anda akan menemukan cara membersihkan kegilaan SketchUp dan membuatnya 
menjadi objek 3D yang dapat dicetak. Proses pembersihan menggunakan tool yang dibahas di 
bab sebelumnya, tetapi cara Anda menggunakan tool ini berbeda. Membersihkan model 
SketchUp yang berantakan dapat terlihat seperti tugas yang menakutkan saat Anda memulai. 
Ingatkan diri Anda bahwa ini seperti memakan gajah: Bagi pekerjaan menjadi beberapa bagian 
yang dapat diatur dan kerjakan satu per satu… meskipun belalainya bisa sedikit kenyal. 

Ingat 

Sebelum Anda mulai membersihkan geometri untuk membuat model Anda dapat dicetak 3D, 
pastikan Anda telah menyimpan salinan terpisah dari file SketchUp Anda, hanya untuk amannya. 

Mengintip ke dalam model 

Meskipun Anda dapat menggunakan tool Bidang Bidang untuk membuat tampilan bagian melalui 
model Anda, tool yang luar biasa ini memiliki kegunaan lain: tool ini dapat menunjukkan kepada 
Anda apa yang terjadi di dalam geometri model Anda. Printer 3D melihat model SketchUp sebagai 
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rangkaian irisan horizontal 2D. Gambar 9-5 menggerakkan Section Plane melalui model secara 
horizontal untuk menunjukkan apa yang akan dilihat printer 3D. 

 

Gambar 9-5: Menggunakan bidang bagian untuk melihat semua bagian yang tumpang tindih yang 
membentuk model Anda. 

Untuk mendapatkan benda padat kedap air, semua kelompok perlu digabungkan menjadi satu, 
dan semua geometri asing itu harus dihilangkan dari model 

Mengetahui apa yang membuat model kokoh 

Untuk berhasil mencetak 3D bagian Anda, bagian tersebut harus berupa benda padat, atau 
sedekat mungkin dengan benda padat. Tidak ada permukaan yang hilang atau ekstra, bagian yang 
tumpang tindih, atau bit asing yang diperbolehkan. Model SketchUp Anda perlu mendeskripsikan 
semua aspek permukaan luar bentuk. Misalnya, untuk mencetak telur, model SketchUp perlu 
mendeskripsikan 100 persen bagian luar cangkang telur. Itu tidak sesederhana kedengarannya. 

Model solid yang dapat dicetak 3D memenuhi kriteria berikut: 

 Model dinding memiliki ketebalan. Ketebalan nol = pencetakan nol. Dinding dengan satu 
sisi memiliki ketebalan nol dan tidak akan dicetak. Anda perlu memastikan semua dinding 
memiliki ketebalan tertentu. 

 Model hanya memiliki permukaan luar. Di SketchUp, Anda dapat membuat model 
dengan cepat (dalam abstrak) dengan mendorong bagian satu sama lain dan membuat 
revisi di atas geometri lama. Untuk printer 3D Anda, bagaimanapun, model seperti itu 
adalah kekacauan tidak logis yang akan membuat M.C. Escher menangis. Printer 3D Anda 
tidak memiliki peluang besar. Anda perlu membersihkan semuanya sehingga hanya 
permukaan luar yang tersisa. Untungnya, tool dan ekstensi SketchUp yang dibahas nanti 
di bab ini dapat membantu.  

 Grup dan komponen digabungkan. Grup dan komponen sangat bagus untuk menjaga 
agar bagian tidak saling menempel saat Anda bekerja, tetapi untuk membuat model 
SketchUp Anda menjadi cangkang solid yang dapat dicetak 3D, Anda perlu 
menggabungkan semuanya. 
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Tips 

Sebelum Anda mulai explodekan benda-benda dan merekatkannya, luangkan waktu sejenak 
untuk memikirkan bagaimana Anda ingin model cetak 3D Anda yang sebenarnya bekerja. Untuk 
sebagian besar proyek, Anda perlu menggabungkan semua grup dan komponen Anda menjadi 
satu objek yang dapat dicetak sebelum mengekspor model Anda dari SketchUp. Untuk proyek 
yang lebih besar, pikirkan tentang menyusun balok menjadi beberapa bagian yang dapat Anda 
cetak 3D dan dipasang bersama nanti. 

Hasilnya adalah printer 3D tidak terlalu pintar. Jika Anda membuat mereka menebak seperti apa 
peran Anda, mereka biasanya akan salah menebak. Gambar 9-6 adalah bukti pembantaian 
tersebut. 

 

Gambar 9-6: Hasil cetak yang buruk ini tidak pernah ada kesempatan 

Menggunakan Solid Tools untuk menggabungkan grup 

Solid Tools sangat bagus untuk menyatukan grup yang terdiri dari bagian solid sederhana. 
Mereka dapat menghemat waktu secara signifikan. Sayangnya, bentuk yang kompleks 
menyebabkan Solid Tools untuk bertindak secara tidak terduga - dan, setelah beberapa iterasi, 
rusak. 

Pada Gambar 9-7, Solid Tools tidak memiliki masalah untuk memotong beberapa kubus 
sederhana menjadi satu, tetapi menambahkan bentuk kompleks ke objek menyebabkan tool 
tersebut rusak. Bilah sisi yang menyertai melihat lebih dekat mengapa ini terjadi. 
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Gambar 9-7: Boolean bagus untuk hal-hal sederhana. Tapi jangan mengandalkan mereka untuk 
pembersihan yang rumit. 

 

CleanUp3 dan Solid Inspector2 

Dua tool dari Extension warehouse SketchUp sangat penting untuk pencetakan 3D: 

CleanUp3 dan Solid Inspector2, keduanya dibuat oleh Thomas Thomassen. CleanUp3 memeriksa 
dan menyederhanakan geometri model SketchUp Anda. Ini menggabungkan banyak face, 
menghilangkan data yang tidak relevan, dan menghapus garis apa pun yang tidak membentuk 
face. Dua dari opsi CleanUp3 yang paling berguna adalah Hapus Face Duplikat dan Perbaiki edge 
Terbelah, yang dapat diaktifkan di menu CleanUp3. Face duplikat dan edge yang terbelah adalah 
kesalahan yang pasti muncul dalam model Anda saat Anda bekerja di SketchUp, dan hal itu 
mendorong kacang printer 3D. Kedua kesalahan tersebut sulit dikenali dan diperbaiki secara 
manual. 

CleanUp3 juga bagus untuk menyederhanakan file STL (file yang dapat dicetak 3D) yang Anda 
impor ke SketchUp. Pada Gambar 9-8, yang menunjukkan data triangulasi yang Anda peroleh dari 
file STL yang diimpor, permukaannya telah dipecah menjadi ratusan segitiga. Dengan menghapus 
triangulasi tersebut, CleanUp3 membuat file yang diunduh dari komunitas pencetakan 3D (seperti 
Thingiverse di www.thingiverse.com) lebih mudah diedit di SketchUp. 

 

Gambar 9-8: File STL yang diimpor, sebelum dan sesudah menjalankan CleanUp3. 

Tips 

Solid Inspector2 menemukan dan menyoroti masalah yang mencegah model Anda menjadi 
kerangka yang solid, dan kami tidak dapat terlalu menekankan kegunaannya. Ini menyoroti area 
masalah dan membantu Anda secara otomatis berpindah dari satu kesalahan ke kesalahan 
berikutnya, membuat perbaikan jauh lebih cepat (lihat Gambar 9-9). Ini adalah tool yang harus 
dimiliki setiap orang yang menggunakan SketchUp untuk pencetakan 3D. 
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Gambar 9-9: Solid Inspector2 sangat bagus dalam menemukan masalah yang perlu diperbaiki 
dengan cepat. 

Ingat 

Saat Anda mengerjakan model Anda, biasakan menjalankan CleanUp3 secara berkala. Jalankan 
Solid Inspector2 sebelum Anda mengekspor dari SketchUp ke cetakan 3D. Ini akan menangkap 
kesalahan apa pun yang akan menyebabkan pencetakan gagal. 

Menggabungkan grup dengan Intersect Faces 

Cara alternatif untuk mengumpulkan grup Anda menjadi satu objek adalah dengan menggunakan 
perintah Intersect Faces. Untuk pencetakan 3D, Intersect Faces dapat menghilangkan geometri 
yang tumpang tindih dan meninggalkan objek padat. Anda dapat menggunakan Intersect Faces 
pada objek dan grup yang sangat kompleks yang belum solid. 

Dalam model yang kompleks, pisahkan dan kerjakan satu bagian kecil dari model SketchUp dalam 
satu waktu, buat setiap bagian menjadi satu bagian yang solid. Ulangi proses pada bagian 
tersebut sampai Anda memiliki satu model yang solid. Langkah-langkah berikut menjelaskan 
proses ini secara lebih rinci: 

1. Pilih grup yang ingin Anda gabungkan dan kelompokkan bersama.  

Grup asli Anda sekarang menjadi subkelompok yang ada bersama di dalam grup baru. 

2. Pilih Edit ⇒ Intersect Faces with Context.  
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Melakukannya akan membuka grup baru Anda dan memilih semua subgrup, 
menggambar garis di semua tempat yang berpotongan dengan grup. Garis persimpangan 
baru ini ada di luar subkelompok dan belum terpaku pada apa pun, seperti yang 
ditunjukkan pada Gambar 9-10. 

3. Pilih garis perpotongan dan copy dengan memilih Edit ⇒ copy. 
4. Buka setiap subkelompok dan tempel garis perpotongan ke dalamnya, menggunakan 

Edit ⇒ Paste di Tempat.  

Gambar 9-10 menunjukkan prosedurnya. 

5. Buka setiap subkelompok dan hapus semua area tumpang tindih di luar garis 
persimpangan.  

Bekerja dengan sengaja, bolak-balik di antara subgrup untuk memastikan Anda 
menghapus area yang benar. 

6. Kembali ke grup utama, pilih semua subgrup, context-clicks pilihan, dan pilih Explode 
pada menu yang muncul.  

Anda berakhir dengan satu kulit terluar dari sebuah objek dalam grupnya sendiri. Gambar 
9-10 menunjukkan hasil ini. 

7. Jalankan CleanUp3 pada part baru dan gunakan Solid Inspector2 untuk memeriksa 
lubang yang tidak disengaja. 

Tips 

Face individu dan segmen garis pendek bisa hilang selama proses ini. Anda mungkin perlu 
melakukan sedikit sentuhan dengan Line Tool. 
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Gambar 9-10: Hapus geometri yang tumpang tindih untuk membuat kulit terluar 

Memeriksa mode Normal 

Dari perspektif ilmu komputer yang sangat teknis, setiap face dalam model Anda memiliki dua 
sisi: dalam dan luar. Kedua sisi dipisahkan oleh sedikit data yang disebut face normal. SketchUp 
cukup cerdas sehingga tidak peduli bagaimana orientasi normals (juga dikenal sebagai depan dan 
belakang); kedua sisi diperlakukan sama. Printer 3D tidak begitu pintar; mereka harus memiliki 
semua yang normals berorientasi sehingga sisi luar menunjuk keluar dan bagian dalam menunjuk 
ke dalam. 

Untuk memeriksa model normal Anda, Anda harus melihatnya ditata dengan tekstur default 
SketchUp. Pilih Tampilan ⇒ Style Face ⇒ Monokrom untuk menyembunyikan warna atau tekstur 
apa pun yang telah Anda tambahkan ke model dan melihat bahan default.  

Setiap face yang diarsir dengan warna biru default memiliki warna normal terbalik. Face-face ini 
perlu dikoreksi, atau printer 3D akan menganggapnya hilang. 

 Untuk mengoreksi satu face, context-clicks pada face dan pilih Face Terbalik dari menu 
yang muncul. 
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 Untuk mengoreksi beberapa face yang tidak sejajar, context-clicks salah satu face yang 
berwarna putih dan pilih Orient Faces. Melakukannya membalik semua permukaan dalam 
model agar sesuai dengan tampilan yang ditunjukkan pada Gambar 9-11. 

 

 

Gambar9-11: Normal yang benar adalah normal bahagia. 

Tips 

Jika tool Orient Faces menyebabkan semuanya membalik secara acak, itu tandanya ada face asing 
di dalam model Anda. Gunakan tool Section Plane untuk melihat ke dalam, menemukan face, 
dan menghapusnya. 

Memeriksa ukuran model Anda 

Setiap printer 3D memiliki ukuran minimum dan maksimum objek yang dapat dibuatnya, seperti 
yang ditunjukkan pada Gambar 9-12. Ukuran ini biasanya ditentukan oleh ukuran tool yang 
mencetak bahan dan ukuran keseluruhan printer. Untuk membangun sesuatu yang lebih besar, 
Anda harus kreatif. Untuk membuat sesuatu yang lebih kecil, Anda memerlukan printer 3D yang 
lebih mahal. 
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Gambar 9-12: Terlalu besar dan terlalu kecil. Ada sesuatu di sana di sebelah kanan; itu sangat 
kecil. 

Terlalu kecil untuk dicetak  

Dalam dunia SketchUp, Anda dapat mendesain gedung pencakar langit yang cukup kecil untuk 
muat di kepala pin, tetapi printer 3D tidak dapat mencetaknya. Setiap printer 3D memiliki ukuran 
minimum untuk apa yang dapat dibuatnya; sesuatu yang lebih kecil dari itu tidak akan dicetak. 
Anda menemukan nilai-nilai ini terdaftar sebagai Ukuran Fitur Minimum dan Ketebalan Dinding 
Minimum. Ukuran Fitur dan Ketebalan Dinding dapat berubah menjadi batu sandungan saat 
Anda mencoba mencetak model SketchUp secara 3D yang dibuat dalam ukuran penuh dan 
kemudian diperkecil. 

 Ketebalan Dinding Minimum memberi tahu Anda seberapa tipis sebuah geometri yang 
berdiri sendiri dapat dan masih dicetak. Ketebalan itu biasanya antara 1.0mm dan 0.5mm. 

 Minimum Feature Size adalah ukuran terkecil dari sebuah feature pada permukaan objek 
yang akan dicetak. Biasanya antara 0,7 mm dan 0,2 mm. 

Jika Anda memodelkan objek kecil untuk pencetakan 3D, buat model dalam unit kecil, seperti 
milimeter, dari awal. Untuk menyetel atau mengubah unit default di template model SketchUp 
Anda, pilih Window => Preferences (SketchUp => Preferences di Mac) dan pilih template yang 
menggunakan milimeter. Anda juga dapat menyesuaikan unit default di window Info Model 
dengan memilih Window => Model Info dan memilih opsi Unit di sebelah kiri. 

Terlalu besar untuk dicetak 

Objek terbesar yang dapat Anda cetak 3D sekaligus disetel oleh volume pembuatan printer. Jika 
model Anda tidak cocok dengan volume build, Anda harus memperkecil ukuran objek Anda, atau 
mencetaknya menjadi beberapa bagian. Bagian selanjutnya berbicara tentang cara membagi 
model sehingga Anda dapat mencetaknya menjadi beberapa bagian. 

Ingat 

Meskipun ukuran maksimum dari setiap bagian dibatasi oleh ukuran printer 3D Anda, ukuran dari 
apa yang dapat Anda cetak 3D hanya dibatasi oleh kreativitas dan kesabaran Anda. Seorang pria 
di Selandia Baru mencetak 3D untuk dirinya sendiri sebuah Aston Martin, satu kubus berukuran 
6 inci. 

Berikut adalah beberapa petunjuk praktis untuk memanfaatkan volume build dengan sebaik-
baiknya: 

 Volume bangunan, atau selubung, diberikan oleh pabrikan sebagai ukuran X, Y, Z.xdan Y 
adalah lebar dan kedalaman permukaan bangunan; Z adalah tinggi maksimum. 

 Sebaiknya buat representasi dari volume build maksimum printer 3D Anda dalam model 
SketchUp Anda. Buat blok tembus pandang yang mewakili volume build maksimum dan 
periksa untuk melihat apakah model SketchUp Anda atau komponennya sesuai dengan 
volume tersebut. 
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 Platform rakitan printer 3D jauh lebih panjang secara diagonal daripada di salah satu sisi. 
Untuk memanfaatkan panjang ekstra, putar bagian yang panjang agar tetap berada di 
dalam volume build. 

 Mencetak benda besar hadir dengan masalah dan kerumitannya sendiri. Benda besar 
lebih rentan terhadap kegagalan dan kerusakan. Pastikan Anda merasa nyaman dengan 
printer 3D Anda sebelum mulai mencetak mobil sport Anda sendiri. 

Memecah Model Anda Menjadi Beberapa Bagian 

Saat Anda melakukan lebih banyak pencetakan 3D dengan SketchUp, Anda akan merasa perlu 
untuk membagi model Anda menjadi beberapa bagian. Beberapa ide terlalu besar untuk 
disesuaikan dengan volume pembuatan printer 3D Anda. Ide lain ingin dicetak 3D dalam pelangi 
plastik berwarna. Dan terkadang model hanya perlu dibelah agar mudah dicetak. 

Bagian Mana yang di Potong 

Saat membagi model SketchUp menjadi beberapa bagian yang dapat dicetak, mulailah dengan 
memikirkan tentang apa yang akan Anda lakukan dengan kelimnya. Jika Anda akan 
mengampelas, mengecat, dan menyelesaikan model, miliki dan potong di mana pun Anda mau. 
Namun pengamplasan dan penyelesaian adalah pekerjaan yang sangat berat, terutama jika Anda 
belum pernah melakukannya. Jauh lebih mudah untuk membuat potongan dan kelim Anda 
terlihat seperti bagian yang disengaja dari model. 

Ingat 

Agar jahitan terlihat disengaja, ia harus bekerja dengan logika objek. Setiap objek memiliki 
logikanya sendiri, urutan mendasar yang menginformasikan bagaimana bentuk dan strukturnya. 
Misalnya, pada Gambar 9-13, benda tersebut simetris kiri dan kanan. Jahitan pada sumbu simetri 
kurang dapat diterima dibandingkan jahitan yang berjalan secara acak ke arah lain. Dengan 
mengikuti garis yang secara konseptual sudah ada pada objek, jahitan tersebut memperkuat apa 
yang sudah dilihat oleh mata. 
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Gambar 9-13: Garis tersebut jauh lebih tidak menyenangkan jika dipikirkan dengan matang. 

Tempat lain yang baik untuk menyembunyikan potongan adalah pada perubahan ketinggian, 
kelengkungan, atau warna, seperti yang ditunjukkan pada Gambar 914. Menempatkan jahitan di 
mana permukaan suatu bagian sudah terputus atau dalam transisi akan membuatnya kurang 
terlihat. Ini adalah strategi yang paling umum digunakan untuk bagian cetakan injeksi. Ambil 
sesuatu di sekitar Anda yang terbuat dari plastik dan temukan sambungan tempat bagian-
bagiannya menyatu. Jika Anda bisa meniru jenis jahitan itu, orang akan langsung menerima 
bahwa benda Anda adalah benda yang”nyata". Ini akan terasa benar di antara barang-barang 
yang diproduksi di dunia cetakan injeksi kami, dan Anda akan membodohi orang sehingga 
mengira bagian cetakan 3D Anda berasal dari pabrik di suatu tempat. 
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Gambar 9-14: Apakah jahitannya terlihat tidak pada tempatnya? 

Untuk konstruksi yang sangat besar, satu-satunya pilihan mungkin adalah membuat kisi-kisi dan 
memotong menjadi balok-balok berukuran volume bangunan. Pengamplasan, penyelesaian 
akhir, dan pengecatan dapat bekerja dengan baik pada bagian-bagian besar, tetapi akan 
menghabiskan banyak waktu untuk melakukannya dengan benar. Jika Anda telah menghabiskan 
energi untuk membangun sesuatu yang sebesar itu, Anda akan mendapatkan waktu ekstra untuk 
membuatnya luar biasa. 

Bagaimana cara memotong 

Memotong model menjadi beberapa bagian sangat mirip dengan menggunakan tool Intersect 
Faces untuk menggabungkan kelompok (dibahas sebelumnya di bab ini). Anda menggunakan 
potongan geometri sebagai pemotong yang akan dipotong dengan objek yang lebih besar dan 
menjadi edge potongan yang baru. 

Jika model Anda cukup sederhana dan Anda memiliki SketchUp Pro, Anda dapat menggunakan 
Solid Tools untuk menghubungkan proses ini. Buat blok padat sebagai objek pemotongan dan 
gunakan perintah Solid Tools => Trim. Ingatlah untuk menjalankan CleanUp3 dan Solid Inspector2 
di bagian baru setelah Anda selesai. Untuk model yang lebih kompleks, atau pengguna dengan 
SketchUp Make, gunakan metode Intersect Faces: 

1. Pilih grup yang ingin Anda potong dan buat grup baru di sekitarnya. Grup asli menjadi 
subgrup. 

2. Bekerja di dalam grup baru, buat geometri dalam bentuk potongan yang ingin Anda buat. 
Kerjakan di atas subkelompok, jadi Anda menempatkan potongan dengan benar, seperti 
yang ditunjukkan pada Gambar 9-15. 

3. Saat Anda selesai melakukan pemotongan, buat geometri baru menjadi grupnya sendiri. 
4. Pilih objek Cutter dan pilih Edit ⇒ Intersect Faces with Context (atau pilih Edit dari menu 

context-clicks). Melakukan hal itu menarik garis di setiap tempat di mana kelompok 
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bersentuhan. Garis persimpangan baru ini ada di luar subkelompok dan belum terpaku 
pada apa pun, seperti yang ditunjukkan pada Gambar 9-16. 

5. Di dalam setiap grup, gunakan Explode untuk menyatukan garis persimpangan, 
memotong objek, dan objek dasar. Permukaan objek pemotongan menjadi sisi-sisi bagian 
yang baru. 

6. Pindah kembali ke grup master dan buat salinan grup itu sebanyak jumlah bagian yang 
Anda bagi (lihat Gambar 9-17). 

7. Di setiap salinan, buka grup untuk mengedit dan menghapus semua yang tidak Anda 
perlukan di bagian itu. Lakukan hal yang sama di bagian lain. Pastikan Anda tidak 
menghapus apa yang dibutuhkan objek untuk melakukan tugasnya. 

8. Jalankan CleanUp3 pada bagian baru dan gunakan Solid Inspector2 untuk memeriksa 
lubang yang tidak disengaja. 

9. Posisikan bagian-bagian itu kembali bersama untuk memastikan semuanya berbaris 
seperti yang diharapkan, seperti yang ditunjukkan pada Gambar 9-18. 

 

 

Gambar 9-15: Objek pemotong bisa menjadi satu bidang; itu akan menjadi bagian dari benda 
padat. 
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Gambar 9-16: Garis perpotongan yang dibuat antara dua kelompok. 
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Gambar 9-17: Buatlah satu salinan kelompok untuk setiap bagian model Anda 
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Gambar 9-18: Masih pas! 

Mengekspor File SketchUp Anda 

Setelah Anda membersihkan model SketchUp dan siap mencetaknya, Anda harus mengeluarkan 
model 3D dari SketchUp dan masuk ke perangkat lunak kontrol printer 3D Anda. Sebelum 
pencetak 3D dapat membuka model Anda, Anda harus mengekspor model dalam format file STL 
atau OBJ. 

Jika Anda menggunakan SketchUp Pro, Anda sudah memiliki opsi untuk mengekspor file OBJ. 
Untuk mengekspor file STL dari salah satu versi SketchUp, Anda perlu memasang ekstensi gratis 
dari Extension warehouse SketchUp yang disebut SketchUp STL. Ini adalah tool hebat yang dibuat 
oleh tim SketchUp untuk mempermudah pencetakan 3D. 

Mengenal Printer 3D Anda 

Printer 3D tersedia yang mencetak objek dalam bahan mulai dari plastik hingga titanium. Dunia 
penelitian medis bahkan telah menciptakan mesin yang dapat membangun struktur dari jaringan 
manusia. Semua yang memisahkan teknologi ini adalah biaya. Printer 3D desktop yang terjangkau 
terbatas untuk pencetakan dalam plastik.  

Dua cara utama printer 3D dibandingkan satu sama lain adalah dalam hal biaya per cm3 (yaitu, 
biaya per sentimeter kubik objek yang dicetak) dan tinggi layer minimum. Biaya per cm3 adalah 
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biaya satu sentimeter kubik volume tercetak; ini biasanya angka yang digunakan saat 
membandingkan biaya satu teknologi pencetakan 3D dengan yang lain. Tinggi layer minimum 
adalah ketebalan satu layer pada objek. Semakin kecil ketinggian antar layer, semakin halus 
permukaan objek yang sudah jadi akan terlihat dan terasa. 

Printer 3D desktop 

Printer 3D desktop masih merupakan teknologi baru. Saat memulai dengan printer 3D desktop 
pertama Anda, jangan berharap printer tersebut bekerja dengan sempurna saat pertama kali 
dikeluarkan dari kotaknya. Mesin belum mencapai tingkat semir itu. Sangat membantu untuk 
melihat printer 3D sebagai tool yang sedang Anda pelajari, bukan sebagai tool yang baru saja 
Anda colokkan. Sebelum Anda terjun ke pencetakan kreasi Anda sendiri, luangkan waktu untuk 
mempelajari materi pelatihan printer. Cetak beberapa benda uji dan rasakan cara menggunakan 
mesin. 

Printer 3D desktop cenderung didasarkan pada teknologi teruji dan benar yang telah digunakan 
di mesin industri selama beberapa dekade. Dua teknologi yang tersedia sekarang adalah 
pemodelan deposisi gabungan dan stereolitografi. Bagian berikut memberi Anda gambaran 
umum. 

Pemodelan deposisi gabungan (FDM) 

Printer FDM mewakili jenis printer 3D desktop yang paling banyak tersedia. Mereka membuat 
benda-benda menggunakan plastik padat yang dimasukkan melalui nosel model lem robotik yang 
mewah. Printer FDM tidak mahal untuk dibeli. Komponen yang dicetak FDM selesai saat printer 
selesai dibuat; tidak diperlukan proses sekunder untuk menyelesaikan atau memperkuat objek. 
Bagian yang dibuat printer FDM bisa sekuat bagian dari cetakan injeksi. Sisi negatifnya, printer 
FDM 3D memiliki resolusi maksimum yang terbatas dan cenderung memiliki banyak bagian yang 
bergerak, yang dapat memengaruhi keandalannya. 

Printer FDM menggunakan filamen plastik saat mereka membuat objek. Filamen ditarik ke dalam 
printer, dipanaskan, dan kemudian digabungkan untuk membentuk objek. Filamen melingkar 
pada gulungan yang terlihat seperti kawat pemukul gulma berwarna cerah. Gulungan tersedia 
dengan harga murah melalui vendor online dan mulai tersedia di toko peralatan kantor besar. 

Printer SLA 3D mewakili salah satu teknologi pencetakan 3D tertua. Mereka menggunakan laser 
untuk membangun bagian padat di dalam tong resin cair, secara selektif mengeraskan resin lapis 
demi lapis. Stereolitografi menawarkan resolusi pencetakan yang unggul, yang memberikan 
permukaan halus seperti kaca pada bagian yang sudah jadi. Mesin biasanya kecil dan hampir tidak 
bersuara, dengan beberapa bagian yang bergerak. Pencetakan dari mesin SLA memerlukan 
pembersihan setelah pencetakan. Selain itu, karena toksisitas resin, benda cetakan harus dicuci 
dengan alkohol isopropil sebelum ditangani. 

Resin habis pakai Stereolighografi adalah rekayasa kimia yang menakjubkan. Ini berbentuk cairan 
pada suhu kamar sampai terkena sinar ultraviolet yang intens, yang mengeraskan resin menjadi 
plastik padat. Damar datang sebagai sebotol cairan; biasanya Anda harus membelinya dari 
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pembuat printer 3D Anda untuk memastikan kompatibilitasnya. Resin memiliki umur simpan 
yang ditetapkan dan harus disimpan dengan hati-hati; dapat mulai mengeras jika dibiarkan di 
bawah sinar matahari. 

Lakukan sendiri dan kit printer 

Baik printer FDM dan SLA tersedia sebagai kit dan paket DIY sumber terbuka. Secara umum, 
printer 3D ini adalah pilihan yang baik untuk orang-orang yang tertarik untuk menjelajahi 
teknologi printer dan memodifikasi printer mereka. Kit lebih murah daripada membeli printer, 
tetapi seringkali kurang dapat diandalkan. Pepatahnya adalah,”Jika Anda membangunnya 
sendiri, Anda memperbaikinya sendiri." 

Printer 3D profesional 

Printer 3D profesional biasanya ditempatkan di departemen khusus dan dioperasikan oleh 
karyawan penuh waktu. Mereka mahal, dengan harga ratusan ribu dolar, tetapi menawarkan 
kemampuan melebihi apa yang tersedia di model desktop. Saat pencetakan 3D desktop tumbuh, 
dan paten terus habis, diharapkan teknologi ini menjadi lebih murah dan pindah ke ranah 
desktop. Berikut adalah jajaran produk saat ini: Sintering laser selektif (SLS): Sinter laser selektif 
menggunakan laser untuk melebur dan memadukan plastik bubuk halus. Mesin SLS dapat 
mereproduksi detail halus tanpa menambahkan struktur pendukung apa pun ke model. (Pada 
umumnya, laser yang dapat menangani fitur ini masih relatif mahal.) 

 Berbahan dasar inkjet: Mirip dengan mesin SLS, printer 3D ini menggunakan bubuk yang 
dikeraskan secara selektif dengan lem cair yang disemprotkan dari printhead inkjet. Tinta 
dapat diwarnai dan dicampur; ini adalah salah satu dari sedikit teknologi yang dapat 
menawarkan pencetakan 3D penuh warna. 

 Inkjet, berbasis resin: Mesin ini merupakan perluasan dari teknologi stereolitografi. 
Mereka menggunakan printhead inkjet untuk menyemprotkan layer halus resin sensitif 
UV, yang kemudian dikeraskan oleh sinar UV yang kuat. Materi iklan untuk printer ini 
berbicara tentang ketinggian layer yang diukur dalam atom. 

 Berbasis kertas: Printer ini membuat objek dari kertas fotokopi dengan merekatkan 
lembaran menjadi satu lalu memotong kelebihannya. Bagian-bagiannya sangat kuat, dan 
dapat diperlakukan seperti kayu setelah dicetak. 

Layanan pencetakan 3D 

Layanan pencetakan 3D menawarkan akses ke mesin tingkat profesional dengan dasar bayar-per-
cetak. Biaya didasarkan pada volume materi yang dicetak, dan Anda menerima objek yang 
dicetak melalui pos dalam beberapa hari kerja. Setiap perusahaan menawarkan petunjuk rinci 
tentang ukuran komponen minimum, ketebalan dinding, dan ukuran fitur. Perhatikan aturan ini. 
Layanan tahu apa yang dapat dilakukan mesin mereka, dan Anda tidak ingin terjebak menunggu 
seminggu untuk bagian yang tidak berjalan dengan baik. 
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DAPATKAH SAYA MENCETAK 3D DENGAN LOGAM? 

Ya, printer 3D yang dicetak dari logam memang ada. Tetapi kecuali Anda tinggal di gunung 

berapi berlubang dan jet tempur balap di waktu luang Anda, Anda mungkin tidak mampu 

menggunakannya. Berdasarkan teknologi selektif laser sintering (SLS), printer ini 

menggunakan laser elektron untuk menggabungkan bubuk logam dalam ruang hampa keras. 

Suku cadang yang mereka buat sangat kuat dan kompleks, melampaui segala kemungkinan 

dengan teknologi manufaktur tradisional. Penggunaan SLS saat ini di bidang manufaktur 

mencakup implan medis khusus, mesin jet militer, dan komponen pesawat ruang angkasa. 

Jadi jika biaya bukan masalah, Anda dapat mencetak 3D dalam logam. 

Jika Anda membutuhkan bagian cetakan 3D Anda yang terbuat dari logam, gunakan biro 

layanan pencetakan 3D atau bawa bagian yang dicetak dengan printer FDM atau SLA ke 

pengecoran. Di pengecoran, proses yang disebut burnout membuat versi logam tuang dari 

bagian tersebut. 

 

Menggunakan Printer 3D Anda 

Pabrikan printer 3D baru Anda akan memiliki dokumentasi untuk membantu Anda mempelajari 
cara menggunakan printer dan perangkat lunaknya, jadi kami tidak membahas secara detail 
mesin tertentu. Bagian berikut menyentuh beberapa konsep umum pencetakan 3D yang sering 
tidak dijelaskan dengan baik. Untuk melihat lebih dekat printer 3D, lihat 3D Printing For Dummies 
oleh Kalani Kirk Hausman dan Richard Horne. 

Cetak lebih awal, sering cetak 

Pencetakan 3D desktop murah. Sungguh, luar biasa, sangat murah. Biaya untuk menjalankan 
printer 3D desktop biasa adalah sekitar 60 sen per jam. Setelah Anda memulai printer, itu tidak 
memerlukan masukan lagi dari Anda, yang membebaskan Anda untuk terus mengerjakan desain. 
Dengan tool luar biasa yang sangat murah untuk digunakan, jangan takut untuk terus-menerus 
mencetak. Cetak model SketchUp Anda berulang kali saat Anda memperbaikinya; melakukan itu 
mengembangkannya. 

Printer 3D dibuat untuk mencetak; mereka tidak suka berdiam diri. Cetak lebih sering! Anda akan 
menjadi ahli dalam menggunakan mesin Anda, dan melihat desain Anda seiring 
perkembangannya secara waktu nyata. 

Tips 

Hasil cetak sangat bagus untuk menangkap kesalahan dan kesalahan. Cetakan percobaan juga 
merupakan cara terbaik untuk mendokumentasikan evolusi desain. Sebaiknya simpan versi 



193 
 

model SketchUp Anda yang sesuai dengan setiap file yang Anda cetak 3D. Jika hasil cetak 
mengalami kesalahan yang tidak terduga, Anda dapat melihat kembali file tersebut dan 
memahami apa yang salah, tanpa harus menggali terlalu dalam versi yang terus Anda kerjakan. 
Ingatlah beberapa poin umum: 

 Hasil cetak uji yang menggunakan setelan Kualitas Rendah printer 3D Anda akan 
mencetak lebih cepat, tetapi dengan permukaan yang lebih kasar. 

 Simpan hasil cetak saat proyek berjalan. Mereka adalah cara yang bagus untuk 
menunjukkan kemajuan, dan klien senang melihat ekspresi fisik dari pekerjaan yang telah 
diselesaikan. 

 Banyak plastik cetak 3D dapat didaur ulang atau terurai secara hayati. Setelah selesai 
dengan model Anda yang terbuat dari bahan ini, buang ke tempat sampah daur ulang 
atau di tumpukan kompos. 

Di dalam model Anda 

Komponen cetak 3D unik dalam dunia fabrikasi. Setelah Anda membuat bagian luar, Anda juga 
dapat memutuskan apa yang terjadi di dalamnya. Biasanya Anda membiarkan printer 3D secara 
otomatis menangani bagian dalam komponen, mengisinya dengan struktur yang dibuat secara 
otomatis. Dimungkinkan juga untuk memodelkan struktur interior suatu bagian untuk mengubah 
perilakunya. Misalnya, Anda mungkin ingin melubangi bagian tengah untuk membuatnya lebih 
ringan atau menambahkan ruang untuk komponen internal. Beberapa variasi yang mungkin 
termasuk 

 Rongga internal: Pada mesin SLS dan stereolitografi, strategi penghematan biaya yang 
umum adalah membuat komponen sebagai cangkang tipis dengan interior kosong. Bagian 
yang dihasilkan telah mengurangi kekuatan struktural, tetapi dicetak dengan 
menggunakan bahan sesedikit mungkin. Pastikan untuk memasukkan lubang 
pembuangan sehingga bahan yang tidak dikeraskan yang Anda simpan dapat keluar dari 
bagian tersebut. 

 Kepadatan bagian: Printer FDM secara otomatis menghasilkan struktur untuk mengisi 
interior hasil cetaknya. Kepadatan struktur dikontrol oleh pengaturan yang disebut isian, 
yang dinyatakan sebagai persentase. Bagian dengan isian 100% akan terbuat dari plastik 
padat seluruhnya, dan sekuat bagian cetakan injeksi. Biasanya, printer FDM default ke 
bagian bangunan dengan pengisian 10%, yang berarti bahwa 10 persen interiornya diisi 
dengan plastik. Persentase pengisian yang lebih tinggi berarti lebih banyak plastik yang 
digunakan - dan waktu cetak yang lebih lama. Secara umum, lebih dari 40 persen adalah 
pemborosan waktu dan plastik. 

 Ketebalan dinding luar: Pengaturan printer FDM lainnya, ini berkaitan dengan jumlah 
material yang dimasukkan ke dalam dinding objek sebelum memulai Pengisian. Cari 
pengaturan yang disebut Kerang, yang merupakan jumlah layer plastik yang akan 
digunakan printer untuk membuat bagian luar model. Jika Anda mengalami masalah 
dengan penghancuran komponen, tambah jumlah Kerang; jika tidak biarkan pengaturan 
ini sendiri. 
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 Fleksibilitas: Bahan fleksibel tersedia di sebagian besar printer 3D, biasanya dengan 
menggunakan filamen plastik fleksibel khusus. Anda juga dapat membuat struktur 
menjadi fleksibel dengan membuatnya sangat tipis dengan 0 persen pengisi. 

Melampaui Pencetakan 3D Dasar 

Semakin sering Anda menggunakan printer 3D, semakin mungkin hal itu memengaruhi desain 
SketchUp Anda. Jangan heran jika desain Anda menjadi sedikit lebih ambisius dan rumit secara 
mekanis. Bagian dari bab ini menguraikan beberapa kemungkinan arah dan faktor yang harus 
diperhatikan. 

Merancang bagian yang terhubung 

Jadi Anda memotong model Anda menjadi beberapa bagian. Sekarang Anda memerlukan cara 
agar semuanya tetap bersama setelah dicetak. Di bagian ini, Anda menemukan berbagai strategi 
dan fitur, mekanis dan lainnya, yang dapat Anda buat ke dalam model Anda untuk menyatukan 
bagian-bagiannya. 

Tolerance dan Clearance 

Sebelum kita berdiskusi tentang koneksi mekanis, Anda perlu memahami dua lagi realitas 
mengganggu yang muncul saat Anda keluar dari lingkungan ideal SketchUp: toleransi dan izin. 

 Tolerance adalah perbedaan antara pengukuran komponen Anda di SketchUp dan 
pengukuran bagian yang dihasilkan oleh printer 3D Anda. Jika Anda menggambar kubus 
10mm di SketchUp dan mencetaknya dengan 3D, tidak ada ukuran kubus yang dicetak 
akan persis 10mm. Perbedaannya kecil - hanya sepersepuluh milimeter lebih atau kurang 
- tetapi dapat menyebabkan masalah jika bagian cetakan 3D Anda harus terhubung ke 
bagian yang sudah ada di dunia nyata. Produsen printer 3D memberikan angka untuk 
toleransi mesin sebagai nilai plus atau minus, biasanya seperti pm0.05mm. Ini adalah 
variasi maksimum untuk mesin itu, dan Anda harus menyadarinya saat Anda bekerja. 

 Clearance adalah ruang ekstra yang Anda butuhkan agar komponen dapat saling 
bergeser. Jika Anda mencoba memasang pasak 10mm di lubang 10mm, Anda akan sedikit 
terkejut saat keduanya tidak dapat digabungkan. Pasak dan lubang bisa pas dengan 
sempurna di SketchUp, tetapi bukan itu yang akan terjadi di dunia nyata di mana Anda 
harus menghadapi gesekan. Permukaan pasak sangat mirip dengan permukaan lubang 
sehingga gesekan di antara keduanya akan mencegah pasak masuk jika pasnya terlalu 
tepat. Anda perlu menambahkan sedikit ruang yang disebut clearance sehingga kedua 
bagian dapat meluncur melewati satu sama lain. Berapa banyak jarak yang Anda gunakan 
tergantung pada bagaimana bagian tersebut harus bergerak. Sebuah poros pemintalan, 
misalnya, membutuhkan lebih banyak ruang bebas daripada pemasangan snap 
sederhana. 

Anda akan memahami pemahaman yang melekat tentang izin dan toleransi saat Anda mendesain 
lebih banyak di SketchUp untuk pencetakan 3D. Saat Anda menggunakan printer 3D, Anda akan 
dapat menemukan nilai yang sesuai dengan peralatan Anda. 
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Tips 

Sebagai titik awal, tambahkan jarak bebas 0,2 mm ke semua lubang dan jarak bebas 0,5 mm ke 
titik rotasi mana pun. 

Glue/Lem 

Lem, ditunjukkan pada Gambar 9-19, adalah cara universal untuk menempelkan sesuatu pada 
sesuatu yang lain. Sayangnya, ini juga merupakan metode yang paling lemah dan paling tidak 
dapat diandalkan. Sendi lem dalam plastik memiliki kekuatan yang sangat kecil dan akan 
cenderung patah karena stres, sebagai respons terhadap perubahan suhu, atau jika Anda 
menganggapnya lucu. Jika bagian Anda dimaksudkan untuk lebih dari sekadar model visual, 
gunakan salah satu sistem lampiran lainnya. 

 Plastik yang digunakan pada printer 3D - ABS, PLA, PVA, nilon, dan PETT - semuanya 
membutuhkan perekat khusus untuk merekatkannya. Lem ini tersedia, tetapi harus 
dipesan dari pengecer online. 

 Plastik pati yang dapat terurai secara hayati seperti PLA memiliki struktur kristal yang 
tidak bekerja dengan baik dengan lem super cair. Lem cenderung tetap cair dan tiba-tiba 
bermigrasi ke seluruh permukaan bagian. 

 Jika ragu, gunakan epoksi. Ini barang yang berantakan, tetapi akan menempel pada apa 
saja. 

 Tidak ada lem yang akan menempel pada bahan fleksibel yang tersedia untuk printer 3D. 
Untuk memasang bagian yang terbuat dari bahan tersebut, Anda perlu melihat proses 
yang disebut weld termal, yang berada di luar cakupan buku ini. 

 

Gambar 9-19: Berfungsi secara kosmetik, tetapi jangan berharap banyak ketahanan kecuali Anda 
menggunakan epoksi. 

Snap Fiting 
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Snap fitting adalah cara yang bagus untuk memanfaatkan printer 3D Anda. Didesain dengan 
benar, mereka akan membiarkan Anda menyatukan model Anda segera setelah bagian-
bagiannya dilepaskan dari printer. Fitting snap juga dapat dilepas, sehingga Anda dapat 
mengganti berbagai bagian model Anda seiring perkembangan desain. 

Di SketchUp, Anda membuat fitting snap seperti yang ditunjukkan pada Gambar 9-20 dengan 
mengikuti dua langkah umum: 

1. Buat lidah dengan Line Tool dan Push/pull. 
2. Buat titik tangkap yang cocok di bagian yang berlawanan. 

 

Gambar 9-20: Sambungan snap fit sangat bagus untuk sambungan yang dapat digunakan 
kembali. 

Ingat! 

Saat Anda membuat perlengkapan snap Anda, ingatlah hal-hal ini: 

 Pastikan untuk memberikan ruang yang cukup bagi lidah untuk menekuk ke belakang saat 
meluncur ke tempatnya. 

 Sertakan jarak antara 0,2 mm dan 0,5 mm, tergantung seberapa kencang sambungan 
yang Anda butuhkan. 

 Selalu posisikan fitting snap sehingga mencetak horizontal ke platform pembuatan printer 
3D. Fitting snap dicetak dalam arah Z, tegak lurus dengan platform, cenderung putus. 

 Jika Anda ingin fitting snap Anda dapat dibuka kembali, pastikan Anda menyediakan cara 
agar lidah terlepas dari jepretan. Ini bisa berupa ramp dalam geometri yang memaksa 
lidah mundur saat Anda menarik sambungan, atau titik akses yang memungkinkan Anda 
melepaskan lidah secara manual. 

 Jangan membuat lidah terlalu tebal. Itu harus dibengkokkan agar sendi bisa pergi 
bersama. 

Press Fit 
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Press Fit adalah ketika dua bagian dirancang dengan jarak yang sangat sedikit di antara keduanya. 
Ketika bagian-bagiannya ditekan secara paksa, gesekan membuat sambungan tetap bersama 
tanpa perangkat keras atau lem tambahan. 

Untuk membuat press fit seperti yang ditunjukkan pada Gambar 9-21, gunakan tool Offset untuk 
membuat bibir luar di satu sisi sambungan dan bibir bagian dalam di sisi lainnya. Sertakan jarak 
bebas 0,2 mm atau kurang antar bagian, sehingga Anda masih bisa merakitnya. Ingatlah 
beberapa hal tentang kesesuaian pers: 

 Agar press fit bekerja dengan baik, perlu ada koneksi yang erat. Anda mungkin 
membutuhkan palu kecil, penjepit besar, atau seluruh berat tubuh untuk menyatukan 
semua bagian. 

 Press fit biasanya merupakan koneksi satu arah. Setelah Anda menggabungkannya, 
jangan berharap untuk memisahkannya kembali. 

 Penyesuaian press tidak dapat ditingkatkan dengan baik. Desain selalu sesuai dengan 
ukuran yang akan digunakan untuk mencetaknya. 

 Jarak bebas yang ketat dari press fit dapat membuat Anda sulit untuk memulai. 
Menjalankan pisau hobi atau tool deburring di sekitar edge lubang akan sedikit 
memperlebar area itu dan membantu Anda menyatukan bagian-bagiannya. 

 

Gambar 9-21: Press fit adalah koneksi yang mudah untuk menggambar di SketchUp. 

Baut, sekrup, dan perangkat keras 

Sambungan terkuat yang dapat Anda buat antara komponen cetak 3D adalah sambungan yang 
disatukan dengan perangkat keras logam. Koneksi ini bagus untuk hal-hal yang lebih dari sekadar 
prototipe - misalnya, suku cadang untuk robot atau mekanisme. 

Saat mengintegrasikan perangkat keras ke dalam desain Anda, sertakan perangkat keras tersebut 
dalam model SketchUp Anda. Lakukan pengukuran bagian yang Anda rencanakan untuk 
digunakan dan buat modelnya di SketchUp. Setelah Anda membuat komponen ini, simpan ke 
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component library sehingga Anda bisa menggunakannya lagi dengan sekali klik. Ingatlah poin-
poin ini: 

 Ingatlah untuk memasukkan jarak yang cukup di lubang Anda untuk memasang perangkat 
keras. 

 Jika Anda menggunakan baut atau sekrup dan tidak ingin menyertakan mur yang cocok, 
triknya adalah dengan sedikit mengecilkan ukuran lubang. Benang baut akan memotong 
kelebihan plastik dan menahannya dengan kuat di tempatnya, seperti yang ditunjukkan 
pada Gambar 9-22. 

 Pemasok perangkat keras online seperti McMaster Carr dan Amazon Supply menyediakan 
semua pengikat yang diketahui umat manusia. Jika toko perkakas lokal Anda tidak 
memiliki apa yang Anda cari, toko online ini akan memilikinya. 

 

Gambar 9-22: Tidak ada yang mengatakan kekuatan seperti baut yang terbuka 

Menguji komponen bergerak model Anda 

Sistem koneksi apa pun yang Anda gunakan, selalu uji terlebih dahulu. Sebelum Anda mulai 
mencetak proyek raksasa, buat versi kecil lampiran. Hanya membutuhkan beberapa menit untuk 
mendesain dan mencetak 3D, dan akan memberi Anda kesempatan untuk memastikan 
sambungan berfungsi dengan baik. Tidak ada yang lebih buruk daripada memodelkan sistem 
sambungan dan kemudian menemukan bahwa mereka tidak cocok satu sama lain. 

Mendesain Hal-Hal yang Bergerak 

Pencetakan 3D sesuatu yang Anda rancang di SketchUp itu keren. Pencetakan 3D sesuatu yang 
bergerak bahkan lebih keren. Bagian ini berfokus pada beberapa fitur yang dapat Anda sertakan 
untuk membuat kreasi Anda lebih dari sekadar bongkahan plastik tak bergerak berbentuk 
menarik. 

Captive joints  

Captive joint adalah koneksi bergerak yang keluar dari printer 3D Anda yang sudah terpasang dan 
berfungsi. Sambungan tawanan cenderung berupa engsel mekanis sederhana, sambungan bola, 



199 
 

dan mata rantai. Kesederhanaan mereka adalah kekuatan mereka. Printer 3D dapat dengan 
cepat membuat objek dengan ratusan captive joint yang memerlukan waktu berhari-hari untuk 
membuatnya dengan tangan. Figur aksi, pakaian, dan kalung rantai pada Gambar 923 adalah 
contoh sambungan penahan sederhana yang dirangkai menjadi struktur yang kompleks. 

 

Gambar 9-23: Captive joint menghidupkan kekuatan multiplikasi. 

Membuat captive joint membutuhkan trial and error. Anda harus bereksperimen untuk 
mendapatkan kombinasi jarak bebas dan bentuk yang tepat. Ingatlah prinsip-prinsip ini saat Anda 
mengerjakan captive joint: 

 Gunakan komponen saat membangun struktur dengan sambungan penahan; mereka 
memungkinkan Anda secara otomatis mengubah semua sambungan sekaligus saat Anda 
bekerja. 

 Bagaimana Anda mendesain captive joint bergantung pada teknologi pencetakan 3D 
tertentu yang Anda gunakan. Printer 3D berbasis SLS dapat membuat captive joint yang 
lebarnya beberapa milimeter. Printer FDM dapat membuat sambungan yang sangat kuat, 
tetapi objek yang dicetak harus jauh lebih besar. 

 Sebuah struktur hanya akan sekuat bagian terlemahnya. Jangan membuat persendian 
terlalu halus sehingga terlepas di tangan Anda. 

 Uji bagian cetak dari struktur Anda saat Anda bekerja. Ingat, pencetakan 3D itu murah, 
dan dengan captive joint, Anda mendorong batas teknologi. Benda uji akan membantu 
Anda memeriksa pekerjaan Anda dan menjaga kewarasan Anda. 

Pin 

Pin adalah tool kelengkapan snap bulat kecil yang ditekan ke tempatnya untuk membuat 
sambungan. Mereka bisa menjadi pengganti perangkat keras yang serbaguna. Pada Gambar 9-
24, satu pin bertindak sebagai titik rotasi, dan dua atau lebih akan menyatukan bagian-bagian 
dengan kuat. 
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Gambar 9-24: Sistem sambungan pin yang digunakan untuk membuat mainan sederhana. 

Pin itu seperti baut, kecuali Anda harus membuatnya dalam ukuran dan bentuk yang Anda 
butuhkan. Anda juga dapat mencetak lebih banyak saat kehabisan. 

 Saat mendesain pin Anda, berikan satu sisi yang rata. Sisi datar memberi Anda cara untuk 
membuat pin tanpa menggunakan bahan pendukung - sekaligus menjaga lidah tetap 
horizontal ke platform bangunan. Proses ini juga mencegah pin yang sudah jadi meluncur 
dari meja Anda. 

 Buat pin Anda menjadi komponen sehingga Anda dapat dengan mudah memodifikasi 
semuanya sekaligus jika perlu. 

 Saat mendesain proyek dengan sambungan pin, upayakan untuk menstandarisasi 
sejumlah kecil ukuran pin. Standardisasi membantu menjaga segala sesuatunya rapi dan 
menyederhanakan perakitan. 

Gear (roda gigi) 

Gear/Roda gigi sangat bagus untuk membuat gerakan kompleks atau mentransfer gerakan 
melalui mekanisme. Itu mungkin deskripsi yang paling bersahaja dari lubang kelinci terdalam di 
zaman industri. Roda gigi ada di setiap perangkat mekanis yang dapat Anda bayangkan. Mereka 
telah ada dalam beberapa bentuk atau lainnya sejak sebelum sejarah yang tercatat, dan 
merupakan dasar dari perangkat pintar yang tak terhitung jumlahnya yang memungkinkan 
kehidupan sehari-hari. 

Membuat roda gigi itu menyenangkan dan menginspirasi banyak orang untuk mulai 
bereksperimen dengan pencetakan 3D. Gambar 9-25 menunjukkan sistem roda gigi sederhana 
yang dapat menjadi lebih dari itu. Untuk membantu Anda memulai, berikut beberapa prinsip 
dasar membuat roda gigi: 

 Roda gigi harus memiliki jarak bebas di antara permukaannya agar berfungsi dengan baik. 
Roda gigi yang terlalu pas akan macet. Sertakan jarak bebas pada titik rotasi dan di antara 
gigi persneling dan gigi pasangannya. 

 Ekstensi SketchUp yang disebut Involute Gears mengotomatiskan proses pembuatan roda 
gigi. Pembuat ekstensi belum menyediakannya di Extension warehouse SketchUp, jadi 
Anda harus mencarinya dengan menelusuri plugin perkakas sketsa melalui Google. 

 Membuat roda gigi yang dioptimalkan dari awal adalah bentuk seni teknis yang tidak 
dapat dipraktikkan. Jika Anda ingin mempelajari lebih lanjut tentang merancang roda gigi, 
saya sarankan mendapatkan salinan Buku Pegangan Mesin (Pers Industri). Setelah hampir 
satu abad dicetak, buku ini adalah standar emas untuk segala hal yang berhubungan 
dengan peralatan 
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Gambar 9-25: Selamat datang di Revolusi Industri Baru. Waktunya bersiap. 
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Bab 6 

Melihat Model Anda dengan Berbagai Cara 

Bekerja dengan Style dan  

Dalam Bab ini Anda akan dapat : Shadow 

 Memberi model Anda beberapa style 

 Mengedit, menyimpan, dan berbagi style 

 Mencari tahu tentang panel Shadows 

 Menggunakan shadow untuk membuat model terlihat lebih baik 

 Menampilkan dan mempelajari shadow (bayangan) yang akurat 

SketchUp adalah tool yang sangat mumpuni untuk menyajikan barang yang Anda buat. 
Memutuskan bagaimana tampilan model Anda - longgar dan samar, semi-fotorealistik, atau apa 
pun di antaranya - bisa sangat menyenangkan, dan membuat keputusan yang tepat dapat 
membantu model Anda mengkomunikasikan apa yang seharusnya mereka lakukan. 

Paruh pertama bab ini adalah tentang style. Jika Anda adalah tipe orang yang suka menggambar, 
Anda siap menerima hadiah. Jika Anda tidak dapat menggambar garis lurus dengan penggaris, 
Anda akan mendapatkan hadiah yang lebih besar. Style SketchUp adalah tentang memutuskan 
bagaimana geometri Anda - semua face dan edge Anda - akan benar-benar terlihat. 

Fitur Bayangan SketchUp adalah tool hebat lainnya untuk menampilkan model. Menampilkan 
bayangan juga merupakan pengoperasian yang mudah; itu masalah mengklik tombol. Saat Anda 
menambahkan bayangan ke tampilan model Anda, bayangan tersebut terlihat lebih realistis, 
lebih akurat, dan lebih mudah dibaca. Dan, yah, lebih enak. Anda akan mengerti apa yang kami 
maksud. 

Menata Tampilan Model Anda 

Di SketchUp, style adalah kumpulan setelan yang mengontrol tampilan tepi, face, dan 
Background model Anda. Untuk mengubah keseluruhan tampilan model, Anda hanya perlu 
menerapkan style yang berbeda. Misalnya, Gambar 10-1 menunjukkan empat style berbeda yang 
diterapkan pada model rumah yang sama. Lebih keren lagi, mengubah style model adalah operasi 
sekali klik. Style juga memungkinkan Anda memberi watermark pada model dan mengontrol 
bagaimana isyarat pemodelan di layar muncul.  

Anda juga dapat menyesuaikan style, yang sedikit lebih berhasil daripada sekadar menerapkan 
style ke model, tetapi bisa dibilang lebih memuaskan. Bagian ini menawarkan pedoman untuk 
menggunakan style dan menjelaskan cara menerapkan, mengedit, membuat, dan berbagi style. 

Memilih bagaimana dan di mana menerapkan style 

Style tidak terbatas. Dengan jutaan permutasi dari lusinan setelan, Anda dapat menghabiskan 
sepanjang hari mengutak-atik penampilan model Anda. Tetapi Anda tidak punya waktu seharian, 
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jadi ingatlah satu pertanyaan: Apakah setelan ini membantu model Anda mengatakan apa yang 
Anda ingin katakan? Fokus pada apa yang penting. Style memang keren, tidak diragukan lagi, 
tetapi membuatnya berguna adalah kunci untuk mengendalikannya. 

 

 

Gambar 10-1: Gunakan style untuk membuat model Anda terlihat seperti yang Anda inginkan. 

Ingat 

Untuk membantu Anda membuat keputusan cerdas tentang penggunaan style SketchUp, 
pertimbangkan setidaknya dua faktor saat Anda menata model: 

 Subjek tingkat kelengkapan model Anda: Pesan style samar untuk model yang masih 
berkembang. Pesan yang dikirim oleh style samar adalah”ini tidak permanen/Saya 
terbuka untuk saran/semua ini dapat berubah jika perlu". Saat desain semakin mendekati 
bentuk akhirnya, style dapat membuat model Anda tampak tidak terlalu kasar dan lebih 
halus. Dengan cara ini, style dapat mengkomunikasikan berapa banyak masukan yang 
dapat dimiliki audiens dan keputusan apa yang masih perlu dibuat. 

 Seberapa banyak audiens Anda tahu tentang desain: Juri sekolah arsitektur dan klien non-
desainer yang membangun rumah untuk pertama kalinya memandang style secara 
berbeda. Profesional desain lebih berpengalaman dalam memahami objek 3D dari 
representasi 2D, jadi mereka tidak membutuhkan banyak petunjuk visual untuk 
membantunya. Tujuan utama Styles adalah memberikan petunjuk ini, jadi inilah 
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pedomannya: Semakin banyak audiens Anda tahu tentang desain, semakin sederhana 
Anda harus mempertahankan style Anda. 

Sebelum Anda mendalami style, ingatlah juga bahwa sedikit style akan sangat membantu. Tidak 
peduli seberapa menggoda untuk menjadi sangat liar dengan pengaturan style, tolong tahan 
keinginannya. Ingatlah bahwa tujuan style adalah untuk membantu model Anda berkomunikasi, 
bukan membuatnya terlihat”cantik" atau”keren". Jika style karya Anda mengalahkan isinya, 
kurangi style tersebut. 

Menerapkan Style ke model Anda 

Cara termudah untuk mulai menerapkan style adalah dengan menggunakan style yang telah 
dibuat sebelumnya yang disertakan dengan SketchUp. Anda menemukan banyak sekali, dan itu 
bagus karena melihat apa yang telah dilakukan adalah cara terbaik untuk melihat apa yang 
mungkin. Saat Anda menjalani bagian ini, Anda pasti akan mendapatkan ide untuk style Anda 
sendiri, dan di sanalah kesenangan dimulai. 

Menerapkan style SketchUp ke model Anda adalah proses tiga langkah yang berjalan seperti ini: 

 Buka panel style dengan mengklik panah yang mengarah ke kanan di Default Tray 
(Windows) atau memilih Window ⇒ Styles (Mac). 

 Pada tab Select (yang terbuka secara default), pilih koleksi style dari daftar drop-down 
Styles Collections. Kami akan segera memperkenalkan Anda pada koleksi yang sudah 
diinstal sebelumnya dengan SketchUp. 

 Klik style di window Styles untuk menerapkannya ke model Anda. 

Tips 

Ini mungkin mengejutkan, tetapi tidak mungkin untuk melihat model Anda tanpa style sama 
sekali karena style hanyalah kombinasi dari pengaturan tampilan. Beberapa style lebih menarik 
daripada yang lain, tetapi apa pun yang Anda lakukan, Anda harus selalu menerapkan style. Jika 
Anda menginginkan tampilan model Anda yang relatif netral, pilih style dalam koleksi Style 
Default. 

Hebatnya, SketchUp tidak meninggalkan Anda dalam kedinginan dalam hal konten. SketchUp 
hadir dengan banyak contoh untuk Anda mulai. Gambar 10-2 menunjukkan daftar drop-down 
Styles Collections. 
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Gambar 10-2: Daftar buka-bawah Koleksi Style adalah tempat Anda menemukan semua style 
Anda. 

Berikut pengantar singkat untuk opsi paling menarik di daftar tarik-turun Koleksi Style: 

 Dalam Model: Koleksi Dalam Model menunjukkan semua style yang telah Anda terapkan 
ke model Anda. Koleksinya melacak setiap style yang pernah Anda terapkan pada model 
Anda, baik style tersebut masih diterapkan atau tidak. Untuk melihat daftar style saat ini 
di file SketchUp Anda: 

o Pilih koleksi Dalam style Model untuk menampilkan daftar style yang telah Anda 
terapkan ke model Anda. 

o Klik menu flyout Details dan pilih Purge Unused untuk menyingkirkan style apa 
pun yang tidak Anda gunakan saat ini. 

 Style Default: Pikirkan dasar. Style ini seminimal mungkin: Background putih, edge hitam, 
muka depan dan belakang putih-abu-abu, dan tidak ada efek edge yang mewah. Gunakan 
style ini untuk mendapatkan titik awal yang bersih sehingga Anda bisa mulai dengan 
sederhana dan membangun dari sana. 

 Pemodelan Foto: Style ini memudahkan pekerjaan saat Anda membuat model bertekstur 
foto - seluruhnya tercakup dalam foto.  

 Tepi Sketsa: Style ini menggunakan garis nyata yang digambar tangan (juga disebut style 
nonphotorealistic, atau NPR), bukan style digital untuk merender tepi, membuat model 
Anda terlihat lebih seperti sketsa manual daripada sebelumnya. Anda dapat dengan aman 
menggunakan style edge Sketsa untuk menyampaikan salah satu dari berikut ini: 

o Bahwa desain Anda sedang dalam proses 
o Bahwa model Anda adalah proposal dan bukan produk jadi 
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o Bahwa Anda menyambut umpan balik dalam segala bentuk 

 

DARI REALISME: NPR STYLE 

 

Dalam dunia perangkat lunak pemodelan 3D, trennya mengarah ke fotorealisme. Sinar lampu 

digital dipantulkan sekitar satu miliar kali di dalam komputer Anda sampai Anda dapat melihat 

setiap kilatan sinar matahari di setiap titik embun di setiap helai rumput di halaman. Standar 

kesempurnaan adalah seberapa dekat model tersebut terlihat seperti sebuah foto, dan dalam 

banyak kasus, standar tersebut telah terpenuhi - kami telah melihat rendering komputer yang 

terlihat lebih hidup daripada kehidupan itu sendiri. 

 

 

Tetapi bagaimana dengan model bangunan atau hal lain yang belum selesai sepenuhnya? 

Mungkin Anda seorang arsitek yang merancang rumah untuk klien. Jika Anda tidak yakin jenis 

ubin apa yang akan Anda gunakan pada atap Anda, bagaimana cara membuat rendering 

fotorealistik itu? Anda bisa terus maju dan melempar ubin tua ke sana sebagai pengganti, tapi 

itu bisa menjadi bumerang. Klien Anda dapat membenci ubin dan memutuskan untuk tidak 

mempekerjakan Anda tanpa pernah memberi tahu Anda alasannya, dan semua karena sesuatu 

yang bahkan tidak Anda pilih. 

 

Yang Anda butuhkan adalah cara untuk menunjukkan hanya keputusan yang telah Anda buat 

sejauh ini, dan itulah mengapa arsitek dan desainer lain membuat sketsa alih-alih rendering 

fotorealistik. Saat Anda mendesain, keputusan tidak terjadi sekaligus. Anda harus dapat 

menambahkan detail saat desain Anda berkembang. Sketsa memungkinkan Anda melakukan 

itu karena ia menawarkan kontinum dari”kartun" ke fotografi, dengan segala sesuatu di 

antaranya. Gambar berikut adalah ilustrasi untuk ini. 

 

Program seperti SketchUp menawarkan NPR, atau rendering nonphotorealistic, sebagai cara 

untuk memecahkan masalah ini bagi orang yang mendesain dalam 3D. Alih-alih menghabiskan 

daya prosesor untuk membuat representasi yang terlihat seperti foto, orang-orang yang 

membuat SketchUp justru mengambil arah yang berlawanan; mereka telah membuat tool 

yang memungkinkan Anda membuat gambar yang berguna selama proses desain. Dan karena 
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mesin NPR SketchUp bekerja dalam waktu nyata, Anda dapat membuat perubahan dengan 

cepat, di depan pemirsa Anda. 

 

 

 

 

Mengedit Style Anda 

Jika Anda ahli di dapur, Anda mungkin pernah mendengar bahwa memasak adalah seni dan 
memanggang adalah ilmu. Memasak memungkinkan Anda bereksperimen - saat Anda membuat 
saus, menambahkan sedikit saus ini dan sedikit saja tidak akan merusak apa pun. Namun, 
mengambil kebebasan dengan resep kue dapat dengan mudah mengubah kue menjadi palang 
pintu. Aidan mengetahui hal ini saat dia membuat palang pintu cokelat yang cantik untuk ulang 
tahun istrinya belum lama ini… 

Untungnya, membuat style Anda sendiri memiliki lebih banyak kesamaan dengan memasak 
daripada dengan memanggang. Silakan bermain-main; Anda tidak dapat melakukan kerusakan 
yang tidak dapat dipulihkan. Bermain dengan style tidak memengaruhi geometri model. Karena 
style hanyalah kombinasi pengaturan, Anda selalu dapat kembali ke keadaan sebelum Anda 
memulai. 

Dari tiga tab di panel Styles, Edit jelas merupakan kelompok paus biru. Karena Anda menemukan 
begitu banyak kontrol dan setelan di sini, desainer SketchUp memecah tab Edit menjadi lima 
bagian berikut: Tepi, Face, Background, Watermark, dan Pemodelan (untuk petunjuk pemodelan 
di layar). 

Ingat 

Untuk mengakses setiap bagian, pertama buka panel Styles dengan mengklik panah kanan di 
Default Tray (Windows) atau pilih Window => Styles (Mac). Kemudian klik tab Edit, dan pilih ikon 
yang sesuai dengan bagian yang pengaturannya ingin Anda edit. 

Bagian berikut menjelaskan setiap bagian dari tab Edit secara rinci; kami juga memberikan saran 
untuk menggunakan beberapa pengaturan. 
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MEMPERKENALKAN STYLE BUILDER 

 

Jika Anda menggunakan SketchUp versi Pro, Anda memiliki akses ke Style Builder. Ini adalah 

aplikasi yang sepenuhnya terpisah (seperti LayOut) yang diletakkan di komputer Anda saat 

Anda menginstal SketchUp. 

 

Style Builder memungkinkan Anda membuat style NPR berdasarkan edge yang Anda gambar. 

Ya, benar - Anda dapat membuat model SketchUp terlihat seperti Anda menggambarnya 

dengan tangan menggunakan media pilihan Anda (cat jari, Sharpie, pisau berdarah…). Yang 

Anda butuhkan hanyalah pemindai dan perangkat lunak seperti Photoshop, dan Anda siap 

melakukannya. Hal terbaik tentang style yang Anda buat dengan Style Builder adalah style itu 

benar-benar unik. Kecuali jika Anda membaginya dengan orang lain, tidak ada yang bisa 

membuat model SketchUp yang terlihat seperti milik Anda. 

 

Karena Style Builder adalah program lain dan karena hanya disertakan dalam SketchUp versi 

Pro, kami tidak membahas Style Builder secara mendalam di buku ini. 

 

 

Tweak pengaturan tepi 

 

Bagian edge rumit karena sedikit berubah tergantung pada jenis style yang saat ini Anda terapkan 
pada model Anda. Style NPR memiliki pengaturan yang berbeda dari style biasa, non-NPR. 
Gambar 10-3 menunjukkan kedua versi dari bagian Edge. 



209 
 

 

Gambar 10-3: Bagian edge hadir dalam dua jenis: reguler (kiri) dan NPR (kanan). 

Ingat 

SketchUp hadir dengan dua jenis style: reguler dan NPR. Di NPR, SketchUp menggunakan garis 
digital yang digambar dengan tangan untuk membuat edge dalam model Anda. Semua style 
dalam koleksi edge Sketsa, serta semua style dalam koleksi Style Aneka, adalah style NPR. Karena 
Anda dapat membuat style Anda sendiri berdasarkan style yang sudah ada, semua style yang 
Anda buat menggunakan pengaturan edge dari salah satu style NPR ini juga merupakan style 
NPR. 

Berikut penjelasan tentang beberapa pengaturan yang kurang jelas di bagian Edge; lihat Gambar 
10-4 untuk referensi visual: 

 Back Edge: Mengaktifkan setelan ini memberi tahu SketchUp untuk menggambar semua 
edge model Anda yang dikaburkan (tersembunyi di balik face) sebagai garis putus-putus. 
Saat Anda menampilkan edge belakang, Anda dapat lebih mudah menyimpulkan edge 
dan titik daripada saat edge belakang tidak ditampilkan. Selain itu, tidak ada yang lebih 
baik daripada serangkaian garis putus-putus untuk membuat gambar teknis terlihat 
mengesankan dan rumit. 

 Profiles: Memilih kotak centang Profiles memberi tahu SketchUp untuk menggunakan 
garis yang lebih tebal untuk edge yang menguraikan bentuk dalam model Anda. 
Menggunakan garis profil adalah aturan menggambar standar yang sudah ada sejak lama. 
Meskipun model sering kali terlihat lebih baik dengan Profil aktif, menampilkan Profil ada 
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harganya: menggambar Profil membutuhkan lebih banyak tenaga komputer, yang dapat 
menurunkan performa model Anda. Jika Anda bekerja dengan file besar, pikirkan dua kali 
sebelum Anda mengaktifkan Profil. 

 Depth Cue: Menggunakan ketebalan garis yang berbeda untuk menyampaikan 
kedalaman adalah aturan menggambar populer lainnya. Objek yang paling dekat dengan 
penonton digambar dengan garis paling tebal, sedangkan objek terjauh dalam 
pemandangan digambar dengan garis paling tipis. 

Depth Cue secara otomatis menerapkan efek ini ke model Anda. Ketika kotak centangnya 
dipilih, Depth Cue secara dinamis menetapkan ketebalan garis (draf menyebutnya sebagai 
bobot garis) sesuai dengan seberapa jauh dari Anda benda-benda dalam model Anda. 
Jumlah yang Anda ketik adalah jumlah ketebalan garis yang Anda inginkan dan ketebalan 
dalam piksel dari garis paling gemuk yang akan digunakan SketchUp. Kami 
merekomendasikan ketebalan garis maksimum 5 atau 6 piksel. 

 Tips : Satu hal lagi: Menggunakan Isyarat Kedalaman dan Profil berlebihan. Pilih satu saja.  

 Halo: Saya sangat berharap Halo tersedia untuk style non-NPR karena itu sangat bagus. 
Halo hanya mengakhiri baris tertentu sebelum bertemu dengan yang lain, menciptakan 
lingkaran ruang kosong di sekitar objek di latar depan. Ini membuat model Anda terlihat 
rapi dan mudah dibaca. Faktanya, ini adalah trik menggambar yang digunakan pengguna 
pensil dan kertas selamanya untuk menyampaikan kedalaman. Baca komik favorit Anda, 
dan kemungkinan besar Anda akan menemukan efek ini. (Jika Anda tidak memilikinya, 
Rebecca adalah penggemar http://xkcd.com.) Nomor yang Anda ketik di kotak Halo 
menunjukkan jumlah ruang bernapas yang diberikan SketchUp. Satuan ukuran adalah 
piksel, tetapi tidak ada ilmu nyata untuk itu; hanya bermain dengan nomor tersebut 
sampai semuanya terlihat benar untuk Anda. Untuk apa nilainya, Aidan suka 
meningkatkannya. 

 Level of Detail: Saat Anda menggeser pengontrol Level of Detail (yang hanya muncul 
ketika Anda telah menerapkan style NPR) bolak-balik, Anda secara efektif memberi tahu 
SketchUp seberapa sibuk Anda ingin model terlihat. Semakin jauh ke kanan Anda 
menggesernya, semakin banyak edge Anda yang ditampilkan SketchUp. 
Bereksperimenlah dengan pengaturan ini untuk melihat apa yang terbaik untuk model 
Anda. Dua gambar terakhir pada Gambar 10-4 menunjukkan slider Level of Detail yang 
diposisikan di kiri dan kanan. 

 Color: Gunakan daftar tarik-turun Warna untuk memberi tahu SketchUp warna apa yang 
digunakan untuk semua edge dalam model Anda. Inilah yang dilakukan setiap opsi: 

o All Same: Opsi ini memberi tahu SketchUp untuk menggunakan warna yang sama 
untuk semua edge dalam model Anda. Pilih warna dengan mengklik bidang warna 
di sebelah kanan dan memilih warna. 

o By Material: Opsi ini mengubah warna edge model Anda dari bahan apa pun yang 
mereka lukis. Karena kebanyakan orang tidak tahu bahwa Anda dapat mengecat 
edge dengan warna yang berbeda, setelan ini jarang digunakan. 

o By Axis: Inilah permata yang berguna, namun tersembunyi. Opsi ini memberi tahu 
SketchUp untuk membuat semua yang sejajar dengan salah satu sumbu berwarna 

http://xkcd.com/
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menjadi warna sumbu itu. edge yang tidak sejajar dengan sumbu mana pun tetap 
hitam. Mengapa ini sangat penting? Jika ada yang tidak beres dengan model Anda 
- permukaan tidak akan menonjol atau garis tidak akan meresap - mengalihkan 
warna edge ke By Axis adalah hal pertama yang harus Anda lakukan. Anda akan 
terkejut betapa banyak sisi Anda yang tidak seperti yang terlihat.  
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Gambar 10-4: Pilih di antara pengaturan edge untuk memberikan model Anda tampilan yang 
diinginkan, dari realistis hingga samar. 

 

IN A FOG? 

 

Jika Anda mencari sesuatu untuk memberikan kesan kedalaman dalam tampilan model Anda, 

tidak terlihat lagi selain fitur Fog. Fog melakukan persis seperti yang dikatakannya - membuat 

model Anda terlihat seperti diselimuti fog (lihat gambar yang menyertai). Anda akan berpikir 

bahwa fitur yang rapi ini akan menjadi sedikit rumit, tetapi justru sebaliknya. Ikuti tiga langkah 

berikut untuk membiarkan fog menyelimuti model Anda: 

 

1. Buka Fog Panel dengan memilih Window  => Default tray ⇒ Fog (Windows) atau 
Window=> Fog (Mac). 

2. Pilih kotak centang Tampilan Fog untuk mengaktifkan efek fog. 
3. Bermain-main dengan kontrol sampai Anda menyukai apa yang Anda lihat. 

 

Kami berharap proses pengendalian tampilan fog lebih ilmiah, tetapi sebenarnya tidak. Anda 

hanya bermain-main dengan slider sampai Anda mendapatkan jumlah fog yang Anda inginkan. 

Jika Anda benar-benar perlu mengetahuinya, inilah yang dilakukan slider: 

 

 Penggeser kiri (100%): Ini mengontrol titik di ruang di mana fog benar-benar buram. 
Saat Anda memindahkan penggeser dari kiri ke kanan, Anda memindahkan titik”yang 
benar-benar tidak terlihat" lebih jauh. 

 Penggeser kanan (0%): Ini mengontrol titik di ruang tempat fog mulai muncul di model 
Anda. Saat semuanya berjalan ke kanan (menuju tak terhingga), Anda tidak akan 
melihat fog. 
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Mengubah tampilan Face 

Bagian Face pada panel Style, yang ditunjukkan pada Gambar 10-5, sangat sederhana - setidaknya 
dibandingkan dengan bagian edge (sebenarnya tidak?). Area antarmuka pengguna SketchUp ini 
mengontrol penampilan face, atau permukaan, dalam model Anda. Dari sini, Anda dapat 
mengubah warna, visibilitas, dan tembus pandangnya. Bagian berikut menjelaskan setiap elemen 
secara rinci. 

 

Gambar 10-5: Bagian Face mengontrol penampilan face model Anda. 
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WARNA DEPAN/WARNA BELAKANG 

Di SketchUp, setiap face yang Anda buat memiliki bagian belakang dan depan. Untuk memilih 
warna default untuk semua face baru yang Anda buat, klik bidang warna Depan dan Belakang, 
lalu pilih warna. Kami merekomendasikan untuk tetap menggunakan nada netral untuk default 
Anda; Anda selalu bisa mengecat face individu nanti. 

Tips 

Terkadang saat Anda menjadi model di SketchUp, face terbalik. Ikuti langkah-langkah berikut 
untuk membalik face sehingga sisi kanan terlihat: 

1. Pilih face yang ingin Anda balik. 
2. Context-clicks dan pilih Face Terbalik. 

Masalah Teknis 

Mengetahui face mana yang depan dan mana yang belakang sangat penting jika Anda berencana 
mengekspor model Anda ke program lain atau membuat model 3D yang dapat dicetak. Beberapa 
program, seperti Autodesk 3ds Max, menggunakan perbedaan antara depan dan belakang untuk 
menentukan apa yang akan ditampilkan. Dalam kasus ini, menunjukkan sisi face yang salah dapat 
memberikan hasil yang tidak terduga.  

STYLE 

Face style menyediakan mode berbeda untuk melihat face dalam model Anda. Anda dapat 
beralih di antara mereka sesuka Anda tanpa memengaruhi geometri Anda. Setiap style Face 
memiliki tujuannya, dan semuanya ditunjukkan pada Gambar 10-6: 

 Wireframe: Dalam mode Wireframe, face Anda tidak terlihat. Karena Anda tidak dapat 
melihatnya, Anda tidak dapat memengaruhi mereka. Hanya edge Anda yang terlihat, yang 
membuat mode ini berguna untuk melakukan dua hal: 

o Saat Anda memilih tepi, alihkan ke mode Wireframe untuk memastikan bahwa 
Anda telah memilih apa yang ingin Anda pilih. Karena tidak ada face yang 
menghalangi pandangan Anda, mode Wireframe membantu Anda memilih yang 
Anda inginkan saja. Pengaturan edge Belakang juga berguna untuk ini. 

o Setelah Anda menggunakan Intersect face, Anda biasanya memiliki edge yang 
menyimpang. Wireframe adalah cara tercepat untuk menghapusnya karena Anda 
dapat melihat apa yang Anda lakukan. 

 Hidden Line: Mode Hidden Line menampilkan semua face Anda menggunakan warna apa 
pun yang Anda gunakan untuk Background; itu sesederhana itu. Jika Anda mencoba 
membuat gambar garis hitam-putih bersih yang terlihat seperti ilustrasi teknis, buat 
Background Anda putih. (Kita akan membahas bagaimana nanti di bab ini.) 

 Shaded: Mode Face ini menampilkan warna pada face Anda. Face yang dicat dengan 
warna solid tampak warna itu. Face yang telah Anda tambahkan tekstur akan ditampilkan 
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dengan warna yang paling mendekati warna keseluruhannya. Jika tekstur Anda memiliki 
banyak cokelat di dalamnya, SketchUp mengambil warna cokelat dan menggunakannya. 

o Untuk model dengan banyak tekstur ini, memilih mode Shaded benar-benar dapat 
mempercepat pengorbanan, zooming, dan sebaliknya menavigasi. Kecuali jika 
Anda benar-benar perlu melihat tekstur diterapkan ke face model Anda, coba 
tetap dalam mode Berbayang saat Anda mengerjakan model. 

 Shaded Using Textures: Diarsir Menggunakan Tekstur membuat tekstur terlihat. Karena 
mode ini membebani komputer Anda, ini juga bisa menjadi mode paling lambat untuk 
digunakan. Nyalakan hanya saat Anda mengerjakan model kecil, atau saat Anda perlu 
melihat teksturnya. Tentunya, jika Anda menginginkan efek fotorealistik, ini adalah mode 
yang harus dipilih. 

 Display Shaded Using All Same: Mode ini adalah cara cepat untuk memberikan model 
Anda skema warna yang disederhanakan. Mode ini menggunakan warna muka depan dan 
belakang default Anda untuk mengecat model Anda. Anda juga dapat menggunakan 
setelan ini untuk memeriksa orientasi face Anda jika Anda mengekspor model ke program 
pemodelan 3D lainnya. 

 X-Ray: Tidak seperti menggunakan bahan tembus cahaya hanya pada beberapa face Anda 
(seperti kaca dan air), membalik mode X-Ray memungkinkan Anda melihat semua face 
Anda. Gunakan X-Ray untuk melihat menembus dinding atau lantai dan menunjukkan apa 
yang ada di baliknya. Jika Anda berada dalam tampilan rencana (overhead), mode Sinar-
X adalah cara yang bagus untuk mendemonstrasikan bagaimana hubungan tingkat lantai 
dengan yang di bawahnya. 
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Wireframe 
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Hidden Line 
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Shaded 
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Shaded Using Texture 



220 
 

 

Using All Shame 
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All Same pada X-Ray Mode 

Gambar 10-6: Gunakan style Face untuk mengubah tampilan face Anda. 

TRANSPARANSI 

Menampilkan transparansi (seperti pada bahan tembus cahaya) adalah operasi yang sangat 
melelahkan untuk ditangani SketchUp dan komputer Anda, sehingga Anda dapat memutuskan 
cara menampilkan bahan tembus cahaya: 

 Enable Transparency: Kosongkan kotak centang ini untuk menampilkan bahan tembus 
cahaya sebagai buram. Matikan transparansi untuk mempercepat kinerja SketchUp jika 
Anda merasa itu melambat. 

 Transparency Quality Jika Anda memutuskan untuk menampilkan transparansi, Anda 
dapat lebih menyempurnakan performa sistem Anda dengan memberi tahu SketchUp 
cara menampilkan transparansi tersebut. Di versi SketchUp sebelumnya, Anda memiliki 
pilihan performa yang lebih baik, grafis yang lebih bagus, atau rata-rata dari keduanya. 
SketchUp 2017 menyederhanakan opsi ini menjadi lebih cepat atau lebih bagus; saat 
Nicer dipilih, Anda dapat menyesuaikan opasitas model dengan slider X-Ray Opacity. 
Semakin rendah opacity, semakin tembus model Anda. 

Setting Background 
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Di bagian Background pada panel Styles, Anda memilih warna dan memutuskan apakah Anda 
ingin melihat langit dan bidang tanah. Lihat Gambar 10-7 untuk melihat bagian Background, 
bersama dengan gagasan tentang cara kerjanya. Anda memiliki opsi berikut di bagian 
Background: 

 Background: Untuk kebanyakan model, saya menyetel Background menjadi putih 
tradisional. 

 Sky: Menampilkan langit di window pemodelan Anda membuatnya sedikit lebih realistis, 
tetapi tujuan sebenarnya dari fitur ini adalah memberikan titik referensi untuk model 
Anda. Dalam tampilan 3D hal-hal besar seperti arsitektur, senang bisa melihat cakrawala. 
Alasan lain untuk menyalakan langit adalah untuk mengatur suasana hati - perlu diingat 
bahwa langit tidak selalu biru. Beberapa rendering SketchUp yang indah berwarna oranye 
matahari terbenam (atau mungkin musim dingin nuklir). 

 Ground: Kami bukan penggemar berat fitur Tanah, dan inilah alasannya: Sangat sulit 
untuk menemukan warna dasar yang terlihat cukup bagus, apa pun yang Anda bangun. 
Selain itu, Anda tidak dapat menggali ke dalam bumi untuk membuat ruang cekung 
(seperti halaman) dengan Ground diaktifkan. Alih-alih mengaktifkan fitur ini, coba buat 
bidang tanah Anda sendiri dengan muka dan tepinya. Metode ini lebih fleksibel, dan 
menurut kami terlihat lebih baik. 

 

Gambar 10-7: Gunakan bagian Background untuk menghidupkan langit dan tanah dan untuk 
memilih warna 

Bekerja dengan Watermark 

Watermark jauh lebih mudah dipahami jika Anda tidak menganggapnya sebagai watermark 
sebenarnya yang digunakan untuk merek model. Alih-alih, pikirkan watermark sebagai grafik 
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yang dapat Anda terapkan di belakang atau di depan model Anda untuk menghasilkan efek 
tertentu. Berikut beberapa hal yang dapat Anda lakukan dengan watermark SketchUp: 

 Simulasikan tekstur kertas, seperti beberapa style dalam koleksi Style Aneka. 

 Menerapkan logo atau grafik lain ke tampilan model Anda. 

 Lapisi gambar tembus pandang atau potongan di latar depan untuk menyimulasikan 
tampilan melalui window buram atau teropong. 

 Tambahkan Background fotografi seperti Luar Angkasa atau Di Dalam Ileum Saya untuk 
membuat pengaturan model yang unik. 

KONTROL WATERMARK 

Gambar 10-8 menunjukkan bagian Watermark pada panel Styles. Berikut pengantar singkat 
tentang apa yang dilakukan beberapa kontrol yang kurang jelas: 

 Tombol Add, Remove, dan Edit Watermark: Ikon +, -, dan roda gigi memungkinkan Anda 
untuk menambah, menghapus, dan mengedit (masing-masing) watermark dalam style 
yang Anda edit. 

 Watermark List: Daftar ini menunjukkan semua watermark Anda dalam kaitannya dengan 
ruang model, yang merupakan ruang yang ditempati model Anda. Semua watermark ada 
di depan atau di belakang model Anda, membuatnya menjadi overlay atau underlay. 

 Move Up atau Move Down arrows: Gunakan tombol ini untuk mengubah urutan 
watermark dalam tampilan model Anda. Pilih watermark yang ingin Anda pindahkan 
dalam daftar dan kemudian klik salah satu tombol ini untuk memindahkannya ke atas 
atau ke bawah secara berurutan. 
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Gambar 10-8: Bagian Watermark. 

MENAMBAHKAN WATERMARK 

Watermark sama sekali tidak sederhana, tetapi bekerja dengannya, secara ajaib, adalah. Ikuti 
langkah-langkah berikut untuk menambahkan watermark ke tampilan model Anda: 

1. Klik tombol Add Watermark. Kotak dialog Pilih Watermark muncul. 
2. Temukan gambar yang ingin Anda gunakan sebagai watermark dan kemudian klik 

tombol Open untuk membuka kotak dialog Create Watermark pertama yang 
ditunjukkan pada Gambar 10-9. Anda dapat menggunakan salah satu format file grafik 
berikut: TIFF, JPEG, PNG, dan GIF. 

Poin ini jauh di luar cakupan buku ini tetapi layak disebutkan karena Anda pasti akan 
membutuhkannya cepat atau lambat: Jika Anda ingin membuat watermark dari gambar 
yang bukan persegi panjang solid (seperti logo), Anda perlu menggunakan format file 
grafik yang mendukung saluran alfa (seperti PNG). Saluran alfa adalah layer informasi 
tambahan dalam file grafik yang menjelaskan area mana dari gambar Anda yang 
seharusnya transparan. Kedengarannya rumit, tetapi ini adalah konsep yang sangat 
mudah. Untuk membuat gambar dengan alpha channel, Anda membutuhkan software 
seperti Photoshop atau GIMP (GNU Image Manipulation Program). Coba cari saluran alfa 
di Google untuk informasi lebih lanjut. 

3. Ketikkan nama untuk Watermark Anda di kotak Nama. 
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4. Pilih apakah Anda ingin watermark baru Anda berada di Background atau di latar depan 
sebagai hamparan dan klik tombol Berikutnya. 

5. Putuskan apakah akan menggunakan watermark Anda sebagai topeng.  

Memilih kotak centang ini akan memberi tahu SketchUp untuk membuat watermark Anda 
transparan, yang merupakan simulasi watermark asli. Seberapa transparan setiap bagian 
didasarkan pada seberapa terang bagian itu. Putih adalah warna paling terang, jadi apa 
pun yang putih di watermark Anda menjadi transparan sepenuhnya. Hal-hal yang hitam 
mengubah warna Background Anda, dan semua yang ada di antaranya menjadi bayangan 
warna Background Anda. Kemungkinan fitur ini menarik, tetapi kami belum menemukan 
kegunaannya. 

6. Sesuaikan jumlah watermark Anda yang tercampur dengan apa yang ada di 
belakangnya, lalu klik tombol Next.  

Dalam hal ini, Blend benar-benar hanya sinonim untuk Transparansi. Dengan menggeser 
slider Blend maju mundur, Anda dapat menyesuaikan transparansi watermark Anda. 

Blend berguna untuk membuat tekstur kertas karena proses itu melibatkan penggunaan 
watermark yang sama dua kali: sekali sebagai overlay dan sekali sebagai underlay.  

Versi hamparan dicampur sehingga model Anda tampak seperti digambar di atasnya. 
Untuk melihat cara kerjanya, terapkan salah satu style Tekstur Kertas ke model Anda lalu 
edit setiap watermark untuk memeriksa pengaturannya. 

7. Tentukan bagaimana Anda ingin watermark Anda ditampilkan dan kemudian klik 
tombol Selesai.  

Anda memiliki tiga pilihan bagaimana SketchUp dapat menampilkan watermark Anda: 
diregangkan agar sesuai dengan seluruh window, ubin di seberang window, dan 
diposisikan di window. Jika Anda memilih Dibentangkan agar Sesuai dengan Layar, 
pastikan untuk mencentang kotak Kunci Rasio Aspek jika watermark Anda adalah logo 
yang tidak ingin terlihat terdistorsi. 
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Gambar 10-9: Seri Buat Watermark dari kotak dialog. 

MENGEDIT WATERMARK 

Anda dapat mengedit watermark apa pun di file SketchUp Anda kapan saja. Ikuti langkah-langkah 
sederhana ini untuk mengedit watermark: 

1. Pilih watermark yang ingin Anda edit di daftar Watermark.  

Anda dapat menemukan daftar Watermark di bagian Watermark pada tab Edit pada panel 
Styles. 

2. Klik tombol Edit Watermark (terlihat seperti beberapa roda gigi kecil) untuk membuka 
kotak dialog Edit Watermark. 

3. Gunakan kontrol di kotak dialog Edit Watermark, lalu klik OK setelah selesai.  

Untuk penjelasan lengkap dari kontrol di kotak dialog ini, lihat deskripsi dari kotak dialog 
Buat Watermark di”Menambahkan watermark," di awal bab ini. 

Tweaking modeling settings  

Di bagian Modeling, yang ditunjukkan pada Gambar 10-10, kontrol menyesuaikan warna dan 
visibilitas semua elemen model Anda yang bukan geometri. Kontrol tersebut dijelaskan sebagai 
berikut: 
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 Controls with color wells: Klik bidang untuk mengubah warna jenis elemen tersebut. 

 Section Cut Width: Ini mengacu pada ketebalan garis, dalam piksel, yang membentuk 
potongan bagian saat Anda menggunakan bidang bagian.. 

 Controls with check boxes: Gunakan ini untuk mengontrol visibilitas jenis elemen 
tersebut dalam model Anda. Tiga di antaranya agak membingungkan: 

o Color by Layer: Memberi tahu SketchUp untuk mewarnai geometri Anda sesuai 
dengan warna yang telah Anda siapkan di panel Layer. 

o Section Planes: Ini mengacu pada objek bidang bagian yang Anda gunakan untuk 
memotong bagian. Warnanya abu-abu dengan empat anak panah di sudutnya.  

o Section Cut: Tidak seperti bidang bagian, pengaturan ini mengontrol visibilitas efek 
potongan bagian itu sendiri. Dengan pembatalan pemilihan ini, bidang bagian 
Anda tampaknya tidak memotong apa pun. 

 Match Photo settings : Saat Anda melakukan photo-match mengatur visibilitas foto Anda 
terkadang membantu. Gunakan kontrol ini untuk menyembunyikan, menampilkan, dan 
menyesuaikan opasitas foto di Background dan latar depan. 
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Gambar 10-10: Kontrol di bagian Modeling sesederhana kelihatannya. 

 

MENINGKATKAN AKSESIBILITAS DENGAN STYLE 

 

Jika Anda mengalami buta warna, Anda mungkin kesulitan melihat petunjuk pemodelan di 

layar. Namun, style SketchUp memungkinkan Anda mengubah warna ini dan meningkatkan 

aksesibilitas SketchUp. 
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Untuk memulai, periksa apakah versi SketchUp Anda menyertakan style Buta Warna, yang 

Anda temukan di koleksi Kumpulan Warna. Style Buta Warna baru di SketchUp 2017. 

Jika Anda tidak memiliki style Buta Warna, Anda dapat membuatnya sendiri dengan memilih 

Background hitam dan mengubah warna di bagian Pemodelan menjadi warna kontras yang 

mudah dilihat. 

 

Di SketchUp 2017, Anda juga dapat mengubah warna sumbu dan petunjuk warna tambahan 

di layar di kotak dialog Preferensi. Pilih tool => Preferensi (Windows) atau SketchUp => 

Preferensi (Mac), dan pilih panel Aksesibilitas untuk menemukan dan menyesuaikan opsi ini. 

 

 

Mencampur style untuk membuat yang baru 

Anda dapat menggunakan tab Campuran untuk menggabungkan fitur dari beberapa style untuk 
membuat yang baru. Alih-alih bekerja melalui bagian tab Edit, membalik kontrol on dan off, 
menggeser slider, dan memilih warna, tab Mix memungkinkan Anda membangun style baru 
dengan melepaskan style yang sudah ada ke lubang khusus”kategori". Selain menjadi cara yang 
bagus untuk bekerja, pencampuran adalah satu-satunya cara Anda dapat mengganti setelan edge 
style antara garis NPR dan non-NPR. 

Tips  

NPR mengacu pada style dalam koleksi Aneka Style, edge Sketsa, dan Pemenang Kompetisi. Style 
rendering nonfotorealistik ini menggunakan garis-garis yang dipindai dan digambar dengan 
tangan untuk menggambar edge dalam model Anda. Jika Anda memiliki SketchUp Pro, Anda 
dapat menggunakan Style Builder untuk membuat style NPR Anda sendiri dari garis yang Anda 
gambar dan pindai. Lihat bilah sisi”Memperkenalkan Style Builder,” di awal bab ini, untuk 
informasi lebih lanjut. 

Ikuti langkah-langkah ini untuk mengubah style menggunakan tab Mix, seperti yang ditunjukkan 
pada Gambar 10-11: 

1. Pada panel Styles, pilih tab Mix. Saat Anda memilih tab Campuran, bagian sekunder 
terbuka di bagian bawah panel sehingga Anda dapat melihat style Anda tanpa bolak-
balik dari tab Campur ke Pilih. 

2. Temukan style yang ingin Anda contoh di bagian Pilih.  

Anda dapat menyebutnya style sumber Anda. Katakanlah Anda sedang mengerjakan style 
baru dan Anda ingin tepian Anda terlihat seperti style Marker Loose yang disertakan 



230 
 

dengan SketchUp. Dalam contoh ini, pilih koleksi Sketchy Edges dari daftar drop-down 
Styles Collections, di mana Anda akan menemukan style Marker Loose. 

3. (Windows) Klik style sumber dari daftar Style di bagian Pilih untuk mengambil 
sampelnya lalu klik bidang kategori yang sesuai dengan pengaturan style yang ingin 
Anda terapkan.  

4. (Mac) Seret style sumber Anda dari daftar Style di bagian Pilih ke bidang kategori yang 
sesuai dengan pengaturan style yang ingin Anda terapkan.  

Dalam hal ini, contoh style Marker Loose dari bagian Select dan letakkan di Edge Settings 
Category dengan baik karena Anda ingin pengaturan edge dari style tersebut diterapkan 
ke style yang sedang Anda kerjakan. 

5. Untuk menyimpan style Anda setelah Anda selesai menambahkan semua bagian, lihat 
bagian berikut. 
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Gambar 10-11: Contoh dari berbagai style untuk memperbarui style yang Anda kerjakan. 

Menciptakan style baru 
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Membuat style baru menambahkannya ke koleksi Style Dalam Model Anda, sehingga Anda dapat 
kembali dan menerapkannya ke model kapan pun Anda suka. Ikuti langkah-langkah ini untuk 
membuat style baru: 

1. Klik tombol Buat Create New Style di Styles panel.  

Ini menduplikasi style yang diterapkan pada model Anda sebelum Anda mengklik tombol 
Buat Style Baru. Style baru Anda muncul di koleksi Dalam Model sebagai [nama style asli] 
1. 

2. Gunakan kontrol di tab Edit untuk mengatur style Anda seperti yang Anda inginkan. 

Tips. 

Seringkali, Anda ingin membuat style baru setelah Anda melakukan perubahan pada yang 
sudah ada. Jika Anda ingin membuat style baru yang mencerminkan modifikasi yang telah 
Anda buat, cukup ganti Langkah 1 dan 2. 

3. Di Name Box (di bagian atas Styles Panel), beri nama style baru Anda dan tekan Enter.  

Jika mau, Anda juga dapat memberikan deskripsi style baru Anda di kotak Deskripsi, 
meskipun Anda mungkin ingin menunggu sampai nanti. 

4. Klik tombol Update.  

Ini memperbarui style baru Anda dengan semua perubahan yang Anda buat pada Langkah 
2 dan 3. 

5. Periksa koleksi Dalam Model di select tab untuk memastikan bahwa style baru Anda 
ada di sana. 

6. Klik tombol In Model (yang terlihat seperti rumah kecil) untuk melihat koleksi In Model 
Styles Anda. Style baru Anda muncul menurut abjad dalam daftar. 

Tips 

Jika ada banyak style dalam koleksi Dalam Model Anda yang tidak Anda gunakan lagi dan 
yang ingin Anda bersihkan, klik menu flyout Detail dan pilih Bersihkan yang Tidak 
Digunakan. Ini menghilangkan semua style yang saat ini tidak diterapkan ke Scene apa 
pun dalam model Anda.  

Ingat 

Membuat style baru tidak secara otomatis membuatnya tersedia untuk digunakan di file 
SketchUp lainnya. Untuk mengetahui cara menyimpan dan berbagi style, lihat bagian 
selanjutnya. 

Menyimpan dan berbagi style yang Anda buat 
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Saat Anda bekerja di SketchUp, Anda pasti ingin membuat style Anda sendiri dan menyimpannya 
sehingga Anda dapat menggunakannya di model lain. Jika Anda adalah bagian dari sebuah tim, 
semua orang mungkin ingin mengakses style yang sama sehingga semua model Anda terlihat 
konsisten. 

Menyimpan style yang Anda buat 

Saat membuat style Anda sendiri, Anda dapat melakukan pendekatan dengan dua cara: 

 

 Buat Style Baru: Mengklik tombol ini membuat style baru dengan pengaturan yang sedang 
aktif. Saat Anda membuat style baru, style tersebut muncul di koleksi Dalam Model style 
dan disimpan dengan model Anda. Tombol Buat Style Baru dapat ditemukan di sudut 
kanan atas panel Style. 

 

 Perbarui Style dengan Perubahan: Tombol ini memperbarui style saat ini dengan 
perubahan apa pun yang Anda buat di tab Edit atau Campur. Jika Anda ingin mengubah 
style yang ada tanpa membuat yang baru, inilah caranya. Anda dapat menemukan tombol 
Perbarui tepat di bawah tombol Buat di sudut kanan atas panel Style. 

Memperbarui style yang sudah ada 

Untuk membuat penyesuaian pada style model Anda, Anda perlu memperbaruinya. Ikuti 
langkah-langkah berikut untuk memperbarui style: 

1. Terapkan style yang ingin Anda perbarui ke model Anda. Jika Anda memerlukan bantuan 
untuk ini, ikuti langkah-langkah di bagian,”Menerapkan style ke model Anda," di awal bab 
ini. 

2. Gunakan kontrol di tab Edit untuk membuat perubahan pada style. 
3. Klik tombol Perbarui Style dengan Perubahan di panel Style untuk memperbarui style 

dengan perubahan Anda. 

Tips 

Gunakan tombol Perbarui Style dengan Perubahan untuk mengganti nama style yang ada juga. 
Cukup ketikkan nama baru ke dalam kotak Nama (di bagian atas panel Style), tekan Enter, lalu 
klik tombol Perbarui Style dengan Perubahan. 

Ingat 
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Saat Anda memperbarui style, hanya salinan style yang disimpan dengan model Anda yang 
diperbarui. Anda tidak mengubah salinan style yang muncul di setiap file SketchUp baru yang 
Anda buat. 

Tips 

Setelah Anda memperbarui atau membuat style, Anda mungkin ingin membuat style tersebut 
tersedia di model SketchUp lainnya. Untuk mewujudkannya, Anda perlu membuat koleksi style 
Anda sendiri. Koleksi adalah folder di komputer Anda yang berisi style yang muncul di panel Style. 
Anda dapat membuat koleksi Anda sendiri untuk menjaga style yang Anda ciptakan tetap rapi 
dan rapi. 

Ikuti langkah-langkah berikut untuk membuat koleksi yang berisi style Anda: 

1. Buka panel Styles dengan mengklik panah penunjuk kanan di Default Tray (Windows) 
atau dengan memilih Window => Styles (Mac). 

2. Pada tab Select, klik menu Details, dan pilih Open atau Create a Collection.  

(Di Mac, pilih Buat Koleksi.) Sebuah kotak dialog terbuka, di mana Anda memilih lokasi di 
hard drive Anda untuk koleksi. 

3. Arahkan ke folder di komputer atau jaringan tempat Anda ingin membuat koleksi. 
4. Klik tombol New Folder.  

Folder baru yang Anda buat menjadi koleksi baru Anda. 

5. Ketikkan nama untuk koleksi baru Anda. Misalnya, Anda dapat memanggil koleksi baru 
Anda Josephine's Collection.  

Anda dapat menyebutnya dengan nama lain jika nama Anda bukan Josephine. 

6. (Mac) Pastikan kotak centang Add to Favourite dipilih. 
7. Klik tombol Pilih Folder (Windows) atau tombol Simpan (Mac).  

Kotak dialog ditutup, dan koleksi Anda ditambahkan ke bagian Favorit dari daftar turun 
bawah Koleksi. Ini akan ada di sana di setiap model SketchUp yang Anda buka di komputer 
ini. 

Setelah Anda membuat koleksi baru, Anda dapat menambahkan style ke dalamnya agar tersedia 
dari model apa pun yang Anda kerjakan. 

Ikuti langkah-langkah ini agar style tersedia untuk digunakan di file SketchUp lainnya: 

1. Pilih Window => Styles 

Panel Styles muncul. 
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2. Klik Select tab dan kemudian klik tombol In Model untuk menampilkan koleksi In Model 
Anda.  

In model button tampak seperti rumah kecil. Koleksi Dalam Model berisi semua style yang 
telah Anda gunakan dalam model Anda, termasuk yang telah Anda buat. 

 

3. Klik tombol Perlihatkan Panel Pilihan Sekunder. Tombol ini berada di pojok kanan atas 
panel Styles.  

Saat Anda mengkliknya, salinan kedua dari bagian Select akan muncul dari bagian bawah 
panel Styles, seperti yang ditunjukkan pada Gambar 10-12. Gunakan bagian ini untuk 
menyeret dan melepaskan style antar folder di komputer Anda, yang membuatnya lebih 
mudah untuk mengaturnya. 

4. Di bagian Pilih, pilih koleksi yang ingin Anda tambahi style.  

Jika Anda telah membuat koleksi khusus untuk style yang Anda buat, pilih yang itu; atau 
Anda dapat memilih koleksi apa pun di daftar tarik-turun Koleksi. 

5. Seret style Anda dari daftar Style Model ke daftar Style di bagian Pilih.  

Dengan menyeret dan melepaskan style Anda dari daftar atas ke yang lebih rendah, Anda 
membuat style tersedia bagi siapa saja yang memiliki akses ke koleksi itu. Ini berarti Anda 
dapat menggunakan style dalam model SketchUp lain yang Anda buat di komputer. Untuk 
membagikannya dengan anggota tim Anda yang lain, salin style Anda ke koleksi yang 
dapat diakses orang lain, seperti di jaringan. 
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Gambar 10-12: Gunakan bagian Pilih untuk mengelola style Anda tanpa meninggalkan SketchUp. 

Bekerja dengan Shadows 

Biasanya, Anda menambahkan bayangan ke gambar SketchUp karena dua alasan utama: 

Untuk menampilkan atau mencetak model dengan cara yang lebih realistis: Mengaktifkan 
bayangan menambah kedalaman dan realisme, dan memberi model Anda tingkat kerumitan 
tambahan yang membuatnya tampak seperti Anda bekerja lebih keras daripada yang 
sebenarnya. 

Untuk mempelajari pengaruh matahari pada apa yang telah Anda bangun (atau rencanakan 
untuk dibangun) di lokasi geografis tertentu: Studi bayangan adalah bagian integral dari desain 
objek yang dibangun. Jika Anda membuat ruang berjemur, Anda perlu tahu bahwa matahari 
benar-benar akan menerimanya, bukan? Anda dapat menggunakan SketchUp untuk 
menunjukkan dengan tepat bagaimana matahari akan memengaruhi kreasi Anda, setiap saat, 
setiap hari sepanjang tahun. 

Pada bagian ini, kita mulai dengan deskripsi singkat dan ringkas tentang cara kerja semua kontrol, 
tanpa terlalu mendalami mengapa Anda ingin memilih satu setelan daripada yang lain. Bagian 
kedua dari bagian ini dikhususkan untuk menjalankan setiap skenario sebelumnya dan 
menggunakan kontrol untuk membuat SketchUp melakukan apa yang Anda inginkan. 

Menemukan shadow setting 

Hal dasar yang perlu dipahami tentang bayangan di SketchUp adalah, seperti di kehidupan nyata, 
bayangan dikendalikan dengan mengubah posisi matahari. Karena matahari bergerak dengan 
cara yang persis sama setiap tahun, Anda tinggal memilih tanggal dan waktu, dan SketchUp 
secara otomatis menampilkan bayangan yang benar dengan mencari tahu di mana seharusnya 
matahari berada. Hore untuk matematika! 

Anda melakukan semua manuver sederhana ini pada panel Shadows, seperti yang ditunjukkan 
pada Gambar 10-13. Bagian berikutnya memperkenalkan cara kerja kontrol sehingga Anda dapat 
menerapkannya ke model Anda. 
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Gambar 10-13: Dial up matahari di panel Shadows. 

Menghidupkan matahari 

Bayangan tidak diaktifkan secara default, jadi hal pertama yang perlu Anda ketahui tentang 
menerapkan bayangan adalah cara mengaktifkannya. Ikuti langkah-langkah sederhana ini: 

 Buka panel Shadows dengan memilih Window => Default Tray => Shadows (Windows) 
atau Window => Shadows (Mac). 

 

 Di sudut kiri atas panel, klik tombol Show/Hide Shadows. Mengkliknya akan menyalakan 
matahari di SketchUp, memberikan bayangan ke seluruh model Anda dan, secara umum, 
membuat semuanya jauh lebih menarik. 

Mengatur waktu dan tanggal bayangan 

Panel Shadows memiliki kontrol waktu dan tanggal, yang Anda gunakan untuk mengubah posisi 
matahari SketchUp. Waktu dan tanggal yang Anda pilih, pada gilirannya, mengontrol tampilan 
bayangan dalam model Anda: 

 Mengatur waktu: Anda tidak harus menjadi Copernicus untuk mengetahui cara menyetel 
waktu; gerakkan penggeser Waktu ke depan dan ke belakang, atau ketik waktu di kotak 
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kecil di sebelah kanan. Perhatikan waktu di setiap ujung penggeser? Ini mewakili matahari 
terbit dan terbenam untuk hari dalam setahun yang telah Anda setel di kontrol Tanggal, 
yang dijelaskan di poin peluru berikutnya. 

 Mengatur tanggal: Sama seperti waktu, Anda mengatur hari dalam setahun dengan 
menggerakkan slider Tanggal maju dan mundur, atau dengan mengetikkan tanggal di 
kotak kecil di sebelah kanan. Jika Anda menggeser kontrol Tanggal bolak-balik, perhatikan 
bahwa waktu matahari terbit dan terbenam berubah dalam kontrol Waktu, di titik 
sebelumnya. 

Tips 

Untuk membuka atau menutup kontrol bayangan tambahan, klik tombol Perluas segitiga di sudut 
kanan atas panel Bayangan. 

Memilih tempat munculnya bayangan 

Kotak centang Display di panel Shadows memungkinkan Anda untuk mengontrol di mana 
bayangan dilemparkan. Bergantung pada model Anda, Anda mungkin ingin mengaktifkan atau 
menonaktifkannya. 

 On Face: Hapus centang pada kotak On Face berarti bayangan tidak muncul pada face 
dalam model Anda. Ini aktif secara default, dan mungkin harus dibiarkan, kecuali Anda 
ingin membuat bayangan hanya di tanah. Untuk apa nilainya, kami selalu memilihnya. 

 On Ground: Membatalkan pilihan kotak centang On Ground menyebabkan bayangan 
tidak muncul di bidang tanah. Sekali lagi, ini aktif secara default, tetapi terkadang Anda 
ingin mematikannya. Contoh utama adalah ketika sesuatu yang Anda bangun meluas ke 
bawah tanah. 

 From Edge: Memilih kotak centang From Edge memberi tahu SketchUp untuk 
memungkinkan edge menghasilkan bayangan. Ini berlaku untuk satu edge yang tidak 
terkait dengan permukaan - benda seperti tali, tiang, dan tongkat sering kali dimodelkan 
dengan edge seperti ini. 

Menambahkan kedalaman dan realisme 

Hal yang menarik tentang bayangan di SketchUp adalah seberapa mudah Anda dapat 
menerapkannya - dan betapa mudah penyesuaiannya. Di bagian sebelumnya, Anda menemukan 
daftar kering dari kontrol dasar di panel Shadows. Di bagian berikut, Anda akan mempelajari cara 
menggunakan kontrol tersebut untuk menambahkan kedalaman, realisme, dan nuansa lezat 
pada model Anda. Andai saja Caravaggio melakukannya dengan sangat baik… 

Anda sering membutuhkan bayangan untuk membuat gambar Anda terbaca lebih baik, terutama 
dalam contoh berikut: 

 Pemandangan dalam ruangan: Matahari adalah satu-satunya sumber pencahayaan yang 
dimiliki SketchUp, jadi bayangan apa pun yang Anda gunakan dalam tampilan interior 
harus berasal darinya. 
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 Objek yang tidak berada di lokasi tertentu: Untuk hal-hal seperti mobil dan furnitur, tidak 
masalah apakah bayangan akurat secara geografis; yang terpenting adalah mereka 
membantu membuat model Anda terlihat bagus. 

 Tampilan 2D: Tanpa bayangan, kedalaman membaca dalam tampilan 2D dari ruang 3D 
hampir mustahil. 

Pencahayaan ruang dalam ruangan 

Menambahkan bayangan ke tampilan interior menghadirkan masalah yang menarik: Karena 
SketchUp tidak memiliki lampu selain matahari, bagaimana Anda bisa membuat sesuatu yang 
terlihat setengah realistis? Dengan langit-langit di kamar Anda, semuanya gelap. Jika Anda 
meninggalkan langit-langit, model Anda terlihat konyol. Jangan putus asa - berikut beberapa 
triknya: 

 Kurangi kegelapan bayangan. Menggeser penggeser Gelap ke kanan akan sangat 
mencerahkan tampilan Anda. Anda masih dapat melihat bayangan matahari yang masuk 
melalui window dan bukaan lainnya, tetapi seluruh ruangan tidak akan terlihat seperti 
sesuatu yang buruk akan terjadi. Lihat Gambar 10-14. 

 Buat langit-langit yang tidak mungkin. Selama Anda belum membuat model apa pun di 
atas interior yang ingin Anda tampilkan, Anda dapat memberi tahu langit-langit agar tidak 
menimbulkan bayangan. Dengan begitu, sinar matahari langsung menyinari furnitur 
Anda, menimbulkan bayangan yang sangat rumit di segala hal. 
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Gambar10-14: Cerahkan ruangan dengan mengurangi penggeser Gelap. 

Gambar 10-15 menunjukkan cara kerja metode plafon ini. Untuk membuat efek ini sendiri, ikuti 
langkah-langkah berikut: 

1. Sesuaikan pengaturan di panel Shadows sampai matahari bersinar melalui satu atau 
lebih window dalam tampilan Anda.  

Ini memastikan bahwa bayangan yang ditimbulkan oleh objek di kamar Anda terlihat seperti 
disebabkan oleh cahaya dari window. 

Tips 

Untuk membuatnya tampak seperti lampu di atas kepala ada di tempat Anda, setel waktu sekitar 
tengah hari dan tanggal sekitar akhir Juni. Bayangan yang ditimbulkan oleh furnitur dan objek 
serupa akan berada tepat di bawah objek itu sendiri. Satu hal lagi: Jika Anda memiliki 
perlengkapan pencahayaan di langit-langit, ingatlah untuk mengaturnya agar tidak menimbulkan 
bayangan di panel Entity Info (baca terus). 

2. Buka panel Entity Info dengan mengklik panah penunjuk kanannya di Default Tray 
(Windows) atau pilih Window => Entity Info (Mac). 

3. Pilih permukaan yang membentuk langit-langit.  

Tahan tombol Shift untuk memilih lebih dari satu hal sekaligus. 

4. Di panel Entity Info, hapus centang pada kotak Cast Shadows. 
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Langit-langit sekarang tidak lagi menghasilkan bayangan, sangat mencerahkan ruang Anda. Jika 
Anda tidak melihat kotak centang Cast Shadows, klik ikon Show Details di kanan atas. 

5. Ulangi Langkah 3 dan 4 untuk face dan objek berikut ini: 
a. Dinding dengan window di dalamnya 
b. Windownya sendiri 
c. Setiap dinding dalam pandangan Anda yang menghasilkan bayangan di lantai 

ruangan Anda 
6. Pindahkan penggeser Gelap ke sekitar 50.  

Ini semakin mencerahkan hal-hal dan membuat bayangan Anda lebih dapat dipercaya. 

 

Gambar 10-15: Beri tahu langit-langit untuk tidak membuat bayangan. 

Membuat objek 3D muncul 

Menambahkan bayangan pada benda-benda yang berdiri sendiri seperti meja, lampu, dan nanas 
adalah pekerjaan yang sebagian besar estetika; hanya bermain-main dengan kontrol sampai 
semuanya terlihat baik untuk Anda dan Anda akan baik-baik saja. Ingatlah tip berikut, yang 
diilustrasikan pada Gambar 10-16: 

 Tenang saja tentang kontras - terutama jika menyangkut bentuk atau face yang sangat 
kompleks dengan foto yang dipetakan padanya. Jika model Anda terlalu kontras dan 
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dramatis, mungkin sulit untuk mengetahui apa yang sedang terjadi. Untuk mengurangi 
kontras 

o Pindahkan penggeser Gelap ke sekitar 40 atau 50. 
o Pindahkan slider Light ke bawah ke 60 atau 70. 

 Persingkat bayangan Anda. Aneh rasanya melihat objek menyala seolah-olah sumber 
cahayanya sangat jauh; pencahayaan di atas kepala terlihat lebih alami. Untuk membuat 
bayangan Anda terlihat lebih baik, ikuti langkah-langkah berikut: 

o Setel penggeser Tanggal ke hari di awal musim gugur. 
o Setel penggeser Waktu ke waktu antara pukul 10:00 dan 14:00. 

 Jangan takut untuk merotasi model Anda. Ingatlah bahwa Anda tidak bisa mendapatkan 
semua kemungkinan posisi bayangan dengan hanya menggunakan kontrol di panel 
Shadows. Untuk mendapatkan efek yang Anda inginkan, Anda mungkin harus memutar 
model Anda dengan memilihnya dan menggunakan tool Rotate. 

 Pilih kotak centang Dari Tepi. Seringkali, pemodel menggunakan edge bebas untuk 
menambahkan detail halus pada model (pikirkan harpa atau tool tenun). Memilih kotak 
centang From Edges memberi tahu SketchUp untuk memungkinkan edge tersebut 
menghasilkan bayangan, yang membuat objek kompleks terlihat sekitar 900 persen lebih 
dingin. 

 Perhatikan transparansi face. Jika Anda memiliki face yang dicat dengan bahan 
transparan, Anda dapat memutuskan apakah face tersebut harus menghasilkan bayangan 
- kemungkinan besar tidak. Di SketchUp, aturannya adalah bahwa lebih dari 50 persen 
material menghasilkan bayangan transparan. Jadi, jika Anda tidak ingin salah satu face 
Anda yang tampak transparan menghasilkan bayangan, lakukan salah satu hal berikut: 

o Pilih face dan kemudian hapus centang pada kotak centang Cast Shadows di panel 
Entity Info. 
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o Sesuaikan opasitas bahan face menjadi kurang dari 50 persen di Material Panel

 

Gambar 10-16: Beberapa tip untuk membuat objek menonjol dengan bayangan. 

Membuat studi bayangan yang akurat 

SketchUp dapat menampilkan bayangan yang akurat, salah satu fiturnya yang paling berguna. 
Untuk melakukan ini, diperlukan tiga informasi: 

 Waktu hari ini 

 Hari dalam setahun 

 Garis lintang situs bangunan 

Masalah Teknis 

Posisi matahari (dan juga posisi bayangan) bergantung pada lokasi geografis - artinya, garis 
lintang. Bayangan yang dibuat oleh sebuah gedung pada pukul 3:00 pada tanggal 5 Maret di 
Minsk sangat berbeda dari bayangan gedung yang serupa, pada waktu yang sama, pada tanggal 
yang sama di Nairobi. 

Jika Anda menampilkan bayangan pada model oven pemanggang roti, lokasi geografis mungkin 
tidak menjadi masalah bagi Anda; bayangan hanya ada di sana untuk efek. Tetapi jika Anda 
mencoba melihat berapa banyak waktu yang akan dihabiskan dek kolam renang Anda di bawah 
sinar matahari selama bulan-bulan musim panas, Anda perlu memberi tahu SketchUp di mana 
Anda berada. 

Memberi tahu SketchUp di mana Anda berada 
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Apakah Anda tahu persis garis lintang tempat tinggal Anda? Kami yakin tidak. Ada baiknya 
SketchUp membantu Anda mengetahui di belahan dunia mana model Anda seharusnya berada. 
Anda dapat mereferensikan model Anda secara geografis (memberinya lokasi geografis) dengan 
dua cara; mana yang Anda pilih mungkin bergantung pada apakah Anda memiliki koneksi 
Internet: 

 Menggunakan cuplikan geo-lokasi: Sejauh ini, ini adalah pendekatan yang paling 
sederhana, tetapi Anda harus memiliki gagasan yang tepat tentang di mana model Anda 
seharusnya berada di globe. Ini juga mengharuskan Anda terhubung ke Internet untuk 
operasi. Jika Anda tahu persis ke mana tujuan model Anda, dan Anda sedang online, 
gunakan metode ini.  

 Menggunakan kotak dialog Info Model: Metode ini sedikit lebih rumit, tetapi ini adalah 
satu-satunya pilihan Anda jika Anda tidak online. Baca terus untuk semua detail berdarah. 

Untuk memberi model Anda lokasi geografis saat Anda offline, ikuti langkah-langkah yang 
diilustrasikan pada Gambar 10-17: 

1. Pilih Window => Model Info. 
2. Dalam kotak dialog Info Model yang muncul, pilih Lokasi-Geografis di bar samping di 

sebelah kiri. 

Tip 

Jika Anda melihat apa pun selain Model ini tidak memiliki lokasi geografis, hentikan di sini. Model 
Anda sudah berada secara geografis, dan Anda tidak perlu melakukan langkah-langkah berikut. 
Tutup kotak dialog Model Info, buat kopi sendiri, dan buang waktu yang baru saja Anda hemat 
untuk menghindari langkah selanjutnya. 

3. Klik tombol Set Manual Location untuk membuka kotak dialog lain. 
4. Masukkan informasi yang diperlukan dan klik OK.  

Apa yang Anda ketik di bidang Negara dan Lokasi sepenuhnya terserah Anda; itu tidak 
mempengaruhi geo-lokasi model Anda sedikit pun. Bidang Lintang dan Bujur adalah bagian 
penting dari kotak dialog ini. 
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Gambar 10-17: Memberikan model Anda lokasi geografis saat Anda tidak online. 

Baik Anda mengimpor cuplikan geo-lokasi atau memasukkan sekumpulan koordinat secara 
manual, langkah selanjutnya adalah memastikan model Anda diputar dengan benar relatif ke 
utara. Jika model Anda menghadap ke arah yang salah, studi bayangan Anda sama sekali tidak 
akurat. 

Ingat 

Yang perlu Anda ketahui adalah ini: Secara default, sumbu hijau membentang dari utara-selatan, 
dengan bagian padat mengarah ke utara. Jika arah utara untuk bangunan Anda tidak sejajar 
dengan sumbu hijau, cukup pilih semuanya dan gunakan Rotate tool untuk memutar bangunan 
ke tempatnya.  

Metode berikut, diilustrasikan pada Gambar 10-18, bekerja dengan baik: 

1. Di atas tanah di suatu tempat, gambarlah edge yang menunjuk ke arah utara 
seharusnya. 

2. Mulai dari titik ujung selatan edge yang baru saja Anda gambar, gambar edge lain yang 
sejajar dengan sumbu hijau.  

Anda memiliki bentuk V. 

3. Pilih semuanya dalam model Anda kecuali edge yang Anda gambar pada Langkah 2.  

Snapshot geo-lokasi Anda (jika ada) harus memiliki garis edge merah di sekelilingnya; itu karena 
terkunci. Jika karena alasan tertentu tidak, context-clicks dan pilih Kunci - Anda tidak mau 
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4. Aktifkan Rotate Tool. 
5. Klik puncak (ujung runcing) dari V untuk menetapkan pusat rotasi Anda. 
6. Klik ujung utara edge yang Anda gambar pada Langkah 1. 
7. Klik ujung utara edge yang Anda gambar pada Langkah 2. 

Sekarang semuanya berbaris dengan benar. 

 

 

Gambar 10-18: Pastikan model Anda diorientasikan dengan benar relatif ke utara. 

Menampilkan bayangan yang akurat untuk waktu dan tempat tertentu 

Sekarang Anda telah memberi tahu SketchUp di mana model Anda berada, ini adalah proses yang 
cukup sederhana untuk mempelajari bagaimana matahari akan memengaruhi proyek Anda, 
seperti yang ditunjukkan pada Gambar 10-19. Ini bagian yang menyenangkan; yang harus Anda 
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lakukan adalah memindahkan beberapa slider. Jika Anda memiliki penonton, bersiaplah untuk 
pujian yang benar-benar tidak pantas. 

 

Gambar 10-19: Mempelajari efek matahari pada model Anda. 

Untuk mempelajari bagaimana matahari mempengaruhi proyek Anda, ikuti langkah-langkah 
berikut: 

1. Orbit, perbesar, dan geser hingga Anda memiliki pandangan yang baik tentang bagian 
proyek yang ingin Anda pelajari. 

2. Buka panel Shadows dengan mengklik panah yang mengarah ke kanan di Default Tray 
(Windows) atau dengan memilih Window ⇒ Shadows (Mac). 

3. Pilih tombol Show/Hide Shadows untuk menyalakan matahari SketchUp. 
4. Pastikan pengaturan zona waktu sudah benar untuk lokasi Anda.  

SketchUp tidak selalu mendapatkan zona waktu yang tepat untuk setiap lokasi di dunia; zona 
waktu tidak selalu memetakan langsung ke koordinat. Jika zona waktu yang Anda lihat di daftar 
tarik-turun Zona Waktu (di bagian atas panel Bayangan) tidak benar, pilih yang lain. 

Tips 

Ingin tahu apa zona waktu Anda di UTC? Coba cari Google untuk zona waktu UTC untuk 
menemukan daftar yang bisa Anda rujuk. 
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5. Ketik bulan dan hari ke dalam kotak di sebelah kanan penggeser Tanggal, lalu tekan 
Enter.  

6. Gerakkan penggeser Waktu ke depan dan ke belakang untuk melihat bagaimana 
bayangan akan bergerak sepanjang hari itu. 

7.  Pilih waktu dalam sehari menggunakan kontrol Waktu. 
8.  Gerakkan penggeser Tanggal bolak-balik untuk melihat bagaimana matahari akan 

memengaruhi proyek Anda pada waktu itu sepanjang tahun. 
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BAGIAN 2 

AutoCAD ke SketchUp 

Bab 7 

Tinjauan AutoCAD ke SketchUp 

SketchUp dan AutoCAD dapat digunakan secara sinergis untuk menghasilkan model situs 
terperinci. Program-program tersebut sangat kompatibel; Garis AutoCAD dapat diubah menjadi 
geometri SketchUp. Memanfaatkan denah 2D AutoCAD sebagai titik awal untuk geometri 
SketchUp adalah cara tercepat untuk menghasilkan model denah lokasi yang terperinci. 

Bab ini memberikan gambaran umum singkat tentang metode umum untuk mengintegrasikan 
platform SketchUp dan AutoCAD saat menggunakan Pemodelan Proses SketchUp. Bab ini 
mengulas 

 Bagaimana mengatur dan kemudian mengimpor file AutoCAD ke SketchUp 

 Cara mengubah file AutoCAD yang diimpor menjadi geometri SketchUp 

 Batasan saat bekerja dengan AutoCAD dan SketchUp 

 Pentingnya menggunakan ekstensi untuk membantu mengubah gambar AutoCAD 
menjadi geometri SketchUp 

Sebagian dari metode ini bergantung pada lima ekstensi khusus yang penting saat bekerja 
bersama-sama dengan kedua platform perangkat lunak.  

Gambaran Umum Untuk membuat model dari linework AutoCAD di SketchUp, Anda akan 
menggunakan langkah yang sama yang diuraikan untuk Pemodelan Proses SketchUp, dengan 
beberapa variasi kecil yang memperhitungkan asal dari linework. Proses konversi memiliki tiga 
langkah umum:  

1. Atur file AutoCAD.  
2. Hasilkan geometri.  
3. Ubah objek situs dari blok AutoCAD menjadi komponen SketchUp. 

Mengatur File autoCaD 

Anda harus mengidentifikasi informasi di AutoCAD yang Anda perlukan untuk SketchUp dan 
membuang sisanya). Linework AutoCAD yang berguna akan diatur ulang pada layer yang sesuai. 
Linework lainnya akan diisolasi dan dibuang. Ini termasuk mengatur dan memasukkan pekerjaan 
garis dari file AutoCAD Xref. 
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Ketika mereka diimpor, layer AutoCAD dan informasi pada layer tersebut akan langsung 
ditransfer ke SketchUp. Semua informasi AutoCAD akan diatur pada layer tertentu untuk 
membentuk organisasi layer di SketchUp. Oleh karena itu, organisasi dasar dari layer seperti yang 
diuraikan dalam Pemodelan Proses SketchUp diselesaikan di AutoCAD sebelum mengimpor 
model ke SketchUp. 
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Gambar: Ketika layer AutoCAD diimpor ke SketchUp, mereka mempertahankan nama dan 
informasi layernya. 

Garis CAD yang terorganisir akan dibagi menjadi dua kategori: 

 Garis yang menentukan permukaan denah lokasi dan menciptakan Alas Pekerjaan Datar 

 Blok AutoCAD yang menentukan objek individu, elemen lokasi, dan vegetasi 
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Gambar: Linework Flatwork Base diatur ke dalam file dasar AutoCAD. Ini adalah file pertama 
dengan baris yang diimpor ke SketchUp. 



254 
 

 

Gambar : File AutoCAD terorganisir yang hanya berisi linework yang diperlukan untuk membuat 
file SketchUp 
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Gambar : Blok AutoCAD yang merepresentasikan elemen situs, perabotan, dan vegetasi. Ini 
adalah file kedua yang diimpor ke SketchUp. 

Kedua kategori informasi tersebut akan dipecah menjadi dua file AutoCAD terpisah. File-file ini 
kemudian diimpor ke SketchUp. 

 Satu arsip berisi garis yang mendefinisikan Dasar Flatwork. 

 File kedua berisi blok AutoCAD. 

Menghasilkan Geometri 

Linework AutoCAD yang menyusun Flatwork Base diimpor ke SketchUp terlebih dahulu. Linework 
yang diimpor kemudian digunakan untuk menghasilkan permukaan dan permukaan. 



256 
 

 

Gambar: Linework AutoCAD diimpor ke SketchUp (kiri) dan digunakan untuk menghasilkan face 
(kanan) untuk membuat dasar Flatwork SketchUp. 

Ada dua metode berbeda yang dapat Anda gunakan untuk memulihkan dasar untuk membuat 
face: 

 Gunakan line tool untuk healing face.  

 Gunakan lima ekstensi kustom, yang dikenal sebagai skrip Pembersihan AutoCAD, untuk 
membuat geometri dari linework AutoCAD. 

Setelah Anda membuat geometri dasar, Anda dapat menambahkan warna dan permukaan 
Push/pull untuk membuat volume dan menambahkan detail.  
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Gambar: Flatwork Base diselesaikan di SketchUp. Warna dan volume ditambahkan ke alas. 

Mengatur Objek 

Langkah terakhir adalah mengimpor file AutoCAD kedua yang berisi blok elemen situs, 
perabotan, dan vegetasi. 

 

Gambar: Blok AutoCAD yang mewakili bangku, meja dan kursi, lampu pejalan kaki, tonggak, dan 
pohon 
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Seperti halnya layer, blok AutoCAD diimpor langsung ke SketchUp. Setelah diimpor, blok 
AutoCAD langsung menjadi komponen SketchUp .Ini berarti bahwa semua versi blok sekarang 
menjadi komponen; mereka dapat diedit untuk mempengaruhi semua blok/komponen serupa 
lainnya dalam model. 

 

Gambar: Blok yang diimpor ke SketchUp menjadi komponen yang dapat diedit dan diganti 
dengan model komponen 3D SketchUp. 

Langkah terakhir dari proses konversi hanya mengganti linework 2D dari blok CAD yang diimpor 
dengan komponen 3D SketchUp. Hal ini memungkinkan Anda untuk menyusun berbagai jenis 
objek situs secara instan dan akurat dalam sebuah model.  
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Gambar: File AutoCAD yang Diimpor berisi blok yang ditempatkan ke dalam SketchUp Flatwork 
Base 

 

Gambar: Mengedit blok/komponen 2D dan menempelkan komponen 3D ke dalam blok adalah 
cara cepat untuk menambahkan elemen detail ke model. 
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Gambar: Komponen 3D ditempatkan ke dalam blok 2D. Semua versi dari blok AutoCAD 
sebelumnya sekarang mengandung komponen 3D. 

 

 

Gambar: Tampilan model akhir, dengan komponen yang disalin ke dalam blok untuk membuat 
model situs detail 3D yang cepat. 
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BAB 8 

Mengorganisir AutoCAD 

Saat Anda bekerja dengan file AutoCAD, langkah pertama Anda adalah mengatur ulang informasi 
sehingga Anda dapat bekerja dengannya secara efisien di SketchUp. Tujuan Anda adalah untuk 
memanfaatkan Pemodelan Proses SketchUp pada file dasar AutoCAD yang disesuaikan sehingga 
Anda dapat membuat model 3D. Bab ini menggunakan pendekatan umum untuk reorganisasi 
berikut:  

1. Menerapkan organisasi file dan folder yang komprehensif untuk mengkonversi secara 
efisien dari AutoCAD ke SketchUp.  

2. Identifikasi informasi: linework, blok, dan layer terkait. Anda akan membutuhkan mereka 
untuk membuat Flatwork Base yang dapat digunakan yang terdiri dari permukaan dan 
objek dari file AutoCAD.  

3. Saring dan hapus informasi yang tidak diperlukan atau yang berlebihan.  
4. Atur informasi yang diidentifikasi ke layer baru.  
5. Gunakan blok yang ada atau buat blok baru untuk merepresentasikan objek di denah 

lokasi. 

Untuk membantu mengikuti isi bab ini, Anda perlu mengunduh empat file AutoCAD dari situs 
web Wiley. Kunjungi www.wiley.com/go/sketchupforsites untuk mengunduh file AutoCAD 
berikut:  

 Park Base Plan.dwg (file AutoCAD utama)  

 CS_Park_BaseFile.dwg (file yang sudah selesai)  

 Flatwork.dwg (file sisipan AutoCAD)  

 Objects.dwg ( file sisipan AutoCAD) 

File akan diunduh sebagai file ZIP (.zip). Setelah mereka selesai mengunduh, ekstrak file ke lokasi 
yang sesuai. 

*Dalam bab ini, informasi AutoCAD mengacu pada linework, blok, dan layer yang menyusun 
rencana situs di AutoCAD. 

Reorganisasi AutoCaD 

Saat Anda membuat model 3D dari informasi AutoCAD, pengaturan ulang file adalah bagian 
proses yang paling memakan waktu. File AutoCAD dapat berupa file berlapis-lapis yang kompleks 
di mana hanya sebagian kecil informasi yang diperlukan untuk membuat model. Proses 
mengidentifikasi dan mengatur ulang informasi untuk membuat dasar yang dapat digunakan 
membutuhkan kesabaran dan perhatian terhadap detail. Semakin terorganisir file AutoCAD 
Flatwork Base, semakin mudah dan cepat model akan dibuat. 

Setelah reorganisasi file selesai dan file diimpor ke SketchUp, tugas pemodelan cepat dan efisien. 
Proses ini akan menjadi jauh lebih cepat dengan latihan, karena Anda belajar dengan cepat 
mengidentifikasi dan memisahkan informasi yang tersedia. 

http://www.wiley.com/go/sketchupforsites
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Folder dan Struktur File 

Agar Anda dapat bekerja secara efisien di antara dua platform perangkat lunak dan menjaga 
berbagai file tetap teratur, Anda harus membuat folder dan struktur file. 

Pilih lokasi untuk folder, baik di hard drive lokal atau di server proyek. Jika Anda bekerja dengan 
struktur file proyek yang ada, Anda mungkin ingin menyimpan folder dan file dengan proyek 
terkait. 

Buat folder baru bernama 3D. Ini akan menjadi folder utama yang berisi semua folder dan file 
AutoCAD dan SketchUp. Di dalam folder 3D, buat tiga subfolder tambahan: 

 CAD  

 Gambar  

 SU 

Anda akan menggunakan file CAD untuk menyimpan file AutoCAD yang ingin Anda gunakan di 
SketchUp. Anda akan mengekspor gambar model SketchUp ke folder Images. SU adalah lokasi 
folder untuk file SketchUp. 

 

Gambar: Struktur folder organisasi untuk file AutoCAD dan SketchUp 
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Di folder CAD yang baru dibuat, buat dua subfolder tambahan:  

 Base 

 Insert  

Anda akan menyimpan salinan file dasar asli di folder Dasar. Anda akan menyimpan file AutoCAD 
yang telah diedit di folder Sisipkan. 

File Dasar AutoCAD 

Setelah Anda membuat struktur folder, langkah Anda selanjutnya adalah membuat salinan dari 
file AutoCAD proyek asli. File asli mengacu pada dasar AutoCAD yang digunakan untuk tata letak 
proyek. Biasanya (dan dalam istilah profesional), ini adalah desain skematik, pengembangan 
desain, atau file dasar dokumen konstruksi yang digunakan oleh individu atau tim proyek untuk 
menggambarkan situs atau desain bangunan. Karena Anda akan mengubah file proyek AutoCAD 
secara signifikan, Anda perlu menggunakan salinannya. Dengan begitu, Anda masih memiliki 
struktur dan informasi asli di file proyek asli. File Project AutoCAD disiapkan untuk kebutuhan 
khusus dan tidak boleh diubah. Untuk alasan ini, simpan file terpisah untuk digunakan membuat 
model SketchUp. Simpan salinan file proyek utama di folder CAD/Base. Anda harus 
menyimpannya sebagai CAD_ SU_BASE: ini adalah singkatan dari AutoCAD_SketchUp_Base. 
Ingatlah untuk sering menyimpan saat Anda mengatur ulang informasi AutoCAD. 

*Jangan pernah menggunakan file AutoCAD proyek utama asli saat Anda membuat model 
SketchUp. 

Saring file CAD_SU_BASE dan identifikasi linework serta blok yang Anda perlukan untuk model. 
Tujuan Anda adalah untuk mengedit dan menghasilkan file AutoCAD yang terdiri dari linework 
yang mewakili permukaan dan objek. Agar berhasil menyelesaikan latihan dalam bab ini, Anda 
harus memiliki pengetahuan tentang AutoCAD dan kemampuan untuk mengidentifikasi 
informasi ini. 

Gambar A mengidentifikasi beberapa permukaan dan objek pada Flatwork Base. Gambar b 
mengidentifikasi beberapa objek dan elemen situs yang khas. 
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Gambar A: Linework AutoCAD khas yang menciptakan permukaan 
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Gambar B: Linework AutoCAD tipikal yang menyusun objek dan elemen situs 

File Referensi Eksternal 

Pada pandangan pertama, mengidentifikasi dan mengatur informasi dalam file AutoCAD 
mungkin tampak seperti tugas yang menakutkan — terutama ketika file Referensi Eksternal 
AutoCAD (Xrefs) ada. Namun, Anda dapat menggunakan pendekatan sistematis untuk mengatur 
garis dan blok menjadi informasi yang koheren dan dapat digunakan. Dengan menggunakan 
pendekatan sistematis, Anda dapat membagi keseluruhan tugas Anda menjadi tugas-tugas kecil 
yang dapat Anda tangani dengan mudah. Pendekatan ini dimulai dengan mengedit dan kemudian 
menghapus semua file Xref. Gambar A mengilustrasikan file AutoCAD lengkap yang menyertakan 
informasi Xref terkait. Contoh file Xref diilustrasikan dalam diagram Gambar B hingga Gambar D. 
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File Xref untuk tujuan reorganisasi terbagi dalam tiga kategori:  

Kategori 1 Xrefs yang tidak berisi informasi yang relevan  

Kategori 2 Xrefs yang memiliki garis yang diperlukan dan beberapa informasi yang tidak relevan  

Kategori 3 Xrefs di mana semua garis tersebut diperlukan untuk Flatwork Base  

1. Identifikasi setiap Xref yang termasuk dalam Kategori 1. 
2. Cukup lepaskan Xrefs tersebut dari CAD_SketchUp_BASE.  

a. Untuk melepaskan Xrefs, ketik Xref pada prompt perintah AutoCAD. Ini akan 
memunculkan menu Referensi Eksternal yang mencantumkan semua file Xref  
(Gambar A) 

b. Pilih file yang akan dihapus. (Gambar B) 
c. Di sebelah kanan menu, dengan file yang dipilih, pilih Lepaskan. Ini akan 

menghapus Xrefs yang dipilih dari file. (Gambar C) 

 

Gambar A: Menu AutoCAD Xref dan file Xref. Di sebelah kiri menu adalah file rencana situs 
keseluruhan dengan semua informasi Xref terlihat. 
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Gambar B: Informasi file Utilitas Xref. Denah lokasi ditunjukkan dengan warna abu-abu. 
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Gambar C: File Arsitektur Xref menunjukkan floorplans dan floorprint. 
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Gambar D: File Teknik Sipil Xref menunjukkan jalan, pelat, ketinggian titik, dan tanjakan 

 

Gambar E: Melepaskan Xref dalam menu Xref. Opsi perintah Detach ada di sebelah kanan. 



270 
 

3. Identifikasi setiap Xrefs yang termasuk dalam Kategori 2 dan 3. Anda akan menanganinya 
dengan cara yang sama, seperti yang dijelaskan pada langkah berikutnya. 

4. Bind/Masukkan ke CAD_SU_BASE. Saat Anda Mengikat/Menyisipkan Xref, Xref akan 
disematkan di file dasar alih-alih direferensikan secara eksternal. Xref yang terikat, yang 
menjadi bagian dari gambar dan tidak ditautkan sebagai file terpisah, dapat diedit dengan 
mudah. Untuk mengikat Xref , ikuti langkah-langkah berikut:  

a. Masuk ke Xref pada prompt perintah, membuka menu Xref.  
b. Pilih Xrefs untuk diikat ke dalam gambar. 
c. Pilih tab Bind dan centang kotak Sisipkan. Tekan tombol OK.  
d. Tekan OK pada menu Xref. Bind/Insert mengubah informasi Xrefed dalam satu 

blok yang disematkan dalam file AutoCAD.  
1. Pilih informasi Xref setelah itu terikat dan meledak itu. Ketik explode di command prompt 

AutoCAD dan pilih linework yang menyusun Xref (s). 

 

Gambar : Bind/Insert sebuah Xref dengan informasi yang diperlukan ke dalam gambar 
CAD_SU_Base. 

Setelah informasi Xref telah dihapus atau dimasukkan ke dalam CAD_SU_BASE, file tersebut siap 
untuk diatur lebih lanjut. Dengan melakukan sisa latihan dalam urutan penyajiannya, Anda akan 
menghasilkan dua informasi terpisah: garis kerja datar yang mendefinisikan permukaan dan 
serangkaian blok AutoCAD yang mendefinisikan objek. 

Mengisolasi Permukaan 
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Menggunakan AutoCAD Express Tools atau menu Layer, matikan semua layer dengan linework 
yang tidak mendefinisikan permukaan. Ini termasuk mematikan layer yang mencakup perabotan 
situs, elemen, dan vegetasi. 

Tinjau informasi yang tersisa dengan hati-hati dan pastikan permukaan (termasuk tapak 
bangunan) yang Anda butuhkan untuk membuat Flatwork Base terlihat. 

Setelah Anda meninjau ulang linework dengan cermat, buat layer baru bernama 01 - Flatwork 
Base. Pilih semua garis untuk permukaan dan tempatkan informasi pada layer yang baru dibuat. 

 

Gambar: Gambar denah AutoCAD dengan semua informasi, kecuali garis yang mewakili 
permukaan, dimatikan 
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Gambar: Tempatkan semua garis permukaan ke satu layer (01 - Flatwork Base). 

Ada beberapa cara untuk menempatkan garis pada layer yang berbeda. Anda dapat memilih 
semua linework dan kemudian, dari kotak dialog Layers, pilih 01 - Layer Flatwork Base — atau 
Anda dapat menggunakan AutoCAD Express Tools (terintegrasi sebagai bagian dari AutoCAD 
2008 dan 2009). Pastikan bahwa 01 - Flatwork Base adalah layer saat ini, dan gunakan opsi 
Change to Current Layer. 

Menutup Perimeter 

Untuk berhasil membuat face di SketchUp, semua tepi harus terhubung untuk membuat 
perimeter tertutup. Perhatikan bahwa tapak bangunan (bukan denah interior) dimasukkan 
sebagai bagian dari luas permukaan. 

Anda perlu membuat draf baris tambahan untuk menutup permukaan di sebagian besar file 
AutoCAD. Lokasi berikut biasanya memerlukan tepi tambahan: 

 Streets and roads 

 Jalan setapak 

 Keseluruhan perimeter lokasi 

 Jejak kaki bangunan 
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Gambar: Pastikan untuk menutup area perimeter dengan garis tambahan. Untuk membuat 
permukaan permukaan di SketchUp, luas permukaan perlu ditutup perimeter. Garis berwarna 
magenta pada diagram adalah area di mana garis lain dirancang untuk menutup permukaan 
(jalan). 

Ini lebih mudah dilakukan di AutoCAD daripada di SketchUp. Tambahkan garis sesuai kebutuhan 
untuk membuat perimeter tertutup di sekitar permukaan. Draft semua garis pada layer 01 - 
Flatwork Base. 

Mengorganisir Objek Situs 

Kumpulan informasi kedua yang perlu Anda atur mencakup elemen dan objek situs. 

Semua objek situs harus disusun sebagai blok AutoCAD. Blok AutoCAD seperti komponen 
SketchUp; mereka adalah kumpulan garis yang disusun sebagai satu kesatuan informasi. 
Mengedit blok memengaruhi semua blok serupa. Blok AutoCAD secara otomatis diubah menjadi 
komponen ketika mereka diimpor ke SketchUp. Hal ini memungkinkan blok 2D sebelumnya untuk 
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ditukar dengan representasi 3D SketchUp dari objek, dengan cepat mengisi model dengan 
elemen situs dan vegetasi. 

Jika sebuah objek (atau sekumpulan objek) bukan blok, rancang ulang sebagai blok. Misalnya, jika 
ada garis yang mewakili lampu pejalan kaki tetapi bukan balok, buatlah balok baru untuk 
mewakili lampu pejalan kaki. Kemudian salin blok baru di atas garis saat ini yang melambangkan 
lampu pejalan kaki. Lihat bagian berikut,”Membuat Blok AutoCAD,” untuk cara membuat blok 
baru. 

Mengidentifikasi Objek 

Menyaring rencana dan mengidentifikasi elemen situs yang akan disertakan dalam model 
SketchUp. Matikan semua layer lainnya. Buat blok baru untuk merepresentasikan objek jika 
perlu. 

 

Gambar: Matikan semua garis kecuali objek situs dan elemen situs. 
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Membuat Blok AutoCAD 

Identifikasi objek apa pun yang perlu menjadi blok. Ikuti langkah-langkah standar ini untuk 
membuat blok. Salin dan tempel blok yang dihasilkan di lokasi rencana situs yang sesuai.  

1. Buat draf garis untuk blok pada Layer 0 (buat Layer 0 sekarang).  
2. Di menu CAD, ketik blokir. Ini akan memunculkan menu Blok.  
3. Pilih tombol Pilih Objek.  
4. Pilih garis yang menyusun objek.  
5. Centang kotak Convert Selected to Block.  
6. Berikan nama untuk blok di bagian atas menu.  
7. Pilih OK. 
8. Tempatkan blok pada layer objek yang sesuai.  
9. Salin dan ganti sesuai kebutuhan. 

Menempatkan Blok Objek pada Layer 

Setelah semua objek yang diinginkan telah diidentifikasi, urutkan dan letakkan setiap blok objek 
pada layer yang sesuai. Setiap jenis objek situs harus berada di layernya sendiri. Jika tidak ada, 
tempatkan objek situs pada layer yang sesuai. 

Setiap tipe objek individu, seperti lampu pohon atau pejalan kaki, memiliki layer yang sesuai 
untuk objek tersebut. Semua blok lampu pejalan kaki harus berada di layer Lampu Pejalan Kaki, 
semua blok Pohon harus berada di layer Pohon, bangku harus berada di layer Bench, dll. Jika 
diatur dengan benar, blok AutoCAD yang diimpor akan tiba di SketchUp dengan teratur dan 
mudah dikelola. 

Setelah blok ditukar dengan komponen 3D, komponen tersebut akan tetap berada di layer yang 
sama dengan tempat mereka ditempatkan di AutoCAD. 
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Gambar: Blok pohon harus pada layer Pohon, lampu pejalan kaki pada layer Lampu Pejalan Kaki, 
dll. 

Menulis Block Surfaces and Objects 

Setelah informasi permukaan dikompilasi ke layer 01 - Flatwork Base dan objek telah 
diidentifikasi dan ditempatkan pada layer yang sesuai, CAD_SU_BASE selesai. 

Informasi file sekarang siap untuk diblokir menulis. Write Block (atau WBlock) memungkinkan 
pengguna AutoCAD untuk mengisolasi informasi tertentu dan mengekspornya dari AutoCAD, 
menghasilkan file AutoCAD baru dan terpisah yang hanya berisi linework yang dipilih. 

Dua file Blok Tulis akan diekspor dari CAD_SU_BASE: satu file yang mewakili informasi flatwork 
dan file lain yang berisi blok objek. 

File Flatwork 

Di AutoCAD, gunakan Express Tools Isolate Layers untuk mengisolasi linework 01 - Flatwork Base. 
Atau, di menu Layer, Anda dapat mematikan semua layer kecuali 01 - Flatwork Base. Garis yang 
mewakili permukaan harus menjadi satu-satunya informasi yang terlihat. Gunakan perintah 
Write Block untuk mengekspor linework yang terlihat.  
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1. Di window perintah AutoCAD, ketik wblock. Menu Write Block akan muncul.  
2. Pilih garis permukaan dan simpan file WBlock ke dalam folder 3D/CAD/Sisipkan. 
3. Sebutkan informasi yang diekspor Flatwork. 

 

Gambar: Menu AutoCAD Write Block. Tulis Blok (WBlock) informasi pekerjaan datar ke file sendiri 
yang disebut Flatwork. Simpan file di folder 3D CAD/Insert. 

Blok Objek 

Ulangi langkah-langkah tersebut untuk semua blok objek. Pisahkan semua layer objek sekaligus. 
Tulis Blokir informasi dan simpan di folder 3D/CAD/Sisipkan. Beri nama Objek informasi yang 
diekspor. Blok objek semuanya harus disimpan sebagai satu file. 
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Gambar: Menulis Blok objek situs dan informasi elemen situs. 

Ubah menjadi Blok 

Jika kedua set informasi telah diblokir tulis, tutup CAD_SU_BASE. Arahkan ke dan buka kedua file 
yang diblokir tulis: Flatwork.dwg dan Objects.dwg. Ubah informasi di setiap file menjadi satu blok 
(lihat”Membuat Blok AutoCAD"). Simpan file dan tutup. Langkah ini akan membantu membuat 
informasi AutoCAD lebih mudah digunakan setelah diimpor ke SketchUp. Ini dielaborasi lebih 
lanjut di bab-bab selanjutnya. Perlu dicatat bahwa melewatkan langkah ini dapat menyebabkan 
komplikasi saat mencoba membuat model Flatwork Base di AutoCAD. 

Mengimpor File Flatwork 

Informasi tersebut sekarang siap untuk diimpor dan dimodelkan di SketchUp. 

Unit AutoCAD dan SketchUp 

Sebelum Anda mengimpor file AutoCAD ke SketchUp, Anda perlu memastikan unit penyusunan 
file AutoCAD cocok di SketchUp. 

Periksa dan catat unit gambar untuk file AutoCAD. Di AutoCAD, Anda dapat menemukannya di 
bawah menu Format Units. 
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Gambar: Menu Unit Gambar di AutoCAD. Sebelum Anda mengimpor file ke SketchUp, unit 
SketchUp harus cocok dengan unit gambar di AutoCAD. 

Sebelum mengimpor file, di SketchUp, buka Window Model Info Units. Ubah unit SketchUp agar 
sesuai dengan file AutoCAD. 
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Gambar: Menu Unit di SketchUp 

Ini adalah salah satu dari dua lokasi tempat unit model perlu disetel di SketchUp. Lokasi kedua 
dijelaskan dalam teks berikut. 

File Gambar Flatwork 

File CAD Flatwork akan diimpor terlebih dahulu. Jangan impor kedua file ke SketchUp. File gambar 
Objek akan diimpor hanya setelah Flatwork Base selesai di SketchUp, setelah face dan volume 
telah dibuat. 

Untuk mengimpor file di SketchUp, buka Impor File dan arahkan ke folder CAD/Sisipkan. Setel 
ekstensi file ke AutoCAD (.dwg). Selanjutnya, pilih Opsi di sebelah kanan layar impor. Menu 
AutoCAD Import File Options akan muncul. 
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Gambar: Saat Anda mengimpor file AutoCAD ke SketchUp, Anda harus mengatur unit untuk file 
tersebut. 

1. Pilih unit yang benar dari menu tarik-turun Unit.  
2. Centang kotak Pertahankan Asal Gambar. Memeriksa opsi ini memastikan bahwa file 

tersebut mempertahankan referensi koordinat yang sama (yaitu, lokasi situs) seperti yang 
dirancang di AutoCAD.  

3. Pilih file Flatwork dan pilih Buka. SketchUp akan mengimpor file AutoCAD ke lingkungan 
kerjanya.  

4. Jika garis tidak terlihat setelah impor, pilih View Toolbars Camera dan pilih Zoom Extents. 
SketchUp akan menyesuaikan tampilan dan menunjukkan linework CAD yang diimpor. 

Informasi permukaan AutoCAD di SketchUp merupakan informasi yang Anda butuhkan untuk 
membuat Flatwork Base. Bab selanjutnya menjelaskan bagaimana memodelkan informasi yang 
diimpor.  
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BAB 9 

Memodelkan AutoCAD Flatwork Base 

Bab ini merinci dua metode khusus untuk memulihkan dan membuat permukaan guna 
menentukan permukaan menggunakan linework AutoCAD yang diimpor. Setelah diimpor ke 
SketchUp, garis datar AutoCAD diubah menjadi tepi tetapi tidak face. 

Tepi yang diimpor akan digunakan untuk membuat face. Proses pemodelan Flatwork Base yang 
berasal dari AutoCAD berbeda dari proses yang diuraikan di Bagian 2. Biasanya, permukaan 
diproduksi ketika tepi dirancang dan dihubungkan untuk membentuk perimeter tertutup; 
SketchUp memahami dengan jelas di mana face diinginkan. 

Tepi yang diimpor dari perimeter dan batas tertutup yang telah dirancang sebelumnya menjadi 
tantangan di SketchUp. Karena mereka tidak dirancang di SketchUp, tidak jelas di mana face 
berada dan, dalam beberapa kasus, tepi mana yang terhubung. SketchUp perlu diarahkan, 
sehingga memahami di mana harus membuat face. 

Meledakkan dasar Flatwork 

Unduh File: AutoCAD ke SketchUp Flatwork 

Seperti yang ditunjukkan, setelah informasi AutoCAD diblokir dari CAD_SU_Base, informasi 
pekerjaan datar akan masuk ke SketchUp sebagai komponen. Sebelum Anda bekerja dengan 
salah satu metode, pangkalan harus diledakkan. 

Dalam beberapa kasus, Flatwork Base perlu diledakkan dua kali karena diimpor sebagai 
komponen di dalam komponen. Terlepas dari itu, pastikan bahwa linework bukan komponen saat 
Anda mulai memulihkan face. 
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Gambar: Pilih tepi yang diimpor. Mereka harus menjadi satu komponen. Ledakan komponennya. 

Pertanyaan yang jelas adalah, Mengapa informasi itu dibuat menjadi blok? Ada bug dalam proses 
konversi dari AutoCAD ke SketchUp. Tepi akan memiliki lebih sedikit anomali jika diimpor sebagai 
blok (komponen) daripada jika diledakkan. 

Selanjutnya, SketchUp terkadang mengimpor informasi AutoCAD tanpa mengubahnya menjadi 
komponen. Membuatnya menjadi blok di AutoCAD memastikan bahwa itu akan menjadi 
komponen di SketchUp. 

Garis AutoCaD Bermasalah 

Ketika linework diimpor dari AutoCAD ke SketchUp, beberapa tepi akan masuk ke SketchUp 
dengan distorsi dan anomali. Anomali ini disebabkan oleh perbedaan mendasar antara SketchUp 
dan AutoCAD. AutoCAD bekerja dalam dua dimensi dan, dengan demikian, dapat membuat garis 
yang lebih halus dan lebih presisi. SketchUp, menjadi program penyusunan 3D, dioptimalkan 
untuk menampilkan geometri tiga dimensi. Beberapa tepi menjadi kacau dalam terjemahan. 
Distorsi ini dapat mempersulit penyembuhan face. 

Garis Tumpang Tindih dan Pendek 

Garis yang terhubung di AutoCAD, sekali di SketchUp, dapat tumpang tindih atau gagal mencapai 
titik akhir yang diinginkan. Misalnya, ketika dua garis yang terhubung pada 90 derajat diimpor ke 
SketchUp, pemeriksaan garis secara dekat mungkin menunjukkan bahwa salah satu garis 
diperpanjang melampaui titik akhir atau gagal, menciptakan celah. 

Garis yang tumpang tindih dan pendek ini sulit untuk diketahui, tetapi memengaruhi cara 
pembuatan face. Dengan garis yang tumpang tindih, sedikit tepi ekstra di luar perpotongan garis 
akan mempengaruhi penyembuhan face. Tepi ekstra, dengan hanya menempati area face yang 
mungkin di masa depan, akan mencegah face dibuat. 

Demikian pula, garis pendek membuat celah yang menyebabkan apa yang sebelumnya 
merupakan perimeter tertutup menjadi terbuka, sehingga mencegah terbentuknya permukaan. 
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Gambar: Informasi pekerjaan datar di SketchUp setelah diimpor dari AutoCAD 

 

Gambar: Garis yang tumpang tindih dari file AutoCAD yang diimpor 
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Gambar: Garis pendek yang tidak memenuhi tepi yang dituju 

Busur 

SketchUp tidak menampilkan busur yang sebenarnya. Busur SketchUp terdiri dari serangkaian 
tepi yang disatukan. 

Sebaliknya, AutoCAD menghasilkan busur”benar". SketchUp menafsirkan ulang busur yang 
diimpor dengan tepi segi. Busur yang sebelumnya mulus di AutoCAD menjadi serangkaian garis 
yang mendistorsi keseluruhan bentuk dan bentuk busur di SketchUp. 

Busur yang diimpor adalah penyebab utama dalam menciptakan kesulitan saat Anda healing 
face. Penafsiran ulang busur halus menjadi serangkaian tepi menyebabkan busur menjadi terlalu 
panjang atau tidak sesuai dengan garis yang berdekatan. 
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Gambar: Tinjau tepi busur terlebih dahulu. 

Anomali Acak 

Tidak peduli seberapa baik rencana AutoCAD dirancang, anomali acak akan terjadi, bahkan di tepi 
lurus. Garis yang diimpor bisa dipecah menjadi dua. Celah minus dapat muncul dalam satu garis 
penuh di AutoCAD. Dalam beberapa kasus, SketchUp akan menolak untuk membuat face, bahkan 
dengan perimeter tertutup yang tidak memiliki celah atau tumpang tindih. 

Dalam kebanyakan kasus ini, Anda harus mencari tepi yang sangat kecil yang sulit dilihat. Memilih 
lokasi tepi yang membandel ini dan kemudian menerapkan ekstensi Hapus Garis Pendek (dibahas 
dalam teks berikut) dapat membantu menemukan dan menghapus tepi mikro yang mencegah 
pembentukan face. 

Di situs DanielTal.com (www.danieltal.com), tutorial”Membuat Model dari Rencana yang 
Digambar Tangan" mengulas lebih lanjut bagaimana memecahkan masalah pemodelan face dan 
tepi di SketchUp. 

Healing AutoCaD Flatwork Base 

Mempertimbangkan semua masalah yang dapat terjadi dengan linework AutoCAD yang diimpor, 
membuat face tampaknya menjadi tugas yang menakutkan. Ada dua metode berbeda yang dapat 
Anda gunakan untuk memulihkan Flatwork Base. Perbedaan terbesar di antara keduanya adalah 
jumlah waktu yang dibutuhkan untuk menyelesaikannya. Metode Line Tool (Metode 1) 
membutuhkan waktu lebih lama untuk diselesaikan daripada metode Ekstensi Pembersihan CAD 
(Metode 2). 

http://www.danieltal.com/
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Metode 2 sangat cepat sehingga memungkinkan file AutoCAD yang terorganisir dengan baik 
dikembangkan dan diartikulasikan sepenuhnya dalam waktu kurang dari satu jam. Ini telah 
dibuktikan berkali-kali, termasuk di lokakarya dan demonstrasi langsung di konvensi American 
Society for Landscape Architecture. 

Jadi mengapa menunjukkan Metode 1? Sampai saat ini, Metode 1 adalah satu-satunya cara untuk 
membuat model garis AutoCAD yang diimpor. Dengan mencoba metode ini, Anda akan belajar 
banyak tentang bagaimana SketchUp menghasilkan geometri. Masalah yang muncul saat Anda 
menggunakan Metode 1 tidak eksklusif untuk linework yang diimpor AutoCAD; mereka dapat 
muncul bahkan saat Anda melakukan pemodelan sederhana. Mempelajari cara memecahkan 
masalah pembentukan face di SketchUp adalah keterampilan yang berguna. 

Metode 2 praktis dan mudah digunakan. Untuk melakukannya, Anda perlu membeli tiga ekstensi 
khusus dan mengunduh ekstensi keempat yang gratis. Namun, pengeluaran kecil itu sepadan 
karena kemudahan penggunaan. Selain itu, ekstensi Pembersihan DynaSCAPE baru dapat 
menyederhanakan proses lebih lanjut. 

Penyembuhan dengan alat Line 

Metode 1 sederhana dan melibatkan penggunaan line tool (View Toolbar Drawing Line Tool). 
Kekurangannya adalah dibutuhkan waktu berjam-jam — jika tidak berhari-hari, bergantung pada 
ukuran file — untuk menyelesaikan dasar. 

Premis dasar dari metode ini adalah membuat face. Alih-alih menambahkan tepi untuk membuat 
permukaan, line tool digunakan untuk mengidentifikasi tepi yang diimpor dengan mengambil 
sampel titik di sepanjang tepi. Idealnya, Anda memilih titik akhir tepi dan memilih (menggambar) 
titik akhir lain di tepi yang sama. 

Misalnya, luas permukaan ditentukan oleh keliling empat sisi. Untuk memulihkan face dengan 
line tool, pilih titik akhir dari salah satu tepi, lakukan perjalanan di sepanjang tepi yang sama, dan 
pilih titik lain (di tepi, titik tengah, atau titik akhir). Jika perimeter ditutup dan tidak ada tepi yang 
tidak normal, sebuah permukaan akan dibuat. 

Namun demikian, ini akan menjadi jelas dengan cepat bahwa ini tidak bekerja dengan begitu rapi 
pada semua tepi dalam sebuah gambar. Distorsi pada linework yang diimpor akan mencegah 
beberapa (atau banyak) area dari penyembuhan face. 

Berikut beberapa tip dan trik agar metode ini berhasil: 

Cicipi tepi yang sama. Idenya adalah untuk mengidentifikasi titik akhir dari tepi yang ada, bukan 
untuk menyusun garis baru. Kesalahan ini mudah diidentifikasi jika tepi baru tercipta. 
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Gambar: Menggunakan line tool, pilih titik akhir tepi. 

 

Gambar: Pilih titik kedua di tepi. Mengidentifikasi dua titik di sepanjang tepi lurus akan healing 
face. 
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Gambar: Face yang disembuhkan 

 

Gambar: Hindari menggambar tepi baru. Identifikasi hanya titik akhir di sepanjang tepi yang sama 
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Gambar: Pembesaran tepi draf kecil. Dari tepi ditarik dan face dibuat, cukup hapus tepi ekstra 
dan face harus tetap ada. 

Mulailah dengan busur. Temukan busur apa pun dan coba pulihkan perimeter luas permukaan. 
Jika gagal, perbesar sedekat mungkin dengan persimpangan busur dan tepi (atau busur dan 
busur). Cari garis yang tumpang tindih dan hapus — atau gunakan line tool untuk 
menghubungkan titik akhir busur ke tepi yang berdekatan dan yang dituju. 

Sembuhkan area yang luas terlebih dahulu. Cobalah untuk healing face dari area yang luas dan 
berbatas tegas terlebih dahulu. Pilih titik akhir dan lihat apakah face sudah sembuh. Bekerja 
dengan area yang lebih kecil berikutnya. 
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Gambar: Sembuhkan area permukaan yang lebih besar terlebih dahulu. 

Memburu tepi masalah. Jika pemilihan titik tepi gagal, pendekatan selanjutnya adalah”mencari" 
tepi masalah. Mulai dari titik akhir garis, buat konsep tepi strategis lainnya dan hubungkan ke 
titik tengah garis yang berdekatan. 

Salah satu dari tiga hal yang akan terjadi: 

 Seluruh face akan sembuh. Jika demikian, hapus atau sembunyikan tepi strategis yang 
digunakan untuk healing face. 

 Tidak ada face yang dihasilkan. Coba lagi dengan membuat draf garis dari area berbeda 
atau coba pulihkan area kecil dari permukaan perimeter. 

 Sebuah permukaan akan dibuat di satu sisi dari tepi yang ditarik. Ini adalah hasil yang 
paling umum. Sisi berlawanan tanpa face mengungkapkan di mana anomali mungkin ada. 

Terus tambahkan lebih banyak tepi. Buat draf garis lain untuk mengambil sampel tepi lain (titik 
akhir, titik tengah, atau di tepi). Hasilnya akan menjadi salah satu dari tiga hasil yang dijelaskan 
sebelumnya. 

Tujuannya adalah untuk mempersempit kemungkinan lokasi tepi masalah. Ketika cukup banyak 
tepi ditambahkan, lokasi masalah menjadi lebih jelas. Dengan memperbesar area di mana face 
tidak akan muncul, Anda akan menyorot anomali, biasanya garis pendek atau tumpang tindih. 
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Gambar: Ketika tepi tidak akan pulih dengan mengidentifikasi titik akhir, gunakan tepi strategis 
dalam perimeter permukaan 

 

Gambar: Terus tambahkan tepi untuk mempersempit lokasi 
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Gambar: Area tersebut harus menjadi lebih kecil dengan setiap tepi tambahan. 

 

Gambar: Tambahkan tepi sampai face sembuh. Anda mungkin perlu memperbesar untuk 
menemukan anomali. 

Susun ulang tepinya. Mungkin cara paling efektif untuk healing face adalah dengan menghapus 
lalu menggambar ulang tepinya. Ini memastikan bahwa ujung-ujungnya terhubung di titik-titik 
akhir. Karena menyusun tepi baru di SketchUp dapat dilakukan dengan cepat, Anda tidak perlu 
menemukan lokasi persis tepi yang terdistorsi. 
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Menghapus dan menyusun ulang tepi di persimpangan adalah pendekatan terbaik; ini adalah 
lokasi utama di mana anomali berada. 

Teknik ini sangat berguna dengan busur. Busur yang diimpor dipecah menjadi satu sisi tepi. 
Memilih tepi yang berdekatan dengan titik akhir, lalu menghapusnya dan menyusun ulangnya, 
adalah tempat terbaik untuk memulai. 

 

Gambar: Hapus tepi di perpotongan garis lalu buat ulang garisnya. Ini memastikan bahwa ujung-
ujungnya terhubung secara efisien. 

 

Gambar: Dalam contoh ini, persimpangan kanan atas berisi tepi yang tidak normal. Menghapus 
tepi menunjukkan bahwa tepi tidak terpasang dengan benar ke tepi yang berdekatan. 
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Gambar: Draft tepi baru ke titik ujung penghubung healing seluruh face. 

Ekstensi Pembersihan CaD 

Dengan pengecualian Make Faces, semua ekstensi berharga antara $ 10 dan $ 20 (USD). Mereka 
layak untuk diinvestasikan. Setelah dipasang ke SketchUp, sebagian besar ekstensi terletak di 
bawah menu tarik-turun Ekstensi. Ekstensi Make Faces terletak di bawah menu pull-down Alat. 

 

Gambar: Ekstensi CAD Clean ‐ Up terletak di menu pull-down Plugins. 
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Gambar: Ekstensi Make Faces terletak di bawah menu Tools. 

Jika Anda benar-benar ingin bekerja dengan file AutoCAD, ekstensi ini adalah suatu keharusan. 
Profesi desain didorong oleh kontrak dan jam kerja yang dapat ditagih. Sebagian besar denah 
lokasi dan gambar lainnya dirancang dalam AutoCAD atau program DWG serupa yang kompatibel 
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sebagai bagian dari proses desain yang diterima secara luas. Menggunakan metode dan ekstensi 
ini memungkinkan Anda membuat denah situs dan model bangunan dengan cepat. Dalam 
beberapa kasus, Anda dapat membuat Flatwork Base dalam hitungan menit. 

Premis dasar menggunakan ekstensi ini adalah memilih semua tepi file CAD yang diimpor dan 
menerapkan ekstensi secara berurutan. 

memperpanjang Garis Tutup Ekstensi ini akan memperpanjang garis untuk menghubungkan ke 
tepi yang berdekatan dan dimaksudkan. Ini memecahkan masalah dengan celah antara tepi di 
garis AutoCAD yang diimpor. Delete Short Lines Ekstensi ini akan menghapus semua tepi yang 
tumpang tindih dan sangat kecil yang mencegah penyembuhan face. Ekstensi membantu 
menghilangkan tumpang tindih yang ditemukan di garis AutoCAD yang diimpor. 

Tutup Segmen Garis Terbuka Ekstensi ini membantu menghasilkan tepi antara dua titik di mana 
terdapat celah. Meski mirip dengan Extend Close Lines, itu berbeda. Perpanjang Garis Tutup 
hanya memperpanjang satu sisi (membuatnya lebih panjang). 

Make Faces Ekstensi ini akan menghasilkan permukaan dari linework yang dipilih. Alih-alih 
menggunakan line tool untuk memulihkan face, memilih seluruh dasar dan menjalankan ekstensi 
ini akan memulihkan face untuk seluruh rencana situs. 

Garis Tumpang Tindih Perpotong Ini adalah ekstensi kelima tambahan. Ini akan menyaring semua 
tepi yang dipilih dan mengubah tepi atau persimpangan yang tumpang tindih menjadi titik akhir. 

Bekerja dengan Ekstensi 

Unduh File: AutoCAD ke SketchUp Flatwork 

Prosedur berikut menguraikan proses untuk menggunakan ekstensi gabungan pada tepi 
AutoCAD yang diimpor. Terkadang ekstensi berjalan secara berbeda pada sistem komputer yang 
berbeda. Karena ketidakkonsistenan ini, pastikan Anda menyimpan pekerjaan Anda setelah 
setiap langkah. 

1. Pilih semua tepi. Dari menu Extensions, pilih Extend Close Lines. Window dialog akan 
muncul, menunjukkan berapa banyak tepi yang diperpanjang oleh ekstensi. Simpan file. 
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Gambar: Pilih semua garis tepi flatwork yang meledak. Dari menu Ekstensi, pilih Perpanjang 
Garis Tertutup. 

 

 

Gambar: Pilih semua garis tepi flatwork yang meledak. Dari menu Ekstensi, pilih Perpanjang 
Garis Tertutup. 

2. Pilih kembali semua tepi. Dari menu Extensions, pilih Delete Short Lines. Ekstensi ini 
berjalan tidak konsisten. Salah satu dari dua hal yang akan terjadi:  
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 Setelah ekstensi menjalankan operasi, semua tepi akan tampak batal dipilih. 
Namun, semua garis pendek yang dipilih tetapi sulit dilihat akan dipilih. Segera 
tekan tombol Hapus. Semua garis pendek akan dihapus. Simpan file. 

 Menu pop-up akan muncul dan menunjukkan berapa banyak baris yang telah 
dihapus. Jika ini terjadi, Anda tidak perlu melakukan apa pun. 

 

Gambar: Dari menu Extensions, pilih Delete Short Lines. Satu dari dua hal akan terjadi. 

3. Pilih semua tepi. Dari menu Ekstensi, pilih Tutup Segmen Garis Terbuka. Anda akan 
ditanya apakah Anda ingin menyimpan salinan file tersebut. Pilih Tidak (Anda seharusnya 
sudah menyimpan file di setiap langkah). Tekan OK. 
Ekstensi Tutup Segmen Garis Terbuka membutuhkan waktu lebih lama untuk dijalankan 
daripada dua ekstensi lainnya. Setelah ekstensi selesai, window pop-up akan muncul yang 
menunjukkan berapa banyak tepi yang ditutup. Simpan file. 
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Gambar: Ekstensi Tutup Segmen Garis Terbuka akan memungkinkan Anda untuk menyimpan file 
sebelum Anda menjalankan ekstensi. 

4. Pilih semua tepi. Di bawah menu Tools, pilih Make Faces. Bilah kemajuan akan berjalan di 
kiri bawah. Setelah ekstensi selesai dijalankan, permukaan akan dibuat dari tepinya. 

 

Gambar: Pilih semua tepi. Dari menu Tools, arahkan ke bawah dan pilih Make Faces. 
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Gambar: Make Faces akan memulihkan lokasi permukaan. 

Dalam kebanyakan kasus, permukaan akan dibuat di semua perimeter tertutup. Mulailah 
memilih face dan pastikan mereka terbagi dengan benar. Tidak satu pun permukaan harus 
melampaui tepi permukaan. 

Memecahkan Masalah Ekstensi 

Menjalankan ekstensi ini tidak selalu merupakan ilmu yang sempurna. Mengingat variasi dan 
kompleksitas yang merupakan bagian dari file AutoCAD atau rencana situs, Anda mungkin 
mengalami beberapa masalah umum berikut ini. 

Batasan Ukuran 

Menjalankan Segmen Tutup Garis Terbuka dan Membuat ekstensi Face dapat memakan waktu. 
Semakin banyak tepi yang Anda pilih, semakin lama waktu yang dibutuhkan untuk memproses 
ekstensi. 

Solusinya adalah memilih tepi denah situs dalam potongan yang dapat dikelola dan menerapkan 
ekstensi secara selektif area demi area. Jika sistem tampak membeku atau memakan waktu 
terlalu lama, tutup SketchUp dan muat ulang file. Inilah mengapa Anda harus menyimpan file 
setelah setiap langkah. 

Dalam kebanyakan situasi, Tutup Segmen Garis Terbuka lebih terbatas dalam aplikasinya 
daripada Make Faces. Namun, kedua ekstensi tersebut dapat berjalan dengan sukses di denah 
lokasi seluas 500 acre, meskipun melakukannya membutuhkan waktu. 
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Sebagai aturan umum, semakin kecil suatu area (yaitu, semakin sedikit tepinya), semakin baik 
alat akan bekerja. 

Face Tidak Lengkap 

Dalam beberapa kasus, khususnya dengan denah lokasi area yang luas, tidak semua permukaan 
akan dibuat. Hal pertama yang harus dilakukan adalah mencoba menerapkan kembali ekstensi 
dengan file baru. Dalam banyak kasus, penggunaan kedua kalinya akan healing semua face. 

Jika perpanjangan dijalankan ulang untuk kedua kalinya dan tidak semua permukaan 
disembuhkan, gunakan pendekatan Berburu yang diuraikan dalam Metode 1 dan tambahkan tepi 
di antara garis sampai semua permukaan selesai. 

Atau, pilih tepi area yang hilang. Anda tidak perlu tepat dalam memilih dan dapat menggunakan 
selection box. Anda harus memastikan bagian tepi yang menyusun face yang hilang disertakan. 
Kemudian jalankan kembali ekstensi pembersihan AutoCAD di lokasi yang dipilih. Ini terbukti 
sangat efektif. 

Pembersihan DynaSCAPE CAD 

Langganan DynaSCAPE Sketch3D mencakup pengunduhan ekstensi DynaSCAPE CAD yang juga 
dapat membersihkan dan menyiapkan pekerjaan garis CAD. 

Ekstensi bekerja dengan cara yang sama seperti ekstensi yang disebutkan di bagian sebelumnya. 
Ini memiliki dua perbedaan penting: 

 Ekstensi DynaSCAPE menjalankan semua fungsi ekstensi lainnya yang digabungkan 
sekaligus dan dalam urutan yang benar. 

 Perpanjangan jauh lebih cepat untuk diproses melalui garis CAD. 

Ekstensi ini dapat mempercepat alur kerja bagi pengguna yang perlu membuat model dari 
linework CAD yang diimpor. Penting untuk dicatat bahwa metode yang digunakan untuk 
menyesuaikan garis setelah menerapkan ekstensi Pembersihan CAD masih relevan dengan alat 
ini. 

Ringkasan Metode 

Menggunakan line tool (Metode 1) adalah pendekatan yang membosankan untuk healing face 
pada rencana dasar AutoCAD. Ini mudah diterapkan, tetapi hasilnya bisa berbeda-beda. Jika Anda 
memiliki denah lokasi yang sangat besar dengan banyak tepi yang terdistorsi, pemodelan 
Flatwork Base bisa sangat sulit. 

Meskipun mempelajari cara menggunakan alat Line sangat berharga, menggunakan ekstensi 
Pembersihan AutoCAD untuk membuat model rencana dasar di SketchUp adalah metode yang 
lebih disukai. 
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Menggunakan ekstensi (Metode 2) menawarkan pendekatan tercepat untuk healing linework 
AutoCAD untuk menghasilkan dasar Flatwork. Kecepatan dan efisiensi metode ini dalam 
menghasilkan face sangat meningkatkan proses pemodelan. 

Meskipun Metode 2 memang memerlukan beberapa pemecahan masalah, kerugian ini kecil 
dibandingkan dengan waktu yang diperlukan untuk membuat model dasar denah situs tanpa 
menggunakan ekstensi ini. 

Setelah diterapkan ke lebih dari seratus denah situs di berbagai sistem komputer, Metode 2 telah 
terbukti berfungsi lebih dari 95 persen dari waktu dengan hanya masalah kecil. 

Langkah selanjutnya 

Unduh File: AutoCAD ke SketchUp Tambahkan warna pada face agar lebih mewakili maksud 
permukaan. 

1. Gunakan Push/pull untuk menambah volume pada dinding, tangga, gedung, dan lokasi 
terkait lainnya. 

2. Sesuaikan volume untuk memberikan detail yang diinginkan. 
3. Setelah selesai, pilih seluruh geometri Flatwork Base dan buat menjadi satu grup. 

Tempatkan grup pada layer 01 - Flatwork Base dengan menggunakan menu Entity Info: 
pilih grup Flatwork Base, klik kanan, dan pilih Entity Info.  

4. Untuk melengkapi model, tambahkan objek dan elemen situs ke pangkalan. Ini ditinjau 
pada bab berikutnya. 

 

Gambar: Tambahkan warna pada jalan, area halaman, dan bangunan. 
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Gambar: Tambahkan warna pada jalan setapak, lokasi penanaman, fitur air, dinding, tangga, dan 
struktur. 

 

Gambar: dasar dengan semua area permukaan yang diaplikasikan dengan warna dan bahan 



305 
 

 

Gambar: Volume dinding disesuaikan agar lebih detail (miring ke bawah). 

 

Gambar: Dinding parimeter dan areal penanaman didorong/ditarik ke atas dan memberikan 
volume. 
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Gambar: Area penanam ditinggikan. Detail dekoratif ditambahkan ke dinding abu-abu. 

 

Gambar: dasar Flatwork yang telah selesai. Pilih semua geometri dan ubah alas menjadi sebuah 
grup. Tempatkan grup pada layer Flatwork. 

Dua model flatwork dapat diunduh dari 3D Warehouse. SPM Bagian 4: AutoCAD ke SketchUp 
Flatwork with Color adalah Flatwork Base yang telah selesai dengan warna yang diterapkan. 
AutoCAD to SketchUp - Completed Flatwork adalah Flatwork Base dengan penambahan warna 
dan volume. 

 

  



307 
 

BAB 10 

Menyusun Model 

Sekarang Flatwork Base telah selesai, langkah terakhir Anda adalah mengatur komponen elemen 
situs di base. Pilih Impor File dan pilih file AutoCAD Objects.dwg dari folder CAD / Sisipkan. 
Pastikan bahwa unit dan Pertahankan asal gambar sudah benar di jendela Opsi, lalu pilih Buka. 

Mengisi Basis Flatwork 

SketchUp akan mengimpor semua blok AutoCAD dan lapisannya yang terkait ke dalam file 
gambar. Dalam beberapa kasus, blok dan tepi yang diimpor tidak akan muncul di lokasi yang 
benar dan perlu disejajarkan dengan Flatwork Base. 

Seringkali, blok Objects.dwg yang diimpor akan muncul di bawah atau di Flatwork Base. Hal ini 
mungkin terjadi jika volume (seperti tepi jalan 6 atau ketebalan) ditambahkan ke flatwork. 

Sebelum Anda meledakkan informasi Objek, pindahkan ke atas (vertikal) untuk duduk di atas 
volume terendah Flatwork Base, biasanya di jalan dan halaman rumput. 

 

Gambar 26.1File Objek diimpor dan ditempatkan di bawah Flatwork Base. 
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Gambar 26.2 Pastikan komponen Objek berada di atas permukaan kerja datar terendah. 

Terkadang, file Objects.dwg yang dimasukkan tidak akan dimasukkan dengan benar dan akan 
tidak sejajar dengan Flatwork Base. Jika demikian, setel ulang blok yang dimasukkan secara 
manual; pilih semua blok yang dimasukkan dan pindahkan ke lokasi yang benar dengan alat 
Pindahkan / Salin. Lakukan ini sebelum Anda meledakkan informasi Objek. Ini akan 
mempermudah pemindahan informasi karena akan menjadi satu komponen. 

 

Gambar 26.3 Pada beberapa kesempatan, file yang diimpor tidak sejajar dengan Flatwork Base. 
Pilih komponen yang dimasukkan dan letakkan di lokasi yang benar di pangkalan. 
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Meledakkan Objek 

Seperti pada pekerjaan garis datar, blok yang diimpor akan masuk ke SketchUp sebagai satu 
komponen. Pilih komponen Objek yang diimpor, klik kanan, dan meledak. 

 

 

Gambar 26.4 Meledakkan blok / komponen Objek yang diimpor. 

Jika meledak, tetapi informasinya adalah komponen di dalam komponen, meledak lagi. 
Tujuannya adalah agar setiap blok / komponen dapat dipilih secara individual. Pastikan tidak ada 
komponen individu yang meledak. 
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Gambar 26.5 Blok / komponen individu harus tetap ada setelah komponen yang lebih besar 
diledakkan. 

Mengimpor Lapisan 

Seperti yang diilustrasikan sebelumnya, blok 2D yang diimpor dari AutoCAD dengan mudah 
diganti dengan versi komponen 3D di SketchUp. Jika elemen situs diatur pada lapisan, lapisan ini 
akan diimpor ke SketchUp. Mengganti blok dengan komponen tidak menghapus objek dari 
lapisan. Misalnya, mengedit blok / komponen Pohon tunggal dengan versi 3D akan menempatkan 
pohon di mana pun komponen itu ada. Versi 3D akan tetap berada di lapisan Pohon. 

Selanjutnya, lapisan Pohon dapat diaktifkan atau dinonaktifkan untuk menyembunyikan atau 
membuat pohon terlihat; struktur lapisan AutoCAD akan dipertahankan 
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Gambar 26.6 Struktur lapisan AutoCAD tetap utuh. Setiap jenis komponen berada di lapisannya 
sendiri, seperti di AutoCAD. 

Mengganti Komponen 

Mengganti semua 2D diimpor blok / komponen dengan 3D pra-dibuat atau komponen kustom. 
Proses ini sederhana. Klik dua kali komponen yang diberikan. Setelah berada di contoh 
komponen, langsung masukkan komponen 3D yang diinginkan ke dalam contoh komponen. 
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Gambar: 26.7 Diagram menunjukkan turunan komponen dari Pohon 1. Tepi dalam komponen 
dipilih; semua contoh dari komponen yang diedit akan diedit melalui komponen tunggal ini. 
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Gambar 26.8 Komponen 3D Tree dimasukkan langsung ke dalam blok / komponen yang diedit 

Sesuaikan komponen 3D yang diimpor untuk duduk dengan benar (di tengah) dalam blok. Setelah 
disesuaikan, hapus semua tepi 2D dan simpan hanya komponen 3D. 
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Gambar 26.9 Tepi 2D dihapus dan hanya pohon 3D yang tersisa, langsung mengisi denah situs 
dengan pepohonan. 

Lanjutkan untuk mengganti blok komponen 2D dengan komponen 3D SketchUp, seperti yang 
ditunjukkan pada Gambar di bawah ini. Tiang tiang, lampu pejalan kaki, bangku, kepala air 
mancur, meja dan kursi dan pohon tambahan ditukar. 
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Gambar 26.10 Mengedit blok / komponen 2D Bollard 

 

Gambar 26.11 Tonggak 3D disisipkan ke dalam instance komponen 2D dari blok / komponen 
AutoCAD yang diimpor 
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Gambar 26.12 Instance komponen dari blok / komponen Lampu Pejalan Kaki 2D 

 

Gambar 26.14 Komponen Lampu Pejalan Kaki 3D disisipkan langsung ke blok Lampu Pejalan Kaki 
yang diimpor. 
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Gambar 26.15 Instance blok / komponen 2D Bench 

 

Gambar 26.16 Komponen 3D Bench yang disisipkan. Komponen 3D perlu diputar dan disesuaikan 
agar menghadap ke arah yang benar. Untuk menyesuaikan semua bangku secara universal, 
lakukan ini saat Anda bekerja dalam contoh komponen. 
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Gambar 26.17 Komponen 3D Bench yang telah disesuaikan 

 

Gambar 26.18 Contoh komponen Water Fountain Spouts 
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Gambar 26.19 Jet air mancur diganti dengan komponen 3D yang representatif 

Anda mungkin ingin mematikan lapisan komponen penghitungan wajah yang tinggi, seperti 
pohon dan semak, setelah diganti. Ini akan membuat model bekerja lebih mudah. Beberapa 
komponen yang disisipkan perlu dipindahkan, diputar, atau diskalakan agar lebih sesuai dengan 
konteksnya. Ingatlah untuk menyesuaikan komponen dalam contoh komponen; hal itu akan 
memengaruhi semua komponen serupa dari jenis yang sama. 
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Gambar 26.20 Bekerja dalam contoh komponen Meja dan Kursi 2D 

 

Gambar 26.21 Komponen Meja dan Kursi 3D dimasukkan langsung ke dalam persamaan 
komponen 2D 
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Gambar 26.22 Mengganti komponen Pohon kedua 
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Gambar 26.23 Komponen 3D Palm Tree dimasukkan langsung ke dalam instance komponen Tree 
2 

 

 

Gambar 26.24 Pohon palem memenuhi pangkalan. 



323 
 

 

Gambar 26.25 Semua komponen 3D AutoCAD dimasukkan ke dalam blok / komponen 2D dalam 
model. 

Sentuhan akhir 

Elemen dan detail terakhir yang Anda tambahkan ke model dimaksudkan untuk memberikan 
kedalaman dan menyampaikan maksud desain lebih lanjut. Langkah-langkah berikut adalah 
langkah umum yang menambahkan perkembangan ke model rencana situs. 

Mengartikulasikan Bangunan 

Bangunan memberikan konteks. Anda dapat menambahkan komponen Jendela dan Pintu yang 
sudah jadi atau khusus untuk bangunan. Kemudian Anda selanjutnya dapat menyesuaikan dan 
memanipulasi volume massa bangunan. Ada tiga jenis bangunan yang harus dimasukkan dalam 
rencana lokasi:  

 Setiap usulan bangunan atau struktur yang telah dirancang dan dimodelkan.  

 Bangunan yang ada berdekatan dengan denah lokasi atau arsitektur yang diusulkan. 
Google Earth dan Gudang Gambar 3D berisi banyak bangunan yang sudah jadi yang dapat 
diunduh dan disertakan dalam model situs. 

 Bangunan tetangga yang tidak berdekatan dengan rencana lokasi atau struktur yang 
diusulkan. Ini dapat dimasukkan sebagai volume alih-alih pijat yang diartikulasikan. 
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Gambar 26.27 Tambahkan detail volume ke massa bangunan. 

 

Gambar 26.28 Buatlah komponen Jendela dan Pintu dan letakkan di atas gedung. 
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Gambar 26.29 Rincian komponen Bangunan 

Bertukar Komponen 3D 

Anda dapat menyesuaikan kembali komponen 3D yang Anda sisipkan ke blok / komponen yang 
diimpor. Saat Anda memasuki instance komponen, Anda dapat menghapus komponen 3D yang 
disisipkan dan menukarnya dengan versi yang berbeda. 

Karena elemen dalam model dapat diedit dengan mudah, SketchUp sangat serbaguna; 
keserbagunaan ini dapat digunakan untuk menyampaikan maksud desain. 
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Gambar 26.30 Elemen situs tiga dimensi dapat dengan mudah diganti dengan versi lain. Tonggak 
itu sedang ditukar dengan yang lain. 

 

Gambar 26.31 Dengan mengganti komponen 3D, Anda dapat melatih keserbagunaan SketchUp. 
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Gambar 26.32 Lampu pejalan kaki 3D diganti dengan versi yang lebih kontemporer. 

 

Gambar 26.33 Lampu pejalan kaki 3D 

Penilaian Konseptual 

Anda dapat dengan mudah menambahkan kemiringan dan ketinggian konseptual ke model Anda. 
Dengan menambahkan tingkat dan ketinggian, Anda membantu mengomunikasikan hubungan 
spasial dan maksud desainAnda harus menambahkan nilai konseptual, bahkan kemiringan kecil, 
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jika memungkinkan. Idealnya, menambahkan nilai konseptual harus dilakukan sebelum Flatwork 
Base diisi dengan elemen situs. 

 

Gambar 26.34 Tiga busur dirancang di sepanjang permukaan dinding. Dengan tiga tepi dan garis 
keliling dipilih, gunakan alat Dari Kontur untuk menghasilkan kemiringan konseptual. 

 

Gambar 26.35 Menambahkan lereng dengan pepohonan 
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Gambar 26.36 Alat Dari Awal digunakan untuk menyalin dan menyelaraskan area rumput besar 
di kisi. 

 

Gambar 26.36 Area rumput yang disalin disampirkan ke kisi From Scratch. Grid tersebut 
kemudian dipangkas agar sesuai dengan bentuk area rumput. 
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Gambar 26.37 Garis grid From Scratch yang telah dipangkas kemudian ditempatkan ke dalam 
model situs. 

 

Gambar 26.38 Alat Smoove kemudian diterapkan pada kisi untuk menghasilkan kemiringan dan 
kontur. Dalam kasus ini, lereng diikat ke belakang dinding yang berdekatan dengan fitur air. 
Pohon dijatuhkan ke lereng menggunakan ekstensi Jatuhkan. 

Menambahkan Lebih Banyak Komponen 

Periksa model dan tentukan apakah model tersebut akan mendapat manfaat dari lebih banyak 
elemen situs. Meskipun tidak dirancang dan dimasukkan dalam denah lokasi AutoCAD, Anda 
masih dapat menambahkan bangku, rak sepeda, kepala air mancur, air mancur, kanopi, dll. Anda 
dapat menggunakan komponen yang sudah dibuat sebelumnya atau komponen khusus untuk 
lebih mengisi model dan mengartikulasikan detail. 
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Gambar 26.39 Komponen Bike Rack termasuk dalam model. 

’ 

Gambar 26.40 Kios transportasi 
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Gambar 26.41 Kanopi khusus  

 

Gambar 26.42 Peralatan bermain 

Melakukan Penyesuaian 
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Warna material bisa disesuaikan. Mereka dapat diterapkan kembali atau diubah di menu 
Material. Menggunakan pipet di palet Material, Anda dapat memilih warna langsung dari model. 
Kemudian, menggunakan tab Edit, Anda dapat mengubah warna menggunakan bilah geser atau 
dengan memasukkan nilai nada warna tertentu. 

Selanjutnya, bahan yang memanfaatkan gambar tekstur dapat diubah di Photoshop atau editor 
foto lainnya. Dengan bahan yang dipilih, pilih opsi Edit di menu Bahan. Di bawah Tekstur dan di 
sebelah kanan nama gambar ada dua tombol; yang lebih jauh ke kanan, jika dipilih, akan 
membuka gambar tekstur di editor eksternal. Anda kemudian dapat menerapkan filter atau 
penyesuaian lainnya pada gambar tekstur. Menyimpan gambar (dengan nama file yang sama) 
akan secara otomatis memperbaruinya di SketchUp. Opsi ini hanya tersedia di SketchUp Pro. 

 

Gambar 26.43Anda dapat mengatur warna di menu Material Edit. 
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Gambar 26.44 Setelah warna dipilih, pilih Edit. Anda dapat menyesuaikan warna dengan 
menggunakan sliders atau dengan memasukkan nilai numerik. 

Komponen dapat disesuaikan untuk mencapai hasil tertentu. Misalnya, Anda dapat memilih 
pohon dan komponen vegetasi 3D lainnya dan menerapkan ekstensi Skala dan Rotasi Banyak 
Chris Fullmer, menciptakan habitat pohon yang lebih alami. Ekstensi dapat ditemukan di Gudang 
Ekstensi. 

 

Gambar 26.45 Pohon yang disisipkan sebelum Skala dan Rotasi Banyak diterapkan 
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Gambar 26.46 Pohon yang disisipkan setelah Scale dan Rotate Multiple diterapkan 

Menambahkan Detail Baru 

Flatwork Base masih bisa disesuaikan dan dimodelkan. Pada gambar contoh, area rumput yang 
berdekatan dengan bangunan situs selanjutnya dibagi lagi dengan alat Garis untuk membuat area 
penanaman kecil. 

Permukaan tanam diimbangi untuk membuat dinding. Dinding dan penanam kemudian diberi 
warna dan volume. 

Komponen bunga kecil ditempatkan di penanam. Setiap jenis ditempatkan di lapisannya sendiri. 
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Gambar 26.47 Area pekarangan di dekat gedung akan disesuaikan untuk menambah detail 
model. 

 

Gambar 26.48 Area rumput dibagi lagi menjadi area yang lebih kecil. Kemudian bagian dalam 
halaman rumput diimbangi dengan 8″ untuk membuat permukaan dinding. Warna disesuaikan 
dengan dinding dan permukaan tanam interior. 

 

Gambar 26.49 Dinding dan permukaan tanam di Dorong / Ditarik untuk menciptakan volume. 
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Gambar 26.50 Komponen bunga ditempatkan di penanam. Setiap jenis bunga ada di lapisannya 
sendiri. 

Massa bunga kemudian diacak menggunakan ekstensi Scale dan Rotate Multiple (Anda dapat 
menginstal ekstensi dari Extension Warehouse). 

 

Gambar 26.51 Untuk membuat habitat yang terlihat lebih alami, Scale dan Rotate Multiple 
diterapkan ke komponen Flower. Bunga yang digunakan di sini berasal dari FormFonts. 

Demikian pula, lalu lintas dan jalur jalan dapat dimasukkan. Draft bentuk yang sesuai ke Flatwork 
Base. Ubah menjadi komponen, tambahkan warna, salin, dan susun komponen untuk 
mensimulasikan jalan atau penyeberangan pejalan kaki. 
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Gambar 26.52 Dengan menggunakan alat Garis, bagi lagi permukaan di jalan raya. 

 

Gambar 26.53 Permukaan yang terbagi kemudian diubah menjadi sebuah komponen. 
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Gambar 26.54 Warna ditambahkan ke komponen. Dalam contoh ini, warna putih menciptakan 
garis penyeberangan pejalan kaki. 

 

Gambar 26.55 Komponen Jalur Penyeberangan Pejalan Kaki kemudian disalin dan diatur untuk 
mensimulasikan penyeberangan pejalan kaki. 

Ada banyak cara untuk menambahkan detail ke Flatwork Base. Biasanya, mereka ditambahkan 
melalui penyusunan, garis offset, pemberian warna, dan penambahan volume. 
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Gambar 26.56 Seluruh permukaan jalan diimbangi dengan alat Offset. Garis offset disatukan 
untuk membuat garis pemisah lalu lintas di tengah. Permukaan offset perlu dibagi lagi dan 

“dibersihkan” (tidak ditampilkan) untuk memastikannya terpisah dari jalan.

 

Gambar 26.57 Warna ditambahkan ke bagian muka yang terbagi untuk mensimulasikan garis 
jalan tengah. 

Menambahkan Orang dan Mobil 

Orang dan mobil biasanya merupakan detail terakhir yang Anda tambahkan ke model. Mereka 
membantu menciptakan rasa hidup dan mengaktifkan ruang. Dengan menambahkan orang dan 
mobil secara hati-hati dan menempatkan mereka di lokasi tertentu, Anda dapat membuat 
pemandangan yang tersusun dengan baik. Unduh File: AutoCAD ke SketchUp - Rencana Situs 
Selesai 
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Gambar 26.58 Menambahkan komponen Orang ke model membantu memberikan skala, 
konteks, dan aktivitas. 

 

Gambar 26.59 Program situs dapat digambarkan atau diperkuat dengan menempatkan 
komponen Orang ke dalam pemandangan tertentu seperti kafe luar ruangan ini. 

 



342 
 

Gambar 26.60 Dengan menyertakan orang, Anda memberikan skala penting yang membantu 
menentukan ukuran, bentuk, dan hubungan berbagai detail dan objek situs. 

 

Gambar 26.61 Sertakan mobil dan kendaraan lain untuk memberikan konteks, skala, dan 
aktivitas. Jangan menambahkan terlalu banyak kendaraan karena dapat mengganggu 
pemandangan. 
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BAB 11 

Mengekspor File Gambar, Animasi, dan CAD 

mengubah model rumah Anda menjadi file DWG yang ramah CAD untuk pembangunnya? 

SketchUp dapat melakukan semua ini dan lebih banyak lagi. SketchUp Make (versi gratis) dapat 
mengekspor gambar dan film raster. SketchUp Pro dapat mengekspor gambar raster dan film, 
bersama dengan gambar vektor, file CAD, dan banyak format 3D lainnya. Bab ini membahas 
dasar-dasar yang dibutuhkan oleh sebagian besar pemula SketchUp Make atau Pro: format 
gambar raster umum, format video dasar, dan file CAD. 

Mengekspor Gambar Model 2D Anda 

SketchUp Make dan Pro dapat mengekspor tampilan 2D model Anda sebagai gambar bitmap, 
yang merupakan gambar yang terbuat dari banyak piksel kecil. Saat Anda mengekspor gambar, 
ada baiknya mengetahui sedikit tentang format file grafik secara umum. Jika Anda sudah 
menyukai hal-hal semacam ini, atau jika Anda sedang terburu-buru, Anda dapat langsung beralih 
ke bagian”Mengekspor gambar bitmap dari SketchUp.” 

Memperkenalkan file raster versus file vektor 

Gambar di komputer Anda dibagi menjadi dua jenis dasar: raster dan vektor. Perbedaan antara 
kedua kategori jenis file ini berkaitan dengan cara mereka menyimpan informasi gambar. Ini versi 
satu menitnya: 

 Raster: Gambar raster terdiri dari titik-titik. (Secara teknis, titik-titik ini adalah piksel, 
seperti piksel yang menyusun gambar yang Anda ambil dengan kamera digital.) Format 
file raster terdiri dari informasi tentang lokasi dan warna setiap titik. Saat mengekspor 
raster, Anda memutuskan berapa banyak titik (piksel) yang harus disertakan, yang secara 
langsung memengaruhi seberapa besar gambar dapat ditampilkan. SketchUp 
mengekspor gambar raster TIFF, JPEG, dan PNG; versi Windows juga mengekspor BMP, 
meskipun itu bukan hal yang menarik. Anda dapat membaca lebih lanjut tentang gambar 
raster di sidebar”Memahami raster: Banyak dan banyak titik," nanti di bab ini. 

 Vektor: Gambar vektor terdiri dari instruksi yang ditulis sebagai algoritma. Algoritme ini 
menjelaskan cara menggambar gambar ke perangkat lunak apa pun yang mencoba 
membukanya. Keuntungan utama menggunakan gambar vektor (dibandingkan dengan 
raster) terletak pada skalabilitasnya - vektor dapat diubah ukurannya lebih besar atau 
lebih kecil tanpa memengaruhi kualitas gambarnya, sedangkan raster kehilangan kualitas 
jika Anda memperbesarnya terlalu banyak. 

Masalah Teknis 

SketchUp Make hanya dapat mengekspor gambar raster, tetapi SketchUp Pro dapat mengekspor 
vektor dalam format file PDF dan EPS. 

Mengekspor gambar raster dari SketchUp 
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Proses mengekspor gambar model SketchUp Anda cukup mudah. Bergantung pada format yang 
Anda pilih, opsi ekspor sedikit berbeda, tetapi kami membahas semuanya di bagian ini. 

Ikuti langkah-langkah ini untuk mengekspor gambar raster dari SketchUp: 

1. Sesuaikan tampilan model Anda sampai Anda melihat dengan tepat apa yang ingin 
Anda ekspor sebagai file gambar.  

Ekspor gambar raster SketchUp adalah WYSIWYG - What You See Is What You Get. Pada 
dasarnya, seluruh tampilan window pemodelan Anda diekspor sebagai gambar, jadi 
gunakan tool navigasi atau klik pemandangan untuk menyiapkan tampilan Anda. Gunakan 
style, bayangan, dan fog untuk membuat model Anda terlihat persis seperti yang Anda 
inginkan. Untuk mengubah proporsi gambar Anda, ubah ukuran window SketchUp Anda. 
Ikuti langkah-langkah berikut untuk melakukannya: 

 Khusus Windows: Jika window SketchUp Anda dalam layar penuh, klik tombol 
Minimalkan di pojok kanan atas. 

 Seret tab Ubah Ukuran di sudut kanan bawah window SketchUp Anda sampai 
window pemodelan memiliki proporsi yang tepat. 

2. Pilih File => Export => 2D Graphic.  

Kotak dialog Ekspor File terbuka. 

3. Pilih format file yang ingin Anda gunakan dari daftar drop-down Format. 

Tips 

Sebelum Anda memilih JPEG secara default, ketahuilah bahwa jenis file ini tidak selalu menjadi 
pilihan terbaik. Untuk deskripsi lengkap setiap format (serta rekomendasi kapan harus memilih 
masing-masing), lihat bagian”Melihat format raster SketchUp", nanti di bab ini. 

4. Pilih nama dan lokasi di komputer Anda untuk gambar yang diekspor. 
5. Klik tombol Opsi. Kotak dialog Opsi Ekspor terbuka, di mana Anda dapat mengontrol 

bagaimana gambar Anda diekspor.  
6. Sesuaikan pengaturan di kotak dialog Opsi Ekspor.  

Berikut deskripsi tentang apa yang dilakukan setelan: 

a. Gunakan Ukuran Tampilan: Memilih kotak centang ini memberi tahu SketchUp 
untuk mengekspor file gambar yang berisi jumlah piksel yang sama seperti yang 
saat ini digunakan untuk menampilkan model Anda di layar. Jika Anda berencana 
untuk menggunakan gambar yang diekspor dalam email atau presentasi di layar 
(seperti PowerPoint), Anda bisa memilih Gunakan Ukuran Tampilan. Namun, 
pengaturan lebar dan tinggi secara manual lebih baik. 

b. Lebar dan Tinggi: Jika Anda tidak memilih kotak centang Gunakan Ukuran 
Tampilan, Anda dapat memasukkan ukuran gambar yang diekspor secara manual. 
Karena proses ini membutuhkan cukup banyak perhitungan, kami mencurahkan 
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seluruh bagian untuk itu; lihat ”Memastikan Anda mengekspor cukup banyak 
piksel," nanti di bab ini, untuk mengetahui apa yang harus diketik ke dalam kotak 
Lebar dan Tinggi. 

c. Anti-Alias: Karena gambar bitmap menggunakan kisi kotak berwarna untuk 
menggambar, garis diagonal dan tepinya terkadang terlihat bergerigi dan, yah… 
jelek. Anti-aliasing mengisi celah di sekitar piksel dengan piksel berwarna serupa 
sehingga semuanya terlihat mulus. Gambar 13-3 mengilustrasikan konsep 
tersebut. Secara umum, Anda ingin tetap mengaktifkan anti-aliasing. 

d. Resolusi (hanya Mac): Di sinilah Anda memberi tahu SketchUp seberapa besar 
ukuran setiap piksel, dan oleh karena itu seberapa besar (dalam inci atau 
sentimeter) gambar yang Anda ekspor seharusnya. Ukuran piksel dinyatakan 
dalam piksel per inci/sentimeter. Opsi ini hanya tersedia jika kotak centang 
Gunakan Ukuran Tampilan tidak dipilih. Lihat”Memastikan Anda mengekspor 
cukup banyak piksel," nanti di bab ini untuk bantuan memilih resolusi. 

e. Background Transparan (bukan untuk JPEG): Anda dapat mengekspor file TIFF 
atau PNG dengan Background transparan, yang dapat mempermudah pemilihan 
model Anda di editor gambar. Mengekspor gambar Anda dengan Background 
transparan juga merupakan cara yang bagus untuk menggunakan program 
pengeditan gambar seperti Photoshop untuk ditempatkan di bidang langit dan 
tanah nanti. 

f. Kompresi JPEG (hanya JPEG): Penggeser ini memungkinkan Anda memutuskan 
dua hal pada saat yang sama: ukuran file dari gambar yang diekspor dan seberapa 
bagus gambar itu akan terlihat. Keduanya, tentu saja, terkait secara terbalik; 
semakin jauh ke kiri Anda memindahkan bilah geser, semakin kecil file Anda, 
tetapi akan semakin buruk tampilannya. Jangan pernah mengatur kompresi JPEG 
menjadi kurang dari 8 - model Anda membutuhkan waktu terlalu lama untuk 
dibuat sehingga Anda terlihat buruk saat diekspor. 

7. Klik OK untuk menutup kotak dialog Opsi Ekspor. 
8. Kembali ke kotak dialog Ekspor File, klik tombol Ekspor untuk mengekspor file gambar 

raster Anda.  

Anda dapat menemukan file yang diekspor di lokasi mana pun di komputer yang Anda 
tentukan di Langkah 4. Apa yang Anda lakukan dengannya sepenuhnya terserah Anda - 
Anda dapat mengirimnya melalui email, mencetaknya, atau menggunakannya di program 
perangkat lunak lain untuk membuat presentasi . Jangan khawatir jika proses ekspor 
memakan waktu lebih lama dari yang Anda kira. Jika Anda mengekspor gambar yang 
cukup besar (gambar dengan banyak dan banyak piksel), ekspor membutuhkan waktu 
beberapa saat. Manfaatkan kesempatan ini untuk menelepon ibumu - dia akan 
menghargai 
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Gambar 13-1: Sesuaikan tampilan dan window pemodelan Anda hingga segala sesuatunya 
terlihat seperti yang Anda inginkan dalam gambar yang diekspor. 
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Gmabar 13.2 Opsi Ekspor untuk TIFF, PNG, dan file BMP 

 

Gambar 13.2 Opsi Ekspor untk file JPEG 
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Gambar 13-3: Tampilan gambar yang sama dengan anti-aliasing off (kiri) dan dengan aliasing 
(kanan) 

Melihat format raster SketchUp 

Jadi, Anda tahu bahwa Anda perlu mengekspor gambar bitmap dari SketchUp, tetapi yang mana 
yang Anda pilih? Anda memiliki empat pilihan di Windows; tiga di antaranya tersedia di Mac. 
Bagian berikut memberi Anda detailnya. 

Ingat 

Saat mengekspor gambar bitmap, Anda menyimpan tampilan saat ini di SketchUp ke file terpisah 
di suatu tempat di komputer Anda. Sebagai gambar raster, file tersebut terdiri dari titik-titik kecil 
berwarna, atau piksel - lebih banyak piksel daripada yang dapat Anda goyangkan. Saat Anda 
melihat semua piksel secara bersamaan, mereka membentuk sebuah gambar. 

Tagged Image File (TIFF atau TIF)  

TIFF adalah pendukung dari dunia format file gambar raster; setiap orang dapat membacanya 
dan hampir semua orang dapat membuatnya. TIFF adalah singkatan dari Tagged Image File 
Format, tapi itu tidak terlalu penting. Berikut semua yang perlu Anda ketahui tentang TIFF: 

 Jika kualitas gambar penting, pilih TIFF. Kecuali jika ukuran file menjadi perhatian 
(karena, misalnya, Anda perlu mengirim gambar melalui email), selalu ekspor TIFF jika 
Anda memerlukan gambar raster. Untuk segala hal mulai dari bekerja di Photoshop 
hingga membuat tata letak di InDesign atau QuarkXPress, TIFF dapat memberikan kualitas 
gambar yang Anda butuhkan. 

 TIFF tidak mengompresi data gambar Anda. Itu berarti mereka tidak memasukkan 
sampah seperti JPEG, tetapi itu juga berarti bahwa mereka adalah file yang sangat besar. 

 Perhatikan jumlah piksel Anda. Jika Anda mengekspor TIFF, Anda mungkin mencari 
kualitas gambar terbaik yang bisa Anda dapatkan. Dan jika itu masalahnya, Anda perlu 
memastikan bahwa TIFF Anda cukup”besar" - yang menyertakan cukup piksel - untuk 
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ditampilkan dalam ukuran yang Anda butuhkan. Lihat”Memastikan Anda mengekspor 
cukup banyak piksel", nanti di bab ini, untuk informasi lebih lanjut. 

Joint Photographic Experts Group (JPEG or JPG)  

JPEG adalah singkatan dari Joint Photographic Experts Group, yang membuatnya terdengar jauh 
lebih menarik daripada yang sebenarnya. Hampir setiap gambar digital yang pernah Anda lihat 
adalah JPEG (dibaca JAY-peg); itu adalah format file standar untuk gambar di web. Lihat detail 
JPEG ini: 

 Jika ukuran file menjadi perhatian, pilih JPEG. Inti dari format file JPEG adalah untuk 
memampatkan gambar raster ke ukuran file yang dapat diatur sehingga dapat dikirim 
melalui email dan diletakkan di situs web. JPEG adalah sebagian kecil dari ukuran file TIFF 
dengan jumlah piksel yang sama, jadi JPEG adalah pilihan tepat jika ukuran file lebih 
penting bagi Anda daripada kualitas gambar. 

 JPEG memampatkan ukuran file dengan menurunkan kualitas gambar. Ini dikenal 
sebagai kompresi lossy; Teknologi JPEG pada dasarnya bekerja dengan membuang banyak 
piksel pada gambar Anda. JPEG juga memperkenalkan sejumlah besar pixel sampah; noda 
ini adalah artefak, dan mengerikan. 

 JPEG + SketchUp = Bahaya. Karena cara kerja format file JPEG, ekspor JPEG dari SketchUp 
sangat rentan terlihat buruk. Gambar dari SketchUp biasanya menyertakan garis lurus dan 
area warna yang luas, keduanya sulit ditangani oleh JPEG. Jika Anda akan mengekspor 
JPEG dari SketchUp, pastikan slider Kompresi JPEG tidak pernah disetel kurang dari 8. 
Untuk detail selengkapnya, lihat bagian”Mengekspor gambar bitmap dari SketchUp,” di 
awal bab ini. 

Portable Network Graphics (PNG) 

Format file grafik ini adalah pahlawan kita. Sayangnya, ini tidak digunakan secara luas 
sebagaimana mestinya. Jika kita memiliki druthers, setiap ekspor raster dari SketchUp akan 
menjadi PNG. Mengapa? Karena, setidaknya sejauh menyangkut SketchUp, PNG 
menggabungkan semua fitur terbaik TIFF dan JPEG. Detail PNG adalah sebagai berikut: 

 PNG memampatkan data gambar tanpa memengaruhi kualitas gambar. Sebagai 
teknologi kompresi lossless, PNG adalah file yang lebih kecil daripada TIFF (seperti JPEG), 
tetapi tidak mengacaukan piksel apa pun (sama sekali tidak seperti JPEG). Memang, PNG 
tidak sekecil JPEG, tetapi perbedaan kualitas gambar bernilai beberapa bit tambahan. 

 Jika Anda mengekspor gambar untuk seseorang yang mengetahui satu atau dua hal 
tentang komputer, pilih PNG. Faktanya adalah bahwa beberapa perangkat lunak tidak 
tahu apa yang harus dilakukan dengan PNG, jadi menggunakannya melibatkan risiko. Jika 
Anda berencana untuk mengirim gambar yang diekspor ke seseorang yang tahu apa yang 
dia lakukan, lanjutkan dan kirim PNG - dia akan terkesan bahwa Anda”tahu". Jika 
penerima ekspor Anda kurang canggih secara teknologi, file JPEG atau TIFF mungkin 
menjadi pilihan yang lebih aman. 

Masalah Teknis 
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Format file PNG tidak dikembangkan untuk menggantikan JPEG atau TIFF; itu seharusnya berdiri 
untuk GIF (Graphics Interchange Format), yang merupakan jenis file yang tidak diekspor 
SketchUp. Tanpa terlalu banyak detail, orang menggunakan JPEG untuk gambar seperti foto dan 
GIF untuk hal-hal seperti logo. Karena tampilan SketchUp yang diekspor biasanya memiliki lebih 
banyak kesamaan dengan yang terakhir, PNG (pengganti GIF) adalah pilihan yang lebih baik. Jadi 
mengapa PNG tidak dapat menggantikan JPEG dan TIFF? Untuk sebagian besar foto (yang 
merupakan sebagian besar gambar di web), JPEG lebih baik daripada PNG karena menghasilkan 
file yang lebih kecil, yang pada gilirannya menghasilkan waktu muat lebih cepat saat Anda 
menjelajahi Internet. TIFF lebih serbaguna daripada PNG karena mendukung ruang warna yang 
berbeda, yang penting bagi orang-orang di industri percetakan. Untuk alasan yang berada di luar 
cakupan buku ini dan tidak relevan dengan ekspor dari SketchUp, PNG masih merupakan pilihan 
terbaik - jika bukan pilihan teraman. 

Windows Bitmap (BMP) 

Windows Bitmap, atau BMP, file adalah jadul; mereka hanya dapat digunakan di Windows, dan 
mereka besar. Jika BMP adalah mobil, itu akan menjadi van tua dengan lantai berkarat. Seperti 
yang mungkin bisa Anda tebak, kami tidak menyarankan penggunaan BMP untuk apa pun. 

Memastikan Anda mengekspor cukup banyak piksel  

Dengan gambar bitmap, ini semua tentang piksel. Semakin banyak piksel yang dimiliki gambar 
Anda, semakin tajam gambar tersebut, dan semakin besar dapat ditampilkan atau dicetak. 
Gambar 13-4 menunjukkan gambar yang sama sebanyak tiga kali. Gambar pertama berukuran 
150x50, artinya lebar 150 piksel kali tinggi 50 piksel. Gambar kedua berukuran 300x100, dan yang 
ketiga 900x300. Perhatikan bagaimana gambar dengan piksel lebih banyak terlihat jauh lebih 
baik? Itulah inti dari bagian ini. 

 

150x 50 piksel 
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300x100 piksel 

 

900x300 piksel  

Gambar 13-4: Semakin banyak piksel menghasilkan gambar yang jauh lebih detail. 

Tips 

Mengapa tidak selalu mengekspor satu truk penuh piksel, kalau-kalau Anda membutuhkannya? 
Ada dua alasan: 

 Ekspor gambar dengan banyak piksel membutuhkan waktu lama untuk diproses. 

 Gambar raster adalah file yang sangat besar. Jika Anda ingin berbagi gambar secara digital 
melalui email atau web, Anda menginginkan piksel yang cukup untuk membuat gambar 
terlihat bagus di layar tetapi tidak terlalu banyak sehingga penerima Anda mendapatkan 
beberapa uban atau koneksi internet mereka mencoba mengunduh foto. 

Berapa banyak piksel yang perlu Anda ekspor tergantung pada tujuan Anda akan menggunakan 
gambar tersebut. Secara umum, Anda dapat melakukan dua hal dengan gambar Anda: 

 Tampilkan atau proyeksikan di layar, secara digital. 

 Cetak ini. 
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Mengekspor piksel yang cukup untuk presentasi digital 

Jika Anda berencana untuk menggunakan gambar yang diekspor sebagai bagian dari presentasi 
di layar, ada baiknya untuk mengetahui apa yang dapat ditampilkan monitor komputer dan 
proyektor digital: 

 Perangkat terkecil dan tertua yang saat ini digunakan memiliki gambar dengan lebar 1024 
piksel kali tinggi 768 piksel. 

 Di ujung lain spektrum, monitor LCD 30 inci kelas atas menampilkan 2560x1600 piksel. 

Jadi masuk akal jika Anda mengekspor gambar yang hanya akan dilihat di layar, Anda perlu 
membuat gambar dengan lebar antara 800 dan 2500 piksel. Tabel 13-1 memberikan beberapa 
pedoman tentang ukuran gambar untuk aplikasi digital yang berbeda. 

Tabel 13-1 Ukuran Gambar yang Disarankan untuk Penggunaan di Layar 

Tabel 13.1. Ukuran Gambar yang Disarankan untuk Penggunaan di Layar 

Bagaiaman Gambar akan digunakan Image Width (Pixels) 

Email 400 hingga 800 

Website, Gambar besar 600 

Website, Gambar kecil 200 

Presentasi PowerPoint (Full Screen) 800 atau  1024 (Tergantung pada proyektor) 

Presentasi PowerPoint (Gambar 
mengambang) 

400 

 

Memahami resolusi: Mengekspor gambar untuk dicetak 

Ingat 

Gambar yang ingin Anda cetak harus memiliki lebih banyak piksel daripada yang hanya akan 
ditampilkan di layar. Itu karena printer - foto, inkjet, laser, dan offset - semuanya beroperasi 
dengan sangat berbeda dari monitor komputer dan proyektor digital. Saat Anda mencetak 
sesuatu, piksel pada gambar Anda berubah menjadi bintik mikroskopis dari tinta atau toner. 
Untuk membuat cetakan berukuran layak dari gambar yang Anda ekspor, itu harus berisi piksel 
yang cukup per inci gambar. Kepadatan piksel suatu gambar, dinyatakan dalam piksel per inci 
(ppi), adalah resolusinya. Jenis resolusi yang Anda butuhkan bergantung pada tiga hal: 

 Jenis perangkat yang Anda gunakan untuk mencetak: Untuk printer inkjet rumahan, 
Anda dapat menggunakan resolusi sekecil 150 ppi. Jika gambar Anda akan muncul di buku 
yang diproduksi secara komersial, Anda memerlukan resolusi setidaknya 300 ppi. 

 Seberapa jauh gambar dari audiens: Ada perbedaan besar antara halaman majalah dan 
spanduk pameran dagang. Untuk aplikasi close-up, resolusi 200 hingga 300 ppi sesuai. 
Grafik besar yang akan dilihat dari jarak beberapa meter bisa serendah 60 ppi. 

 Materi pokok gambar: Gambar fotografi cenderung terdiri dari area warna yang agak 
kabur; jenis gambar ini dapat tahan dicetak pada resolusi yang lebih rendah daripada 
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gambar dengan banyak detail yang rumit. Untuk gambar dengan banyak garis seperti 
model SketchUp, yang terbaik adalah bekerja dengan resolusi yang sangat tinggi - 300 
hingga 600 ppi - terutama jika gambar akan dilihat dari dekat. 

Tabel 13-2 memberikan beberapa pedoman untuk mengekspor gambar yang akan dicetak. 

Tabel 13-2 Resolusi yang Direkomendasikan untuk Cetakan 

Tabel 13.2 Rekomendasi Resolusi untuk di Cetak 
Bagaimana Gambar akan 
digunakan 

Resolusi Gambar 
(Pixel/Inchi) 

Resolusi gambar (Pixel/cm) 

8.5-x-11 or 11-x-17 inkjet 
atau print laser 

200 hingga 300 80 hingga 120 

Pamflet atau brosur warna 300 120 

Majalah atau buku (warna 
dan bayangan) 

300 120 

Majalah atau buku (hanya 
Linework) 

450 hingga 60 180 hingga 240 

Papan presentasi  150 hingg 200 60 hingga 80 

Banner 60 hingga 100 24 hingga 40 

 

Tips 

Ingatlah bahwa gambar raster terbesar yang dapat diekspor SketchUp adalah dengan lebar atau 
tinggi 10.000 piksel (mana saja yang lebih besar). Ini berarti gambar spanduk terbesar, dicetak 
pada 100 ppi, yang dapat dibuat SketchUp memiliki lebar sekitar 100 inci. Untuk memperbesar 
gambar, Anda perlu mengekspor file vektor, yang memerlukan SketchUp Pro dan berada di luar 
cakupan buku ini. 

Ikuti langkah-langkah berikut untuk memastikan Anda mengekspor cukup piksel untuk mencetak 
gambar Anda dengan benar: 

1. Dalam kotak dialog Opsi Ekspor, pastikan bahwa kotak centang Gunakan Ukuran 
Tampilan tidak dipilih.  

Untuk masuk ke kotak dialog Opsi Ekspor, ikuti Langkah 1–6 di bagian”Mengekspor 
gambar raster dari SketchUp," di awal bab ini. 

2. Tentukan resolusi yang Anda perlukan untuk gambar yang diekspor.  

(Lihat Tabel 13-2.) Pertahankan resolusi di kepala Anda atau corat-coret di selembar 
kertas. 

3. Tentukan seberapa besar gambar yang Anda ekspor akan dicetak, dalam inci atau 
sentimeter.  
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Catat ukuran gambar fisik yang Anda inginkan, seperti yang Anda lakukan dengan resolusi 
di langkah sebelumnya. 

4. Kalikan resolusi Anda dari Langkah 2 dengan ukuran gambar Anda dari Langkah 3 untuk 
mendapatkan jumlah piksel yang perlu Anda ekspor: 

Tips 

Resolusi (piksel/in atau cm)×Ukuran (in atau cm) = Jumlah piksel 

Dengan kata lain, jika Anda tahu resolusi apa yang perlu Anda ekspor, dan Anda tahu 
seberapa besar gambar Anda akan dicetak, Anda dapat mengalikan kedua angka tersebut 
untuk mendapatkan jumlah piksel yang Anda butuhkan. Berikut ini contohnya: lebar 300 
piksel/inci×8 inci = lebar 2400 piksel. 

Untuk mengekspor gambar yang dapat dicetak dengan lebar 8 inci pada 300 ppi, Anda 
perlu mengekspor gambar dengan lebar 2400 piksel. Gambar 13-5 memberikan ilustrasi 
contoh ini. 

Tip 

Setelan default SketchUp adalah membuat gambar yang diekspor sesuai dengan proporsi 
window pemodelan Anda; artinya, Anda hanya dapat mengetik lebar atau tinggi, tetapi 
tidak keduanya. Jika Anda menggunakan Mac, Anda dapat memasukkan kedua dimensi 
secara manual dengan mengklik Batalkan tautan (yang terlihat seperti rantai). Anda selalu 
dapat mengekliknya lagi untuk menautkan ulang dimensi lebar dan tinggi nanti. 

5. Ketik lebar atau tinggi gambar yang ingin Anda ekspor, dalam piksel.  

Biasanya cukup sulit untuk mengetahui dengan pasti seberapa besar gambar Anda 
nantinya ketika dicetak, dan bahkan jika Anda melakukannya, Anda mungkin ingin 
menyisakan ruang untuk pemangkasan. Untuk alasan ini, Anda dapat menambahkan 15–
25 persen ke jumlah piksel yang Anda perlukan. Misalnya, jika sebuah gambar memanggil 
2400 piksel, Anda mungkin mengekspor 3000 piksel, hanya untuk amannya. 

Tips 

Jika Anda menggunakan Mac, segalanya menjadi sedikit lebih mudah karena perancang 
SketchUp membuat kalkulator piksel ke dalam kotak dialog Opsi Ekspor. Cukup masukkan 
resolusi yang Anda inginkan di tempat yang sesuai, ubah unit Lebar dan Tinggi dari piksel 
menjadi inci atau sentimeter, dan ketik ukuran gambar yang Anda inginkan. SketchUp 
melakukan aritmatika untuk Anda. 

6. Klik OK untuk menutup kotak dialog Opsi Ekspor. 
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Gambar 13-5: Untuk mengetahui berapa banyak piksel yang perlu Anda ekspor, kalikan resolusi 
dengan ukuran fisik. 
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Membuat Film dengan Mengekspor Animasi  

Ketika datang untuk bersenang-senang, mengekspor animasi film model SketchUp Anda ada di 
sana dengan Pokémon GO dan kembang api yang dibeli di toko. Seperti kedua hal ini, yang hebat 
tentang ekspor animasi adalah betapa mudahnya melakukannya. 

Bukan berarti animasi dan video digital adalah topik sederhana - sebenarnya tidak. Diperlukan 
lift barang untuk memindahkan buku-buku yang telah ditulis tentang bekerja dengan video di 
komputer, tetapi di bagian ini, kami membuatnya tetap sederhana. Apa yang Anda temukan di 
sini hanyalah yang perlu Anda ketahui untuk mengekspor animasi model 3D SketchUp. 

Bersiap untuk prime time 

Kunci untuk mengekspor animasi model SketchUp Anda menggunakan Scene; jika Anda belum 
membacanya. Scene adalah tampilan tersimpan model Anda yang dapat Anda atur dalam urutan 
apa pun yang Anda inginkan. Saat Anda mengekspor animasi, SketchUp merangkai Scene dalam 
model Anda untuk membuat file film yang dapat diputar di hampir semua komputer yang dibuat 
dalam beberapa tahun terakhir. 

Ikuti langkah-langkah berikut untuk menyiapkan model Anda untuk diekspor sebagai animasi: 

1. Buat Scene  untuk membangun”kerangka" animasi Anda. 
2. Untuk menyesuaikan pengaturan animasi dalam kotak dialog Model Info, pilih Window 

=> Model Info dan kemudian pilih panel Animation.  
3. Pilih kotak centang Enable Scene Transitions untuk memberi tahu SketchUp agar 

berpindah dengan mulus dari satu Scene ke Scene berikutnya. 
4. Masukkan waktu transisi untuk memberi tahu SketchUp berapa lama waktu yang 

dihabiskan untuk berpindah antar Scene.  

Jika Scene Delay Anda 0 (di bawah), Anda dapat mengalikan waktu transisi dengan jumlah 
Scene untuk mengetahui berapa lama animasi yang akan diekspor. 

5. Masukkan waktu tunda Scene untuk menjeda setiap Scene sebelum melanjutkan ke 
Scene berikutnya. 

Tips 

Jika Anda berencana membicarakan setiap Scene, gunakan waktu tunda Scene untuk 
berhenti sejenak sebelum setiap Scene. Jika animasi Anda seharusnya menjadi panduan 
atau jalan layang yang mulus, setel ini ke 0. 

6. Sesuaikan proporsi window pemodelan Anda untuk mendekati proporsi film Anda.  

Tidak seperti format ekspor 2D SketchUp, proporsi film yang diekspor tidak bergantung 
pada window pemodelan Anda; Artinya, membuat window pemodelan Anda panjang dan 
kurus tidak akan menghasilkan film yang panjang dan kurus. Anda memilih berapa banyak 
piksel lebar dan tinggi yang Anda inginkan untuk film Anda, jadi untuk mendapatkan 
gambaran tentang seberapa banyak yang dapat Anda lihat, buat window pemodelan 



357 
 

Anda cocok dengan proporsi file yang diekspor. (Rasio aspek 16: 9 umum untuk format 
video.) Lihat Langkah 1 di bagian”Mengekspor gambar bitmap dari SketchUp," di awal bab 
ini, untuk panduan menyesuaikan window pemodelan Anda. 

7. Saat proyek Anda siap, lanjutkan ke bagian berikutnya untuk mengekspor animasi 
Anda. 

Mengekspor film 

SketchUp menawarkan sup alfabet format ekspor video yang sesungguhnya: Anda dapat memilih 
dari tujuh di Windows dan enam di Mac. Daftar ini mungkin tampak menakutkan, jadi berikut 
adalah lembar sontekan yang akan menyelamatkan Anda dari derita mental: 

 H.264 (.mp4): Format video ini sedekat mungkin dengan standar industri. Setiap orang 
dengan Mac dan siapa saja yang memiliki QuickTime di komputer Windowsnya dapat 
langsung menonton film H.264 tanpa kerumitan apa pun. Ini juga merupakan format 
upload pilihan untuk situs berbagi video populer seperti YouTube dan Vimeo. File H.264 
yang diekspor SketchUp dikompresi dengan baik, yang membuatnya kecil dan terlihat 
bagus. 

 AVI (.avi): Semua mesin Windows dan Mac dengan plugin khusus dapat memutar film 
AVI. Situs web berbagi video populer seperti YouTube dan Vimeo memungkinkan Anda 
mengunggah file AVI, tetapi mereka cenderung lebih memilih H.264. Animasi AVI yang 
diekspor SketchUp tidak terkompresi, artinya terlihat bagus dan bersih tetapi file bisa 
menjadi besar dengan cepat. Jika Anda berencana untuk mengirimkan file film Anda 
kepada seseorang, AVI mungkin bukan pilihan terbaik Anda. 

 VP8 (.webm): Belum lama ini, dunia teknologi mulai gelisah tentang dominasi H.264 
sebagai format file yang digunakan untuk menampilkan video di situs web. H.264 adalah 
hak milik, artinya perusahaan besar harus membayar biaya lisensi kepada pemiliknya 
(Apple) jika ingin menggunakannya. WebM adalah alternatif gratis, didukung oleh Google, 
dan dibuat untuk digunakan di situs web yang menggunakan HTML5. Terjemahan: Anda 
tidak perlu mengkhawatirkan WebM kecuali Anda berencana untuk menyematkan film 
Anda di situs web modern tanpa menguploadnya ke YouTube atau Vimeo terlebih dahulu. 

 Theora (.ogv): Theora adalah format sumber terbuka gratis lainnya yang dimaksudkan 
untuk video yang akan disematkan di situs web. Tidak seperti WebM, Theora dikelola oleh 
yayasan independen yang mencoba menjaga format file multimedia penting dari tangan 
perusahaan swasta besar seperti Apple (H.264) dan Google (WebM). 

 JPEG, PNG, dan TIFF: Memilih untuk mengekspor dalam salah satu format ini tidak akan 
memberi Anda file film yang dapat Anda tonton - itu bukan format file video. Sebaliknya, 
Anda akan mendapatkan tumpukan file gambar yang masing-masing mewakili satu 
bingkai dalam animasi Anda; untuk video 3 detik dengan 30 frame per detik, SketchUp 
akan mengekspor 90 gambar individu. Opsi ini berguna untuk editor video serius yang 
membutuhkan banyak kontrol, tetapi kebanyakan orang tidak perlu menggunakannya. 
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Meskipun mengekspor animasi di SketchUp adalah operasi yang cukup sederhana, mencari tahu 
cara menyetel semua kontrol ekspor animasi bisa terasa seperti mendaratkan pesawat ulang-
alik. 

Ikuti langkah-langkah berikut untuk mengekspor file film dari SketchUp: 

1. Siapkan model Anda untuk diekspor sebagai animasi.  

Lihat bagian”Bersiap untuk prime time,” di awal bab ini, untuk daftar hal-hal yang perlu 
Anda lakukan sebelum mengekspor animasi. 

2. Pilih File => Export => Animation => Video.  

Memilih Video memberi Anda format file yang menghasilkan file video. Jika Anda memilih 
Kumpulan Gambar, Anda akan melihat opsi untuk membuat kumpulan gambar diam. 
Kami akan menjelaskan perbedaannya nanti di bagian ini. Jika Anda menggunakan Mac, 
tidak ada percabangan submenu Animasi; cukup pilih File => Export => Animation, dan 
Anda akan melihat semua pilihan format Anda. 

3. Beri nama file film Anda dan kemudian pilih tempat untuk menyimpannya di sistem 
komputer Anda. 

4. Pastikan format file yang benar dipilih.  

Dari daftar drop-down Format, pilih format file yang ingin Anda ekspor SketchUp. Dalam 
kebanyakan kasus, ini adalah H.264 atau AVI, tetapi lihat uraian sebelumnya di bagian ini 
untuk info lebih detail. 

5. Klik tombol Opsi untuk membuka kotak dialog Opsi Ekspor Animasi. 
6. Sesuaikan pengaturan untuk jenis animasi yang ingin Anda ekspor. (Lihat Gambar 13-

6.)  

Bagaimana Anda mengatur semuanya di kotak dialog ini tergantung pada bagaimana 
Anda berencana menggunakan animasi yang Anda buat. Lihat bagian selanjutnya dalam 
bab ini untuk daftar pengaturan dan implikasinya. 

7. Klik OK di kotak dialog Opsi Ekspor.  

Anda kembali ke kotak dialog Ekspor Animasi. 

8. Periksa untuk memastikan semuanya sudah benar, lalu klik tombol Ekspor.  

Karena mengekspor animasi membutuhkan waktu beberapa saat, ada baiknya untuk 
memeriksa ulang pengaturan Anda sebelum Anda mengklik tombol Ekspor. Ketika ekspor 
selesai, Anda dapat menemukan file animasi Anda di lokasi yang Anda tentukan pada 
Langkah 3. Mengklik dua kali file tersebut akan membuatnya terbuka di perangkat lunak 
movieplaying apa pun yang Anda miliki yang dapat membacanya. 
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Gambar 13-6: Kotak dialog Opsi Ekspor Animasi 

Mencari tahu pengaturan Opsi Ekspor Animasi 

Seperti yang kami katakan sebelumnya, video digital bisa jadi rumit. Beruntung bagi Anda, Anda 
tidak benar-benar harus tahu persis apa artinya mengekspor jenis film yang tepat; Anda hanya 
perlu tahu cara menyiapkan semuanya. Kotak dialog Opsi Ekspor Animasi (diperlihatkan pada 
Gambar 13-6) adalah sama untuk setiap format file video yang ditawarkan SketchUp; berikut 
panduan singkat untuk pengaturannya: 

 Resolusi: Penggunaan kata resolusi ini mengacu pada dimensi piksel - ukuran fisik - video 
Anda. SketchUp Make (versi gratis) memungkinkan Anda memilih dari tiga ukuran 
standar, sedangkan SketchUp Pro menyediakan opsi Kustom untuk lebih banyak 
fleksibilitas. Inilah arti istilah tersebut: 

o 1080p Full HD menghasilkan video dengan lebar 1920 piksel dan tinggi 1080 
piksel. Ini adalah resolusi tertinggi yang dapat ditampilkan oleh sebagian besar 
televisi yang lebih baru, dan bahkan lebih tinggi daripada yang dapat ditangani 
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oleh kebanyakan laptop sebelumnya. Pilih opsi ini hanya jika Anda tahu Anda akan 
membutuhkannya; mengekspor piksel sebanyak ini membutuhkan waktu lama. 

o 720p HD, dengan lebar 1280 piksel kali tinggi 720 piksel, adalah resolusi paling 
umum untuk video kualitas tinggi yang diekspor. Ukuran ini terlihat bagus di layar 
komputer dan televisi, dan ini adalah resolusi upload yang disarankan untuk 
YouTube dan Vimeo. Kemungkinan besar ini adalah resolusi untuk Anda. 

o 480p SD, dengan lebar hanya 854 piksel kali tinggi 480 piksel, mungkin akan 
terlihat kecil di sebagian besar layar komputer. Ini adalah resolusi yang digunakan 
untuk DVD, yang diketahui oleh setiap anak usia 16 tahun sebagai artefak aneh 
dari masa lalu. (Aidan memiliki banyak koleksi, sayangnya.) Gunakan 480p jika 
ukuran file menjadi perhatian. 

o Custom hanya tersedia jika Anda menggunakan SketchUp versi Pro. Memilih opsi 
ini”membuka kunci" pengaturan untuk 

 Aspect Ratio dan Frame Rate, yang kami jelaskan nanti dalam daftar ini.  

 Aspect Ratio: Ini mengacu pada proporsi bingkai video Anda; nama depan mengacu pada 
lebar dan nama kedua untuk tinggi. Aspect ratio umum untuk film dan video adalah 16: 9 
(yang lebar) dan 4: 3 (yang lebih persegi). Jika Anda menggunakan SketchUp Pro, Anda 
dapat memilih Kustom dan memasukkan apa pun yang Anda inginkan ke dalamnya. 
Bidang Ukuran Bingkai di bawah pengaturan ini.  

 Frame Size: Pengguna pro dapat memilih dimensi bingkai video mereka sendiri.  

 Preview Frame Size: Ini sebenarnya adalah tombol yang sangat berguna. Klik untuk 
melihat pratinjau kotak hijau tentang seberapa besar video Anda akan terlihat di layar 
Anda. Klik pratinjau untuk menghilangkannya setelah Anda selesai. 

 Frame Rate: Teknologi video yang berbeda menggunakan frame rate yang berbeda. 
Menggunakan lebih banyak frame/detik (fps) menghasilkan gerakan yang lebih mulus 
tetapi file lebih besar dan waktu pemrosesan lebih lama. Secara umum, 30 fps adalah 
sweet spot yang bagus. Jika Anda khawatir tentang file besar, coba 15 fps dan lihat 
tampilannya. 

 Restore Default: Mengganti konten hard drive Anda dengan montase video 8 detik yang 
berulang dari momen-momen sinematik terhebat Keanu Reaves. Hanya memastikan 
Anda masih memperhatikan - tombol ini mengembalikan semua yang ada di Opsi Ekspor 
seperti sebelum Anda mulai mengotak-atik. 

 Loop to Starting Scene: Secara otomatis mengakhiri video Anda di Scene yang Anda 
mulai, bukan Scene terakhir dalam urutan. Opsi ini berguna jika Anda ingin film Anda 
berakhir persis seperti saat dimulainya. 

 Anti-alias Rendering: Memilih ini menggandakan jumlah waktu yang dibutuhkan animasi 
Anda untuk mengekspor, tetapi itu membuat tepian Anda terlihat jauh lebih mulus di film 
terakhir. Anda hampir pasti ingin memilih opsi ini. 

 Transparent Background (Mac only): Jika Anda berencana menggunakan film yang 
diekspor dengan perangkat lunak pengeditan video lanjutan, ini adalah sesuatu yang 
mungkin menarik bagi Anda. Jika tidak, Anda mungkin harus membiarkan opsi ini tidak 
dipilih. 
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 Always Prompt for Animation Options (Windows only): Pilih ini untuk memaksa 
SketchUp menampilkan kotak dialog Opsi Ekspor Animasi setiap kali Anda mengekspor 
film. 

Mengekspor File CAD 

AutoCAD dan perangkat lunak berbasis CAD lainnya sangat populer di kalangan arsitek, insinyur, 
dan siapa saja yang perlu membuat atau membuat barang super presisi. Meskipun beberapa 
profesional telah sepenuhnya menggantikan alur kerja berbasis AutoCAD dengan SketchUp dan 
LayOut, yang lain masih menggunakan AutoCAD. 

Jika Anda perlu mengekspor model SketchUp ke file DWG yang berfungsi dengan perangkat lunak 
berbasis CAD, SketchUp Pro memiliki cara kerja bagian dalam untuk menerjemahkan file SKP 
Anda menjadi file DWG. (Anda tidak dapat mengekspor file CAD dari SketchUp Make; Anda harus 
mengeluarkan uang untuk Pro.) Karena proses SKP-toDWG cukup maju, bagian ini sebagian besar 
memberi Anda gambaran umum tingkat tinggi dari proses ekspor sehingga Anda memiliki 
pemahaman dasar tentang cara kerjanya. 

Mempersiapkan file Anda 

Pertama, beberapa tugas dapat menghasilkan file ekspor yang lebih bersih. Berikut cara 
menyiapkan file Anda sebelum mengekspornya sebagai file DWG: 

 Periksa unit Anda. Jika format satuan (inci atau desimal, misalnya) file SketchUp Anda 
cocok dengan satuan yang diinginkan untuk file DWG, proses ekspor berjalan jauh lebih 
lancar. Untuk memeriksa unit model Anda, pilih Window => Model Info dan pilih panel 
Units di sebelah kiri. 

 Matikan style yang bermasalah. Style garis yang menggunakan titik akhir atau ekstensi 
tidak selalu diterjemahkan dengan baik dalam proses ekspor. Jika Anda memiliki masalah 
dengan titik akhir atau ekstensi di file yang Anda ekspor, coba nonaktifkan. Anda 
mematikan style garis pada tab Edit panel Style.  

 Atur view Anda. Jika Anda mengekspor file DWG 2D, kemungkinan Anda mengekspor 
denah lantai yang mungkin perlu mencerminkan skala tertentu. Jika demikian, pastikan 
model dalam tampilan Proyeksi Paralel (pilih Kamera => Proyeksi Paralel) dan gunakan 
salah satu tampilan standar, seperti Atas atau Depan. (Tampilan standar apa pun tetapi 
Iso tidak apa-apa.) 

Masalah Teknis 

Ingatlah bahwa layer SketchUp tidak dapat diterjemahkan secara langsung ke layer CAD. 

Mengekspor file DWG 2D 

Untuk mengekspor model SketchUp sebagai file CAD 2D, ikuti langkah-langkah berikut: 

1. Siapkan file Anda, seperti yang dijelaskan di bagian sebelumnya.  
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Kami tidak ingin Anda melewatkan tips tersebut. 

2. Pilih File => Export => 2D Graphic. 
3. Di kotak dialog ekspor yang muncul, pilih untuk mengekspor file Anda sebagai file DWG. 

Kemudian klik tombol Options. 
4. Pilih opsi yang Anda inginkan.  

Bagian Drawing Scale dan Size memungkinkan Anda memilih opsi skala. Jika model Anda 
menggunakan garis profil), maka Anda dapat memilih opsi di sini yang mengekspor garis 
profil sebagai polyline CAD dan menyesuaikan lebar garis jika Anda mau. Kotak centang 
Pisahkan pada Layer, ketika dipilih, tempatkan garis profil atau garis potong bagian pada 
layer terpisah. 

5. Klik OK di kotak dialog Opsi Ekspor. Kemudian klik tombol Ekspor. Bergantung pada 
seberapa besar file SketchUp Anda, proses ini dapat memakan waktu cukup lama. 

Mengekspor file DWG 3D 

Saat Anda mengekspor file SketchUp ke file 3D DWG, Anda dapat memilih entitas yang ingin Anda 
ekspor. Misalnya, Anda mungkin ingin mengekspor hanya edge dan menghilangkan face, 
dimensi, dan teks. Ikuti langkah-langkah berikut untuk mengekspor model SketchUp Anda ke file 
3D DWG: 

1. Ingatlah untuk mempersiapkan file Anda, seperti yang dijelaskan di awal bagian ini. 
2. Pilih File => Export => 3D Model. 
3. Di kotak dialog Model Ekspor yang muncul, pilih jenis file DWG. 
4. Klik tombol Opsi untuk memilih entitas apa yang ingin Anda ekspor. Setelah selesai, klik 

OK. 
5. Klik tombol Ekspor. Roda gigi SketchUp mulai mengubah file Anda menjadi format yang 

ramah CAD. 
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BAB 12 

Membagikan Apa yang Telah Anda Buat 

Mencetak di atas kertas dan mengupload ke cloud mungkin tampak berlawanan secara diametris, 
tetapi keduanya sebenarnya hanya mengacu pada kontinum berbagi yang sama. 

Di bagian pertama bab ini, Anda mempelajari cara mencetak tampilan model SketchUp Anda. 
Karena versi Windows dan Mac dari prosedur ini sangat berbeda, setiap sistem operasi memiliki 
bagiannya sendiri. 

Bagian kedua dari bab ini didedikasikan untuk 3D Warehouse SketchUp. Ini adalah warehouse 
model online raksasa yang dibuat (kebanyakan) oleh pemodel SketchUp sehari-hari. 
Mengunggah kreasi Anda sendiri ke 3D Warehouse berguna untuk berbagi dan mengarsipkan 
pekerjaan Anda. 

Mencetak Pekerjaan Anda 

Meskipun semua orang suka berpura-pura bahwa kita hidup di dunia serba digital, kenyataannya 
tidak. Beberapa klien lebih suka melihat hasil cetak. Aidan suka sekali printoutnya untuk ditempel 
di dinding. Rebecca suka bertukar pikiran dan membuat sketsa perubahan potensial pada 
cetakan, sebagai cara mengembangkan peta jalan untuk perubahan yang benar-benar ingin dia 
lakukan sebelum lebih lanjut mengubah file digital. 

Mencetak dari komputer Windows 

Mencetak dari SketchUp itu mudah, selama Anda tidak mencoba melakukan sesuatu yang terlalu 
rumit. Yang kami maksud dengan rumit adalah mencetak ke skala tertentu, yang bisa menjadi 
pengalaman yang mengerikan beberapa kali Anda mencobanya. Untungnya, mencetak sesuai 
skala adalah sesuatu yang hampir tidak pernah dilakukan oleh kebanyakan orang, jadi kami 
menyimpan petunjuk tentang cara melakukannya di akhir bagian ini. 

Membuat cetakan dasar (Windows) 

Sering kali, yang perlu Anda lakukan hanyalah mencetak persis seperti yang Anda lihat di layar. 
Ikuti langkah-langkah berikut untuk melakukannya: 

1. Pastikan bahwa tampilan yang ingin Anda cetak muncul di window pemodelan Anda.  

Kecuali Anda mencetak untuk skala, SketchUp mencetak persis seperti yang Anda lihat di 
window pemodelan Anda. 

2. Pilih File => Print Setup.  

Kotak dialog Print Setup terbuka, di mana Anda memilih printer dan kertas yang ingin 
Anda gunakan. 

3. Pada kotak dialog Print Setup yang ditunjukkan pada Gambar 12-1, lakukan hal berikut: 



364 
 

a. Pilih printer yang ingin Anda gunakan. 
b. Pilih ukuran kertas untuk cetakan Anda. 
c. Pilih orientasi untuk cetakan Anda; sering kali, Anda ingin menggunakan 

Pemandangan karena layar Anda biasanya lebih lebar daripada tingginya. 
4. Klik OK untuk menutup kotak dialog Pengaturan Cetak. 
5. Pilih File => Print Preview. 

Tips 

Kotak dialog Print Preview terbuka. Pratinjau Cetak memungkinkan Anda melihat gambar 
seperti apa cetakan Anda sebelum Anda mengirimkannya ke printer. Banyak pohon 
terima kasih telah menghemat kertas dengan menggunakan Pratinjau Cetak setiap kali 
Anda mencetak. 

6. Dalam kotak dialog Pratinjau Cetak, lakukan hal berikut: 
a. Di area Tabbed Scene Print Range, pilih Scene mana yang ingin Anda cetak, jika 

Anda memiliki lebih dari satu. 
b. Beri tahu SketchUp berapa banyak salinan dari setiap Scene yang Anda butuhkan. 
c. Pastikan kotak centang Paskan ke Halaman dipilih. 
d. Pastikan kotak centang Use Model Extents tidak dipilih. 
e. Pilih kualitas cetak untuk hasil cetak Anda. Kami merekomendasikan Definisi 

Tinggi untuk sebagian besar pekerjaan. 
7. Klik OK.  

Kotak dialog Print Preview menutup, dan Anda mendapatkan pratinjau di layar tentang 
seperti apa hasil cetak Anda. 

8. Jika Anda menyukai apa yang Anda lihat, klik tombol Cetak di sudut kiri atas window 
Pratinjau Cetak untuk membuka kotak dialog Print.  

Jika Anda tidak menyukai apa yang akan Anda cetak, klik tombol Tutup (di bagian atas 
layar) dan kembali ke Langkah 1. 

9. Dalam kotak dialog Cetak (yang akan terlihat persis seperti kotak dialog Pratinjau 
Cetak), klik OK.  

Pekerjaan pencetakan Anda masuk ke printer. 
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Gambar 12-1: Kotak dialog Print Setup di Windows. 

Decoding kotak dialog Print Preview dan Windows Print 

Tiga sorakan untuk kesederhanaan! Kotak dialog Print Preview dan Print di SketchUp sama persis. 
Gambar 12-2 menunjukkan yang pertama karena itulah yang kami anjurkan untuk digunakan 
pertama kali, tetapi deskripsi di bagian ini berlaku untuk keduanya. 

PRINTER 

Jika Anda menggunakan kotak dialog Print Setup terlebih dahulu, Anda tidak perlu mengubah 
pengaturan di bagian ini. Jika mau, dari daftar drop-down, Anda dapat memilih printer mana yang 
akan digunakan. Jika Anda mengetahui sesuatu tentang printer, Anda bahkan dapat mengklik 
tombol Properties untuk menyesuaikan pengaturan printer Anda. (Karena setelan berbeda untuk 
setiap printer di Earth, itu antara Anda dan manual pengguna printer Anda.) 

RENTANG TABBED SCENE PRINT 

Gunakan area ini untuk memberi tahu SketchUp Scene mana yang ingin Anda cetak, jika Anda 
punya lebih dari satu. Opsi ini sangat berguna untuk mencetak semua pemandangan Anda 
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dengan cepat. Pilih opsi Tampilan Saat Ini untuk mencetak hanya apa pun yang saat ini ada di 
window pemodelan Anda. 

SALINAN 

Yang ini cukup mendasar: Pilih berapa banyak salinan dari setiap tampilan yang ingin Anda cetak. 
Jika Anda mencetak banyak salinan dari beberapa Scene, pilih kotak centang Susun untuk 
mencetak paket, yang dapat menyelamatkan Anda dari merakitnya sendiri. Inilah yang terjadi 
jika Anda mencetak tiga salinan dari empat Scene: 

 Memilih kotak centang Susun akan mencetak halaman dalam urutan berikut: 
123412341234. 

 Membatalkan pilihan kotak centang Susun akan mencetak halaman seperti ini: 
111222333444. 
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Gambar 12-2: Kotak dialog Print Preview di Windows. Kotak dialog Print terlihat persis sama. 

PRINT SIZE 

Sejauh ini, ini adalah bagian paling rumit dari kotak dialog ini; Ukuran Cetak mengontrol 
bagaimana model Anda akan terlihat pada halaman yang dicetak. Gambar 12-3 menunjukkan 
efek dari beberapa pengaturan ini pada cetakan akhir. 
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Gambar 12-3: Pengaturan Ukuran Cetak yang berbeda diterapkan pada tampilan yang sama di 
SketchUp. 

Kontrol Ukuran Cetak adalah sebagai berikut: 

 Sesuaikan dengan Halaman: Memilih kotak centang ini memberi tahu SketchUp untuk 
membuat halaman yang dicetak terlihat seperti window pemodelan Anda. Selama kotak 
centang Use Model Extents tidak dipilih, Anda dapat melihat dengan tepat apa yang Anda 
lihat di layar - tidak lebih, tidak kurang. 

 Gunakan Model Extents: Opsi ini memberi tahu SketchUp untuk memperbesar agar 
model Anda (tidak termasuk langit, tanah, watermark, dan apa pun yang terlihat di layar 
Anda) sesuai dengan halaman yang dicetak. Jika kita menginginkan efek ini, kita lebih suka 
memilih Camera => Zoom Extents dari menu bar sebelum mencetak model. 
Melakukannya memastikan kita tahu persis apa yang kita dapatkan. 

 Ukuran Halaman: Selama Anda tidak mencentang kotak Paskan dengan Halaman, Anda 
dapat memasukkan ukuran halaman secara manual menggunakan kontrol ini. Jika Anda 
mengetik lebar atau tinggi, SketchUp akan mengetahui dimensi lainnya dan berpura-pura 
mencetak pada selembar kertas dengan ukuran berbeda. 

 Scale: Di sinilah pencetakan menjadi sedikit rumit. Untuk mencetak ke skala, Anda harus 
melakukan dua hal sebelum Anda mendekati kotak dialog Print atau Print Preview: 

 Beralih ke mode Proyeksi Paralel. 

 Pastikan Anda menggunakan salah satu tampilan Standar. 

Lihatlah bagian”Mencetak untuk menskalakan (Windows dan Mac),” nanti di bab ini, untuk 
ikhtisar lengkap tentang pencetakan untuk menskalakan di SketchUp. 

TILED SHEET PRINT RANGE  

Mungkin Anda mencetak dalam skala yang tidak muat di satu halaman, atau Anda telah 
memasukkan ukuran cetak yang lebih besar dari ukuran kertas yang Anda pilih di kotak dialog 
Pengaturan Cetak. Area Tiled Sheet Print Range memungkinkan Anda mencetak gambar Anda 
pada beberapa lembar dan kemudian melampirkannya nanti. Anda bisa mendapatkan poster dari 
printer format kecil Anda! 

KUALITAS CETAK 
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Sejujurnya, memilih kualitas cetak untuk gambar Anda memerlukan sedikit trial and error. Apa 
yang Anda dapatkan dengan setiap pengaturan sangat bergantung pada model Anda, jadi 
cobalah beberapa pengaturan berbeda jika Anda punya waktu. 

 Draf dan Standar benar-benar hanya berguna untuk memeriksa bagaimana model Anda 
muncul pada halaman yang dicetak. 

 Untuk hasil cetakan yang tampak selesai, coba High Definition terlebih dahulu dan 
kemudian naik ke Ultra High Definition jika komputer/pengaturan printer Anda dapat 
menanganinya. 

PENGATURAN LAINNYA 

Anda juga dapat mengontrol pengaturan peluang dan akhir berikut di kotak dialog Pratinjau 
Cetak: 

 2-D Section Slice Only: Jika Anda memiliki potongan bagian yang terlihat dalam tampilan 
model Anda, memilih kotak centang ini memberitahu SketchUp untuk mencetak hanya 
bagian yang dipotong tepi. Gambar 12-4 menunjukkan tampilan model yang sama tanpa 
(di kiri) dan dengan (kanan) opsi ini dipilih. Anda dapat menggunakan opsi ini untuk 
menghasilkan tampilan rencana dan bagian sederhana. 

 Gunakan Akurasi Tinggi HLR: Kabar buruknya adalah kita tidak tahu apa kepanjangan dari 
HLR. Kabar baiknya adalah itu tidak terlalu penting. Memilih kotak centang ini memberi 
tahu SketchUp untuk mengirim informasi vektor ke printer alih-alih data raster biasa. 
Mengapa Anda harus peduli? Garis vektor terlihat jauh lebih halus dan lebih bersih saat 
dicetak, sehingga seluruh model Anda akan terlihat lebih baik - dengan satu syarat: 
Gradien (bayangan halus yang bagus pada permukaan bulat) tidak tercetak dengan baik 
sebagai vektor. Jika Anda memiliki banyak permukaan membulat atau melengkung pada 
tampilan model Anda, Anda mungkin tidak ingin memilih opsi ini. Cobalah untuk 
mencetak dua arah dan pilih salah satu yang terlihat lebih baik. 

 

Gambar : Mencetak hanya irisan bagian 2D akan menghasilkan gambar sederhana yang mudah 
untuk membuat sketsa. 
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Mencetak dari Mac 

Jika Anda menggunakan Mac, kisah pencetakan sedikit lebih sederhana daripada untuk orang-
orang yang menggunakan komputer Windows - tetapi hanya sedikit. Bagian pertama dari bagian 
berikut menjelaskan prosedur untuk menghasilkan cetakan yang sederhana dan lugas dari apa 
yang Anda lihat di window pemodelan Anda. 

Bagian kedua bisa disebut”Anatomi kasar kotak dialog Mac". Di bagian ini, kami menjelaskan apa 
yang dilakukan setiap pengaturan. 

Membuat cetakan dasar (Mac) 

Ikuti langkah-langkah berikut untuk mencetak dengan tepat apa yang Anda lihat di window 
pemodelan Anda di Mac: 

1. Pastikan window pemodelan Anda berisi apa pun yang ingin Anda cetak.  

SketchUp mencetak persis seperti yang Anda lihat di window pemodelan Anda, kecuali 
tentu saja Anda mencetak untuk skala. Karena mencetak untuk skala itu rumit, topik 
tersebut memiliki bagiannya sendiri nanti di bab ini. 

2. Pilih File => Page Setup.  

Kotak dialog Page Setup terbuka, di mana Anda memutuskan printer dan ukuran kertas 
yang akan digunakan. 

3. Pada kotak dialog Page Setup yang ditunjukkan pada Gambar 12-5, lakukan hal berikut: 
a. Pilih printer yang ingin Anda gunakan dari Format For daftar drop-down. 
b. Pilih ukuran kertas untuk cetakan Anda. 
c. Pilih orientasi untuk cetakan Anda. Lansekap adalah pilihan paling umum, karena 

window pemodelan SketchUp biasanya lebih lebar daripada tingginya. 
4. Klik OK untuk menutup kotak dialog Page Setup. 
5. Pilih File => Pengaturan Dokumen. 

Kotak dialog Document Setup terbuka. 

6. Dalam kotak dialog Pengaturan Dokumen, pastikan bahwa kotak centang Sesuaikan 
Tampilan dengan Halaman dipilih.  

Lihat bagian selanjutnya dalam bab ini untuk penjelasan lengkap tentang apa yang 
dilakukan semua hal. 

7. Klik OK untuk menutup kotak dialog Pengaturan Dokumen. 
8. Pilih File => Print untuk membuka kotak dialog Print.  

Dalam kotak dialog Cetak, Anda melihat pratinjau di layar tentang seperti apa hasil cetak 
Anda di atas kertas. 
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9. Jika pratinjau cocok untuk Anda, klik tombol Cetak untuk mengirim pekerjaan 
pencetakan Anda ke printer.  

Jika Anda tidak puas dengan pratinjau, klik tombol Batal dan mulai lagi di Langkah 1. 

 

Gambar 12-5: Kotak dialog Page Setup pada Mac memungkinkan Anda memilih printer, ukuran 
kertas, dan orientasi halaman. 

Kotak dialog Pengaturan Dokumen 

Anda menggunakan pengaturan dalam kotak dialog Pengaturan Dokumen yang ditunjukkan pada 
Gambar 12-6 untuk mengontrol seberapa besar model Anda dicetak. Inilah yang dilakukan 
semuanya: 

 Print Size: Yang ini cukup jelas, tetapi berikut adalah beberapa detail untuk berjaga-jaga: 
o Sesuaikan Tampilan dengan Halaman: Pilih kotak centang ini untuk memberi tahu 

SketchUp agar halaman tercetak Anda terlihat seperti window pemodelan di layar. 
Sesederhana itu. 

o Lebar dan Tinggi: Jika kotak centang Sesuaikan Tampilan dengan Halaman (Fit 
View to Page) tidak dipilih, Anda dapat mengetikkan lebar atau tinggi untuk 
cetakan akhir Anda. Ini adalah cara yang tepat jika Anda ingin mencetak poster 
berubin dari beberapa lembar kertas; cukup masukkan ukuran akhir, dan Anda 
akan memiliki poster dalam waktu singkat. 

 Print Scale: Gunakan setelan ini untuk mengontrol skala gambar yang Anda cetak, jika itu 
jenis cetakan yang Anda coba buat. Karena mencetak dengan skala sedikit menyusahkan, 
kami mencurahkan bagian terakhir dari bab ini ke topik. Lihat bagian itu untuk penjelasan 
tentang apa yang dilakukan pengaturan ini. 
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 Page Rquirement: Ini hanyalah pembacaan dari berapa banyak halaman yang perlu Anda 
cetak. Jika Anda telah memilih kotak centang Sesuaikan Tampilan dengan Halaman, ini 
adalah 1. Jika cetakan Anda tidak muat pada satu lembar, itu ubin ke jumlah lembar yang 
ditampilkan di bagian kotak dialog ini. 

 

Gambar 12-6: Kotak dialog Pengaturan Dokumen Mac. 

Kotak Dialog Print 

Kotak dialog Print di Mac adalah semacam binatang berkepala banyak; beberapa panel 
tersembunyi di bawah daftar drop-down SketchUp. Untungnya, Anda tidak perlu menyesuaikan 
opsi tersebut kecuali Anda mengelola warna atau teknis pencetakan lain yang berada di luar 
cakupan buku ini. Opsi pada panel SketchUp, ditunjukkan pada Gambar 12-7, dijelaskan dalam 
daftar berikut: 

 Copies: Beri tahu SketchUp berapa banyak salinan yang ingin Anda cetak. 

 Pages: Jika pembacaan Halaman yang Diperlukan di bagian bawah kotak dialog 
Pengaturan Dokumen (lihat Gambar 12-6) mengatakan bahwa Anda memerlukan lebih 
dari satu lembar untuk mencetak gambar Anda, Anda dapat memilih untuk mencetak 
semua atau beberapa halaman itu di sini . 

 Print Quality: Pengaturan ini mungkin memerlukan beberapa percobaan dan kesalahan, 
karena setiap printer menangani pengaturan kualitas dengan caranya sendiri. Untuk 
memulai, coba pengaturan Tinggi dan sesuaikan dari sana. Secara umum, Draft atau 
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Standard hanya bagus untuk memeriksa bagaimana tampilan halaman. Jika Anda punya 
waktu, cobalah Tinggi dan Ekstra Tinggi dan lihat mana yang paling bagus. 

 Vector Printing: Jika Anda memilih kotak centang ini, SketchUp mengirimkan informasi 
vektor (bukan raster) ke printer. 

Ingat 

Hasilnya di sini adalah bahwa pencetakan vektor membuat edge terlihat jauh lebih halus dan 
lebih bersih tetapi melakukan pekerjaan yang buruk pada gradien (bayangan pada permukaan 
lengkung Anda). Gunakan pencetakan vektor jika tampilan model Anda sebagian besar terdiri 
dari permukaan datar, tetapi coba cetak kedua cara (dengan pencetakan vektor aktif dan 
nonaktif) untuk melihat mana yang terlihat lebih baik. 

 Tips 

 Jika tampilan model Anda menyertakan style edge Sketsa, jangan pilih Pencetakan Vektor; Anda 
tidak akan melihat efek bagus dan samar di cetakan akhir Anda. 

 Line Weight: Opsi ini hanya berfungsi jika Anda telah memilih kotak centang Pencetakan 
Vektor. Angka dalam kotak ini mewakili ketebalan edge pada hasil cetak Anda; setiap edge 
yang setebal 1-piksel dalam tampilan model Anda akan digambar dengan garis setebal 
yang Anda pilih untuk opsi ini. Standarnya adalah 0,50 poin, tetapi silakan bereksperimen 
untuk melihat apa yang paling cocok untuk model Anda. 

 

Gambar 12-7: Panel SketchUp pada kotak dialog Print. 

Mencetak ke skala tertentu 

Di sinilah pencetakan menjadi menarik. Kadang-kadang, alih-alih mencetak persis seperti yang 
Anda lihat di layar agar pas di selembar kertas, Anda mungkin perlu mencetak gambar sesuai 
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skala. Lihat sidebar terdekat”Membungkus kepala Anda di sekitar skala" untuk informasi lebih 
lanjut tentang menggambar dengan skala. 

Tips 

Perlu diingat bahwa jika Anda memiliki SketchUp Pro, Anda dapat menggunakan LayOut untuk 
menghasilkan tampilan berskala dari model Anda dengan sangat mudah 

Mempersiapkan untuk mencetak dengan skala  

Sebelum Anda dapat mencetak tampilan model Anda ke skala tertentu, Anda harus menyiapkan 
semuanya dengan benar. Ingatlah hal-hal berikut ini: 

 Tampilan perspektif tidak dapat dicetak sesuai skala. Jika Anda memikirkannya, ini 
masuk akal. Dalam pandangan perspektif, semua garis tampak”kembali" ke kejauhan, 
yang berarti bahwa garis tersebut terlihat lebih pendek dari yang sebenarnya. Karena inti 
dari gambar berskala adalah agar dapat melakukan pengukuran yang akurat langsung dari 
cetakan Anda, tampilan dengan perspektif tidak berfungsi. 

 Beralih ke Proyeksi Paralel jika Anda ingin mencetak dengan skala. Kami tahu, kami tahu 
- ini sama dengan poin terakhir. Tapi cukup penting untuk disebutkan dua kali. Untuk 
mengubah mode tampilan Anda dari Perspektif ke Proyeksi Paralel, pilih Camera => 
Parallel Projection. 

 Anda harus menggunakan tampilan Standar. SketchUp memungkinkan Anda melihat 
model Anda dengan cepat dari atas, bawah, dan samping dengan beralih ke salah satu 
tampilan Standar. Pilih Kamera => Standar dan pilih salah satu tampilan kecuali Iso. 

Mencetak sesuai skala (Windows dan Mac) 

Langkah-langkah di bagian ini memungkinkan Anda menghasilkan cetakan berskala dari 
SketchUp. Instruksi Windows muncul pertama kali dan kemudian rincian Mac. Jika elemen 
antarmuka pengguna berbeda untuk kedua platform, yang untuk Mac ditampilkan dalam tanda 
kurung. Gambar 12-8 menunjukkan kotak dialog yang relevan untuk pencetakan dengan skala di 
Windows dan Mac. 
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Gambar 12-8: Menyiapkan untuk mencetak pada skala 1 inci = 4 kaki (¼ inci = 1 kaki). 

Ingat 

Sebelum memulai, pastikan Anda telah beralih ke Proyeksi Paralel dan tampilan Anda diurutkan 
dengan benar. Lihat bagian sebelumnya dari bab ini untuk bantuan dengan tampilan model Anda 
untuk pencetakan berskala. Ikuti langkah-langkah ini untuk menghasilkan cetakan berskala: 

1. Pilih File => Pengaturan Cetak (Pengaturan Halaman). 
2. Pilih printer, ukuran kertas, dan orientasi kertas, lalu klik OK. 
3. Pilih File => Pratinjau Cetak (Pengaturan Dokumen). 
4. Kosongkan kotak centang Fit to Page (Fit View to Page). 
5. Windows: Pastikan bahwa kotak centang Use Model Extents telah dikosongkan.  

Pengguna Mac tidak memiliki opsi ini. 

6. Masukkan skala yang Anda inginkan untuk mencetak tampilan model Anda.  

Jika Anda ingin mencetak gambar dengan skala ¼-inci, masukkan yang berikut ini:  

 1 Inci ke dalam kotak In the Printout (In Drawing)  

 4 Feet ke dalam kotak In SketchUp (Dalam Model)  

Jika Anda ingin mencetak dengan ukuran 1: Skala 100, masukkan yang berikut ini:  

 1 m ke dalam kotak In the Printout (In Drawing)  
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 100 m ke dalam Box In SketchUp (In Model) 
7. Perhatikan bagaimana halaman yang Anda perlukan untuk mencetak gambar Anda. 

 
Jika Anda menggunakan Windows, Anda dapat mencentangnya di area Rentang Cetak 
Lembar Berubin di kotak dialog. Di Mac, jumlah halaman yang Anda perlukan muncul di 
bagian Halaman yang Diperlukan dari kotak dialog Pengaturan Dokumen. Jika Anda ingin 
mencetak pada kertas berukuran berbeda, ubah pengaturan dalam kotak dialog 
Pengaturan Cetak (Pengaturan Halaman). 

8. Jika Anda ingin mencetak gambar Anda pada satu lembar dan tidak muat, gunakan skala 
yang lebih kecil.  

Menggunakan contoh ¼ inci = 1 kaki, coba susutkan gambar ke skala inci = 1 kaki. Untuk 
melakukan ini, masukkan yang berikut ini:  

 3 Inches ke dalam kotak In the Printout (In Drawing)  

 16 Feet ke dalam kotak In SketchUp (In Model) 
9. Jika Anda senang dengan hasil gambar Anda, klik Oke. 
10. Lakukan langkah berdasarkan sistem operasi Anda:  

 Windows: Jika Anda menyukai apa yang Anda lihat di kotak dialog Pratinjau Cetak, 
klik tombol Cetak (di sudut kiri atas) untuk membuka kotak dialog Cetak.  

 Mac: Pilih File => Cetak. 
11. Dalam kotak dialog Print, klik OK untuk mengirim pekerjaan pencetakan Anda ke printer. 

Lihat bagian sebelumnya dari bab”Membuat cetakan dasar" (untuk sistem operasi Anda) 
untuk keseluruhan cerita tentang pencetakan dasar dari SketchUp. 

Bekerja dengan 3DWarehouse 

3D Warehouse adalah online collection besar model 3D yang dapat ditelusuri dan, yang 
terpenting, gratis untuk digunakan semua orang. Untuk mengakses 3D Warehouse, yang Anda 
butuhkan hanyalah sambungan Internet. Jika Anda memiliki model SketchUp yang ingin Anda 
bagikan kepada dunia, dibagikan hanya dengan beberapa orang, atau simpan di server SketchUp 
untuk pengamanan, 3D Warehouse adalah tempat Anda meletakkannya. 

Mengapa Warehouse? 

Tips 

Sebelum melanjutkan, izinkan kami segera menghilangkan kesalahpahaman populer: Saat Anda 
mengunggah model ke 3D Warehouse SketchUp, Anda tidak secara otomatis mendonasikan kerja 
keras Anda kepada dunia - Anda dapat menjadikan model dan koleksi yang diunggah menjadi 
pribadi. 

Dengan pemahaman tersebut, berikut beberapa alasan hebat untuk menggunakan 3D 
Warehouse: 
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 Berbagi itu baik untuk harga diri Anda. Untuk lebih jelasnya, kami tidak mengikuti pola 
pikir teknologi nouveau bahwa semua informasi ingin diberikan secara gratis. Jika Anda 
menghabiskan banyak waktu untuk sesuatu dan tidak ingin memberikannya begitu saja, 
Anda tidak perlu melakukannya. Namun jika Anda bangga dengan apa yang Anda buat, 
dan membagikannya dengan orang lain akan membuat Anda merasa senang, 3D 
Warehouse menawarkan cara yang hebat untuk berkontribusi pada komunitas 
pemodelan 3D. 

 Buat perpustakaan komponen pribadi Anda sendiri. Karena SketchUp dapat mengunduh 
model langsung dari 3D Warehouse ke dalam model yang sedang Anda kerjakan, 
membuat online collection Anda sendiri sangatlah berguna. Semua yang Anda unggah 
dapat diakses di mana pun Anda bekerja. Misalnya, Anda bisa memelihara koleksi furnitur 
di rumah Anda. Kapan pun Anda membutuhkan model sofa, Anda dapat mengunduhnya 
- apa pun komputer yang Anda gunakan. 

 Jelajahi model yang diunggah dalam 3D tanpa harus mengunduhnya. Anda dapat 
mengorbit, menggeser, dan memperbesar/memperkecil model apa pun yang dapat Anda 
lihat di 3D Warehouse - tanpa harus mengunduhnya terlebih dahulu ke SketchUp. Jika 
Anda ingin menunjukkan model Anda dalam 3D kepada seseorang, Anda dapat 
mengirimkannya tautan 3D Warehouse-nya. Lebih baik lagi, Anda dapat menyematkan 
window penampil 3D di laman web Anda; siapa pun yang mengunjungi halaman Anda 
dapat melihat-lihat. 

 Memiliki cadangan bukanlah ide yang buruk. Jika yang ingin Anda lakukan hanyalah 
menyimpan salinan pekerjaan Anda di cloud (di mana Anda tidak dapat menumpahkan 
kopi Anda seluruhnya), layanan seperti Dropbox, Google Drive, dan Microsoft OneDrive 
adalah pilihan yang bagus. Namun, tidak satu pun dari ini memberi Anda akses langsung 
ke model Anda di dalam SketchUp. Saat Anda mengunggah sesuatu ke 3D Warehouse, itu 
aman dan sudah tersedia. 

Membuka 3D Warehouse 

Anda dapat membuka 3D Warehouse dengan dua cara: 

 Dari SketchUp: Pilih File => 3D Warehouse => Dapatkan Model; ketika Anda 
melakukannya, browser web mini terbuka tepat di depan window pemodelan Anda. 

 Dari web: Jelajahi https://3dwarehouse.sketchup.com. 

Tips 

Mengakses 3D Warehouse dari web adalah cara terbaik untuk berburu model 3D tanpa membuka 
SketchUp terlebih dahulu. 

Silakan melihat-lihat 3D Warehouse. Sungguh menakjubkan apa yang Anda temukan; ribuan 
orang menambahkan konten baru setiap hari. Sebagian besar tidak terlalu berguna, tetapi Anda 
masih menemukan banyak hal menarik untuk diunduh dan dilihat. 

Mengupload model 
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Ikuti langkah-langkah berikut untuk mengunggah model Anda ke 3D Warehouse: 

1. Buka model yang ingin Anda unggah di SketchUp dan mainkan dengan tampilan Anda 
sampai Anda menyukai apa yang Anda lihat.  

Saat Anda mengunggah model ke 3D Warehouse, SketchUp secara otomatis membuat 
gambar pratinjau yang merupakan cuplikan dari window pemodelan Anda. 

2. Pilih File => 3D Warehouse => Share Model.  

Window browser mini terbuka, dan ini menampilkan layar masuk untuk 3D Warehouse. 
Jika Anda ingin mengunggah model, Anda memerlukan ID Trimble atau akun Google. 
Kedua jenis akun ini gratis; Anda hanya perlu alamat email yang valid untuk 
mendapatkannya. Jika Anda belum memilikinya, ikuti petunjuk di layar untuk mendaftar. 

3. Masukkan informasi akun Anda, klik tombol Masuk, dan isi formulir Unggah ke 3D 
Warehouse selengkap mungkin: 

a. Privacy: Anda dapat memilih untuk menjadikan model Anda Publik atau Pribadi. 
Mencentang opsi Publik memberi siapa pun hak untuk menemukan, mengunduh, 
dan menggunakan model Anda sesuka dia. Jika Anda memilih Pribadi, model Anda 
tetap tersembunyi (dari semua orang kecuali Anda). Beralihlah ke”Mengelola 
model secara online", di bab ini, untuk mengetahui lebih lanjut tentang topik ini. 

b. Title: Masukkan judul untuk model Anda. Jika ini adalah bangunan publik, Anda 
dapat memasukkan namanya. Sesuatu seperti Royal West Academy akan berhasil. 

c. Description: Model dengan deskripsi lengkap sangat populer di kalangan orang-
orang yang berburu di sekitar Gudang. Coba gunakan kalimat lengkap di sini; 
semakin banyak Anda menulis, semakin baik. 

d. URL: Jika Anda memiliki alamat situs web yang Anda inginkan agar dikunjungi 
orang yang melihat model Anda, masukkan di sini. Misalnya, jika model Anda 
adalah bangunan bersejarah, Anda dapat menyertakan situs web yang 
memberikan informasi lebih lanjut tentang bangunan itu. 

e. Tag: Ketikkan string kata yang mendeskripsikan hal yang Anda modelkan. Mesin 
telusur 3D Warehouse menggunakan apa pun yang Anda masukkan di sini untuk 
membantu orang menemukan model Anda. Untuk meningkatkan jumlah orang 
yang melihat apa yang Anda buat, tambahkan banyak tag. Misalnya, jika Anda 
mengunggah meja kopi modern, Anda dapat memasukkan tag berikut: meja kopi, 
meja, kopi, modern, ruang tamu, furnitur, kaca, krom, logam, dan baja. Anda 
mendapatkan idenya - teliti. 

4. Klik tombol Unggah untuk menambahkan model Anda ke 3D Warehouse.  

Jika semuanya berfungsi dengan baik, Anda akan melihat halaman dengan model Anda di 
atasnya, bersama dengan semua informasi yang baru saja Anda masukkan. Selamat - 
Anda sekarang adalah anggota penuh dunia SketchUp. 

Tips 
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Robot 3D Warehouse (backendnya, dalam bahasa geek) membutuhkan waktu beberapa saat 
untuk memproses model Anda setelah Anda mengunggahnya. Anda tidak akan dapat 
menelusurinya, melihatnya di koleksi Anda, atau bahkan mempratinjaunya dalam 3D selama 
beberapa menit. Tapi tidak apa-apa - duduk saja dan renungkan apa yang akan dikatakan kakek 
buyut Anda jika dia mendengar Anda mengeluh. Dia memang harus berjalan kaki 50 mil ke 
sekolah. 

 

MENGHUBUNGKAN DENGAN ID TRIMBLE 

 

Jika Anda berbagi model SketchUp sebagai bagian dari alur kerja kantor Anda atau dengan 

klien Anda, menggunakan ID Trimble menawarkan beberapa keuntungan dibandingkan akun 

Google. Kedua jenis akun tersebut memungkinkan Anda untuk masuk ke layanan online 

SketchUp, seperti 3D Warehouse dan Extension warehouse. Namun, ID Trimble memberi 

Anda akses ke Trimble Connect, yang memiliki beberapa tambahan yang mungkin berguna 

bagi Anda: 

 

 Orang lain, apakah mereka anggota tim proyek atau klien, dapat meninjau dan 
mengomentari model di browser web. Kemampuan ini memungkinkan orang untuk 
meninjau model tanpa harus mengunduh SketchUp.  

 Trimble Connect menawarkan banyak manajemen proyek dan tool alur kerja, seperti 
pelacak aktivitas dan item agenda. 

 

 

Mengelola model secara online 

3D Warehouse bukanlah model individual gratis untuk semua yang beredar di dunia maya. Ini 
sebenarnya tempat yang cukup terorganisir. Lihat halaman detail masing-masing model untuk 
melihat kemungkinannya. 

Berikut daftar barang-barang yang kurang jelas dan gadget di 3D Warehouse yang ingin Anda 
ketahui: 

 Account drop-down menu: Dengan opsi untuk membuka halaman yang penuh dengan 
model Anda sendiri, membuat koleksi baru (lebih lanjut tentang itu nanti), dan keluar dari 
akun Anda, ini adalah bagian penting dari antarmuka Gudang. 

 Search Bar: Ketikkan kata kunci untuk menemukan model; tidak ada yang ajaib di sini - 
kecuali jika Anda mengeklik ikon kecil di bilah yang terlihat seperti sepasang roda gigi 
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mesin. Ikon ini menunjukkan opsi untuk mencari koleksi (bukan model), dan tautan ke 
halaman pencarian lanjutan. Ini adalah tiket Anda untuk mencari nirwana dengan tepat. 

 Viewer Setting: Ketiga ikon ini memungkinkan Anda memilih antara gambar statis, 
tampilan 3D, dan bagan yang menunjukkan popularitas model (tampilan dan unduhan) 
dari waktu ke waktu. 

Tips 

Dari ketiga tampilan tersebut, tampilan 3D (ikon tengah) adalah yang paling revolusioner. Dapat 
mengorbit di sekitar model tanpa harus mendownloadnya terlebih dahulu akan menghemat 
banyak waktu dan energi. 

 Statistics pane: Angka-angka yang muncul di bagian halaman ini semuanya menarik dan 
berguna, tetapi yang paling Anda perhatikan adalah Poligon dan Bahan. Ini memberi tahu 
Anda ukuran model dalam dua metrik yang paling penting: 

o Polygon adalah singkatan pemodelan 3D untuk face; semakin banyak yang Anda 
miliki, semakin keras SketchUp harus bekerja untuk menampilkan model Anda. 
Jika Anda berpikir untuk mengunduh pohon dengan 350.000 poligon, 
pertimbangkan untuk berlibur ke Tahiti saat SketchUp membukanya. 

o Material juga membebani kinerja komputer Anda, tetapi materi tersebut hanya 
berlaku untuk model yang sangat bertekstur foto. 

 Share: Berteriak ke Twitter, Facebook, Google Plus, dan Pinterest di sini. Unggah model 
Anda, lalu beri tahu jejaring sosial Anda tentang model itu. 

 Embed: Klik di sini dan 3D Warehouse menyajikan beberapa kode HTML yang dapat Anda 
gunakan untuk menyematkan model di laman web. 

Tips 

Fitur Sematkan sangat penting bagi produsen produk, desainer, dan siapa pun yang ingin 
membiarkan publik menjelajahi model dalam 3D tanpa meninggalkan situsnya. 

 Add to Collection: Salah satu hal paling produktif yang dapat Anda lakukan di 3D 
Warehouse adalah mengumpulkan model - milik Anda sendiri dan model orang lain. 
Jadikan diri Anda sebagai koleksi kosong untuk barang-barang seperti kursi, figur skala, 
pohon, dan perusak bintang. Kemudian isi dengan model menakjubkan yang Anda 
temukan saat menjelajah. Kembali ke SketchUp, di panel Komponen, pilih Koleksi Saya 
dari menu tarik-turun Koleksi, dan itu dia, siap digunakan dalam pekerjaan Anda sendiri. 

 Edit: Mengklik tombol Edit mengubah sebagian besar area teks pada halaman menjadi 
bidang teks yang dapat diedit; untuk mengubah judul model Anda, cukup ketikkan yang 
baru tepat di tempat yang lama. Sederhana. 

Sementara kita membahas tentang koleksi, berikut cara membuatnya sendiri: 

1. Pastikan Anda masuk ke 3D Warehouse.  
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Jika Anda masuk, Anda akan melihat nama pengguna Anda di menu tarik-turun akun di 
bagian atas setiap laman di Gudang. Jika Anda belum masuk, klik Masuk (juga di bagian 
atas setiap laman) dan masukkan kredensial akun Anda. 

2. Pilih Buat Koleksi dari menu tarik-turun Akun di bagian atas halaman mana pun.  

Anda dapat membuat koleksi dengan beberapa cara lain, tetapi cara ini yang paling 
universal; ini berfungsi di mana pun Anda berada di 3D Warehouse. 

3. Pilih pengaturan Privasi untuk koleksi baru Anda.  

Publik berarti semua orang di Gudang dapat melihatnya. Pribadi berarti hanya Anda yang 
dapat melihatnya, dan hanya ketika Anda masuk. 

4. Beri judul untuk koleksi baru Anda. 
5. Tuliskan deskripsi singkat namun bermakna tentang isi koleksi Anda.  

Ingatlah bahwa koleksi bisa berisi baik model maupun koleksi lainnya. 

6. Tambahkan URL (alamat web), jika relevan. 
7. Ketikkan tag yang mungkin membantu orang lain menemukan koleksi Anda. 

Tips 

Pemberian tag sangat relevan untuk koleksi bertanda Publik. 

8. Klik Buat Koleksi di bagian bawah halaman. 
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BAB 13 

Membuat Presentasi dan Dokumen dengan LayOut 

LayOut memberi Anda tool untuk menambahkan merek perusahaan, dimensi yang akurat, pola 
bayangan dan arsiran, dan banyak lagi - apa pun yang diperlukan untuk menyertai tampilan 
model Anda. Anda dapat membuat presentasi dengan ukuran fisik apa pun dan mengekspornya 
sebagai PDF atau gambar untuk dikirim ke orang lain. 

Ingat 

Yang terbaik dari semuanya, ketika desain Anda berubah di SketchUp, Anda dapat dengan mudah 
memperbarui tampilan model Anda di LayOut untuk mencerminkan perubahan tersebut. Jika 
Anda mencari nafkah dengan mendesain dan menyajikan ide dalam 3D, LayOut dapat 
menghemat banyak waktu. 

Meskipun buku ini tidak dapat menggali semua yang dapat dilakukan LayOut, bab ini membantu 
Anda mulai menggunakan fitur utama LayOut untuk menampilkan model Anda. 

Membuat Dokumen LayOut  

Untuk membantu Anda mendapatkan posisi Anda di LayOut, bagian ini membantu Anda 
menyusun dokumen LayOut. Tarik napas dalam-dalam, pasang baterai baru di mouse Anda, dan 
persiapkan untuk membuat presentasi Anda menjadi jauh lebih mudah dari sebelumnya…. 

Saat Anda meluncurkan LayOut (atau setiap kali Anda memulai dokumen LayOut baru), kotak 
dialog Memulai muncul dan meminta Anda untuk memilih templat. Anda dapat mengubah 
perilaku default ini jika Anda mau, tetapi templat biasanya merupakan cara termudah untuk 
memulai. 

Semua opsi templat diperluas sehingga Anda dapat melihat semua kategori opsi. Template yang 
dipilih pada Gambar dibawah ini  adalah template Titleblock yang menggunakan font serif 
sederhana dan ukuran dokumen surat standar (8 ½x11 inci). Baik Anda memulai dengan templat 
prebuilt atau membuat sendiri, bagian berikut memandu Anda melalui dasar-dasar pembuatan 
presentasi di LayOut. 



383 
 

 

Gambar 14-1: Pilih template dalam kotak dialog Memulai. 

Kustomisasi Layer dan Halaman Dokumen 

Banyak template LayOut memiliki banyak halaman dan layer, seperti yang ditunjukkan pada 
Gambar 14-2. Saat Anda menggunakan halaman dan layer secara bersamaan, mereka memberi 
Anda banyak kendali atas apa yang muncul di mana dalam dokumen Anda: 

 Page: Dokumen Anda dapat memiliki halaman sebanyak yang Anda suka. Di panel 
Halaman di sebelah kanan, Anda dapat menyesuaikan jumlah dan urutan halaman. Untuk 
menambahkan halaman, klik ikon tanda tambah. Untuk menduplikasi halaman, klik ikon 
Duplicate Selected Page. Untuk menghapus halaman, klik ikon tanda minus. Untuk 
mengubah urutan halaman, klik dan seret halaman ke atas atau ke bawah secara 
berurutan. 

 Layer: Dalam LayOut, layer bekerja seperti lembaran asetat yang ditumpuk satu sama lain. 
Pada panel Layer, Anda dapat menambahkan layer yang mengontrol apa yang muncul 
atau tidak di setiap halaman. Dua fitur memungkinkan Anda untuk mengelola layer: 
visibilitas layer (ikon mata) dan berbagi layer (ikon halaman tunggal atau ganda). 

Dalam template, layer mungkin dikunci secara default sehingga Anda tidak dapat memindahkan 
sesuatu secara tidak sengaja. Untuk menyesuaikan template dengan informasi Anda sendiri, buka 
kunci setiap layer dengan mengklik ikon gembok kecilnya. Gambar 14-3 membantu Anda 
menemukan kontrol penting ini pada panel Layers. 
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Gambar 14-2: Halaman dan layer memungkinkan Anda untuk mengontrol apa yang muncul di 
mana dalam dokumen 

 

Gambar 14-3: Di panel Layout's Layers, ikon mengontrol berbagi dan visibilitas. 
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Untuk menambahkan elemen di hampir setiap halaman, ikuti langkah-langkah berikut: 

1. Di Layer Panel, buat Layer atau pilih Layer yang ada. 

Ingat 

Layer dengan pensil merah kecil di sebelahnya adalah layer aktif Anda. 

2. Klik ikon berbagi layer sehingga terlihat seperti dua halaman (bukan satu).  

Langkah ini membagikan apa pun yang Anda tambahkan ke layer ini di setiap halaman 
dalam dokumen Anda. 

3. Membuat elemen, seperti mengetik teks, menggambar bentuk, atau memasukkan 
model atau gambar SketchUp.  

Anda menemukan cara menambahkan item ke halaman di bagian mendatang. 

4. Di panel Halaman, pilih halaman yang tidak Anda inginkan untuk menampilkan item. 
5. Kembali ke panel Layers, klik ikon mata sehingga mata tertutup dan layer tersebut 

beralih ke status tersembunyi.  

Elemen menjadi tersembunyi di halaman yang dipilih. Pada Gambar 14-2, perhatikan 
bahwa Halaman Sampul dipilih pada panel Halaman. Untuk membuat halaman sampul 
kustom, layer On Every Inside Page disembunyikan. 

Ingat 

Di panel Layer, saat sebuah layer dibagi di antara semua laman Anda, Anda dapat mengontrol 
keterlihatan layer pada laman yang dipilih dengan mengubah ikon mata. 

Sebaliknya, jika Anda ingin elemen hanya muncul di satu halaman, ikuti langkah-langkah berikut: 

1. Di Page panel, pilih halaman tempat Anda ingin menampilkan elemen. 
2. Pada panel Layers, klik ikon plus untuk membuat layer baru atau pilih layer yang 

menampilkan elemen hanya pada halaman yang dipilih. 
3. Klik ikon berbagi layer sehingga terlihat seperti satu halaman. 
4. Dengan halaman dan layer dipilih, buat elemen pada layer baru. 

Saat Anda membuat dokumen, menjaga elemen Anda tetap teratur dengan halaman dan layer 
dapat menghemat kewarasan Anda. Berikut beberapa tip untuk membantu Anda dalam 
perjalanan: 

 Untuk melacak apa yang dilakukan setiap halaman dan layer, berikan masing-masing 
nama deskriptif, mirip dengan nama yang Anda lihat pada template yang ditunjukkan 
pada Gambar 14-2. Untuk menamai halaman atau layer, klik dua kali namanya, dan 
namanya dapat diedit. 



386 
 

 Untuk melihat di layer mana elemen berada, pilih elemen tersebut dan cari titik biru kecil 
di panel Layer. Jika Anda memilih dua elemen pada dua layer yang berbeda, Anda akan 
melihat dua titik biru. 

 Untuk mengubah layer mana yang ada, pilih layer tujuan di panel Layer. Kemudian 
context-clicks elemen yang ingin Anda pindahkan dan pilih 

 Pindah ke Layer Saat Ini. Memilih beberapa elemen, mengcontext-clicks salah satunya, 
dan memilih Pindah ke Layer Saat Ini memindahkan semuanya. Pindahkan beberapa 
elemen dari banyak layer ke satu layer dengan Salin dan Tempel. Menyalin elemen dari 
beberapa layer dan menempelkannya akan menempel semuanya pada layer yang sama - 
yang aktif. 

Menambah dan mengedit teks 

 

LayOut memungkinkan Anda menambahkan teks lama biasa dengan tool Teks, dan itu mudah 
dilakukan. Label dan dimensi, yang akan dibahas nanti dalam bab ini, memiliki beberapa fitur 
hebat yang tidak dimiliki teks biasa. 

Kotak teks di LayOut diklasifikasikan menjadi dua tipe besar, bergantung pada cara Anda 
membuatnya: 

 Bounded: Jika Anda mengklik dan menyeret dengan tool Teks, kotak teks yang Anda buat 
dibatasi. Teks apa pun yang Anda masukkan ke dalamnya yang tidak sesuai tidak akan 
terlihat, dan Anda mendapatkan panah merah kecil di bagian bawah. Panah itu memberi 
tahu Anda bahwa masih ada lagi di kotak teks Anda; Anda perlu menggunakan tool Pilih 
untuk memperbesar kotak untuk menampilkan semua yang ada di dalamnya. Gunakan 
kotak teks terbatas kapan pun teks Anda perlu pas dengan ruang yang tepat dalam desain 
Anda. 

 Unbounded: Jika, alih-alih membuat kotak teks dengan tool Teks, Anda cukup mengeklik 
untuk menempatkan kursor di suatu tempat di laman Anda, teks yang Anda buat tidak 
dibatasi. Itu tetap berada di dalam kotak teks, tetapi kotak teks itu secara otomatis 
mengubah ukurannya untuk mengakomodasi teks apa pun yang Anda masukkan di 
dalamnya. Untuk mengubah kotak teks tidak terbatas menjadi kotak, cukup ubah 
ukurannya dengan tool Pilih atau pilih Teks => Buat Tidak Terbatas. 

Tips 

Biasanya, Anda mengontrol hal-hal seperti ukuran teks, warna, perataan, dan font menggunakan 
panel Style Teks (kotak dialog Font di Mac). Pilih teks yang ingin Anda format dan pilih setelan 
yang Anda inginkan di panel. 

Saat Anda menambahkan dan mengedit teks di LayOut, berikut beberapa tip untuk membantu 
Anda: 
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 Untuk mengedit teks, klik dua kali elemen teks dengan tool Pilih. Setelah selesai, klik di 
tempat lain pada halaman. 

 Perbesar dokumen Anda jika Anda perlu menambahkan atau mengedit teks dengan tepat. 
Lihat sidebar terdekat,”Zooming", untuk detailnya. 

 Pilih Text => Insert Auto-Text untuk memasukkan tag yang menampilkan teks yang dibuat 
secara otomatis. Misalnya, Anda bisa menyisipkan nomor halaman atau nama 
perusahaan. Untuk menyesuaikan teks yang muncul untuk tag Auto-Text tertentu, pilih 
Text => Customize Auto-Text, dan di kotak dialog yang muncul, pilih tag di bagian atas dan 
ketik teks yang Anda inginkan di area yang ditentukan di bagian bawah. 

 Di Mac, memilih Text => Show Rulers tidak hanya menampilkan kenaikan yang ditentukan 
di bagian atas window gambar Anda. Ini juga memungkinkan kontrol tambahan untuk 
penspasian paragraf dan daftar - berpoin dan bernomor. Cukup pilih teks di dokumen 
Anda untuk melihatnya muncul di atas penggaris. 

Memasukkan tampilan model SketchUp 

Dengan setiap program tata letak halaman lainnya di alam semesta, satu-satunya cara untuk 
menyertakan tampilan model SketchUp adalah dengan mengekspor tampilan tersebut dari 
SketchUp sebagai file gambar dan kemudian menempatkannya di program tata letak. Mengubah 
file SketchUp berarti melalui seluruh proses ekspor-dan-tempat lagi. Jika presentasi Anda 
menyertakan banyak tampilan model SketchUp, proses ini bisa memakan waktu berjam-jam. 

Ingat 

Ini membawa kita ke alasan LayOut: Alih-alih mengekspor tampilan dari SketchUp untuk 
memasukkannya ke dalam LayOut, yang Anda lakukan hanyalah menyisipkan file SketchUp. Dari 
dalam LayOut, Anda dapat memilih tampilan yang paling Anda sukai. Anda juga dapat 
menggunakan tampilan model yang sama sebanyak yang Anda inginkan. Ketika file SketchUp 
Anda dimodifikasi, LayOut mengetahuinya dan (menggunakan panel Referensi di kotak dialog 
Pengaturan Dokumen) memungkinkan Anda memperbarui semua tampilan Anda sekaligus 
dengan mengklik satu tombol. Jika Anda perlu berhenti sebentar untuk membiarkan aspek 
penghematan waktu dari fitur ini masuk, kami mengerti. 

Ikuti langkah-langkah berikut untuk memasukkan area pandang SketchUp (tampilan model) ke 
dalam dokumen Anda: 

1. Di SketchUp, buat Scene untuk setiap tampilan model Anda yang ingin Anda perlihatkan 
di dokumen LayOut Anda. Setelah selesai, simpan dokumen Anda.  

2. Di LayOut, pada panel Pages, pilih halaman tempat Anda ingin menyisipkan viewport. 
3. Pilih File => Insert. 
4. Pada kotak dialog Sisipkan yang muncul, cari file SketchUp di komputer Anda yang ingin 

Anda sisipkan dan klik tombol Open.  

Kotak dialog Sisipkan ditutup, dan model SketchUp Anda ditempatkan pada halaman 
dokumen LayOut Anda saat ini. 
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5. Dengan tool Pilih, context-clicks area pandang Anda, pilih Pemandangan, lalu pilih 
nama pemandangan yang ingin Anda munculkan di area pandang ini, seperti yang 
ditunjukkan pada Gambar 14-4. 

Tip 

Jika Anda tidak melihat daftar Scene, Anda mungkin lupa menyimpan file SketchUp Anda pada 
Langkah 1. Simpan file SketchUp Anda; lalu context-clicks area pandang Anda (di LayOut) dan 
pilih Perbarui Referensi. 

6. (Opsional) Tetapkan skala gambar ke tampilan model Anda jika sesuai.  

Jika pemandangan yang Anda pilih di Langkah 5 adalah tampilan ortografis (atas, depan, 
samping) di mana perspektif dimatikan, Anda mungkin ingin menunjukkan model Anda 
pada skala gambar tertentu. Lihat”Membuat tampilan ortografik berskala” nanti di bab 
ini untuk detailnya. 

7. Gunakan tool Pilih untuk memposisikan atau mengubah ukuran tampilan model Anda.  

Klik dan seret untuk memindahkan elemen apa pun di dokumen Anda di halaman. Klik 
dan seret Rotation Grip (tongkat biru kecil di tengah gambar Anda saat dipilih) untuk 
memutar. Anda dapat mengubah ukuran apa pun dengan mengeklik dan menyeret sudut 
mana pun. 
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Gambar 14-4: Mengaitkan pemandangan dari model Anda dengan viewport di LayOut. 

Tip 

Jika ikon tanda seru kuning cerah muncul di pojok kanan bawah area pandang, Anda perlu 
memberi tahu LayOut untuk merender area pandang tersebut sehingga mencerminkan 
perubahan apa pun yang telah Anda buat. Context-click viewport, pilih Render Model dari menu 
konteks, dan Anda siap melakukannya. 

Mereposisi tampilan model di LayOut 

Di LayOut, saat Anda bekerja di dalam model viewport, Anda bekerja dalam 3D. Anda dapat 
melakukan beberapa hal untuk mengubah sudut pandang viewport Anda: Gunakan tool Kamera 
atau edit pemandangan dengan panel Model. 

Mengklik dua kali area pandang dengan tool Pilih sedikit seperti mengaktifkan SketchUp dari 
dalam LayOut. Saat Anda berada dalam mode seperti SketchUp ini, batas biru tebal di sekitar 
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area pandang model menjadi bingkai biru tipis. Jika Anda menggunakan model ini, Anda dapat 
mengubah sudut pandang Anda sebagai berikut: 

 Orbit, zoom, dan geser menggunakan mouse Anda, persis seperti yang Anda lakukan di 
SketchUp. 

 Context-klik viewport dan pilih tool Kamera tertentu dari menu konteks (Orbit, Pan, 
Zoom, Zoom Window, Look Around, atau Walk). 

 Pada tab View panel Model SketchUp, ditunjukkan pada Gambar 14-5, pilih opsi dari 
daftar tarik-turun Pemandangan atau Tampilan Standar. 

 

Gambar 14-5: Panel Model SketchUp di LayOut. 

Saat Anda selesai mengubah posisi model, klik di tempat lain untuk berhenti mengedit area 
pandang. LayOut merender kembali tampilan, dan model Anda kembali terlihat bagus dan segar. 

Membuat model Anda tampil terbaik. 

Tab kedua panel Model SketchUp - Style - berisi salah satu pengaturan terpenting di semua 
LayOut: bidang Garis Bobot. Angka yang Anda masukkan ke dalam bidang Line Weight memberi 
tahu LayOut seberapa tebal menggambar garis tertipis di viewport Anda. Memasukkan 2 edge 
hasil dengan lebar 2 poin. Mengetik 0,25 membuat edge Anda selebar seperempat poin - jauh 
lebih tipis dan (dalam banyak kasus) jauh lebih bagus. Gambar 14-6 mengilustrasikan bagaimana 
penyesuaian pengaturan ini mengubah tampilan model. 
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Gambar 14-6: Gunakan bidang Garis Ketebalan untuk membuat model Anda terlihat paling 
bagus. 

Ingat 

Mengubah nomor Line Weight adalah satu hal terbaik yang dapat Anda lakukan untuk model 
Anda di LayOut. Bobot garis yang Anda gunakan bergantung sepenuhnya pada ukuran area 
pandang dan kompleksitas gambar Anda. Cobalah untuk menghindari membuat apa pun terlihat 
terlalu tipis atau terlalu tebal - kuncinya di sini adalah keterbacaan. 

Masalah Teknis 

Jika style yang diterapkan ke area pandang Anda telah mengaktifkan Profil, beberapa edge 
terlihat lebih tebal. Untuk mengubah ketebalan Profil di viewport, edit style yang mendefinisikan 
Profil di model SketchUp. Ketebalan profil selalu kelipatan: Pengaturan 4 menghasilkan Profil 
yang empat kali lebih tebal dari edge biasa. 
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Cara LayOut merender model juga dapat berdampak besar pada penampilan model Anda. Anda 
mengontrol rendering pada tab Styles panel SketchUp Model: Di kanan bawah, daftar drop-down 
memungkinkan Anda untuk memilih Vector, Raster, atau Hybrid. Berikut ini bagaimana pemilihan 
setiap opsi memengaruhi bagaimana model Anda dirender (dan lihat Gambar 14-7 untuk melihat 
contoh dari setiap style rendering): 

 Raster: Merender viewport Anda sebagai gambar yang terdiri dari banyak titik kecil. Jika 
model Anda dirender sebagai raster, model dapat menampilkan style sketsa, bayangan, 
dan efek lain yang membuatnya tampak seperti di SketchUp. Di sisi lain, mencetak atau 
mengekspor gambar raster dalam ukuran besar memerlukan banyak piksel, dan itu dapat 
membuat LayOut tersendat. Lihat”Menyeimbangkan kinerja dan kualitas" sidebar 
terdekat untuk mencari tahu lebih lanjut. 

 Vektor: Menampilkan area pandang model yang Anda pilih sebagai gambar vektor. Garis 
tampak halus dan tajam, tetapi hal-hal seperti bayangan, tekstur, dan style sketsa tidak 
muncul. Selain itu, memilih rendering vektor untuk model yang sangat kompleks dapat 
memakan waktu lama untuk diproses. 

 Hibrid: Menggabungkan garis vektor bersih dengan tampilan raster yang kaya, bayangan, 
dan barang lainnya. Di balik layar, LayOut merender model dua kali - sekali sebagai vektor 
dan sekali sebagai raster. Rendering hybrid membutuhkan waktu lebih lama daripada 
rendering vektor tetapi menghasilkan hasil yang sangat bagus. Jika Anda punya waktu, 
coba rendering hibrida untuk melihat tampilannya. 

 

Gambar14-7: Pilih metode rendering untuk setiap viewport di dokumen LayOut Anda. 
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Cobalah rendering raster untuk model dengan style Sketchy Edges dan untuk model apa pun 
dengan banyak geometri. Pilih rendering hybrid atau vektor untuk setiap rencana, bagian, atau 
tampilan lain yang menampilkan banyak pekerjaan garis. 

 

MENYEIMBANGKAN KINERJA DAN KUALITAS 

 

Semakin kompleks model SketchUp Anda, semakin lama waktu yang dibutuhkan untuk 

merender di LayOut. Jika LayOut lamban, menyesuaikan beberapa pengaturan rendering 

mungkin akan memberikan sedikit perubahan pada langkahnya. Coba yang berikut ini: 

 

 Pilih File => Document Setup => Paper. Dari daftar drop-down Display Resolution, pilih 
Low, yang sesuai dengan resolusi 72 ppi (piksel per inci). 

 Pada panel Model SketchUp, kosongkan kotak centang Otomatis di kiri bawah. 
Melakukannya akan memberi tahu LayOut untuk tidak merender area pandang model 
setiap kali Anda mengeditnya. Sebaliknya, LayOut menunggu hingga Anda mengklik 
tombol Render (di sebelah kotak centang) sebelum melakukan rendering apa pun. 

 

 

Membuat tampilan ortografis berskala  

Langkah pertama dalam membuat gambar berdimensi adalah mengubah area pandang menjadi 
tampilan ortografis 2D model Anda. Meskipun Anda dapat menggunakan kontrol di panel Model 
SketchUp untuk melakukannya, cara yang lebih baik adalah kembali ke model dan membuat 
pemandangan. 

Ikuti langkah-langkah berikut untuk menyimpan Scene ortografis dalam model SketchUp Anda 
dan menetapkannya ke area pandang di LayOut: 

1. Di LayOut, context-clicks (dengan Select Tool) area view yang berisi model Anda dan 
pilih Open with SketchUp. 

2. Jika Anda berencana untuk memiliki potongan bagian aktif dalam tampilan Anda, 
tambahkan ke model Anda (jika Anda belum melakukannya).  

3. Di SketchUp, pilih Camera => Parallel Projection; lalu pilih Camera => Standard View ⇒ 
Top (atau opsi lain dari daftar ini kecuali Iso). 

4. Zoom dan geser (tapi jangan orbit) hingga Anda mendapatkan tampilan yang 
diinginkan, lalu pilih View => Animation => Add Scene. 

5. Simpan model Anda dan Close. 
6. Di LayOut, context-clicks area pandang dan pilih Perbarui Referensi. 
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7. Di tab Tampilan pada panel Model SketchUp, pilih Scene baru Anda untuk 
mengaitkannya dengan area view. 

Sekarang setelah Anda memiliki tampilan ortografis model Anda, Anda dapat menetapkan skala 
untuk itu. Berikut semua yang perlu Anda ketahui tentang itu: 

 Tetapkan skala menggunakan Scale drop-down list di panel Model SketchUp. Jangan 
lupa untuk memilih area pandang yang sedang Anda kerjakan terlebih dahulu. Bergantian, 
dengan tool Pilih, context-clicks area pandang Anda, pilih Skala, dan kemudian pilih satu 
dari daftar yang muncul, seperti yang ditunjukkan pada Gambar 14-8. 

 Buat Scale Anda sendiri jika Anda mau. Butuh skala yang tidak muncul di daftar default? 
Pilih Edit => Preferences (LayOut =>  Preferencespada Mac) untuk membuka Preferences 
dialog box; lalu klik Timbangan di sebelah kiri. Klik tanda plus untuk menambahkan skala 
baru ke daftar. Skala yang Anda tambahkan tersedia untuk file LayOut apa pun yang 
sedang Anda kerjakan. 

 Pastikan Preserve Scale on Resize dipilih. Setelah Anda menetapkan skala ke area 
pandang, Anda mungkin ingin mengubah ukuran batasnya secara manual dengan tool 
Pilih. Sebelum Anda melakukannya, pastikan kotak centang Preserve Scale on Resize (di 
panel Model SketchUp) dipilih. Jika tidak, Anda mengubah skala tampilan model Anda 
saat mencoba mengubah ukuran viewport-nya. 

Ingat 

LayOut memungkinkan Anda menetapkan skala ke tampilan lama mana pun, tetapi itu tidak 
masalah. Skala gambar hanya berlaku untuk tampilan model Anda secara langsung dan 
nonperspektif. 

Memperbarui referensi model 

Jika Anda tidak yakin apakah area pandang SketchUp Anda mencerminkan perubahan terbaru 
pada file model SketchUp Anda (file .skp), LayOut memungkinkan Anda untuk memeriksanya. 
Pilih File => Document Setting => References. Anda melihat daftar file yang direferensikan oleh 
dokumen LayOut dan apakah referensi tersebut terkini. Untuk memperbarui file model SketchUp 
secara manual, pilih dalam daftar dan klik Perbarui. File SketchUp harus disimpan ke hard drive 
Anda agar proses pembaruan dapat bekerja. 

Menambahkan foto dan grafik lainnya 

Memasukkan gambar ke dalam dokumen LayOut Anda sangatlah mudah. Cukup pilih File ⇒ 
Sisipkan dan ambil dari sana. Beberapa hal lagi yang perlu diketahui tentang gambar yang Anda 
sisipkan: 

 LayOut dapat memasukkan gambar raster. Gambar raster terbuat dari piksel, atau titik-
titik kecil. TIFF, JPEG, GIF, BMP, dan PNG adalah semua format file grafik yang menyimpan 
gambar sebagai banyak titik kecil. 
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 Versi Mac dari LayOut juga dapat memasukkan PDF. Ini adalah cara terbaik untuk 
menghadirkan seni vektor, seperti logo. Anda dapat menggunakan program seperti 
Adobe Illustrator untuk menyimpan file AI (Illustrator) atau EPS sebagai PDF. 

 Gambar sangat mirip dengan area pandang. Teknik untuk memindahkan, mengubah 
ukuran, dan memutar gambar bekerja seperti yang mereka lakukan untuk tampilan model 
SketchUp; gunakan tool Pilih untuk melakukan semuanya. Ingatlah untuk menahan 
tombol Shift saat Anda mengubah ukuran untuk mempertahankan rasio aspek gambar 
Anda. 

 

Gambar 14-8: Tetapkan skala gambar yang tepat ke area pandang ortografis mana pun. 

Sayangnya, LayOut tidak menawarkan cara mudah untuk mengimpor grafik vektor yang dapat 
diedit (seperti AI, EPS, dan SVG). Jika Anda ingin menggunakan grafik vektor dalam dokumen 
LayOut, Anda memiliki dua pilihan: 

 Buatlah milik Anda sendiri. LayOut adalah tool ilustrasi vektor yang fantastis. Bagian yang 
akan datang,”Menggambar dengan tool vektor LayOut", membantu Anda memulai. 
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 Pinjam dari panel Scrapbooks. Salah satu hal terbaik tentang LayOut adalah ratusan - 
mungkin ribuan - elemen grafis yang telah digambar sebelumnya yang dapat Anda 
temukan di panel Scrapbooks (ditunjukkan pada Gambar 14-9). Anda menemukan hal-hal 
seperti  

 Simbol: Panah, penanda bagian, indikator utara, skala grafik, dan kisi kolom 

 Entourage elements: Pohon, mobil, dan orang dalam berbagai skala dan tingkat detail 

 Palet warna: Untuk membantu menghasilkan dokumen yang menarik dengan cepat 

Untuk menggunakan sesuatu yang Anda lihat di Scrapbooks, cukup klik dengan tool Select untuk 
mengambil sampelnya dan kemudian klik lagi untuk mencapnya ke halaman Anda. Anda dapat 
terus mengklik untuk memberi cap lebih banyak salinan. Tekan tombol Esc saat Anda siap untuk 
keluar dari mode stamping. 

 

Gambar 14-9: Scrapbooks berisi semua jenis gambar yang dapat Anda sisipkan ke dalam 
dokumen LayOut. 

Menggambar dengan tool vektor LayOut 

LayOut menyertakan serangkaian tool menggambar yang dapat Anda gunakan untuk membuat 
logo, bilah judul, panah utara, skala grafik - apa pun yang Anda inginkan. Gambar yang Anda buat 
adalah vektor, artinya Anda dapat melakukan hal berikut: 

 Skala gambar tanpa kehilangan kualitas. 

 Ubah warna fill dan stroke (outline). 

 Pisahkan garis lalu gabungkan kembali untuk membuat bentuk baru. 
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Karena kami tidak tahu apa yang ingin Anda gambar, daftar langkah menjadi sangat tidak berguna 
di sini. Sebagai gantinya, berikut beberapa petunjuk untuk Anda mulai: 

 Buat bentuk dengan cara yang sama seperti Anda membuatnya di SketchUp. Garis, 
busur, persegi panjang, lingkaran, poligon - Anda melihat tool yang sama atau serupa, dan 
Anda dapat (untuk sebagian besar) klik-gerakkan-klik untuk membuat bentuk seperti yang 
Anda lakukan di SketchUp. 

 Ketik pengukuran dan sudut. LayOut memiliki measurement box (di pojok kanan bawah 

layar Anda), seperti yang ada di SketchUp.  

 Bangun bentuk kompleks dari yang lebih sederhana. Misalnya, dengan tool Pisah dan 
tool Gabung, Anda dapat menggabungkan segitiga dan persegi panjang untuk membuat 
panah tebal dan kotak. 

 Gunakan bidikan yang tepat. Anda dapat menjepret ke objek atau ke kisi melalui menu 
Atur. 

 Buka panel Shape Style. Gunakan panel Shape Style untuk mengubah karakteristik isian 
dan guratan dari bentuk yang dipilih. Dalam bahasa Inggris biasa, klik dua kali contoh Fill, 
Pattern, atau Stroke untuk membuka panel tempat Anda dapat memilih warna dan pola 
untuk hal-hal yang Anda gambar. Kontrolnya sangat mudah, jadi Anda tidak 
membutuhkan banyak bantuan dari kami; hanya bereksperimen dan lihat apa yang 
terjadi. Anda juga dapat memilih garis putus-putus atau menambahkan panah ke awal 
atau akhir baris. 
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Gambar 14-10: Gambar bentuk dan sesuaikan garis tepi, isian, pola, dan warnanya. 

Menganotasi dengan label 

Tips 

Jika Anda seorang profesional, seperti arsitek atau insinyur, yang perlu merepresentasikan 
material yang berbeda menggunakan pola standar yang disebut arsiran, LayOut telah membantu 
Anda - dan yang lebih penting, membantu Anda menutupi gambar Anda. LayOut mencakup 
beberapa arsiran yang paling umum (yang disebut Simbol Material), serta arsiran untuk Ubin 
Geometris, Pola Situs, dan Pola Tonal (yang mencakup titik dan garis dengan berbagai ukuran). 
Untuk menerapkan arsiran ini (atau pola apa pun) ke bentuk dalam dokumen LayOut Anda, pilih 
bentuknya, klik dua kali contoh Pola di panel Style Bentuk. Pada panel Pattern Fill yang terbuka, 
pilih kategori dari daftar drop-down di bagian atas, dan kemudian pilih arsiran atau pola yang 
Anda inginkan di antara contoh yang muncul. Gambar 14-10 menunjukkan proses ini dalam 
tindakan. 

 



399 
 

Di LayOut, label adalah cara termudah untuk menambahkan info (catatan dengan garis pemandu) 
ke model dan gambar. Dengan tool Label, Anda dapat menambahkan label di mana pun Anda 
membutuhkannya. Berikut enam poin penting tentang salah satu tool paling berguna di LayOut: 

 Aktifkan, klik, klik, ketik, dan klik. Aktifkan tool Label, klik sekali untuk menyematkan 
ujung garis pemimpin ke elemen dalam gambar Anda, klik lagi untuk menempatkan kursor 
teks Anda, ketik sesuatu, dan klik di tempat lain untuk menyelesaikan label Anda, seperti 
yang ditunjukkan pada Gambar 14-11. 

 Jika mau, Anda dapat membuat garis pemandu melengkung. Mereka sering kali lebih 
menonjol ketika sebagian besar bentuk dalam gambar Anda memiliki edge yang lurus. Di 
LayOut, Anda membuat kurva garis pemandu dengan klik-seret-melepaskan mouse Anda 
saat Anda menempatkan titik akhirnya. (Anda juga dapat melakukan ini dengan garis yang 
dibuat dengan Line Tool.) 

 Hemat waktu dengan teks yang terisi otomatis. Saat Anda memberi label jenis entitas 
tertentu dalam model viewport, LayOut secara otomatis mengisi bagian teks untuk Anda. 
Memberi label pada komponen memberi Anda namanya. Memberi label pada face 
memberi Anda luasnya. Jika Anda tidak menginginkan saran LayOut, cukup ketik yang lain. 

 Garis pemimpin menempel pada elemen gambar. Saat Anda memindahkan hal yang 
disematkan pada garis pemimpin Anda, garis itu juga bergerak bersamanya. 

 Gunakan panel Shape Style untuk mengedit tampilan garis pemimpin Anda. Anda dapat 
mengubah warna, ketebalan, dan titik akhir (panah, garis miring, dan titik) dari garis 
pemandu dengan sangat mudah setelah Anda membuatnya. 

 Hemat waktu dengan pengambilan sampel. Setelah Anda mengedit label, mudah untuk 
membuat setiap label berikutnya cocok: 

o Aktifkan tool Label lalu tekan tombol S. Kursor Anda berubah menjadi pipet. 
o Klik bagian teks dari label yang Anda contoh dan kemudian klik S lagi. 
o Klik garis pemimpin label yang Anda contoh. 

Sekarang setiap label yang Anda buat terlihat seperti yang Anda ambil sampelnya.  

Menampilkan dimensi 

Dimensi dapat menampilkan pengukuran yang tepat berdasarkan model atau gambar Anda. 

Ingat 

Alat dimensi bekerja bergandengan tangan dengan model yang disisipkan untuk menghemat jam 
kerja Anda. Misalnya, jika Anda menambahkan dimensi ke model SketchUp yang disisipkan dan 
kemudian mengubah dimensi model Anda, LayOut dapat mengetahui tentang perubahan 
tersebut dan memperbarui model yang disisipkan dan dimensi yang sesuai. 

Tip 

Sebelum Anda menggunakan tool dimensi mana pun, pastikan Jepretan Objek diaktifkan. (Ini 
aktif secara default.) Dengan Object Snap on, garis pemandu dimensi Anda dapat”melihat" titik 
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yang seharusnya mereka lampirkan. Pada menu Arrange, Anda dapat memeriksa status Object 
Snap. 

 

 

Gambar 14-11: Tambahkan keterangan teks dengan tool Label. 

Untuk membuat dimensi linier, ikuti langkah-langkah berikut: 

 

1. Pilih Linear Dimension tool. 
2. Klik titik awal, lalu klik titik akhir. 
3. Klik untuk menentukan offset, dan selesai. 

Tip 
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Setelah Anda membuat dimensi pertama dan saat tool masih aktif, klik dua kali titik berikutnya 
yang ingin Anda dimensi. Teknik ini menduplikasi offset yang Anda tetapkan untuk dimensi 
pertama. 

Dimensi sudut sedikit lebih rumit daripada dimensi linier. Ikuti langkah-langkah ini untuk 
membuatnya berhasil (lihat Gambar 14-12): 

 

1. Aktifkan Angular Dimension tool. 
2. Klik di suatu tempat di sepanjang garis pertama untuk sudut yang ingin Anda tandai, 

dan klik lagi di sepanjang garis itu.  

Anda membuat dua”titik pin" yang membentuk garis pertama dari sudut yang ingin Anda 
tandai. 

3. Klik di suatu tempat di sepanjang garis kedua yang menciptakan sudut, dan klik lagi.  

Anda membuat set titik pin kedua yang memberi tahu LayOut di mana garis sudut lainnya 
berada. 

4. Klik untuk terakhir kalinya untuk memposisikan teks dimensi sudut Anda. 
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Gambar 14-12: Membuat dimensi sudut membutuhkan waktu untuk membiasakan diri. 

Tip 

Membuat layer terpisah untuk teks, label, dan dimensi menghemat waktu dalam jangka panjang. 
Lihat”Menyesuaikan halaman dan layer dokumen" di awal bab ini untuk detailnya. 
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Mengedit dimensi 

Setelah Anda benar-benar menggambar dimensi - linier atau sudut - pada halaman Anda, Anda 
dapat melakukan banyak hal untuk mengubah seperti apa dimensi itu. Untuk memulainya, lihat 
anatomi suatu dimensi. Gambar 14-13 menunjukkan contoh dari masing-masing jenis. 

 

Gambar 14-13: Anatomi dimensi LayOut. Linear di kiri, sudut di kanan. 

Sekarang setelah Anda memahami nomenklatur dengan jelas, berikut beberapa saran tentang 
mengedit tampilan dimensi (pada dasarnya, semuanya kecuali kotak teksnya): 

 Gunakan panel Shape Style untuk mengubah warna, style garis, ketebalan garis, dan 
style panah (hal-hal di ujung garis dimensi). 

 Gunakan panel Text Style untuk mengubah font, ukuran teks, dan sebagainya. 

 Gunakan Style tool untuk menyalin pemformatan dan pengaturan lainnya dari satu 
dimensi ke dimensi lainnya. Aktifkan tool Style, klik dimensi”sumber" Anda, lalu klik 
setiap dimensi yang ingin Anda ubah. 

 Klik dua kali dimensi untuk mengakses semua internalnya. Setelah dapat diedit, Anda 
dapat mengeklik dan menyeret titik koneksi dimensi, titik offset, titik jangkauan, atau teks 
sesuka Anda. 

 Pilih baris individu untuk mengeditnya. Setelah Anda mengklik dua kali dimensi, Anda 
dapat memilih garis penyusunnya untuk mengeditnya. Aidan suka menggambar garis 
dimensi sedikit lebih tebal daripada garis ekstensi, jadi dia memilih garis dimensi dan 
meningkatkan lebarnya di panel Shape Style. 
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 Overshoot bisa jadi rumit. Overshoot (seperti yang ditunjukkan pada Gambar 14-13) 
adalah bagian dari garis ekstensi yang melampaui garis dimensi. Anda dapat 
menyesuaikan panjang overshoot Anda jika Anda mau. Begini caranya: 

o Klik dua kali dimensi untuk mengeditnya. 
o Klik untuk memilih garis ekstensi yang overshootnya ingin Anda sesuaikan. 
o Ubah nomor di samping pengaturan End Arrow di panel Shape Style. 

Sayangnya, tidak ada cara untuk mengubah overshoot kedua path ekstensi secara bersamaan. 
Setelah Anda mengubah satu baris, pilih Edit => Copy Style; lalu pilih yang lain dan pilih Edit => 
Paste Style. 

Ingat 

Untuk mengambil sampel style dimensi sehingga setiap dimensi baru yang Anda gambar cocok, 
pilih tool Style (atau tekan tombol S) dan klik dimensi sumber Anda sebelum Anda menggambar 
yang berikutnya. 

Perhatikan panel Dimension Style, seperti yang ditunjukkan pada Gambar 14-14. Sebagian besar 
kontrol di sini jelas, tetapi beberapa jelas tidak. Menyelam tepat di: 

 Text Position: Pilih untuk menampilkan string teks di atas, di bawah, atau tepat di tengah 
garis dimensi yang sesuai. 

 Text alignment: Memaksa string teks untuk selalu horizontal atau vertikal pada halaman, 
atau disejajarkan (paralel) atau tegak lurus dengan garis dimensinya. 

 Display units: Orang yang menggunakan sistem pengukuran Imperial cenderung 
menunjukkan satuan pada dimensinya. Orang-orang metrik cenderung tidak 
melakukannya. Anda punya pilihan. 

 Auto Scale button: Di sinilah dimensi mulai menjadi sedikit rumit. Untuk diskusi lengkap 
tentang fungsi tombol ini, lihat bagian selanjutnya. 

 Scale drop-down list: Ini hanya tersedia jika Auto Scale tidak dipilih. Lewati untuk 
membaca semua tentang ruang model dan ruang kertas. Memahami topik ini 
membutuhkan waktu. 

 LengthProfesi yang berbeda memiliki konvensi yang berbeda untuk dimensi yang mereka 
berikan pada gambar mereka. Pilih salah satu yang paling cocok untuk Anda. 

 Precision: Jika Anda mengukur panjang keseluruhan landasan pacu bandara, Anda 
mungkin tidak perlu akurat hingga 1000 inci. Namun, jika Anda mendesain katup jantung 
buatan 

 Angle: Derajat atau radian - Anda yang memutuskan. Terkadang, perangkat lunak 
mengingatkan Anda bahwa kutu buku matematika yang membuatnya. 
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Gambar 14-14: Panel Dimension Style. 

Melacak Paper Space dan Model Space 

Saat Anda menempatkan area pandang model SketchUp di halaman Anda, Anda akan 
mendapatkan dua jenis ruang di dokumen LayOut: 

 Paper Space: Jarak yang berkaitan dengan lembar fisik kertas yang sedang Anda kerjakan 
dikatakan dalam ruang kertas. Kotak biru berukuran 4x4 inci di ruang kertas memiliki 
panjang 4 inci. 

 Model Space: Jarak dalam area pandang model tidak ada hubungannya dengan ukuran 
selembar kertas tempat tampilan terlihat. Sebuah bangunan berukuran 80x80 kaki yang 
ditunjukkan pada skala 1 inci = 8 kaki berukuran panjang 80 kaki dalam model ruang. Di 
ruang kertas, panjangnya 10 inci. 

Ingat 

Dimensi yang Anda gambar di LayOut ada di ruang kertas atau di ruang model. Di mana dimensi 
secara default bergantung pada apa yang terhubung dengan dimensi: 

 Viewports: Saat Anda menggambar dimensi antara dua titik dalam model viewport, 
LayOut cukup pintar untuk menganggap bahwa Anda ingin menampilkan panjang antara 
titik-titik dalam model (dalam ruang model). 
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 Lainnya: Saat Anda membuat dimensi antara dua titik yang tidak ada hubungannya 
dengan viewport, LayOut mengasumsikan bahwa Anda ingin melihat panjang sebenarnya 
di halaman (di ruang kertas). 

Gambar 14-15 mengilustrasikan perbedaan antara ruang model dan ruang kertas. Kedua dimensi 
tersebut memiliki panjang fisik yang sama persis di halaman: 3 inci. Namun, dimensi di sebelah 
kiri dipasang ke dua titik pada model SketchUp yang ditampilkan pada skala 1 inci = 8 kaki. 
Dimensi ini menampilkan model ruang panjang 24 kaki (3x8), sedangkan dimensi di sebelah 
kanan menunjukkan ruang kertasnya 

 

Gambar 14-15: Dimensi dapat menunjukkan ruang model atau ruang kertas. 

Tip 

Tombol Auto Scale di panel Dimension Style secara otomatis dipilih setiap kali Anda membuat 
dimensi baru. Jika dimensi Anda menyentuh titik di area pandang model, string teks 
menampilkan panjang dalam ruang model. Jika tidak menyentuh area pandang model sama 
sekali, Anda mendapatkan panjang di ruang kertas. 

Mematikan Skala Otomatis memungkinkan Anda menetapkan skala ke dimensi yang Anda pilih. 
Memilih 1 inci = 60 kaki untuk dimensi yang secara fisik panjangnya 4 inci membuat string teksnya 
terbaca 240 kaki - apa pun dimensi yang dilampirkan. 
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Membuat tabel 

 

Jika Anda membuat dokumen konstruksi, tool Tabel cocok untuk Anda. Baru di LayOut 2017, fitur 
tabel memungkinkan Anda dengan mudah menambahkan jadwal konstruksi, area dan kuantitas 
lepas landas, legenda, atau apa pun yang Anda butuhkan untuk membantu orang lain memahami 
dokumen LayOut Anda. 

Untuk mulai membuat tabel, berikut ini dasar-dasarnya: 

 Untuk membuat tabel, pilih tool Tabel, klik untuk menyetel sudut kiri atas, gerakkan 
kursor hingga jumlah baris dan kolom yang Anda inginkan muncul, klik untuk menyetel 
pojok kanan bawah tabel, dan klik sekali lagi untuk menyesuaikan dimensi tabel. 

 Untuk menambahkan teks ke tabel, klik ganda tabel untuk mengakses sel tabel. Klik dalam 
sel dan ketikkan teks yang ingin Anda munculkan. 

 Untuk mengedit lebar garis dan Background tabel, pilih tabel dan gunakan panel Shape 
Style. 

 Untuk mengedit baris, kolom, dan sel, klik ganda tabel lalu context-clicks untuk melihat 
menu opsi. 

Tip 

Tabel LayOut menyertakan beberapa fitur keren untuk membuat dan mengelola data tabel: 

 Jika data tabel Anda sudah disimpan sebagai file Excel (.xlsx) atau CSV (.csv), Anda dapat 
mengimpor data tersebut ke LayOut dan menghemat banyak waktu. Untuk mengimpor 
file, pilih File => Insert, pilih file, pastikan lembar yang benar dipilih, dan klik OK. Anda juga 
dapat memilih untuk mengimpor pemformatan tabel dari Excel. 

 Setelah Anda mengimpor tabel, mengelola perubahan antara file sumber tabel Anda dan 
LayOut sangatlah mudah. Jika Anda perlu memperbarui file sumber, Anda dapat 
memperbarui tabel Anda di LayOut dengan mengcontext-clicks tabel dan memilih 
Perbarui Referensi Tabel dari menu yang muncul. 

Membuat Template Anda Sendiri 

Ingat 

Sebagian besar presentasi desain yang Anda (atau perusahaan Anda) kumpulkan mungkin 
terlihat serupa - bagaimanapun juga, itu adalah bagian dari identitas merek Anda. Jika dokumen 
presentasi yang Anda buat adalah semua variasi pada beberapa tema, mengapa tidak membuat 
templat Anda sendiri dan menggunakannya setiap kali Anda memulai proyek baru? Anda dapat 
mengatur LayOut sehingga templat Anda muncul di kotak dialog Memulai, membuatnya lebih 
mudah untuk membuat presentasi yang konsisten, lebih cepat. 
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Ikuti langkah-langkah berikut untuk mengubah file LayOut menjadi template: 

1. Buat file LayOut yang menyertakan semua elemen yang Anda inginkan.  

Elemen-elemen ini mungkin termasuk blok judul, logo, penomoran halaman, dan 
halaman sampul. Anda mungkin juga ingin menyiapkan hal-hal yang tidak dapat Anda 
lihat, seperti tag Teks Otomatis, sistem pelayer, dan bahkan halaman kosong yang telah 
dibuat sebelumnya untuk konten. Untuk memastikan template Anda menangkap 
semuanya, Anda dapat menghapus semua konten dari dokumen LayOut yang telah Anda 
buat dan kemudian menyimpan shell yang dihasilkan sebagai template. 

Tip 

Sebelum Anda pindah ke Langkah 2, pastikan Anda melihat halaman yang ingin Anda gunakan 
sebagai pratinjau thumbnail di daftar template. 

2. Pilih File => Save as Tempelate.  

Kotak dialog Save As Template terbuka. 

3. Ketikkan nama untuk templat Anda, lalu pilih lokasi untuk templat baru Anda.  

Dalam daftar di bagian bawah kotak dialog, klik folder (semuanya adalah folder) tempat 
Anda ingin menyertakan template yang Anda tambahkan. 

4. Klik OK (Simpan di Mac).  

Saat berikutnya kotak dialog Memulai muncul, templat baru Anda akan ada di dalamnya. 

Menyusun Scrapbooks Anda Sendiri 

Sebagian besar pengguna LayOut hardcore membuat scrapbook sendiri yang berisi gambar skala, 
mobil, pohon, simbol penyusunan, tipografi - apa pun yang perlu mereka gunakan berulang kali. 

Seperti templat, lembar memo hanyalah file LayOut yang telah disimpan dalam folder khusus di 
sistem Anda. Saat Anda membuka program, ia memeriksa folder itu dan menampilkan file yang 
ditemukannya di panel Scrapbooks. 

Ikuti langkah-langkah berikut untuk membuat lembar memo LayOut Anda sendiri: 

1. Buat file LayOut dengan elemen yang ingin Anda sertakan dalam lembar memo Anda. 
2. Pilih File =. Save as Scrapbook. 
3. Ketikkan nama untuk lembar memo Anda.  

Dalam kotak dialog Simpan Sebagai Scrapbook, daftar Folder Scrapbook menunjukkan 
lokasi folder tempat lembar memo baru Anda akan disimpan. Jika Anda lebih suka 
menggunakan folder lain, Anda dapat menambahkannya menggunakan panel Folder dari 
kotak dialog Preferensi. 
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4. Klik OK (Simpan di Mac).  

Lain kali Anda memulai ulang LayOut, lembar memo Anda muncul di bagian atas panel 
Scrapbooks. 

Beberapa catatan tentang membuat scrapbook Anda sendiri: 

1. Ukuran yang bagus adalah 6x6 inci. Anda dapat memilih ukuran kertas apa pun untuk file 
yang ingin Anda simpan sebagai lembar memo, tetapi lembar yang lebih kecil berfungsi 
lebih baik. Lembar memo yang disertakan dengan LayOut berukuran 6 inci persegi. 

2. Kliping dapat memiliki banyak halaman. Nyatanya, hampir semua lembar memo default 
di LayOut melakukannya. Halaman pertama dalam dokumen Anda menjadi halaman 
sampul untuk scrapbook; semua halaman berikutnya muncul di bawahnya dalam daftar. 
Perhatikan nama halaman Anda, yang juga muncul di panel Scrapbooks. 

3. Gunakan locked layer. Apa pun yang Anda taruh di layer terkunci tidak dapat ditarik 
keluar dari lembar memo. Lihatlah lembar memo People yang disertakan dengan LayOut 
- kata People dan informasi di sebelahnya ada di layer terkunci. Perhatikan bagaimana 
Anda tidak bisa menyeretnya ke dalam gambar Anda? 

4. Anda dapat menempatkan area pandang model ke dalam scrapbook. Buka Arrow => 3D 
=> Curved scrapbook. Seret salah satu panah ke halaman Anda. Sekarang klik dua kali - 
itu adalah model! Aidan membuat lembar memo itu secara khusus untuk memberi story 
board panah yang dapat digerakkan yang dapat mereka tunjukkan sesuka mereka. Moral 
dari cerita ini adalah Anda dapat memasukkan apa saja ke dalam lembar memo: grafik, 
gambar, area pandang, dan teks. 

Mengeluarkan Dokumen Anda dari Pintu 

Setelah Anda membuat dokumen LayOut, Anda dapat melakukan empat hal berikut untuk 
memperlihatkannya kepada orang lain: 

 Print. 

 Ekspor sebagai PDF atau file gambar. 

 Ekspor sebagai file DWG atau DXF (CAD).  

 Lihat sebagai presentasi layar penuh. 

Empat bagian berikutnya memberikan detail lebih lanjut tentang masing-masing opsi ini. 

Mencetak pekerjaan Anda 

Mencetak dari SketchUp; perhatikan bahwa panjangnya lebih dari sepuluh halaman. Instruksi 
untuk mencetak dari LayOut, di sisi lain, akan dengan mudah masuk ke dalam kartu nama: 

1. Pilih File => Print. Dalam kotak dialog Cetak, pilih halaman mana yang akan dicetak dan 
berapa banyak salinan yang Anda inginkan. 

2. Klik OK untuk mengirim dokumen Anda ke printer. 
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Dan itu, pembaca yang budiman, itulah mengapa Anda harus selalu memasukkan model 
SketchUp Anda ke dalam dokumen LayOut jika Anda perlu mencetaknya. 

Tips 

Konon, Aidan hampir tidak pernah mencetak langsung dari LayOut. Sembilan puluh persen dari 
waktu, dia mengekspor PDF dan menggunakan Adobe Acrobat (atau Reader) untuk mengirim 
pekerjaan sebenarnya ke printer. Pengaturan di kotak dialog Adobe's Print memberi Anda kontrol 
lebih atas produk jadi. 

Mengekspor file PDF atau gambar 

Siapapun dengan perangkat lunak Adobe Reader (yang gratis dan sudah dimuat di jutaan 
komputer) dapat melihat dokumen PDF yang Anda buat; yang harus Anda lakukan adalah 
mengirimkannya melalui email ke penerima Anda. 

Atau Anda dapat mengekspor halaman file Anda sebagai gambar raster individual dalam format 
JPEG atau PNG.  

Ikuti langkah-langkah berikut untuk mengekspor dokumen LayOut Anda sebagai file PDF atau 
gambar: 

1. Pilih File => Export => PDF atau File => Ekspor => Gambar. Di Mac, pilih File => Ekspor, 
lalu pastikan PDF, PNG, atau JPEG dipilih di kotak dialog Ekspor. Kotak dialog ekspor 
terbuka. 

2. Beri nama file Anda dan beri tahu LayOut di mana menyimpannya di komputer Anda. 
Jika Anda menyimpan gambar, pilih format file untuk gambar tersebut. 

3. Klik tombol Simpan (Windows) atau tombol Opsi (Mac). 
4. Di kotak dialog yang muncul, atur opsi untuk PDF atau gambar Anda.  

Inilah yang dilakukan setiap opsi: 

a. Pages: Pilih halaman mana yang ingin Anda ekspor. Jika Anda mengekspor 
gambar, setiap halaman di dokumen LayOut Anda diekspor sebagai file gambar 
terpisah. 

b. Image Resolution: Jika Anda mengekspor PDF, Anda dapat memilih Tinggi, 
Sedang, atau Rendah. Berikut panduan yang bagus: Untuk dokumen yang cukup 
kecil untuk dipegang, kami merekomendasikan pengaturan Tinggi. Untuk sesuatu 
yang lebih besar, gunakan Medium. Jika Anda mengekspor gambar, Anda dapat 
menentukan lebar atau tinggi dalam piksel atau mengetik resolusi dalam piksel 
per inci (ppi). 96 ppi berfungsi dengan baik pada layar, dan 300 ppi berfungsi 
dengan baik untuk pencetakan. 

c. Image Compression: Anda melihat opsi ini hanya jika Anda mengekspor PDF. Pilih 
pengaturan ini untuk menerapkan kompresi style JPEG ke gambar.  

d. Layer: Anda melihat opsi ini hanya jika Anda mengekspor PDF, karena PDF dapat 
memiliki layer, seperti yang dimiliki dokumen LayOut. Jika masuk akal untuk 
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melakukannya, Anda dapat mengekspor PDF berlapis sehingga orang yang 
melihatnya dapat mengaktifkan dan menonaktifkan layer tersebut. 

e. Finish: Pilih kotak centang ini untuk melihat PDF atau gambar Anda setelah 
diekspor. 

5. Khusus Mac: Klik OK untuk menutup kotak dialog Opsi. 
6. Klik tombol Ekspor (tombol Simpan di Mac) untuk mengekspor dokumen Anda sebagai 

PDF atau gambar. 

Mengeksport file DWG atau DXF 

Anda akan kesulitan menemukan software gambar berbantuan komputer (CAD) profesional yang 
tidak dapat membaca format DWG dan DXF, yang merupakan standar industri untuk bertukar file 
CAD dengan orang yang menggunakan aplikasi seperti AutoCAD. Berikut cara mengubah 
dokumen LayOut Anda menjadi file CAD: 

1. Atur semua area pandang SketchUp Anda ke mode rendering vektor. Area pandang yang 
dirender sebagai raster akan diekspor ke DWG/DXF sebagai gambar raster. Ini biasanya 
bukan yang Anda inginkan - terutama jika Anda mengekspor file CAD. Lihat”Membuat 
model Anda terlihat terbaik" di awal bab ini untuk detail tentang menyetel mode 
rendering area pandang. 

Tip 

Jika area pandang berisi tampilan yang tepinya tidak ingin Anda manipulasi dalam CAD 
(seperti rendering mewah), biarkan sebagai raster. 

2. Pilih File => Export => DWG/DXF. Di Mac, pilih File ⇒ Export dan pastikan DWG/DXF 
dipilih di kotak dialog Export. 

3. Beri nama file Anda, beri tahu LayOut di mana menyimpannya di komputer Anda, dan 
klik tombol Simpan (Opsi di Mac).  

Kotak dialog DWG/DXF Export terbuka. 

4. Setel opsi Ekspor DWG/DXF. Inilah yang dilakukan semua kenop dan sakelar: 
a. Format: Kecuali Anda tahu Anda membutuhkan DXF, ekspor file DWG. Untuk versi 

yang mana, tetap gunakan yang terbaru dalam daftar. 
b. Pages: Pilih halaman mana yang ingin Anda ekspor. Ingatlah bahwa setiap 

halaman di dokumen LayOut Anda diekspor sebagai file terpisah. 
c. Layer: Jika Anda ingin LayOut mengekspor layer Anda sebagai layer DWG/DXF pilih 

opsi itu. Jika Anda ingin mengekspor layer tersembunyi, pilih Ekspor Layer Tak 
Terlihat. Lihat”Menyesuaikan halaman dan layer dokumen" untuk detail tentang 
visibilitas layer. 

d. Lainnya: Pilih kotak centang untuk opsi apa pun yang Anda suka. Color by Layer 
mengekspor setiap layer sebagai warna berbeda. Anda dapat mengekspor entitas 
LayOut sebagai entitas DWG/DXF asli. Jika Anda memberi tahu LayOut untuk 
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mengabaikan isian, bentuk yang digambar di LayOut dan diisi dengan warna atau 
pola tidak akan muncul di file yang diekspor. 

5. Khusus Mac: Klik OK untuk menutup kotak dialog Ekspor DWG/DXF. 
6. Klik tombol Ekspor (tombol Simpan di Mac) untuk mengekspor dokumen Anda sebagai 

satu atau lebih file DWG/DXF. 

Jika file LayOut Anda menyertakan gambar raster yang disisipkan (seperti JPEG atau PNG), 
Anda juga akan mendapatkan folder yang berisi salinannya. Mereka diperlukan untuk file 
DWG/DXF yang Anda buat. 

Menggunakan layar penuh (Ingat) 

Seringkali, presentasi desain untuk klien melampaui papan cetak dan buklet. Presentasi ini 
termasuk tayangan slide digital yang biasanya melibatkan beberapa jam kerja dalam program 
seperti PowerPoint atau Keynote. LayOut membantu Anda melewati langkah PowerPoint 
dengan membiarkan Anda menampilkan presentasi Anda dalam tampilan layar penuh. Anda 
dapat berpindah-pindah antara halaman dengan tombol panah di komputer Anda, dan Anda 
bahkan dapat mengklik dua kali tampilan model SketchUp untuk mengorbitnya. Ikuti tips 
berikut ini: 

 Beralih ke mode Presentasi membutuhkan waktu kurang dari satu detik. Pilih View 
=>Start Presentasi untuk melihat presentasi Anda dalam layar penuh. Tekan tombol Esc 
untuk keluar dari mode Presentasi. 

 Tentukan di mana Anda ingin presentasi Anda muncul. Gunakan panel Presentasi di 
kotak dialog Preferensi untuk memberi tahu SketchUp monitor (atau proyektor) mana 
yang ingin Anda gunakan untuk menampilkan presentasi Anda. 

 Pindah dari halaman ke halaman. Gunakan tombol panah kiri dan kanan. 

 Pilih halaman mana yang akan menampilkan layar penuh. Anda dapat memutuskan 
untuk tidak menampilkan halaman tertentu dalam mode layar penuh dengan 
menggeser ikon Show Page in Presentations di sebelah kanan nama halaman tersebut di 
panel Halaman. (Anda harus berada dalam tampilan Daftar untuk dapat melakukan ini.) 

 Klik dua kali untuk mengubah tampilan model SketchUp Anda. Saat berada dalam 
mode layar penuh, Anda dapat mengklik dua kali area pandang model SketchUp untuk 
mengorbit dan memperbesar tampilan di dalamnya. Klik di mana saja di luar tampilan 
untuk keluar. 

 Gambar saat Anda dalam mode layar penuh. Coba klik dan seret saat Anda dalam 
mode layar penuh; melakukannya memungkinkan Anda membuat anotasi merah 
langsung di presentasi Anda. Jika klien tidak menyukai beranda yang Anda rancang, 
coretxbesar merah di atasnya untuk memberi tahu dia bahwa Anda mengerti. Saat Anda 
menekan Esc untuk keluar dari mode Presentasi, Anda dapat memilih untuk menyimpan 
anotasi Anda sebagai layer terpisah. 

 Putar animasi Scene dalam mode layar penuh. Anda dapat mengklik dua kali lalu 
mengcontext-clicks tampilan model dengan pemandangan yang telah Anda siapkan di 

SketchUp; lalu pilih Mainkan Animasi. Transisi LayOut dari satu Scene ke Scene lain.   
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BAB 14 

Sepuluh Perangkap SketchUp dan Penanganannya 

SketchUp Tidak Akan Membuat Face Yang Anda Inginkan 

Anda dengan patuh telah menelusuri semua tempat di mana Anda ingin SketchUp membuat face, 
tetapi tidak ada yang terjadi. Coba periksa apakah tepian Anda tidak semuanya pada bidang yang 
sama. 

Ingat 

Sembilan puluh persen dari waktu, saat SketchUp tidak membuat face seperti yang Anda kira, 
edge tidak berada di bidang yang Anda kira. Untuk memeriksa apakah edge Anda coplanar, 
gambar edge yang memotong secara diagonal di area tempat Anda ingin face muncul. Jika sebuah 
face muncul sekarang, tepian Anda tidak semuanya pada bidang yang sama. Untuk memperbaiki 
masalah, Anda harus mencari tahu edge mana yang menjadi penyebabnya, dan opsi Color By Axis 
dapat membantu Anda melihat informasi ini secara sekilas. Berikut cara kerja Color By Axis: 

 Di panel Styles, ubah warna edge Anda dari All Same menjadi By Axis. SketchUp 
menggambar edge dalam model Anda dengan warna sumbu yang sejajar; ujung-ujungnya 
sejajar dengan sumbu merah berwarna merah, dan seterusnya. 

 Perhatikan dengan cermat edge yang Anda inginkan untuk menentukan face yang Anda 
inginkan. Apakah semua tepinya memiliki warna yang seharusnya? Jika tidak semuanya 
harus sejajar dengan sumbu gambar, teknik ini tidak akan banyak membantu. Tetapi jika 
ya, dan satu (atau lebih) dari mereka berwarna hitam (bukan merah atau hijau atau biru), 
edge (atau tepi) itu adalah anak bermasalah Anda. Perbaiki dan alihkan kembali ke Semua 
Sama setelah Anda selesai. 

Jika bidang tidak bermasalah dengan tepian Anda, periksa apakah salah satu tepinya adalah 
bagian dari kelompok atau komponen yang terpisah. Untuk memeriksa apakah Anda memiliki 
masalah komponen, coba sembunyikan grup atau komponen dan periksa tepinya untuk 
memastikan bahwa semuanya ada dalam grup atau komponen yang menurut Anda ada di 
dalamnya.  

Face Anda adalah Dua Warna Berbeda 

Ingat 

Di SketchUp, face memiliki dua sisi: depan dan belakang. Secara default, kedua sisi ini memiliki 
warna yang berbeda. 

Saat Anda melakukan hal-hal tertentu seperti menggunakan Push/Pull atau Follow Me pada face, 
terkadang face pada geometri yang dihasilkan terlihat”dalam ke luar". Bagi sebagian orang, 
masalahnya hanya mengganggu. Jika Anda ingin mencetak 3D model Anda, masalah harus 
diperbaiki agar model Anda dapat dicetak dengan benar. 
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Untuk memperbaiki masalah ini, context-clicks pada face yang ingin Anda balik dan pilih Face 
Terbalik dari menu konteks. Jika Anda memiliki banyak face untuk dibalik, Anda dapat memilih 
semuanya lalu memilih Membalikkan Face untuk membalik semuanya sekaligus. 

Dalam pencetakan 3D, proses ini disebut memeriksa model normal Anda.  

Edge pada Face Tidak Akan Tenggelam 

Ini cenderung terjadi saat Anda mencoba menggambar persegi panjang (atau sosok geometris 
lainnya) pada face dengan salah satu tool menggambar bentuk SketchUp. Biasanya, tool Persegi 
Panjang membuat face baru di atas setiap face yang Anda gunakan; setelah itu, Anda bisa 
menggunakan Push/Pull untuk membuat lubang, jika Anda mau. Jika edge yang baru saja Anda 
gambar sepertinya tidak memotong face yang Anda gambar, cobalah pendekatan ini: 

Jiplak salah satu tepinya. Terkadang itu berhasil - Anda akan terkejut seberapa sering. 

Pilih Hidden geometry dari menu Tampilan. Anda memeriksa untuk memastikan bahwa face yang 
baru saja Anda gambar tidak melewati edge yang tersembunyi atau halus; jika ya, face yang Anda 
anggap datar mungkin tidak rata. 

Pastikan face yang Anda gambar bukan bagian dari grup atau komponen. Jika ya, batalkan 
beberapa langkah lalu gambar ulang bentuk Anda saat Anda mengedit grup atau komponen. 

SketchUp Hancur, dan Model Anda Hilang 

Sayangnya, SketchUp terkadang mogok. 

Kabar baiknya adalah SketchUp secara otomatis menyimpan salinan file Anda setiap lima menit. 
File yang disimpan otomatis SketchUp sebenarnya adalah file terpisah, SimpanOtomatis_nama 
file Anda.skp. Jika file Anda pernah rusak karena crash, file utuh sudah siap untuk Anda. 

Masalahnya adalah kebanyakan orang bahkan tidak tahu bahwa file yang disimpan otomatis itu 
ada di sana. dimana Anda menemukannya? 

 Jika Anda pernah menyimpan file Anda, itu ada di folder yang sama dengan aslinya. 

 Jika Anda tidak pernah menyimpan file Anda, file itu ada di folder Dokumen Anda - kecuali 
Anda menggunakan Mac, dalam hal ini file itu ada di sini: 

Masalah Teknis 

Sederhana bukan? Tidak secepat itu. Di Mac, Anda mungkin perlu mengubah folder Perpustakaan 
dari tersembunyi menjadi terlihat. Di app Finder, tahan tombol Option saat Anda memilih Go => 
Library. Jika Anda tidak menahan tombol Option, Library mungkin tidak muncul di menu. 

Saat Anda menutup model Anda, SketchUp biasanya menganggap tidak ada yang tidak diinginkan 
yang terjadi dan membersihkannya sendiri dengan menghapus file yang disimpan secara 
otomatis. 
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Tips 

Untuk meminimalkan jumlah pekerjaan yang hilang ketika perangkat lunak (atau perangkat 
keras) tidak berjalan lancar, selalu lakukan dua hal: 

 Sering menabung - secara kompulsif, bahkan. 

 Gunakan perintah Save a Copy As pada menu File. 

Saat Anda mengerjakan proyek besar, langkah-langkah berikut dapat membantu memastikan 
Anda tidak kehilangan pekerjaan apa pun: 

1. Simpan versi asli file Anda sebagai namafilename_Master.skp. Itu adalah file yang akan 
selalu Anda kerjakan. 

2. Buat folder yang berada di tempat yang sama dengan file Master Anda; beri nama folder 
itu seperti Arsip nama file Anda. 

3. Setiap setengah jam atau lebih, pilih File => Simpan Salinan Sebagai dan simpan versi 
bernomor dari file Anda ke folder Arsip. 

SketchUp adalah Sooooo Slooooooooow 

Semakin besar model Anda, semakin buruk kinerja komputer Anda. Apa yang membuat seorang 
model menjadi besar? Singkatnya, face. 

Tips 

Lakukan segala daya Anda untuk menjaga model Anda sekecil mungkin. Berikut beberapa tip 
untuk melakukannya: 

 Kurangi jumlah sisi pada lingkaran dan busur yang diekstrusi.  

 Gunakan orang dan pohon 2D alih-alih yang 3D. Tumbuhan tiga dimensi dan manusia 
masing-masing memiliki ratusan face. Pertimbangkan untuk menggunakan model 2D, 
terutama jika model Anda tidak akan banyak terlihat dari atas. 

Beberapa model memang besar, dan Anda tidak dapat berbuat banyak. Berikut beberapa trik 
untuk bekerja dengan model SketchUp yang sangat besar: 

 Manfaatkan Outliner dan layer secara bebas. Fitur SketchUp ini secara khusus dirancang 
untuk memungkinkan Anda mengatur model Anda menjadi bagian yang dapat diatur. 
Sembunyikan semua yang tidak Anda kerjakan saat ini - melakukannya akan memberi 
komputer Anda kesempatan untuk berjuang. 

 Gantikan formulir sederhana untuk sejumlah besar komponen kompleks. Misalnya, 
sisipkan tongkat sebagai placeholder untuk kumpulan besar pohon 3D, mobil, dan 
komponen besar lainnya.  

 Matikan bayangan dan alihkan ke style sederhana, seperti Berbayang dalam koleksi 
Style Default. Dibutuhkan banyak tenaga komputer untuk menampilkan bayangan, efek 
tepi, dan tekstur secara real time di monitor Anda. Saat Anda bekerja, matikan semua itu.  
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 Gunakan Scene untuk bernavigasi di antara tampilan. Scene tidak hanya untuk 
mempresentasikan model Anda - tetapi juga bagus untuk mengerjakannya. Jika Anda 
membuat pemandangan untuk tampilan berbeda yang biasa Anda gunakan dan dengan 
kombinasi hidden geometry yang berbeda, Anda tidak perlu mengorbit, menggeser, dan 
memperbesar model raksasa Anda. Untuk lebih mempercepat, batal pilih Enable Scene 
Transitions (di panel Animation pada kotak dialog Model Info). 

Anda Tidak Bisa Mendapatkan Tampilan Yang Baik dari Bagian Dalam Model Anda  

Tidak selalu mudah untuk mengerjakan bagian dalam sesuatu di SketchUp. Anda dapat 
melakukan hal-hal ini untuk membuatnya lebih mudah: 

 Potong model Anda dengan beberapa bagian. Fitur Bagian SketchUp memungkinkan 
Anda memotong bagian model Anda - untuk sementara, tentu saja - sehingga Anda bisa 
mendapatkan tampilan yang lebih baik tentang apa yang ada di dalamnya.  

 Perluas bidang pandang Anda. Bidang pandang adalah bagian dari model Anda yang dapat 
Anda lihat di layar sekaligus. FOV yang lebih luas seperti memiliki penglihatan edge yang 
lebih baik.  

Sebuah Face Berkedip Saat Anda Orbit  

Jika Anda memiliki dua face di tempat yang sama - mungkin satu face dalam grup atau komponen 
terpisah - Anda akan melihat efek pembiasan Z. SketchUp memutuskan face mana yang akan 
ditampilkan dengan beralih bolak-balik di antara mereka; ini bukan solusi yang baik, tetapi yang 
pasti logis - setidaknya untuk sebuah perangkat lunak. Satu-satunya cara untuk menghilangkan 
pembiasan jarak adalah dengan menghapus atau menyembunyikan salah satu face. 

Anda Tidak Dapat Memindahkan Komponen Anda Seperti Yang Anda Inginkan 

Saat Anda memasukkan beberapa komponen ke dalam model Anda, komponen secara default 
menempel pada permukaan. Contoh komponen yang direkatkan sebenarnya tidak direkatkan di 
satu tempat. Alih-alih, itu direkatkan ke bidang face tempat Anda awalnya menempatkan (atau 
membuatnya). Misalnya, jika Anda meletakkan komponen sofa di lantai ruang tamu Anda, Anda 
dapat memindahkannya hanya di bidang itu - bukan ke atas dan ke bawah. 

Perilaku menempel ini berguna saat Anda menangani hal-hal seperti furnitur; ini memungkinkan 
Anda untuk mengatur ulang berbagai hal dengan Move tool tanpa mengambilnya secara tidak 
sengaja. 

Jika Anda tidak dapat memindahkan komponen seperti yang Anda inginkan, context-clicks dan 
lihat apakah Hapus lem adalah sebuah opsi - jika ya, pilihlah. Sekarang Anda dapat memindahkan 
komponen sesuka Anda. 

Hal-Hal Buruk Terjadi Setiap Kali Anda Menggunakan Eraser 
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Saat Anda menggunakan Eraser Tool, sangat mudah untuk menghapus barang secara tidak 
sengaja. Lebih buruk lagi, Anda biasanya tidak menyadari apa yang hilang sampai semuanya 
terlambat. Berikut beberapa tip untuk menghapus dengan lebih akurat: 

 Orbit di sekitar. Cobalah untuk memastikan tidak ada apa pun di balik apa pun yang Anda 
hapus; gunakan tool navigasi SketchUp untuk mendapatkan gambaran model Anda 
sehingga Anda terhindar dari bahaya. 

 Aktifkan Back Edges. Saat Anda melakukan banyak penghapusan, pilih View => Edge Style 
=> Back Edges. Dengan begitu, Anda dapat melihat setiap sisi dalam model Anda, dan 
Anda cenderung tidak menghapus yang salah. 

 Periksa ulang. Setelah Anda melakukan banyak penghapusan, berikan model Anda sekali 
lagi dengan tool Orbit, hanya untuk memastikan bahwa Anda tidak membuang sesuatu 
yang penting. Letakkan catatan tempel di monitor komputer Anda yang mengatakan 
sesuatu seperti Periksa setelah Hapus! hanya untuk mengingatkanmu. 

Semua Edge dan Face Anda Berada di Layer Yang Berbeda 

Peringatan 

Menggunakan Layer di SketchUp adalah bisnis yang berbahaya. Selalu bangun semuanya di 
Layer0, dan letakkan seluruh grup atau komponen di layer lain hanya jika Anda benar-benar 
membutuhkannya. 

Jika Anda menggunakan layer dan sekarang semuanya kacau, inilah yang dapat Anda lakukan 
untuk memulihkannya: 

1. Pastikan semuanya terlihat.  

Pilih Hidden geometry pada menu Tampilan; kemudian (di panel Layers) buat semua layer 
Anda terlihat. Pastikan Anda dapat melihat semua yang ada di model Anda. 

2. Pilih Edit => Pilih Semua. 
3. Di panel Entity Info, pindahkan semuanya ke Layer0. 
4. Pada panel Layers, hapus layer Anda yang lain. Saat diminta, beri tahu SketchUp untuk 

memindahkan apa pun yang tersisa ke Layer0. 

Lebih dari Sepuluh Cara untuk Mempelajari Tentang SketchUp 

Free Online Resource 

Di resepsi mewah, Rebecca mencicipi setiap item di buffet makanan penutup, dan Aidan yang 
mengisi saku jasnya dengan hors d'oeuvres yang dibungkus dengan serbet. Kami sangat 
menyukai barang gratis. Jadi tanpa basa-basi lagi, berikut adalah lima sumber bantuan SketchUp 
gratis. 

 SketchUp training resources: SketchUp menerbitkan materi kelas satu langsung di situs 
webnya (www.sketchup.com/learn): 

http://www.sketchup.com/learn
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o Video tutorial: Saat SketchUp pertama kali diluncurkan pada tahun 2000, 
SketchUp dikenal karena tutorial videonya yang luar biasa. Gambar 16-1 
menunjukkan seri untuk pemula. Kami tidak dapat merekomendasikan mereka 
dengan cukup tinggi; tidak ada yang seperti melihat SketchUp beraksi. 

o Tutorial mandiri: Ini adalah file SketchUp yang menggunakan pemandangan untuk 
mengajarkan berbagai aspek program dengan style”Follow Me". Jika ini adalah 
cara Anda suka memikirkan sesuatu, lihatlah. 

o Pusat Bantuan Online: Pusat Bantuan SketchUp mencakup ratusan artikel yang 
dibuat khusus untuk membantu pengguna baru. (Rebecca membantu menulis 
banyak di antaranya.) Cara termudah untuk masuk ke Pusat Bantuan SketchUp 
adalah dengan memilih Help => Knowledge Center dari Menu bar SketchUp. 

o Forum Komunitas SketchUp: Forum online SketchUp adalah komunitas online 
yang berkembang pesat dan tempat yang tepat untuk belajar dari pengguna 
SketchUp lainnya. Ketika masalah pemodelan 3D membuat Anda bingung, orang-
orang di sini dapat membantu Anda. 

 SketchUcation: Anda menemukan diskusi, tutorial, plugin, berita, dan tumpukan hal 
bagus lainnya di SketchUcation. Anda juga akan menemukan forum pengguna yang besar 
dan aktif dari seluruh dunia. (www.sketchucation.com) 

 SketchUp School videos: Ini adalah saluran YouTube yang hebat. Video gratisnya adalah 
yang terbaik, dan Anda dapat membeli langganan untuk menonton lebih dari seratus 
lainnya di situs web SketchUp School. (www.youtube.com/4sketchupgo2school) Para 
desainer Sekolah juga telah membuat beberapa video pendidikan/pelatihan SketchUp 
terbaik di dunia; Anda dapat membayar langganan untuk menontonnya di situs web 
Sekolah (www.sketchupschool.com). Kualitas produksi pada hal-hal ini luar biasa, dan 
Mike Tadros dan Alex Oliver (dua dari orang Sekolah) melakukan pekerjaan luar biasa 
dalam mengajar SketchUp untuk sistem operasi Windows dan Mac. 

 MasterSketchUp.com: Matt Donley telah menyusun situs bagus yang didedikasikan 
untuk tip dan trik bermanfaat, video, dan tutorial lainnya. Dia juga menerbitkan sendiri 
buku tentang LayOut; Anda dapat membacanya di bagian selanjutnya. 
(www.mastersketchup.com) 

 Blog SketchUpdate: Kunjungi blog SketchUp secara teratur untuk berita, studi kasus, tip 
dan trik, profil pemodel, plugin, dan pembaruan lainnya. (http://blog.sketchup.com/) 

http://www.sketchucation.com/
http://www.youtube.com/4sketchupgo2school
http://www.mastersketchup.com/
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http://www.sketchup.com/learn/videos/58?playlist=58 

Gambar 30.1 Video pelatihan SketchUp membantu pemula melihat cara kerja pemodelan 3D. 

Daftar Bacaan SketchUp Utama 

Buku dan sumber daya ini menghabiskan sedikit uang, tetapi nilainya setiap sennya: 

 Buku Bonnie Roskes: Bonnie’s The SketchUp Book (diterbitkan oleh 3DVinci) adalah buku 
pertama yang tersedia, dan sekarang dia memiliki beberapa judul, termasuk buku 
SketchUp untuk anak-anak. Jika Anda ingin mendapatkan buku lain yang lebih besar 
tentang SketchUp (ditulis dengan memikirkan arsitek dan ahli desain lainnya), lihat buku 
Bonnie di www.3dvinci.net. 

 Buku Daniel Tal: Daniel Tal berfokus pada teknik khusus yang dapat membantu 
membangun keterampilan pemodelan 3D tingkat lanjut. SketchUp for Site Design: A 
Guide to Modeling Site Plans, Terrain and Architecture, 2nd Edition (Wiley), 
sederhananya, adalah buku yang bagus. Buku terbaru Dan (juga diterbitkan oleh Wiley) 
adalah Rendering di SketchUp: Dari Pemodelan hingga Presentasi untuk Arsitektur, 
Arsitektur Lansekap, dan Desain Interior. Ini mengungkap seni gelap rendering 
fotorealistik dengan cara yang mungkin akhirnya membuat Anda mencobanya. Saat Anda 
siap untuk mengambil langkah selanjutnya dalam hubungan SketchUp Anda, dapatkan 
buku Dan. 

 Buku Michael Brightman: Tambahan baru-baru ini untuk rak buku SketchUp, Alur Kerja 
The SketchUp untuk Arsitektur: Bangunan Model, Desain Visualisasi, dan Pembuatan 
Dokumen Konstruksi milik Michael dengan SketchUp Pro dan Tata Letak (Wiley) adalah 
titik balik dalam sejarah penerbitan SketchUp. Dia datang dengan alur kerja yang layak 

http://www.sketchup.com/learn/videos/58?playlist=58
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untuk menggunakan SketchUp Pro (termasuk LayOut) untuk menghasilkan kumpulan 
dokumen konstruksi lengkap yang terlihat seperti yang biasanya Anda gunakan untuk 
membuat AutoCAD atau Revit. Hal-hal dalam buku ini sangat pintar - Anda harus 
membacanya untuk mempercayainya. 

 Buku Alex Schreyer: Judul Desain Arsitektur dengan SketchUp: Pemodelan Berbasis 
Komponen, Plugin, Rendering, dan Skrip (Wiley) tentu menyiratkan bahwa ini adalah buku 
untuk arsitek. Itu tidak sepenuhnya benar; ini sebenarnya adalah sumber daya yang bagus 
bagi siapa saja yang ingin mencari tahu lebih lanjut tentang semua topik dalam teks film. 
Alex berhak mendapatkan penghargaan khusus atas pengantar terampilnya pada skrip 
Ruby untuk nonprogramer. 

 Buku Matt Donley: Orang di belakang MasterSketchUp.com telah menulis e-book 
berjudul SketchUp to LayOut: Panduan Penting untuk Membuat Dokumen Konstruksi 
dengan SketchUp Pro dan LayOut. Tidak seperti buku Mike Brightman (yang kami 
sebutkan sebelumnya), buku Matt mendekati subjek lebih dari perspektif pemula. Ini juga 
menunjukkan contoh pertukangan dan dapur dan kamar mandi, yang seharusnya menarik 
bagi orang-orang yang bukan arsitek.  

 Buku Dennis Fukai: Tiga kata: detail yang mencengangkan. Buku Dennis sulit untuk 
dijelaskan. Dia menulis tujuh di antaranya, masing-masing diilustrasikan sepenuhnya di 
SketchUp, dan masing-masing mengajarkan subjek yang berbeda. Jika Anda ingin 
mengetahui lebih banyak tentang penggunaan SketchUp dalam konstruksi gedung atau 
lebih banyak tentang konstruksi itu sendiri, atau Anda hanya ingin benar-benar 
terinspirasi oleh apa yang dapat Anda lakukan dengan SketchUp, lihatlah buku-buku ini. 
Telusuri namanya di Amazon (www.amazon.com) atau buka situs perusahaannya, 
www.insitebuilders.com. 

Tool Lain dari Pembuat SketchUp 

 my.SketchUp: SketchUp versi gratis ini berjalan di browser web. my.SketchUp memulai 
debutnya pada tahun 2016 dengan perangkat yang terbatas, tetapi semua drawing tool 
utama ada di sana, seperti yang ditunjukkan pada Gambar 162. Anda dapat berharap 
untuk melihat lebih banyak fitur seiring dengan perkembangan produk. Semua tool yang 
tersedia bekerja hampir persis seperti yang mereka lakukan di SketchUp, meskipun Anda 
akan menemukan beberapa perbedaan kecil untuk mengakomodasi bekerja di browser 
alih-alih di aplikasi yang diinstal di komputer Anda. Untuk memulai, kunjungi 
http://www.sketchup.com/products/my-sketchup. 

 Extension Warehouse: Ekstensi biasanya menambahkan sedikit fungsionalitas untuk 
tugas khusus, seperti pencetakan 3D. Memang, bukan kebetulan bahwa sebagian besar 
pembahasan tentang ekstensi yang semuanya tentang pencetakan 3D. Baik Anda 
menggunakan SketchUp untuk arsitektur, pengerjaan kayu, desain interior, set film, atau 
yang lainnya, Anda dapat menemukan seluruh kategori ekstensi yang dirancang untuk 
membuat tugas tertentu sedikit lebih mudah. Mulailah menjelajah di 
http://extensions.sketchup.com/ atau di dalam SketchUp, pilih Window ⇒ Extension 
Warehouse. Untuk benar-benar menginstal ekstensi di SketchUp, Anda harus masuk 
dengan ID Trimble atau akun Google. Saat Anda masuk melalui SketchUp (dengan memilih 

http://www.sketchup.com/products/my-sketchup
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Window Window Extension Warehouse), menginstal ekstensi biasanya cukup mudah: 
Cukup klik tombol Instal berwarna merah di kiri atas halaman detail ekstensi. 

Tip 

Setelah Anda menginstal beberapa ekstensi, SketchUp 2017 memungkinkan Anda untuk memilih 
Window => Manajer Ekstensi untuk membantu mengelola ekstensi Anda dan menjaganya tetap 
mutakhir. Pada versi SketchUp sebelumnya, Anda dapat mengelola ekstensi melalui antarmuka 
online Extension warehouse online. 

 SketchUp Viewer: Jika Anda perlu menampilkan model kepada klien Anda (yang 
kemungkinan besar tidak menginstal SketchUp di komputer mereka), SketchUp Viewer 
dapat membantu Anda berbagi file SketchUp. SketchUp Viewer adalah aplikasi terpisah 
yang sebenarnya hadir dalam tiga versi berbeda: 

o Versi desktop dapat diunduh gratis (dapatkan di sini: 
http://www.sketchup.com/products/sketchup-viewer). 

o Versi seluler adalah aplikasi murah yang dapat Anda unduh untuk iOS atau 
Android. 

o Versi realitas maya membawa Anda ke Star Trek Holodeck sehingga Anda dapat 
melindungi galaksi dalam model 3D pilihan Anda. Oke tidak juga. Versi ketiga 
memungkinkan Anda untuk membenamkan diri dalam model 3D menggunakan 
realitas virtual. Saat buku ini dicetak, versi realitas maya hanya tersedia melalui 
Microsoft Store di Microsoft HoloLens. Jika Anda sedang mencari cara mutakhir 
untuk mengesankan klien Anda, pasti lihat cara-cara di mana Anda dapat melihat 
hologram model di atas meja atau melompat dari satu lantai ke lantai lain dalam 
tampilan yang imersif. Jika Anda belum mampu membeli penampil realitas virtual 
yang mahal, Anda setidaknya bisa mendapatkan pratinjau kemungkinan di video 
YouTube Penampil SketchUp untuk HoloLens (https://youtu.be/c2HIrT3Nshs). 

 

Gambar 30.2 my.SketchUp memungkinkan Anda membuat model di browser web. 

http://www.sketchup.com/products/sketchup-viewer
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DAFTAR PUSTAKA 

 
Alex Schreyer’s book: The title of Architectural Design with SketchUp: Component-Based 

Modeling, Plugins, Rendering, and Scripting (Wiley) certainly implies that it’s a book for 
architects. That’s not strictly true; it’s actually a great resource for anyone looking to find 
out more about all the topics in the subtitle. Alex deserves special credit for his skillful 
introduction to Ruby scripting for nonprogrammers. 

Bonnie Roskes’s books: Bonnie’s The SketchUp Book (published by 3DVinci) was the first book 
available, and now she has several titles, including SketchUp books for kids. If you think 
you want to get another, bigger book about SketchUp (written with architects and other 
design pros in mind), check out Bonnie’s books at www.3dvinci.net. 

Daniel Tal’s books: Daniel Tal focuses on specific techniques that can help build advanced 
3Dmodeling skills. SketchUp for Site Design: A Guide to Modeling Site Plans, Terrain and 
Architecture, 2nd Edition (Wiley) is, simply put, a great book. Dan’s latest book (also 
published by Wiley) is Rendering in SketchUp: From Modeling to Presentation for 
Architecture, Landscape Architecture and Interior Design. It demystifies the dark art of 
photo realistic rendering in a way that might finally get you to try it. When you’re ready 
to take the next step in your SketchUp relationship, get Dan’s books. 

Dennis Fukai’s books: Three words: jaw-dropping detail. Dennis’s books are hard to describe. 
He’s written seven of them, each is fully illustrated in SketchUp, and each teaches a 
different subject. If you want to discover more about using SketchUp in building 
construction or more about construction itself, or you just want to be completely inspired 
by what you can do with SketchUp, have a look at these books. Search for his name on 
Amazon (www.amazon.com) or go to website, www.insitebuilders.com 

Extension Warehouse: Extensions typically add little bits of functionality for specialized tasks, 
such as 3D printing. Indeed, it's no coincidence that most of the discussion about 
extensions occurs in Chapter 9, which is all about 3D printing. Whether you use SketchUp 
for architecture, woodworking, interior design, movie sets, or something else, you can 
find whole categories of extensions designed to make specific tasks a little bit easier. Start 

exploring at http://extensions.sketchup.com/ or within SketchUp, choose Window ⇒ 
Extension Warehouse. To actually install an extension in SketchUp, you need to login with 
a Trimble ID or Google account. When you log in through SketchUp (that is, by choosing 

Window ⇒ Extension Warehouse), installing an extension is usually pretty easy: Just click 

the red Install button in the upper left of the extension's details page. 
Matt Donley’s book: The man behind MasterSketchUp.com has written an e-book called 

SketchUp to LayOut: The Essential Guide to Creating Construction Documents with 
SketchUp Pro and LayOut. Unlike Mike Brightman’s book (which we mention earlier), 
Matt’s book approaches the subject from more of a beginner’s perspective. It also shows 
woodworking and kitchen and bath examples, which should appeal to people who aren’t 
architects. 

MasterSketchUp.com: Matt Donley has put together a nice site dedicated to helpful tips and 
tricks, videos, and other tutorials. He also self-published a book about LayOut; you can 
read about it in the next section. (www.mastersketchup.com) 

http://www.insitebuilders.com/
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Michael Brightman’s book: A recent addition to the SketchUp bookshelf, Michael’s The SketchUp 
Workflow for Architecture: Modeling Buildings, Visualizing Design, and Creating 
Construction Documents with SketchUp Pro and LayOut (Wiley) is a watershed in the 
history of SketchUp publishing. He came up with a viable workflow for using SketchUp Pro 
(including LayOut) to produce complete construction document sets that look just like the 
ones you’d normally use AutoCAD or Revit to make. The stuff in this book is insanely clever 

— you have to read it to believe it. 
my.SketchUp: This free version of SketchUp runs in a web browser. my.SketchUp debuted in 2016 

with a limited toolset, but the main cast of drawing tools is all there. You can expect to see 
more features as the product evolves. All the tools that are available work almost exactly 
as they do in SketchUp, although you will find some minor differences to accommodate 
working in a browser instead of in an application installed on your computer. Visit 
http://www.sketchup.com/products/my-sketchup. 

Online Help Center: The SketchUp Help Center includes hundreds of articles created specifically 
to help new users along. (Rebecca helped to write many of them.) The easiest way to get 
to the SketchUp Help Center is to choose Help ⇒ Knowledge Center from the SketchUp 
menu bar. 

Self-paced tutorials: These are SketchUp files that use scenes to teach different aspects of the 
program in a “follow along with me” style. If this is how you like to figure things out, have 
a look. 

SketchUcation: You find discussions, tutorials, plugins, news, and piles of other good stuff at 
SketchUcation. You'll also find a large and active forum of users from around the world. 
(www.sketchucation.com) 

SketchUp Community Forum: SketchUp's online forum is a thriving online community and a great 
place to learn from other SketchUp users. When a 3D modeling issue has you stumped, 
the folks here can lend you a hand. 

SketchUp School videos: This is a terrific YouTube channel. The free videos are first rate, and you 
can buy a subscription to watch over a hundred more on SketchUp School’s website. 
(www.youtube.com/4sketchupgo2school) The School designers have also produced 
some of the world’s finest SketchUp educational/training videos; you can pay for a 
subscription to watch them on the School website (www.sketchupschool.com). The 
production quality on these things is outstanding, and Mike Tadros and Alex Oliver (two 
of the School guys) do an amazing job of teaching SketchUp for both the Windows and 
Mac operating systems. 

SketchUp training resources: SketchUp publishes first-rate materials right on its website 
(www.sketchup.com/learn): 

The SketchUpdate blog: Visit the SketchUp blog regularly for news, case studies, tips and tricks, 
modeler profiles, plugins, and other updates. (http://blog.sketchup.com/) 

Video tutorials: When SketchUp first launched in 2000, it became known for its excellent video 
tutorials. Figure 16-1 shows the series for beginners. We can’t recommend them highly 
enough; there’s nothing like seeing SketchUp in action. 

 

http://www.youtube.com/4sketchupgo2school
http://blog.sketchup.com/
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